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Form No. 008-42104-00

WARRANTY
MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each
instrument manufactured by it to be free from defects in material and workmanship impairing its usefulness
under normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts, when returned prepaid to us, and which our examination discloses to have been
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for
warranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory
inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications
are made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary
practice, the repair or replacement of such of his products that may prove defective in workmanship or
materials. Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This
states our entire liability in respect to such products, except as an authorized person of MICROMERITICS
may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the
discretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects.
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or
manufactures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or
implied, including, but not limited to the implied warranties of merchantability or fitness for use.

One Micromeritics Drive     z    Norcross, GA 30093-1877   z Fax (770) 662-3696

Domestic Sales - (770) 662-3633                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
Rev. 12/95
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AutoChem II 2920 Organization of the Manual
1.  GENERAL DESCRIPTION

Organization of the Manual

This manual describes how to install, operate, and maintain the AutoChem II 2920 Analyzer. 
The manual is divided into the following chapters.

Several appendices and an index are also included.

Chapter 1 GENERAL DESCRIPTION. Provides a general description and 
specifications of the analyzer.

Chapter 2 INSTALLATION. Provides unpacking and inspection information, and 
installation instructions.

Chapter 3 USER INTERFACE. Describes basic skills for using the software.

Chapter 4 GENERAL OPERATING PROCEDURES. Describes operating 
procedures for the AutoChem II analysis program.

Chapter 5 FILE MENU. Provides descriptions for each item on the File menu.

Chapter 6 UNIT MENU. Provides descriptions for each item on the Unit menu. (A Unit 
menu is created for each analyzer connected to your system.)

Chapter 7 REPORTS MENU. Provides descriptions for each item on the Reports 
menu, as well as instructions for using the Peak Editor. Also includes 
examples of some of the reports available for the analysis program.

Chapter 8 OPTIONS MENU. Provides descriptions for each item on the Options menu.

Chapter 9 TROUBLESHOOTING AND MAINTENANCE. Describes 
troubleshooting and maintenance procedures.

Chapter 10 . ORDERING INFORMATION. Provides information on ordering parts 
and accessories for the analyzer. 
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Conventions

This manual uses the symbols shown below to identify notes of importance, cautions, and 
warnings.

Equipment Description

The AutoChem II 2920 is a highly automated catalyst characterization system. It can perform 
the following experiments individually or in various sequences:

• Temperature-Programmed Desorption (TPD)
• Temperature-Programmed Reduction (TPR)
• Temperature-Programmed Oxidation (TPO)
• Temperature-Programmed Reaction
• Pulse Chemisorption
• BET Surface Area 

The AutoChem II software represents a major advancement in the convenience and control of 
temperature-programmed analyses because of the high level of automation offered. Very few 
steps must be physically performed by an operator; the vast majority are controlled with 
precision by the software.

This automated process is determined by the sample file you create. In addition to information 
about the sample itself, the sample file contains a list of specific instructions, which the 
analyzer follows to perform any series of experiments you desire. The instrument monitors the 
progress of each step, then initiates the next one while continuously controlling temperatures 
and gas flows. Delays are eliminated, because most experiment steps do not require an 
operator to initiate them. The potential for human error is reduced, and less labor is required. 
You can create standard sets of analysis conditions, making it possible for a laboratory 
manager to standardize procedures for laboratory technicians to use during repeat sample 
analyses.

Notes contain a tip or important information pertinent to the subject matter.

Cautions contain information to help you prevent actions which could damage the 
instrument.

Warnings contain information to help you prevent actions which could cause personal 
injury.
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Convenient Windows® Interface

The Windows interface makes it easier than ever to create sample files, control analyses, and 
generate the reports you need. You can:

• Monitor detector signal, time, and temperature data.
• Create and store standard sets of analysis conditions for frequently performed analyses.
• Integrate detector signal peaks both automatically and manually.
• Display and print peak graphs and reports.
• Establish calibration curves for calculation of unknown sample concentrations. 
• Reprocess stored analysis data using different parameters.
• Export data in ASCII text format for use in other applications.

Flexible Peak Editing

The AutoChem’s powerful Peak Editor enables you to evaluate results quickly and easily, edit 
peaks, and produce reports that reflect your specific needs. Adjusting peak boundaries is a 
matter of simply pointing and clicking them to eliminate baseline noise or other undesirable 
effects. The Peak Editor also enables you to separate composite peaks.

Major Components and Features

Figure 1-1. AutoChem 2920 Analyzer
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The AutoChem II 2920 analyzer is designed to offer maximum control, flexibility, and 
automation. Some features include: 

On-screen graphical status 
display

Enables you to observe the status of automatically controlled 
operations. In manual mode, the graphical status display 
allows you to control valves, heat zones, and other 
components manually.

Point-and-click intuitive 
user interface

Allows you to create sample files using pre-programmed 
analysis conditions.

Temperature control Four separate heat zones let you heat internal gas lines, the 
thermal conductivity detector, and valves individually, from 
ambient to 150 ºC. 

Furnace control Lets you set furnace temperatures, their duration, and ramp 
rates. Sample target temperature can range from ambient to 
1100 ºC (or -70 to 1100 °C with the optional CryoCooler).

CryoCooler (optional) Enables you to start analyses at subambient temperatures. 
The CryoCooler can also be used to speed throughput by 
ramping the furnace temperature rapidly down to ambient 
after an analysis.

KwikCool Enables you to ramp the furnace temperature rapidly down 
to near ambient, reducing analysis time and increasing 
throughput.

Clamshell-type furnace Heats samples efficiently and offers easy access to analysis 
ports. 

Mass Flow Controllers 
(MFCs)

Provide precise control of gas flows, using the rates you 
specify in the sample’s analysis file. 

Vapor Generator (optional) Allows analysis using vapors from liquids carried by an inert 
gas.

Exhaust gas analysis port Allows sampling of analysis gas after it has passed the 
thermal conductivity detector for analysis by a mass 
spectrometer, infrared spectroscope, thermal analyzer, or gas 
chromatograph. 
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Temperature-Programmed Analyses

The AutoChem II is a sophisticated instrument that enables you to perform a variety of 
complex experiments. Most temperature-programmed experiments, however, are based on the 
following highly simplified steps:

1. Gas flows into the analyzer.

2. The gas interacts with the sample as the temperature changes.

3. Gas flows past the detector.

4. The detector collects data.

Diversion ports (with cold 
trap attached)

Allow trapping of condensibles in the gas flowing from the 
sample before they reach the thermal conductivity detector. 
A delay loop, dryer, or mass spectrometer may also be 
attached.

Thermal Conductivity 
Detector (TCD)

Highly accurate, gold-plated filaments detect minute 
changes in the thermal conductivity of gases. Highly linear 
sensitivity enhances the accuracy of results.

Exhaust ports Allow attachment of appropriate exhaust systems to meet 
local safety standards for chemisorption exhaust. 

Internal Blending Allows limited blending of gas mixtures in the analyzer. 
Useful for multipoint BET surface area analysis, for 
example, or to mix gases instead of purchasing premixed gas 
bottles. This feature is enabled using an option on the Gas 
Flows dialog.

This section provides a basic, simplified description of the technique for performing 
temperature-programmed analyses.
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5. The software plots and calculates results.

How does the detector work?

The detector contains heated filaments; it measures the difference in gas thermal conductivity 
sensed between the gases flowing over the sample and reference filaments.

The gases flowing past the detector cool the filament by extracting heat. How quickly any type 
of gas removes heat from the detector is determined by its thermal conductivity1. A gas with a 
high thermal conductivity cools the filament rapidly, and more power is required to maintain 
its temperature. A gas with a lower thermal conductivity removes heat from the filament more 
slowly.

When the sample reacts with the gas, it causes changes in the composition of the gas and, 
consequently, changes the thermal conductivity of the gas. These changes are sensed by the 
detector as an increase or decrease in the amount of power required to maintain the filament at 
a constant temperature.

What data are collected?

The detector reports the amount of electricity (in volts) required to keep its temperature 
constant during the analysis.

What role does sample temperature play?

Because the sample’s temperature determines how rapidly it interacts with the analysis gas (or 
if it reacts at all), data are collected over the range of temperatures you specify.

In some experiments, you may wish to start collecting data at a very low temperature to 
establish a baseline where the gas is completely unaffected by the sample. In other cases, you 
may wish to collect data after a reaction has begun. In still other experiments, your primary 
interest may be determining the temperature at which the maximum reaction occurs.

1. The thermal conductivity of a gas is its ability to conduct heat. Each gas has a distinct thermal con-
ductivity.

In the sample tube, 
the gas reacts with 
the sample.

The detector collects 
data, which are sent 
to the computer.

To exhaustGas enters 
the system.

The computer 
processes data and 
calculates results.
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Here’s one example:

Consider the example of a Temperature-programmed reduction (TPR). During the TPR, a 
metal oxide is reacted with hydrogen to form a pure metal. This reaction is referred to as 
“reducing” the metal; for example, TPR of a catalyst containing Platinum. Argon, which has a 
very low thermal conductivity, is used as a carrier gas. It is blended in a fixed proportion with 
hydrogen, an analysis gas with a much higher thermal conductivity. Then the gas mixture 
flows through the analyzer, through the sample, and past the detector.

When the gas blend begins flowing over the sample, a baseline reading is established by the 
detector. This baseline is established at a low enough temperature that no reduction of the 
sample is occurring, so the baseline level recorded by the detector is that of the thermal 
conductivity of the two gases in their fixed proportion. In other words, the proportion of gases 
flowing over the detector is the same as the proportion of gases entering the analyzer, because 
at the low temperature, there is no interaction with the sample.

The temperature is then changed, and when a critical temperature is reached, hydrogen atoms 
in the gas flow react with the sample, forming H2O molecules. The H2O molecules are 
removed from the gas stream using a cold trap. As a result, the amount of hydrogen in the 
argon/hydrogen gas blend inside the analyzer decreases, and the proportion between the two 
gases shifts in the direction of argon, as does the mixture’s thermal conductivity.

Gas flows into the sample tube 
and through the sample.

Before the reaction begins, 
the concentration of gases 
exiting the sample tube is 
unchanged after flowing 
through the sample.

As the temperature changes, 
the sample begins to react with 
the gas(es) flowing through it.

The concentration of gases exiting the 
sample tube is altered after passing 
through the sample. This change in the 
gas concentration is recorded by the 
Thermal conductivity Detector 
downstream.
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Since argon has a lower thermal conductivity than hydrogen, the mixture’s thermal 
conductivity consequently decreases. The flowing gas removes heat from the filament more 
slowly, requiring less electricity to maintain a constant filament temperature. The instrument 
records the electrical demand as it changes (this is called the detector signal). The detector 
signal is recorded continuously over a range of temperatures. When these readings are 
graphed, the data form one or more peaks. Peaks can be positive or negative; negative peaks 
are show in this example.

This example illustrates the fundamental concept upon which the analyzer operates. Of course, 
the various types of analyses the AutoChem can perform result in different types of traces. For 
example, a pulse chemisorption analysis results in a series of peaks that gradually increases in 
size as the sample is dosed with separate increments of gas. Initially, the gas uptake by the 
sample results in smaller peaks. But when all the active sites are saturated, no more gas can be 
taken up and the peaks become equal. 

2. As the temperature changes, the sample begins to 
react with one of the gases. Therefore the gas mix is 
then made up of a larger proportion of the other gas. 
This causes a shift in the mixture’s thermal 
conductivity. The detector measures this change by 
recording the change in the amount of electricity 
required to maintain constant filament temperature. 3. As temperature continues to 

increase, the interaction reaches a 
maximum, then begins to diminish.

1. Baseline readings. The gas(es) is 
(are) not reacting with the sample, so 
there is no change in the signal from 
reading to reading.

4. As fewer and fewer sample atoms are available 
to bond with the analysis gas, there is less and 
less change in the mix of gases flowing into the 
analyzer and past the detector, so the thermal 
conductivity shifts back toward the baseline value.
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Peak Area

The area beneath each peak is calculated to provide information about the volume of gas 
reacted during the analysis. Calculations are described in Appendix B.

Automatic Operation

The AutoChem II software provides a simple format for you to specify all the analysis 
conditions for the experiment; you create a sample file which contains sample information and 
a list of specific steps the analyzer will follow to perform the experiment(s). Then, the 
instrument automatically performs the analysis, from controlling the gas mixture and flow rate 
to monitoring the temperature and pressure. Data points are recorded automatically. BET 
analyses require some operator interface. After analysis, you can use the Peak Editor to adjust 
the peaks to create reports that contain the data you need, without baseline noise or other 
undesirable effects.

Because you can specify up to 99 experiments and each experiment can contain up to 99 steps, 
the AutoChem II can perform a wide variety of preparation and analysis functions 
automatically.

Cold Trap

In some cases, it is desirable to trap substances resulting from the reaction. In the previous 
example, H2O is produced during the analysis. If the gas flow is passed through the cold trap at 
an appropriate temperature, the water can be removed before the gas flows past the detector. 
The cold trap can also be used as a delay path for BET surface area experiments.

Injection Loop

Injection loops are provided for injecting carefully measured doses of gases for analyses such 
as Pulse Chemisorption. The AutoChem II is shipped with a 1.0-cm3 loop installed; 0.5- and 
5.0-cm3 loops are also included. If you set up your sample file so that a loop is used for 
introducing gas into the analyzer, the instrument will automatically dose the sample as 
specified in the sample file.
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Sample Preparation and Calibration

Depending on the type of experiment(s) you wish to perform, sample preparation and/or 
calibration may be required. More specific instructions are contained in the appropriate 
sections of this manual.

A sample is prepared for analysis by removing unwanted adsorbates from the surface of the 
sample. This is usually accomplished by flowing gas over the sample and may include heating 
the sample. The flowing gas may be inert or chemically active gases may be used to activate 
the surface.

Calibration routines provide the AutoChem II analyzer and software with the appropriate 
information to convert electrical signals to physically meaningful data such as volume 
adsorbed, loop volume, and gas concentration.

Analysis Types

Regardless of which type of experiment you perform, the basic concept is the same: the 
filament detects changes in the gas mixture flowing past it. The sample, gas selection, and 
analysis conditions determine what changes occur. Some of the analyses you can perform with 
the 2920 are described in the following sections.

TPD Analysis

Temperature-Programmed Desorption (TPD) analyses determine the number, type, and 
strength of active sites available on the surface of a catalyst from measurement of the amount 
of gas desorbed at various temperatures.

After the sample has been outgassed, reduced, or otherwise prepared, a steady stream of 
analysis gas flows through the sample and adsorbs on the active sites. Programmed desorption 
begins by raising the temperature linearly with time while a steady stream of inert carrier gas 
flows through the sample.

At a certain temperature, the heat overcomes the activation energy; therefore, the bond 
between the adsorbate and adsorbent will break and the adsorbed species desorb. If different 
active metals are present, they usually desorb the adsorbed species at different temperatures. 
These desorbed molecules enter the stream of inert carrier gas and are swept to the detector, 
which measures the gas concentrations. The volume of desorbed species, combined with the 
stoichiometry factor and the temperature at which pre-adsorbed species desorb, yields the 
number and strength of active sites.

A tutorial for some of the different type of analyses is provided in Appendix J.
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TPR Analysis

Temperature-Programmed Reduction (TPR) determines the number of reducible species 
present in the catalyst and reveals the temperature at which the reduction occurs. An important 
aspect of TPR analyses is that the sample need not have any special characteristics other than 
containing reducible metals.

The TPR analysis begins by flowing analysis gas (typically hydrogen in an inert carrier gas 
such as nitrogen or argon) through the sample, usually at ambient temperature. While the gas 
is flowing, the temperature of the sample is increased linearly with time and the consumption 
of hydrogen by adsorption/reaction is monitored. Changes in the concentration of the gas 
mixture are determined. This information yields the hydrogen uptake volume.

TPO Analysis

Temperature-Programmed Oxidation (TPO) examines the extent to which a catalyst can be 
oxidized or was previously reduced.

Usually the sample is pretreated and the metal oxides are reduced to the base metal, typically 
with a gas mixture of hydrogen with either nitrogen or argon. Then the reactant gas, typically 
2-5% oxygen with helium, is applied to the sample in pulses or, alternatively, as a steady 
stream.

The furnace heats the sample tube and sample according to the user-selected temperature 
program. The oxidation reaction occurs at a specific temperature. The AutoChem II 2920 
measures the uptake of oxygen.

Pulse Chemisorption Analysis

A Pulse Chemisorption analysis determines active surface area, percent metal dispersion, and 
the average active particle size by applying measured doses of reactant gas to the sample.

The gas reacts with each active site until all sites have reacted. Once the active sites have 
completely reacted, the discretely injected gas volumes elute from the sample tube unchanged. 
The amount chemisorbed is the difference between the total amount of reactant gas injected 
and the amount that eluted from the sample. The quantity of each pulse of reactant gas is 
determined by the loop volume on an automatically controlled valve. Three loops of different 
volumes are provided with the analyzer.

When using any mixture of gases for TPR or TPO analyses, make sure the thermal 
conductivities of the two gases in the mixture are quite different for maximum 
sensitivity (see appendix C).
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BET Surface Area Analysis 

The BET Surface Area analysis lets you evaluate total surface area of the catalyst before and 
after chemisorption. Pore-plugging phenomena which might occur due to the irreversible 
adsorbed species during chemical reactions, as well as the occurrence of sintering, can be 
studied.

After outgassing the sample, a mixture of nitrogen and helium (typically 5 to 30% nitrogen) 
flows over the sample which is immersed in a liquid nitrogen (LN2) bath. Both the adsorption 
and desorption of the N2 are recorded. The amount of nitrogen desorbed at LN2 temperatures 
and the sample weight are used to calculate total specific surface area.

The entire BET analysis — or even repeat analyses — is performed in situ.

Langmuir Surface Area Analysis

The Langmuir surface area analysis allows you to evaluate the total surface area of the catalyst 
and is especially useful for adsorbate/adsorbent systems that adsorb only a monolayer. These 
materials typically exhibit a Type 1 isotherm and are often microporous. The Langmuir 
surface area analysis may be best applied to zeolites and microporous carbons – typically the 
Langmuir surface area will exceed the BET surface area for these materials and provide a 
more accurate estimation of the total surface area.

The Langmuir surface area report may be applied to a wide range of gas concentrations and is 
not limited to the typical BET range (5-30% N2).

Total Pore Volume Analysis

The Total Pore Volume is a single-point estimate of the pore capacity of a material. The total 
pore volume analysis is usually conducted near the saturation pressure of the adsorbate (0.995 
P/Po). The total pore volume of a material can be determined on both fresh and used materials, 
the difference in pore volume may indicate pore plugging and directly relate to changes in the 
performance of catalysts and adsorbents.

For a high surface area sample (> 100 m2/g), a quantity less than 50 mg is recommended. The 
high sensitivity combined with the large quantity of adsorbed gas allows the use of smaller 
sample quantities while maintaining high precision. The reduced sample quantity will also 
reduce the likelihood of saturating the high sensitivity detector.

Additional Uses of the AutoChem II 2920

The AutoChem II 2920 may also be used for Temperature-Programmed Reactions, Catalyst 
Pretreatment, and Isothermal Reactions. These techniques are similar to many of the 
procedures that have been previously described. The tremendous flexibility of the AutoChem 
II 2920 allows the use of custom applications.
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Catalyst Pretreatment

Catalyst Pretreatment usually consists of activating a catalyst prior to its use in a chemical 
reaction. For example, when a temperature-programmed reaction is to be performed, the 
catalyst must be reduced under a flow of H2 at a specific temperature. The reduction is 
necessary to create active sites, or reduced atoms of active metals, which are responsible for 
the activity of a catalyst. 

Temperature-Programmed Reaction

A Temperature-Programmed Reaction lets you monitor the products from the reaction 
between gases and a catalyst at a specified temperature. The AutoChem II 2920 analyzer can 
be programmed to raise the temperature of a catalyst bed at a constant ramping rate as the 
gases flow through the catalyst. At the optimal temperature, the gases react in the presence of 
the catalyst, creating products. The products of the reaction and the excess reactants can be 
diverted to a gas chromatograph or to a mass spectrometer to be analyzed.

Isothermal Reaction

An Isothermal Reaction is similar to a temperature-programmed reaction except that the 
catalyst is kept at a constant temperature (isothermal) to perform the catalytic reaction. Both 
the product of the reaction and the excess reactants can be diverted to a gas chromatograph or 
to a mass spectrometer to be analyzed.

Applications

Catalytic processes that benefit from TPD/TPR analyses include:

Polymerization Oxidation
Hydrogenation Dehydrogenation
Catalyst Cracking Hydrotreating
Hydrocracking Alkylation Reforming
Isomerization
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System Requirements

Location

When selecting the location of the analyzer, keep the following in mind:

• The analyzer performs best in a relatively constant temperature environment. 

• It should be installed on a workbench approximately 0.9 m (36 in.) high, in a location 
free of drafts from sources such as a forced-air heating or cooling system.

• The analyzer should not be placed near a window; exposure to direct sunlight may 
cause the temperature to vary. 

• Consider your needs for venting the analyzer exhaust. If you are using toxic or 
hazardous samples, gases, or vapors, you may wish to locate the analyzer near a vent 
hood. Considerations for venting the analyzer exhausts are discussed in Venting the 
Gas Exhausts on page 2-6.

• There must be adequate space for several gas supply bottles nearby, as well as for any 
options, such as the CryoCooler.

Gases

Compressed gases are required for sample analysis with the AutoChem II 2920 analyzer. Gas 
bottles and a rack for storage of these bottles should be located near the analyzer. As an 
alternative, outlets from a central source may be provided nearby. Gas sources must be able to 
supply flow rates of up to 200 cm3 per minute at 7 psig (50 kPag) for helium and hydrogen, or 
at 11 psig (75 kPag) for other gases. 

Gas purity should be 99.999% and gases should be free of H2O. 

Gas Regulators

High-purity, dual-stage gas regulators should be used with the AutoChem II 2920. 
(Appropriate gas regulators are available from Micromeritics; refer to Ordering Information 
on page 10-1.) Dual-stage regulators minimize the effect of pressure drop in the gas bottle, 
ensuring that a constant supply of carrier gas is delivered to the instrument. This steady 
pressure of gas contributes to stable baselines and more reproducible analyses. Refer to Gas 
Connections on page 2-3 for instructions on connecting gas bottles and regulators.
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Coolant

An inlet port is provided on the front of the furnace for attaching a coolant. A complete 
discussion of cooling options is contained in Chapter 4. One cooling device, the KwikCool, is 
included as a standard accessory. The optional CryoCooler may be purchased from 
Micromeritics. Refer to Ordering Information on page 10-1.

• The KwikCool enables you to cool the furnace rapidly to ambient temperature. This 
speeds the analysis and allows for more rapid throughput.

• The CryoCooler makes it convenient to perform subambient analyses. In some cases, 
such as the reduction of Platinum, the reaction begins at approximately -28 °C, so 
analyses begun at ambient temperature are undesirable. The CryoCooler, in conjunction 
with the furnace, lets you continuously ramp temperatures from -120 °C to 1100 °C. 
The CryoCooler can also be used to speed cooling to ambient following an analysis.

Vapor Generator

An optional Vapor Generator can be used with water or other liquids. The Vapor Generator 
attaches easily to the analyzer, and its operation is controlled by the software. 

The Vapor Generator allows an inert carrier gas, such as helium, to be bubbled through the 
liquid at up to 100 °C. The vapor then passes through a cooler condensation zone, which is 
maintained at an accurate temperature to ensure a stable vapor pressure. The vapor then passes 
to the loop valve zone (Fill/Inject valve) for precise injections onto the sample.
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Specifications

The following table contains the specifications of the AutoChem II 2920.

Table 1-1. AutoChem II 2920 Specifications

Characteristic Specification

—————— TEMPERATURE SYSTEM ——————

Range: -100 to 1100 ºC (with optional CryoCooler)
Ambient to 1100 ºC (without CryoCooler)

Selection: Digitally set, 1 ºC increments

Ramp rates: Up to 50 ºC per minute within -70 to 500 ºC range; 
Up to 30 ºC per minute within 500 ºC to 750 ºC range; 
Up to 10 ºC per minute within 750 ºC to 1100 ºC Range

—————— GASES ——————

Loop (Analysis): H2, CO, O2, N2O, NH3 (maximum 15% NH3 in helium), 
liquid vapors and others

Carrier He, Ar, and other inert gases or other mixtures 

Preparation: H2, O2, He, Ar, and others

The Corrosion Resistant version of the AutoChem 2920 allows the use of gases such as H2S 
and HCl. Review the list of Wetted Materials and also consult Micromeritics for more 
guidance.

—————— GAS FLOW RATE ——————

All Mass Flow Controllers (MFC)

Manual control: 0 - 100 cm3/min. (Rate for Hydrogen; other gases have a 
different range)

—————— GAS DELIVERY ——————

Inlet ports: 4 each for preparation gas, carrier gas, and loop (analysis) 
gas

Temperature control: Internal gas lines and valves can be heated up to 150 ºC

—————— SAMPLE TUBE ——————
Type: FlowThruTM sample tubes, for use up to 1100 ºC, accept 

powders and pellets up to 9 mm diameter 

Material: Fused quartz
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Characteristic Specification

—————— ELECTRICAL ——————

Voltage: 85 to 265 VAC

Frequency: 50/60 Hz

Power: 1100 VA

—————— ENVIRONMENT ——————

Temperature: 15 to 35 oC operating; 0 to 50 ºC non-operating

Humidity 20 to 80% relative, non-condensing

—————— PHYSICAL ——————

Height 24.5 in. (62.2 cm)

Width: 26.0 in. (66 cm)

Depth: 22.75 in. (58 cm)

Weight: 130 lbs (59 kg)

—————— COMPUTER ——————

Minimum requirements: Computer capable of running Windows® 2000, 
   Windows® XP Professional, or Windows Vista®
    Business or Ultimate operating system
CD-ROM drive
128 megabytes of main memory
1-gigabyte hard drive
SVGA monitor (800 x 600 minimum resolution)

—————— WETTED MATERIALS ——————

Standard System

Stainless steel, Gold plated nickel/iron (filaments), Kalrez® or Chemraz® (most O-ring 
seals), Quartz (sample tubes, thermocouple sheath), Quartz wool (supports sample in tube), 
Inconel®- sheathed sample thermocouple (can be placed outside tube or sheathed in 
quartz), PEEK (Poly Ether Ether Ketone - some ferrules), Teflon® tubing (most exhaust 
lines; TCD exhaust is stainless steel for connection of external devices), Copper (gas supply 
lines and BET delay path), Nickel plated brass and steel (gas inlet valves), Viton® (seals 
inside mass flow controllers), Polyaryletherketone/PTFE composite (rotary valves seals), 
Silicone/Teflon® sandwich (septum).
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Characteristic Specification

—————— WETTED MATERIALS ——————

System with Vapor Generator Option

As above, plus borosilicate glass Vapor Generator flask, Kalrez® or Chemraz® flask 
gasket.

System with Corrosion Resistant Option

As above, but stainless steel manifolds are protected from corrosion with vapor deposited 
Silcolloy by Silcotek®, Stainless steel tubing, fittings, ferrules and rotary valves are 
replaced by Hastelloy-C® versions, Kalrez® is used for all O-ring seals and the seals inside 
the mass flow controllers, stainless steel grade 316 gas supply lines, stainless steel gas inlet 
valves with Kalrez® or Chemraz® seals.
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2.  INSTALLATION

This chapter describes how to unpack, inspect, and install the AutoChem II 2920 analyzer.  

Unpacking and Inspection

When you receive the shipping cartons, carefully compare the Packing List with the 
equipment actually received and check the equipment for any damage that may have occurred 
during shipment. Be sure to sift through all packing material before declaring equipment 
missing. 

Equipment Damage or Loss During Shipment

If equipment is damaged or lost in transit, you are required to make note of the damage or loss 
on the freight bill. The freight carrier, not Micromeritics, is responsible for all damage or loss 
occurring during shipment. If you discover that equipment was damaged or lost during 
shipment, report the condition to the carrier immediately. 

Equipment Return

Micromeritics strives to ensure that all items arrive safely and in working order. Occasionally, 
due to circumstances beyond our control, equipment may be received which is not in working 
order. When equipment has been damaged (either during shipment or in use) and you wish to 
return the equipment to Micromeritics for repair or replacement, please follow these steps: 

1. Pack the instrument in its original shipping carton if possible. If the original carton is 
unavailable, for a nominal fee Micromeritics can provide another carton for your use.

2. Tag or otherwise identify the defective equipment, noting the defect and, if possible, the 
circumstances under which the defect occurs. 

3. Make reference to the sales order or purchase order for the equipment, and provide the 
date the equipment was received. 

4. Notify a Micromeritics Service Representative of the defect and request shipping 
instructions. The Service Department will assign a Return Material Authorization (RMA) 
number to your return and provide shipping information.  

Save the shipping cartons if equipment or parts have been damaged or lost. The 
inspector or claim investigator must examine the cartons prior to completion of the 
inspection report.

Failure to package your instrument properly may result in shipping damage.
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Installing the Hardware

The AutoChem 2920 analyzer initially is installed by a Micromeritics representative. The 
following sections are provided to explain common tasks you may need to perform during use 
of the analyzer.

Power Supply

Connect the female end of the power cord supplied with your instrument to the power 
connector located on the side panel. Connect the male end to an appropriate power source.

Follow the manufacturers’ instructions for connecting your computer and printer to an 
appropriate power supply. 

Figure 2-1. Power Switch and Connector Location

The power and RS-232 cables supplied with your analyzer are shielded. If you replace 
or alter any of these cables, they may no longer conform with the European Council 
Directives.

RS-232 connector
(from Analyzer to 
Computer)

RS232 Spare 
connector

Power Cord connector

Power switch (On/Off)

Digital I/O connector

Option connector

Analog I/O connector
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Cable Connections

Use the RS-232 cable supplied with your instrument to connect the analyzer to the computer; 
this cable is connected to the connector labeled RS232 (refer to Figure 2.1 for location). 

When connecting a cable to the connector labeled Analog I/O or Digital I/O, be sure it is no 
longer than 2.9 m (9.5 ft).

Do not connect cables to the connectors labeled Option and RS232 Spare; these connectors 
are for factory use only.

Auxiliary Inputs and Outputs

Ports are provided for connecting auxiliary inputs and outputs. For example, you may wish to 
connect a chart recorder to the analyzer for use in gas chromatography. 

Refer to Appendix E, page E-1 for a complete description of the auxiliary input/output 
function.

Gas Connections

Gas regulators used with the AutoChem II must be of comparable quality to those used for 
semiconductor manufacturing and gas chromatography. Regulators must avoid or minimize 
the amount of lubricants and elastomers to which the gas is exposed. Avoid low-quality 
regulators because the lubrication and elastomers may contaminate the gas stream and cause 
unstable baselines, catalyst poisoning, and other problems.

Always use two-stage regulators for the carrier gas (to ensure stable flow rates) and for the 
preparation and loop gas (to minimize regulator lock-up).

High-quality regulators are usually available to suit local gas connections and safety 
regulations from chromatography gas suppliers and semiconductor gas suppliers, as well as 
from Micromeritics (refer to Ordering Information on page 10-1).

The AutoChem II 2920 provides inlet connections for up to four preparation gases, four carrier 
gases, and four loop (analysis) gases. Before connecting gas bottles: 

• Make sure that all gas bottles are shut off before connecting them to the analyzer.
• Make sure that no analysis is in progress (the software is idle).

1. Attach an appropriate regulator to the first supply bottle you want to connect. (Copper 
tubing and brass reducer fittings are supplied with the analyzer. If you are using a gas that 
is incompatible with brass and copper, substitute compatible tubing and fittings; stainless 
steel gas lines are available from Micromeritics.) Leave the gas bottle shut-off valve 
closed until instructed otherwise. 
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Figure 2-2.  Connecting a Gas Supply Bottle to the Regulator

2. If the regulator has a 1/8-in. outlet, proceed to step 3. If the regulator has a 1/4-in. outlet, 
attach the supplied brass reducer fitting to the outlet of the regulator shut-off valve. 

3. Tighten the regulator shut-off valve nut. 

4. Attach the copper tubing to the regulator or to the brass reducer fitting. 

5. Purge the regulator as follows:  

a. Close the regulator shut-off valve by turning it fully clockwise.

b. Turn the pressure regulator control knob fully counterclockwise.

c. Open the gas bottle valve by turning it counterclockwise, then close the gas bottle 
valve.  

d. Observe the gas bottle pressure gauge. If the pressure decreases, tighten the nut 
connecting the regulator to the gas bottle. If the pressure is stable, proceed to step e. 

Gas Bottle Shut-Off valve

Pressure Control 
knob

Gas Bottle Pressure Gauge

Shut-Off valve 
nut

Copper Tubing

Outlet Pressure Gauge

Regulator Shut-
Off Valve

Brass Reducer 
fitting

Do not over-tighten the fittings. Doing so can collapse the brass fitting and cause a 
leak.

For hazardous gases, make sure the gas supply equipment is adequately vented.
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e. Turn each pressure regulator control knob clockwise until the outlet pressure gauge 
indicates 5 psig (35 kPag). Then open each regulator shut-off valve by turning it 
counterclockwise. This action will purge the regulator and copper tubing.  

f. Make sure the gas bottle valve is completely closed. 

6. Attach the other end of the copper tubing to the appropriate fitting on the side of the 
analyzer.  

Figure 2-3. Side Panel Connections - Inlets and Exhausts

7. Set the regulator pressure using the following guidelines:

• A pressure of 18 to 22 psig is appropriate for most applications.

• When high flow rates are required, you may have to raise the pressure to 30 psig.

• If you are using a gas supply tubing that is longer than the tubing supplied with your 
analyzer, you may have to raise the pressure to achieve the desired flow rate. 

8. Repeat steps 1 through 7 for each additional preparation, carrier, or loop (analysis) gas 
supply bottle you wish to attach. 

Inlet Ports

Outlet Ports

A form is provided in Appendix A for you to record the name of the gas connected to 
each inlet port. This form may be helpful in completing the Gas Selections dialog, as 
described later in this chapter. 
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Venting the Gas Exhausts

Each of the exhaust ports should be safely vented. The appropriate method for venting each 
port depends upon the gases you are using and the experiments you are performing.

Vapor Generator Exhaust

The type of venting described for the vapor generator may also apply to other exhausts if the 
possibility of condensation of liquids is present.

Recommended Method

The ideal treatment for vapor exhaust is to run the exhaust through heated extension lines to a 
fume hood, separate from any other exhausts. Additionally, a downward slope of the extension 
lines should be carefully maintained to prevent accumulation of any liquids that should 
condense in the line.

Use extreme caution when establishing your exhaust method, in order to prevent 
dangerous accumulations or combinations of gases, vapors, or condensibles, 
particularly when using the optional Vapor Generator. (Instructions for attaching the 
Vapor Generator are located on page 2-16.) 

If the Vapor Generator contains toxic or otherwise hazardous liquids, these are 
vaporized, travel through the system, and are vented through the Vapor Generator 
exhaust port. After the vapor leaves the heated analyzer, it may cool and return to the 
liquid state. Accumulation and/or mixing of such condensibles can create a variety of 
dangerous conditions in the laboratory. It is the operator’s responsibility to ensure 
safe venting of all exhausts.
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Alternative Method

As an alternative to the method recommended above, you may wish to vent the exhaust 
through a collection container to collect any condensibles before gases are vented. An example 
of one such method is shown in the following illustration.

Figure 2-4. Example of a Collection Container for Venting Exhaust

Particular care should be taken if you plan to vent the exhaust from more than one port into a 
single collection container before diverting the gases. Make sure that you consider any hazards 
of combining the various exhausts in a single venting container, basing your decision on the 
materials being used in the experiment.

Results of Improper Venting

Another possible effect of improper venting is condensation of liquid drops in the exhaust line, 
which could cause intermittent blockage of the line. As a result, detector signals may become 
erratic. This is visible in the data as smaller-than-expected peaks, missing peaks, or even larger 
peaks, depending upon the timing of the drop blocking the exhaust.

Maintain a downward path from 
the analyzer to the vent hood.

Beaker
To vent hood

From analyzer

If no venting method is provided, the vapor is discharged into the laboratory, 
potentially causing a hazard for laboratory personnel.
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Installing the Furnace

Initially, the furnace should be installed on the analyzer. However, it should be removed when 
performing B.E.T. analyses. Removal instructions follow these instructions.

1. Hold the open furnace next to the support post. Raise the furnace, moving it above the 
support post until the retaining knob is inserted in the hole in the top of the furnace.

Figure 2-5. Raising the Furnace onto the Retaining Knob 

2. When the retaining socket on the bottom of the furnace is located above the support post, 
gently lower the furnace until it rests securely on the post.

Figure 2-6. Lowering the Furnace onto the Retaining Post

3. When you are ready to begin the experiment, close the furnace around the sample tube and 
secure the latch.

4. Plug the thermocouple cable and the furnace power cable into the appropriate connectors 
on the analyzer. These connectors are located on the recessed front panel, and are labeled.

Retaining Knob

Furnace

Retaining Post

Furnace
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Removing the Furnace

When performing B.E.T. analyses, the furnace must be removed to allow placement of a cold 
bath dewar around the sample.

1. Unplug both the furnace power plug and the thermocouple cable from the analyzer.  

2. Open the latch, then open the furnace.  

3. Gently lift the right side of the furnace until it is freed from the support post.

4. Lower the furnace, moving it away from the support post until it is free of the retaining 
knob.

5. Close the furnace and secure the furnace latch. Place the furnace in a location where it will 
be protected from damage.

If used recently, parts of the furnace may be hot. Use the cotton gloves provided with 
the analyzer to protect your hands.

Support post

Furnace

                        Figure 2-7. Removing the Furnace
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Attaching the KwikCool or Optional CryoCooler

KwikCool

A KwikCool unit is shipped with every AutoChem II 2920. This unit allows you to cool the 
furnace quickly between analyses.

Installation

1. Turn off the analyzer.

2. Attach the KwikCool cable to the connector labeled Sub Ambient Cooler on the front 
panel of the analyzer.

3. Attach the tubing provided to the inlet on the front of the furnace.

4. Attach a supply of dry house air (or nitrogen) to the gas inlet on the front of the KwikCool; 
the pressure is indicated next to the inlet.

5. Fill a dewar with an ice water bath.

6. Place the KwikCool on top of the dewar.

7. Turn on the analyzer and start the analysis program.

Operation

When you insert an experiment step, a space is provided (on the Temperature Ramp dialog) for 
you to indicate that you are using the KwikCool. Refer to “Enable KwikCool” on page 5-38.

    

             Figure 2-8. Installing a KwikCool

Furnace
Inlet

Sub Ambient
Cooler
Connector

Dewar

Gas Inlet
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CryoCooler

The CryoCooler is an optional device that enables you to start an analysis at sub ambient 
temperatures. The CryoCooler cools the sample quickly and holds the temperature at a user-
specified value between +20 and -100 ºC. 

The CryoCooler unit consists of a cryogenic pump mechanism, a storage dewar for liquid 
nitrogen (LN2), and a delivery hose that attaches to the AutoChem furnace. 

Stable subambient temperatures are achieved by small, frequently repeated injections of LN2 
into the analyzer’s furnace cavity, which contains the sample. (Actually, the stream that 
reaches the sample compartment is not liquid but cold vapor.)

CryoCooler 

LN2 Dewar

          Figure 2-9. CryoCooler Unit

Always wear a safety face shield or goggles and gloves when handling liquid nitrogen 
to prevent the possibility of splashing liquid nitrogen into your eyes or onto your skin.

The CryoCooler must be free of internal moisture before insertion into LN2. If present, 
moisture will freeze and prevent operation. The system was free of moisture when it 
left the factory; however, dry air, nitrogen, or other inert gas should be passed through 
the delivery hose to be sure it has remained dry.
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Installation

1. Attach one end of the cable (provided with the CryoCooler) to the connector labeled Sub 
Ambient Cooler on the front panel of the analyzer. Attach the other end of the cable to the 
connector on the CryoCooler.

2. To verify the CryoCooler is operating properly before inserting it into LN2, enable manual 
control, right-click on the CryoCooler icon, and set the speed to 100%. The green light on 
the housing should come on and the rotor on the pump should be visibly turning. Turn the 
CryoCooler off using manual control, but leave the cable connected.

3. Fill the dewar approximately two-thirds full with LN2.

4. Insert the CryoCooler into the dewar. Boiling will result as the pump mechanism contacts 
the LN2 so insert the CryoCooler slowly over a period of several minutes. This permits 
most of the resulting vapor to escape before the CryoCooler is finally centered on the 
dewar opening.

5. Place the dewar on the floor near the front of the analyzer or beside the analyzer on its 
workbench. 

 CryoCooler                                  Analyzer Front Panel

 
Connect
Cable from
CryoCooler
to Analyzer

Insert the CryoCooler into the LN2 slowly. Inserting it too quickly will cause the LN2 to 
boil-off and possibly splash onto your hands.
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6. Attach the delivery hose from the CryoCooler to the furnace inlet tube.

7. Secure the delivery hose by tightening the thumbwheel on the furnace connection.

8. Allow five minutes for thermal expansion and contraction effects to dissipate, then start 
the AutoChem analysis.

If the CryoCooler fails to respond immediately, it may be due to components having not yet 
thermally adjusted to their new temperature surroundings or to ice formation from previously 
condensed moisture. Wait a few minutes and try again. Failure this time is almost certainly due 
to ice formation.

Routine Maintenance

The buildup of ice and frost particles is likely in any device which uses liquid nitrogen in a 
laboratory environment. Repeated filling and evaporation alone can lead to an accumulation of 
ice crystals within the dewar. The CryoCooler has been carefully designed to minimize 
problems from ice. Ice problems can be avoided almost entirely if, on a weekly basis, you 
empty the dewar and thoroughly dry its interior.

Delivery hose connection
(tighten thumbwheel to secure)
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Recovering from an Iced Condition

If ice buildup should occur in the CryoCooler, a thermal overload switch activates and cuts 
power to the pump motor. The green light will also be off in this condition. Perform the 
following steps to remove ice buildup:

1. Remove the CryoCooler from the dewar.

2. Unplug the cable from the Sub Ambient Cooler connector on the front of the instrument 
to allow a few minutes for the thermal protector to reset itself.

3. Turn the thumbwheel on the delivery hose connection clockwise to loosen, then 
disconnect the hose from the analyzer.

4. Blow dry air or nitrogen into the hose and out of the pump mechanism, holding the 
CryoCooler nearly vertical. 

Cable connection

Delivery hose
connection

 Delivery Hose

Pump Mechanism

Nitrogen
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5. Also blow into the pump inlet and into one of the holes of the member connecting the 
housing and the pump just above its connection point to the pump.

6.  It is permissible to heat the pump mechanism with a laboratory heat gun until it is too 
warm to hold. When doing so, be careful not to heat the plastic delivery hose directly; it 
will melt if overheated.

7. Slowly insert the CryoCooler back into the dewar and proceed with the sample analysis.

Replenishing the Dewar

You can replenish the dewar without completely removing the CryoCooler in either of two 
ways:

• By adding liquid nitrogen to the dewar.

Lift the CryoCooler a few inches above the neck of the dewar, allowing it to rest on the 
rim of the neck. Then insert the nozzle of an LN2 transfer system and refill the dewar. 
The Model 021 LN2 transfer system is available from Micromeritics (refer to Chapter 
10 for ordering information). 

Do not apply heat directly to the delivery hose. Doing so may melt the plastic.

The CryoCooler reservoir retains LN2 for several days when not used. If its use is 
temporarily suspended, leave it plugged into the instrument but disconnected from 
the furnace inlet. An internal heater produces a slight outflow of gaseous nitrogen 
which prevents ice buildup in the delivery hose.

LN2 Transfer
Hose

Insert the CryoCooler into the LN2 slowly. Inserting it too quickly will cause the LN2 to 
boil-off and possibly splash onto your hands.
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• By attaching the CryoCooler to another dewar.

Remove the CryoCooler from the nearly empty dewar and immediately insert it into 
another full dewar.

Attaching the Optional Vapor Generator 

The Vapor Generator enables you to perform analyses using vapor.

The majority of the Vapor Generator’s components are internal to the analyzer, and are 
installed and calibrated by a Micromeritics Service Representative. 

To attach the Vapor Generator’s external parts:

1. Fill the Erlenmeyer flask to a depth of at least 50 mm (2 in.) with the desired liquid.

2. Unzip the heating mantle, place it around the flask; do not zip it shut. Screw the flask into 
the port on the underside of the front panel. The metal cylinder that extends down from the 
Vapor Generator port is the aerator. When the flask is properly installed, the aerator should 
extend down into the flask and its contents. Zip the mantle shut.

3. Plug the heating mantle connector into the appropriate connector on the recessed front 
panel (identified on the panel). Tighten the connector screws.

Use appropriate safety measures to prevent injury from contact with hazardous liquids 
used in the Vapor Generator. Information about safely venting the exhausts is found 
earlier in this chapter.

Vapor Generator
Heating Mantle 

   

Heating Mantle
Connector

   Aerator
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4. The valve that controls the flow of gas from the Vapor Generator has two states: Bypass 
and Vapor. When you create the sample information file, select Vapor for the state of the 
Vapor Generator valve during the portion(s) of analyses in which you wish to flow vapor 
through the system. The Loop gas is the gas which flows through the Vapor Generator; 
make sure the gas you are using for vapor generation is connected to one of the Loop gas 
inlet valves.

Turning On the Analyzer

Place the power switch (main breaker switch) on the side panel of the analyzer in the ON ( | ) 
position. The power switch is located on the right side of the analyzer next to the power cord 
connector (refer to Figure 2-1, page 2-2).

When the system is turned on for the first time or after a period of non-use, it should be 
allowed to warm up for at least three hours before analyses are performed. During this time, a 
purge carrier gas (such as helium or nitrogen) should be flowed through the system at about 50 
cm3/min.; the heat zones should be set at 110 °C. Refer to Enable Manual Control on page
6-12.

When the analyzer is turned on (but the software is still not running), the uppermost and 
lowermost indicator lights (the red Fault light and the green Attention! light) on the upper 
front panel are illuminated. When the software is subsequently started and communication is 
established with the analyzer, these lights are turned off and the second light from the bottom 
(the green OK light) is illuminated.

Instructions for starting the software are found later in this chapter. Refer to Front Panel 
Indicators on page 3-1 for a description of the indicators.

Be sure to clean the vapor generator before changing to a different liquid (refer to 
Chapter 9 for cleaning instructions).

If you are connecting the KwikCool, or CryoCooler, do so before turning the analyzer 
on.

Fault

OK

Attention
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Installing the Software

The AutoChem II 2920 program is also available as a standalone option so that  you can install 
it on a computer other than the one controlling the analyzer. This allows you to create or edit 
sample and parameter files, as well as generate reports on completed sample files. Review the 
Micromeritics PROGRAM License Agreement for restrictions on using another copy.

Install the AutoChem II application software as follows:

1. Insert the AutoChem program CD into the CD-ROM drive.

2. Select Start, Run from the Status bar.

3. Enter the drive designator for the CD-ROM, followed by SETUP (for example: e:setup.), 
then click OK.

4. The New Installation dialog is displayed. 

The Destination Folder group box displays the amount of current disk space, the amount 
of disk space required for the analysis program, and the directory into which the 

Proceed to Step 4 if AutoPlay is enabled on your computer; Setup will start 
automatically and display the New Installation dialog.

Displays the amount of current 
disk space and the amount 
required for installation of the 
application. Also displays the 
directory into which the 
application will be installed.

Select this option to add 
the AutoChem II 2920 
icon to your desktop.

You may terminate the installation at any time by clicking Exit. If you do so, you must 
start the installation program from the beginning.
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application will be installed. If you prefer a different directory for installation, click 
Browse to select the desired directory.

5. If you want to run the application from the desktop, select the checkbox just below the 
Destination Folder group box to add an icon.

6. The AutoChem II icon will be added to the Micromeritics folder by default. If you prefer a 
different folder, enter or select one from the drop-down list.

7. Click Next; the Analyzer configuration dialog is displayed.

8. In the Step 1 group box, click the radio button for the number of analyzers to be attached 
to this computer. If you are attaching two analyzers, be sure your computer has two serial 
communication ports.

9. For each analyzer, enter the analyzer’s serial number and communications port number.

10. Click Next; the Calibration File Installation dialog is displayed. Read the information 
displayed and proceed accordingly.

11. After the calibration files have been installed, the Installation Complete dialog containing 
the Readme file is displayed.

12. Use the scroll bar if you want to read the contents of the file, then click Finish to close the 
dialog.

13. Remove the program CD and store in a safe place. The original program CD contains the 
calibration files specific to your instrument. Upgrade CDs do not contain calibration files. 
Therefore, it is important that you store the original program CD in a secure location in the 
event calibration files need to be reinstalled.

Choose 0 (zero) if you are installing this program for offline data reduction on a 
computer other than the one controlling the analyzer, or if this is the destination 
computer in a Move operation.
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Using the Setup Program for Other Functions

After initial installation of the AutoChem analysis program, the application setup program can 
be used to:

• Upgrade software
• Add an analyzer
• Move an analyzer from one computer to another computer
• Remove an analyzer from the computer
• Change the analyzer setup
• Reinstall calibration files
• Uninstall the analysis program

To start the application setup program:

1. Ensure that the analysis program is not operating.

2. Insert the AutoChem HP 2950 Setup CD into the CD-ROM drive.

3. Select Start, Run from the Status bar.

4. Enter the drive designator for the CD-ROM, followed by SETUP (for example: e:setup.), 
then click OK.

5. The setup Welcome screen showing the options available is displayed.

Proceed to Step 5 if AutoPlay is enabled on your computer; Setup will start 
automatically and display the New Installation dialog.
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6. Select the operation you wish to perform. Procedures for performing each operation are in 
subsequent sections.

After the requested operation is completed, the setup Welcome screen is again displayed. 
A confirmation message indicating completion of the operation is shown in the lower 
section of the dialog.

7. After you have completed all desired operations, click Exit to close the dialog.

Installing Subsequent Software Versions

When you install a software upgrade, the system installs all of the application files and any 
status files that do not already exist on the computer. Existing analyzer status files are not 
affected and default and data files are not overwritten. There are three types of subsequent 
installation; the software version controlled by the setup program is:

• a later version than the version installed on the computer
• the same version as the version installed on the computer
• an earlier version than the version installed on the computer

The setup program automatically detects which type of installation applies and customizes the 
selection in the Setup dialog accordingly.

1. Start the Setup program. Choose the software option; remember, only the applicable 
option will display; it will be one of the following:

• Upgrade software to version (number) from version (number)
• Reinstall software version (number)
• Downgrade software to version (number) from version (number)

Indicates status of last 
operation performed
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2. Click Start File Installation; the application installs the software and redisplays the setup 
Welcome dialog. If no other operations are desired using this dialog, click Exit to close the 
dialog.

Adding an Analyzer

Add an analyzer to the existing application as follows:

1. Start the Setup program. Select Add an analyzer, then click Next; the Setup analyzer 
dialog is displayed:

2. Enter the serial number of the analyzer being added, then the communications port to 
which it is to be connected.

3. Click Next; the Calibration Installation dialog is displayed.

4. Select the location of the calibration source files. If the calibration files are located in a 
directory other than the one displayed, click Browse to select the directory. Click Finish; 
a media change dialog is displayed.

5. Click OK to install the calibration files. A dialog containing the Readme file is displayed 
after the calibration files are installed.

6. Click Exit to close the dialog.
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Moving an Analyzer from One Computer to Another Computer

You can move an analyzer, along with its status and calibration files, from one computer 
(Source PC) to another computer (Destination PC).

1. Install the analysis program on the destination computer. Refer to Installing the Software 
on page 2-18. Be sure to select 0 as the number of instruments; all related instrument 
information will be transferred in the Move operation.

If the analysis program is already installed on the destination computer, proceed to Step 2.

2. Start the application setup program on the source computer. Refer to Using the Setup 
Program for Other Functions on page 2-20.

3. In the Setup dialog, select Move an analyzer from one PC to another PC, then click 
Next; the Move analyzer operation dialog is displayed.

This operation does not move sample or parameter files. To move these files, use a file 
management program such as Explorer or a backup/restore utility.
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4. Select Source PC, then click Next; the following dialog is displayed.

5. In the Step 1 group box, select the analyzer that is to be moved.

6. In the Step 2 group box, choose a location in which the moved files will be stored. If 
possible, choose a floppy drive or a shared network drive. If this is not possible, select a 
local folder. After the files are placed there, use a folder transfer utility to copy this folder 
from the Source PC to the Destination PC.

Calibration files are not included in the moved files. These files must be copied and 
moved separately to the destination computer. The calibration files are located in a 
subdirectory (folder) of the Hardware directory. The subdirectory is named 292-(serial 
number).

7. Click Finish; the files are moved and the setup Welcome screen is displayed.

8. Start the application setup program on the destination computer.

9. In the Setup dialog, select Move an analyzer from one PC to another PC; the Move 
analyzer operation dialog is displayed (shown on previous page).

10. Select Destination PC, then click Next; the following dialog is displayed.
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11. In the Step 1 group box, enter the serial number of the analyzer being moved and the 
communications port to which it will be attached.

12. In the Step 2 group box, click Browse and choose the location of the moved files.

13. Click Finish; the files are moved and the setup Welcome dialog is displayed.
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Removing an Analyzer

You can remove an analyzer from the computer as follows. When you remove an analyzer, the 
status files are removed as well.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions on 
page 2-20.

2. From the Setup dialog, select Remove an analyzer, then click Next; the Remove an 
analyzer dialog is displayed.

3. From the drop-down list, choose the serial number of the analyzer you want to remove.

4. Click Browse; the analyzer is removed and the Welcome screen is again displayed.

5. Click Exit to close the dialog.
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Changing an Analyzer Setup

Change the analyzer setup as follows:

1. Start the Setup program. Refer to Using the Setup Program for Other Functions on 
page 2-20.

2. From the Setup dialog, select Change analyzer setup, then click Next; the Change 
analyzer setup dialog is displayed.

3. From the drop-down list, choose the analyzer you want to change.

4. Enter the new port number in the space provided.

5. Click Finish; the change is completed and the Welcome dialog is again displayed.

6. Click Exit to close the dialog.
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Reinstalling the Calibration Files

You can reinstall the files containing an analyzer’s factory calibration data as follows:

1. Start the Setup program. Refer to Using the Setup Program for Other Functions on 
page 2-20.

2. From the Setup dialog, select Re-install calibration files for an analyzer, then click Next; 
the Re-install calibration files dialog is displayed.

3. Select the analyzer whose calibration files you want to reinstall from the drop-down list. If 
you have only one analyzer installed, a drop-down list is not included.

4. Insert the CD containing the calibration files; ensure that the CD drive is displayed as the 
calibration file source location. If not, click Browse and choose the CD drive.

5. Click Finish; the calibration files are reinstalled and the Welcome dialog is again 
displayed.

6. Click Exit to close the dialog.
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Uninstalling the Analysis Program

You can remove the AutoChem II analysis program as follows. When you perform this 
operation, the application removes the analysis program, status files, analyzer setup files, and 
resulting empty directories. It does not remove data files.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions on 
page 2-20.

2. From the Setup dialog, select Uninstall, then click Next; the Uninstall dialog is displayed.

3. Click Uninstall; the Select Uninstall Method dialog is displayed.
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4. Choose one of the following:

• Automatic: click Next; the system uninstalls the AutoChem II software automatically 
and the setup Welcome dialog redisplays.

• Custom: click Next; a series of dialogs is displayed, allowing you to choose the files 
you wish to uninstall. After all files are selected and uninstalled, the setup Welcome 
dialog redisplays.

5. Click Exit to close the Welcome dialog.

Starting the AutoChem Software

1. Follow standard laboratory procedures to turn on your computer and any attached devices.

2. Select Start >Programs from the Windows Task bar.

3. Select the AutoChem 2920 program from the Micromeritics group.

If you had an icon added to your desktop, simply double-click on the icon.
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Specifying Gases

After gases are connected to the instrument, select Unit > Gas Selections to specify the gases 
connected to each port.

Select the appropriate gas from the drop-down lists of each port for the Preparation, Carrier/
Reference, and Loop gases. 

If a gas or gas mixture you wish to use does not appear in the drop-down list, you can add it to 
the list using the Gas Defaults option on the Options menu. 

1. Close the Gas Selections dialog.

2. Select Gas Defaults from the Options menu. 

3. Add the gas or mixture to the Gas Defaults list. (Refer to Gas Defaults on page 8-13 for 
additional information.)

4. Reopen the Gas Selections dialog and select the new gas from the list.

 

If you change a gas connection, it is essential that you update the Gas Selections 
window to reflect the current gas connections, in order to avoid creating dangerous 
combinations of gases in the analyzer.
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Purging the System

Purging Air

The instrument must be purged of air after installation or after you change the instrument 
hardware. For example, you must purge the instrument and gas supply lines after changing a 
gas bottle (that line only must be purged) or changing the loop.

Purge the analyzer’s internal gas lines of air as follows: 

1. Select Unit > Show Instrument Schematic, then Enable Manual Control. (Refer to 
Enable Manual Control on page 6-12 for detailed information on manually controlling 
the system. The following instructions are sufficient for you to purge the instrument.)

Figure 2-8. The Instrument Schematic

Purge one line at a time. It is the operator’s responsibility to make sure that dangerous 
combinations of gases are not created while using Manual Control. It may be 
necessary to flow an inert gas through the system between flows of incompatible 
gases. 

Loop Valve 
Heat Zone

Detector Heat 
Zone

Analysis Valve 
Heat Zone

Cold Trap Valve 
Heat Zone

Preparation 
Gas MFC

Inlet Valves

Reference Gas MFC Carrier Gas MFC Loop Gas MFC
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2. Set the Cold Trap valve, Analysis valve, Loop valve, and Detector heat zone temperatures 
to 110 °C. 

a. Position the cursor over the desired valve’s heat zone (the cursor will change to a 
thermometer) and right-click.

b. Select Set temperatures, then enter 110. 

c. Click OK.

3. Wait until the temperature reaches the 110 °C target. (Click on the heat zone to display 
both the target and current temperatures in the box on the right side of the schematic.)

4. First, purge all air from the preparation gas line. 

a. Position the cursor over the preparation gas Mass Flow Controller (MFC) and right-
click.

b. Select Set flow rate and enter 50. 

c. Click OK.

d. Position the cursor over the four preparation gas valves and right-click.

e. Open the valve that corresponds to the gas you wish to flow by clicking the appropriate 
Flow Gas [n] menu choice. 

f. Allow the gas to flow for approximately 20 minutes or until you are certain the lines 
have been purged of air.

5. Repeat step 4 for each valve to which a gas bottle is connected.

6. Repeat the process (steps 4 and 5) for the carrier and loop gas flows. 

Purging Gases

When you change the gas that is flowing through the instrument, or when you change the type 
of gas connected to a port, you should purge the instrument of the previous gas by flowing the 
new gas.

Use the instructions for Purging Air from the System to purge the previous gas. Be sure to 
change the Gas Selections dialog to reflect the change in gases. (See Specifying Gases on 
page 2-31 for more information.) 

When you have clicked on the heat zone, the cursor appears as a thermometer. If you 
have accidentally clicked on the valve, move the cursor slightly and click again. 
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Changing the Gas Flow During an Analysis

When you change gases during an analysis, you may wish to allow the new gas to flow for a 
period of time before creating conditions that cause the experiment to begin (such as elevating 
the temperature). In some cases, you may wish to purge one gas (by flowing an inert gas for a 
period of time) before starting to flow another gas. This may be useful for avoiding 
undesirable combinations of gases within the analyzer.

To flow an inert gas between incompatible gases, you can insert a Change Gas Flows step (in 
which an inert gas is flowed for a period of time) and a Wait step (to wait for the inert gas to 
purge the analyzer) between other steps that involve incompatible gases. 

When gas flows are changed while the analyzer is recording data, the gas flow is 
briefly disturbed. This may result in a brief period of noise or other visible 
disturbances on the peak data. Either disregard the disturbance or insert a Wait for 
stable baseline step immediately after changing gas flows.
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3.  USER INTERFACE

This chapter provides a description and the functions of the front panel LEDs (lights), and 
general instructions for using the software.

Front Panel Indicators

There are four indicator lights (Light-Emitting Diodes—LEDs) on the upper left of the 
analyzer’s front panel. 

The top three LEDs show the state of the instrument’s communication with the computer.

Red (Fault) There is no communication with the computer (For example, if the 
2920 software was exited). When in this state, the Attention! LED 
(which is green) is also illuminated.

Yellow Five minutes have elapsed with no communications.

Green (OK) Normal communications.

Attention! Blinks to alert the operator that attention is required. For example, if a 
Wait step requiring action by the operator was included in the list of 
experiment steps, the LED blinks and the appropriate message 
appears on the computer screen. After the operator performs the 
requested action and clicks OK, the LED ceases to blink. 

Red

Yellow

Green

Attention
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Using the Software

The AutoChem II 2920 analyzer operates in the Windows environment and requires 
familiarity with standard Windows operations such as using the mouse, menus, and dialog 
boxes. This manual provides brief instructions for standard operations; however, you may 
need to refer to your Windows documentation or the Windows tutorial to clarify functions 
which are specific to Windows. 

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus or pop-up menus) are avail-
able for certain components on the instrument schematic when in manual mode, and for 
onscreen graphs and tabular reports. These menus are accessed by selecting the item for which 
you wish to display its menu and clicking the right mouse button. For example, right-click in a 
column of an onscreen report and the following menu is displayed.

Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut keys or key 
combinations (if assigned) are listed to the right of the menu item. Instead of opening the menu 
and choosing the command, simply press the key combination. For example, to open a sample 
information file, press F2; the Open Sample Information dialog is displayed.

You can also use shortcut keys to access a menu or any function that contains an underlined 
letter by pressing Alt plus the underlined letter in the command. For example, to access the 
File menu, press Alt, then F.

Table 3-1 provides a list of the keys available in the AutoChem 2920 analysis program.
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Table 3-1. Shortcut Keys

Key(s) Function

F2 Open a sample information file
Clear the selected field (when using the Select Dates dialog)

F3 Open an analysis conditions file
Insert the current date (when using the Select Dates dialog)

F4 Open a report options file
Display a calendar (when using the Select Dates dialog)

F6 Tile windows
F7 Cascade windows
F8 Start report
F9 Close all open report windows
Alt + F4 Exit the analysis program
Shift + F2 List sample information files
Shift + F3 List analysis conditions files
Shift + F4 List report options files
Shift + F9 Display action(s) available for selected component on the instrument 

schematic when manual control is enabled
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Dialog Boxes and Subdialog Boxes

Dialog Boxes and Subdialog Boxes are provided for you to enter information to be used by the 
software. They are sometimes called “windows” and sometimes called “screens.” Dialog 
boxes are displayed when an item followed by an ellipsis (...) is selected. Subdialog boxes are 
displayed when a push button on a dialog box is selected. Both types of boxes may contain one 
or more of the following:

Data Entry Field The entry in these fields may be numeric (numbers only) or 
alphanumeric (numbers, letters, or printable characters). If an invalid 
entry is made, an error message is displayed. When a numerical data 
entry field is selected, its valid range is displayed in an information 
bar across the bottom of the dialog.

Radio Button Small, circular radio buttons are sometimes provided when you must 
choose only one item from a group of options.

Check Box Check boxes allow you to choose multiple options from a group of 
options.

Push Button Several types of push buttons are found on the 2920 dialogs. When 
you click a push button, a subdialog appears enabling you to perform 
a function or enter data pertinent to the subject matter. Other push 
buttons, such as OK and  Cancel, execute a single command.

Push Button - displays a subdialog 
pertinent to the TCD reading

Check Box
Radio Button

Data Entry 
Field

Push Button - invokes an action; saves 
the changes and closes the dialog

Displays the range 
for numerical data 
entry fields
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Push Button
(continued)

A push button that you will find frequently on dialogs is Replace. 
This push button allows you to replace the contents of the current file 
with those of another file. For example, if you are creating an analysis 
conditions file, you can save time by clicking Replace. A dialog 
opens allowing you to choose the file containing the values you wish 
to use. After you close the dialog, your new file contains the same 
values as the file from which they were copied. The old file remains 
unchanged, even if you edit the values in your new file. 

List A list contains selections from which you may choose one or more 
items. To choose an item from the list, simply double-click on the 
desired selection, or highlight the item and press Spacebar. A check 
mark precedes the item when it is selected. Items are deselected in the 
same manner.

Indicates report 
is selected
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Selecting Files

Sample information is stored in files and saved under file names. Certain dialogs contain a 
Files list window that displays a list of files available for the current operation. For example, 
the Open Sample Information dialog:

From the list of files in the Files list window, move the mouse pointer to the file you wish to 
open and double-click. If you do not see the desired file, it may be in another directory. Go to 
the Directories list box and choose the correct drive and/or directory.

You can limit the list of files displayed in the Files list box by choosing one or more of the 
following:

• Select a file status from the Status drop-down list. Table 3-2 describes each file status.

Table 3-2. File Status and Description

Status Description

All All sample information files in the specified directory and 
within the specified range of dates.

Analyzing Sample information files that are currently being used for 
analysis.

Complete Sample information files that were used in an analysis that 
has been completed.

No Analysis Sample information files that have not been used in an 
analysis.
3-6                                                    May 06



AutoChem II 2920 Using the Software
• Enter a range of dates. Click Dates; the Select Dates dialog box is displayed.

Select Show Date Range to enable the From and To fields so that you can enter 
beginning and ending dates. You can also double-click in each field to display a 
calendar to set a date. The range of dates remains the default until the range is changed 
or Show All Dates is selected.

For convenience, the following shortcut keys are available when the Select Dates dialog 
is displayed:

F2 Clears the field
F3 Inserts the current date
F4 Displays a calendar from which you may select a date

• Use wildcard characters in the path name you enter in the File name field. Wildcard 
characters such as * and ? can be used to filter file names. For example, you can limit 
the list of files displayed to those containing TPD as the first three characters of the file 
name by entering TPD*.smp.

• Navigate to a different directory. The current directory is displayed just above the 
Directories list box. You can change directories by double-clicking a directory in the 
Directories list box, double-clicking [..] to move up one level, or by entering the 
desired directory in the File Name field. For example, enter C:\2920files\sample\*.smp 
to display sample files in the 2920files\sample directory on your local drive.

You can change the date format by using the Date and Time function on the Windows 
Control Panel.
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File Name Conventions

For sample information files, a default file name (the next available sequence number) and a 
default extension are displayed when the Files list box is opened. For analysis conditions and 
report options, only a default extension is displayed with an * (*.ANC, for example). The 
following table shows the file name extensions for the AutoChem II 2920 analysis program.

Table 3-3. Default File Name Extensions

File Type Extension

Sample Information SMP

Analysis Conditions ANC

Report Options RPO

Export to disk (ASCII) EXP

Export to disk (Grams 32) CGM

Report to disk RPT

List to disk LST

Calibration CAL

Vapor Generator (option) calibration VCL

The following types are available for reports saved from the Report 
window:

Spreadsheet XLS

ASCII TXT

Report REP
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Menu Structure

Main Menu Bar

All functions for the AutoChem II 2920 are accessed from the Main menu bar. Brief 
descriptions of each menu are provided below; refer to the chapter given in parentheses for a 
detailed description of the options contained on that menu.

File Allows you to manage sample and parameter files. (Chapter 5, page 
5-1)

Unit <n> Enables you to perform analyses. A unit menu is displayed for each 
attached unit. (Chapter 6, page 6-1)

Reports Enables you to generate and close reports. (Chapter 7, page 7-1)

Options Allows you to edit sample defaults, specify your system 
configuration, and select data presentation formats. (Chapter 8, page 
8-1)

Windows Enables you to arrange the windows and icons on your screen. It also 
displays the names of all open windows. (this chapter, page 3-10)

Help Displays help information. (this chapter, page 3-10)
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Windows Menu

The Windows menu also displays all open files and windows. The current file is preceded with 
a check mark.

Help Menu

Tile Resizes all open windows and arranges them side by side so that the 
contents of all open windows are visible.

Cascade Resizes all open windows and arranges them in a stacked manner. 
The active window is positioned on top of the stack. Each window’s 
title remains visible, making it easy to select other windows.

Arrange icons Arranges all minimized icons in an orderly manner.

Operator’s Manual Displays the AutoChem II 2920 Operator’s Manual in PDF format.

About Win2920 Displays information about the AutoChem II 2920 analyzer.
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4.  GENERAL OPERATING PROCEDURES

This chapter describes many of the procedures for using the analyzer and the software for 
analyses. Maintenance procedures are described in Chapter 9. Procedures which generally 
occur when the analyzer is first installed are included in Chapter 2.

Specifying Sample Defaults

Sample information files include the information required by the AutoChem II 2920 to 
perform analyses and collect data. The analysis program automatically generates sample 
information file names and assigns default values. Sample defaults allow you to customize 
your sample file as well as the file name sequence. It is best to use defaults for materials that 
you most commonly analyze. You can always edit the values when the sample file is created.

The sample information presentation can be presented in a basic, advanced, or restricted 
format. Sample defaults can be specified in the basic and advanced formats only; you cannot 
specify sample defaults using the restricted format. 

If desired, you can define parameter files before entering sample defaults (refer to Defining 
Parameter Files on page 4-4).

Advanced Format

1. Select Options > Sample defaults; the 2920 Sample Defaults dialog is displayed

Select Option > Option Presentation and ensure that Advanced is selected as the 
format.
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2. In the Sequence field, specify a default string. This is the number that is incrementally 
sequenced and displays in the File name field when you select File > Open > Sample 
information.

3. In the field on the right of the Sample line, enter a format for the identification. Be sure to 
include the $ symbol if you want the sample file number included as part of the 
identification.

4. Edit the Operator and Submitter lines as desired. Or, you may have either (or both) of 
these limes omitted entirely by selecting Omit. 

5. In the Mass field, enter an approximate value for the mass of sample you typically use in 
your analysis. A more accurate value can be entered in the sample file itself.

6. Click the Analysis Conditions tab and enter appropriate information for your most 
commonly analyzed sample material. Remember, you can always edit this information in 
the sample file when it is created.

7. Click the Report Options tab and choose the desired reports. Again, this selection can be 
edited in the sample file when it is created.

8. Click Save, then Close.

You can also edit the word Sample. For example, you may prefer to use Test or 
Material.
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Basic Format

1. Select Options > Sample defaults; the Basic Sample Information Defaults dialog is 
displayed. 

2. In the Sequence field, specify a default string. This is the number that is incrementally 
sequenced and displays in the File name field when you select File > Open > Sample 
information.

3. In the field on the right of the Sample line, enter a format for the identification. Be sure to 
include the $ symbol if you want the sample file name (sequence number) included as part 
of the identification.

4. In the Mass field, enter an approximate value for the mass of sample you typically use in 
your analysis. A more accurate value can be entered in the sample file itself.

5. Select the down arrow to the right of the Analysis Conditions field to choose a default 
parameter file. The steps included in this file will display in the window below the field. 
You may view the details of these steps by selecting View.

6. Select the down arrow to the right of the Report Options field to choose a default 
parameter file. The reports chosen (preceded with a check mark) for the selected file will 
display in the list of reports below the field. 

7. Click Save, then Close.

Select Option > Option Presentation and ensure that Basic is selected as the format.

You can also edit the word Sample. For example, you may prefer to use Test or 
Material.
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Defining Parameter Files

Analysis Conditions and Report Options files can exist as part of the sample information file 
or as an individual parameter file. Having these files exist independently allows you to use 
them over and over again. For example; unless you expect each analysis to use unique sets of 
analysis conditions and report options, you can create a group of standard parameter files 
containing the values you expect to use most frequently. The contents of these files can be 
copied and imported into multiple sample information files, providing speed and consistency. 
After these values have been copied and imported into the sample information file, they can be 
edited in any way that you wish. The original parameter file remains intact and ready for its 
next use.

Several predefined parameter files (located in the PARAMS directory) are included with the 
AutoChem II analysis program. These files are examples only and the gases specified in these 
files may not match the gases connected to your analyzer. If you wish to use one of these files 
as a starting point, simply create a new file and select Replace. A dialog is displayed so that 
you can select the existing parameter file. After the values from this file are copied into the 
current file, you can edit them in any way desired. 

Make sure you save these files to the directory specified as the Parameter File directory (refer 
to Chapter 8 for additional information). If you do not save these files to the parameter file 
directory, they will not display in the drop-down lists on the Basic sample file editor.

Parameter files can also be created from the Advanced Sample information window using the 
Save as function on the File menu. Simply select Save As > Report Options or Analysis 
Conditions — whichever portion of the sample information file you wish to save.

This makes it possible for one person (such as a laboratory manager or senior 
chemist) to create standard parameter sets that can be used easily by others (such 
as laboratory technicians).
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Analysis Conditions

Analysis conditions specify the data used to guide an analysis.

1. Select File > Open > Analysis conditions; the Open Analysis Conditions File dialog is 
displayed.

2. Enter a name for the file (up to eight characters) in the File name field.

3. Click OK, then Yes to create the file; the Analysis Conditions dialog is displayed.

4. Enter a description in the Analysis Conditions field. Use a description that will help you 
identify the conditions specified. You can use up to 42 characters.

5. Click Insert to insert steps for the analysis. Each step you insert has an associated dialog, 
which contains the parameters for that step. You can insert up to 1000 steps in the 
Synopsis.

6. Choose Experiment, or a calibration option, then click OK; an associated dialog is 
displayed.

7. Define the experiment (or calibration) as desired, then click OK; the experiment (or 
calibration) will display in the synopsis window.

8. Click Save, then Close.

Refer to Analysis Conditions on page 5-10 for detailed information on the fields 
contained on this dialog.
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Report Options

1. Select File > Open > Report options ; the Open Report Options File dialog is displayed.

2. Enter a name for the file (up to eight characters) in the File name field.

3. Click OK, then Yes to create the file; the Report Options dialog is displayed.

4. Enter a description (up to 42 characters) in the Report Options field. Use a description 
that will help you identify the types of reports selected.

5. Select Show report title and enter the title you wish to appear at the top of the report. Or 
deselect this option if you do not want a title on your report.

6. Select (or deselect) the desired report by highlighting the report and double-clicking. 
Alternatively, you can press the Spacebar after the report is highlighted. A report is 
selected when it is preceded with a check mark.

7. Edit reports as desired.

8. Click Save, then Close.

Refer to Report Options on page 5-39 for detailed information on the fields contained 
on this dialog.

If your company logo exists as a bitmap (bmp) or enhanced metafile (emf), you can 
have it display in the report header, select Show graphic. Click Browse to select the 
file; use the Width and Height fields to specify a size.
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Creating Sample Information Files

Every analysis requires a sample information file. The file consists of information groups 
which, collectively, identify the sample, guide the analysis and specify the data reduction.

A sample file may be created in any of the three different formats:

• Advanced
Provides complete access to all parts of the sample file, allowing you to quickly edit 
parameters as required.

• Basic
Presents a single window in which you select predefined parameter files for your 
analysis. You can also switch to the Advanced format to edit parameters if desired.

• Restricted
Presents a single window in which you select predefined parameter files (identical to 
the Basic format). You cannot, however, switch to the Advanced format for editing 
purposes. This format is password-protected.

Select Options > Option presentation to choose the format you wish to use.

Sample information files can be created in advance of the analysis or they can be created at the 
time of analysis, whichever is convenient for you.

Advanced Format

The Advanced format presents the sample information editor in a manner similar to that of an 
index card file. Simply click on the appropriate tab and enter the required information.

1. Select File > Open > Sample information; the Open Sample Information dialog is 
displayed.

2. Accept the next sequenced file number or enter a new name in the File name field.
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3. Click OK, then Yes to create the file; the Advanced sample dialog is displayed.

4. In the Sample field, enter a description or add to the existing one. 

5. Edit the Operator and Submitter fields if desired.  

6. Use the Comments field if desired for any comments about the sample or analysis 
conditions. Anything you enter in this field will display in the header of some reports.

7. Click the Analysis Options tab and define analysis conditions. Refer to Defining 
Parameter Files for instructions on completing the dialog. 

8. Click the Report Options tab and specify desired report options. Refer to Defining 
Parameter Files for instructions on completing the dialog. 

9. Click Save, then Close.

The values contained on the dialog are those specified in Sample Defaults. You can 
accept these defaults to create the file or continue with the subsequent steps to edit 
them.
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Basic Format

The Basic format allows you to create a sample file by choosing from predefined parameter 
files. The values in these files can be edited when needed by switching to the Advanced 
format.

1. Select File > Open > Sample information; the Open Sample Information dialog is 
displayed.

2. Accept the next sequenced file number or enter a new name in the File name field.

3. Click OK, then Yes to create the file; the Basic Sample Information dialog is displayed.

4. In the Sample field, enter a description or add to the existing one. You can use up to 42 
characters.

5. Click the down arrow to the right of the Analysis Conditions field and choose the file 
containing the appropriate analysis conditions. After you choose a file, its steps are 
displayed in the window below the Analysis Conditions field. You can view the details of 
the steps by highlighting the step and clicking View.

6. Click the down arrow to the right of the Report Options field and choose an appropriate 
file. You can select additional (or deselect current) reports by double-clicking on the 
report(s).

7. Click Save, then Close.

The values contained on the dialog are those specified in Sample Defaults. You can 
accept these defaults to create the file or continue with the subsequent steps to edit 
them.
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Restricted Format

Sample information files are created using the Restricted format in the same manner as with 
the Basic format. The name displayed in the title bar even displays as Basic Sample 
Information. However, the dialog for this format does not allow you to switch to the Advanced 
format to edit parameters. Certain menu functions are also disabled with this format. 

Preparing for an Analysis

Depending upon the standard procedures at your laboratory, some preparation activities may 
be performed at the beginning of the day or at the beginning of a shift. Regardless of when you 
choose to perform them, the following activities must be performed before beginning an 
analysis:

• If the analyzer has been turned off, allow it to warm up for at least 3 hours after turning 
on. (Refer to Turning on the Analyzer on page 2-17.)

• Check all gas regulator pressure settings. (Refer to Gas Connections on page 2-3.) 

• Ensure that there is an adequate amount of cryogen in the dewar. The cryogen level 
should be approximately 25 mm (1 in.) from the top. (This chapter, page 4-26.)

• Make sure the sample thermocouple is properly positioned. (This chapter, page 4-11)

• Update the current ambient temperature and pressure. (Refer to Environmental 
Defaults on page 8-16.)
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Selecting the Thermocouple Position

Before beginning an analysis, the thermocouple must be attached to the analyzer. There are 
three possible configurations for the thermocouple:

• inside the sample tube
• inside the sample tube surrounded by a quartz sheath
• outside the sample tube

Best accuracy is obtained when the bare thermocouple is placed inside the sample tube. In 
some cases, however, one or more of the gases used during the experiment may react with the 
InconelTM material of which the thermocouple is made. A quartz sheath is provided to protect 
the thermocouple when the gases or sample used in the experiment may damage it. In this 
case, the sheath is placed around the thermocouple and the thermocouple is positioned inside 
the sample tube. When placed inside the tube, you can adjust the thermocouple so that the end 
is located in the sample or just above it; always try to position the end of the thermocouple as 
close to the furnace thermocouple as possible. 

Positioning the thermocouple along the exterior of the sample tube is less accurate than the 
other configurations. If the thermocouple is placed outside the sample tube, make sure it is 
clamped against the sample tube, and that its end does not extend below the point where the 
sample tube begins to taper.

Changing the Position of the Thermocouple

1. Turn the analyzer’s power switch off, then disconnect the analyzer from its power source.

2. Press in on the right side of the retractable handle on the top of the analyzer to protrude the 
handle. Then, using the handle, open the top panel. The top panel is hinged to allow easy 
access to its components; it is not necessary to remove the top panel.  

Pull down the upper front panel.

3. The Analyze/Prepare valve cover is held in place by two knobs or plungers. Remove the 
valve cover by pulling the plungers outward until the valve cover is released. Pull the 
cover up and out.
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4. Remove the insulation that surrounds the Analyze/Prepare valve.

5. Use an open-ended wrench to loosen the sample thermocouple fitting.

6. Loosen the fitting for the stainless steel plug in the alternate thermocouple opening and 
remove the plug.

7. Remove the fitting that retains the sample thermocouple.

8. Move the sample thermocouple from its current position to the new position.

If you are using the quartz sheath, perform the following before proceeding to the next 
step. Remember, the sheath can only be used when the thermocouple is being placed 
inside the sample tube.

a. Remove the ferrule from the thermocouple, straighten the thermocouple as much as 
possible.

b. Insert the thermocouple into the sheath. 

c. Place a larger ferrule around the sheath.

Analyze/Prepare 
Valve Cover

Upper Front Panel

Analyze/Prepare 
Valve Cover Knobs

For viewing purposes only, this 
illustration shows the top panel 
entirely removed. It is not necessary 
for you to remove the panel.

The sample thermocouple and nearby components may be hot. Make sure you allow 
the sample thermocouple to cool before removing it. Use the cotton gloves provided 
with the analyzer to protect your hands. If the zone is not near room temperature, 
loosening or tightening the fittings may cause damage to components of the 
instrument.
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 Figure 4-1. Thermocouple Placed Inside the Tube (Using a Sheath)

Figure 4-2. Thermocouple Placed Inside the Sample Tube (Without Sheath)

9. Place the stainless steel plug in the unused thermocouple opening and tighten the fitting. 
Reinstall the sample thermocouple retaining screw.

The sheath is very fragile and can be easily broken. Because the sheath is made of 
quartz, you must use the cotton gloves when handling it. (Oils from your fingers may 
lower the quartz’ melting point.)

Use the left opening to place 
the thermocouple outside the 
tube. (In this illustration, this 
opening contains a plug.)

Use the right opening (as shown) 
to place the thermocouple inside 
the tube. Lower End of Thermocouple 

with Sheath

Top Edge of Sheath

Fitting

Stainless Steel Plug

Top Edge of Thermocouple

Fitting

Lower End of Thermocouple
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10. Adjust the exposed portion of the sample thermocouple to the appropriate length. When 
adjusting the length of the exposed portion, consider the following:

• The thermocouple’s end should be aligned as closely as possible with the furnace 
thermocouple. (The furnace thermocouple’s location is shown in the following 
sections.)

• The thermocouple’s end should never be placed outside the painted (black), recessed 
area inside the furnace.

• If the thermocouple is positioned inside the tube, its end should generally be located 
approximately 2-3 mm (1/8 in.) above the sample surface. In some cases, you may 
allow the thermocouple to extend into the sample.

• If the thermocouple is positioned outside the tube, its end should not extend below the 
point where the sample tube begins to taper. 

Figure 4-3. The Furnace Thermocouple

11. Tighten the thermocouple fitting.

12. Place the insulation in its original position. Reinstall the Analyze/Prepare valve cover.

13. Return the upper front panel and the top panel to their original closed positions.

14. Turn the instrument’s power switch on.

Sample Thermocouple 
(placed inside the sample 
tube)

Furnace Thermocouple
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Using the Thermocouple Clamp

If the thermocouple is placed on the outside of the sample tube, you must clamp it to the tube 
as shown in the following illustrations.

Cleaning Sample Tubes

The sample tube should be cleaned (using an ultrasonic cleaning unit) and adequately dried 
before use to obtain accurate analysis results. You will need the following materials for 
cleaning sample tubes:  

• Ultrasonic cleaning unit 
• Alconox® or other suitable detergent 
• Rubber gloves or lint-free cloth 
• Isopropyl alcohol (IPA) is preferred for cleaning; acetone or deionized water may be 

used if IPA is unavailable
• Nitrogen or helium 
• Fume hood 
• Sample tube brush 

Clean the tubes in an ultrasonic cleaning unit as follows:  

Thermocouple

Clamp

Sample Tube

        Figure 4-4. The Thermocouple Clamp

Do not allow the end of the 
thermocouple to extend below 
the point where the sample 
tube begins to taper.

 Figure 4-5. Vertical Alignment of the Thermocouple End
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1. Ensure that the ultrasonic cleaning unit is clean.  

2. Using a ratio of 5 grams of Alconox (or equivalent detergent) per 500 mL of warm water, 
fill the bowl of the ultrasonic unit with enough water to cover the entire sample tube.  

3. Ensure that the detergent is dissolved before placing the sample tube into the water. If too 
much detergent is used, it may be difficult to rinse from the sample tube.  

4. Fill the sample tube with warm water and place it in the bowl of the ultrasonic cleaning 
unit. Turn on the ultrasonic cleaning unit for approximately 15 minutes.  

5. Using rubber gloves or a lint-free cloth, remove the sample tube from the bowl.  

6. Clean the interior of the sample tube with the brush supplied in the accessories kit.  

7. Rinse the sample tube thoroughly with hot water. Then rinse it again with isopropyl 
alcohol, using a waste container to collect used isopropyl alcohol.  

Figure 4-6. Rinsing the Sample Tube

8. Using dry, compressed nitrogen or air, dry the interior of the sample tube under a vent 
hood. Use a tubing extension long enough and small enough in diameter to fit inside the 
sample tube.

Always wear gloves when handling quartz sample tubes. The salts from bare hands 
lower the normal melting point of quartz (approximately 1300 ºC) to a much lower 
temperature. Oils from your skin may also destroy the quartz when the tube is 
heated.

If isopropyl alcohol is unavailable, acetone or deionized water may be used to rinse 
the sample tube.  
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9. Wipe a stopper with a lint-free cloth; make sure the stopper is dry. Label the sample tube 
and stopper for identification and place the stopper on the sample tube.

Preparing the Sample 

In order to obtain the most repeatable, accurate results, you should:

• Use approximately the same amount of sample for each analysis (especially if you 
compare data from sample to sample).

• Make sure the sample is well dispersed in the tube, not against the side or walls of the 
tube.

• Make sure the material’s particle size distribution remains fairly constant from sample 
to sample. (Large particles of a substance reduce at a different rate than small particles 
of the same substance.) For samples with a wide particle size distribution, care should 
be taken that each sample is representative of the entire lot’s distribution.

Micromeritics recommends analyzing samples weighing between 20 mg and 2 g. When 
determining a sample amount, consider that the sample must be contained within the bottom 
20 mm (3/4 in.) of the sample tube.

When determining sample size, you may also wish to consider the percentage of active metals 
in your sample. Materials with lower percentages of active metals may require larger sample 
amounts for analysis, while materials with high percentages of active metals can be analyzed 
using smaller samples.

 

           Figure 4-7. Placing the Stopper in the Sample Tube    

Larger amounts of very fine powders may become packed in the sample tube and 
block gas flow. The resulting increase in gas pressure may force some of the sample 
out of the sample tube, causing contamination of, or damage to, the analyzer. A 
possible solution is to expand the sample bed with quartz wool.
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Determining the Mass of the Sample 

1. Remove the stopper from the wide opening of the sample tube, and place a small amount 
of quartz wool into the clean, empty sample tube. (Try using a “ball” of quartz wool 
approximately 8-mm in diameter — loosely packed; some trial-and-error may be needed 
to determine the correct amount of quartz wool.) 

2. Press the quartz wool firmly into place using the extractor tool. Replace the stopper.

3. Place the weighing support onto the balance. Zero the balance and allow it to stabilize.

4. Place the sample tube (with stopper) onto the sample weighing support. If you are using 
the Sample Mass form from Appendix A, record the value as the empty sample tube mass.

Always wear gloves when handling quartz sample tubes. The salts from bare hands 
lower the normal melting point of quartz (approximately 1300 ºC) to a much lower 
temperature. Further, oils from your skin may destroy the quartz when the tube is 
heated.

   

Quartz Wool

Extractor Tool

Figure 4-8. Placing Quartz Wool in the Sample Tube     

A form to help you determine the sample’s mass is provided in Appendix A. Make 
copies of this form and use it for your convenience.
4-18                                                    Jul 09



AutoChem II 2920 Preparing for an Analysis
 

5. Remove the sample weighing support and sample tube set (tube and stopper) from the 
balance.

6. Place a sample container onto the balance. Zero the balance and allow it to stabilize. 

7. Slowly add the sample to the container. This step enables you to control the size of the 
sample before it is poured into the prepared sample tube. Do not record the sample mass at 
this point.

8. Remove the stopper from the tube. Using the funnel supplied with the analyzer, pour the 
sample from the container into the sample tube. Use a pipe cleaner to clean the walls of the 
sample tube before weighing the sample.

        Figure 4-9.  Weighing the Sample Tube

   

     Figure 4-10. Placing Sample in the Sample Tube   

Sample

Make sure that all of the sample is located in the lowest 20 mm of the sample tube. 
Any sample located higher in the tube will not be ideally located within the heated 
zone during analysis.
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9. Replace the stopper on the sample tube.  

10. Determine the mass of the sample tube (with stopper) and sample. If you are using the 
Sample Mass form from Appendix A, record the value as the Sample plus sample tube 
mass. 

11. Subtract the sample tube mass from the sample plus sample tube mass. The result is the 
sample mass.

For some types of analyses, the sample mass measured after analysis is preferred, because 
many samples contain elevated levels of contaminants and/or moisture which are included in 
the sample’s mass before degassing. This additional mass may affect the analysis results.

For TPR analyses (or other analyses involving small sample quantities), it may be helpful to 
weigh the sample in a tared container, transfer it to the sample tube, then reweigh the empty 
sample container after you transfer the sample to the tube. If there is a detectable amount of 
sample remaining in the container, subtract its mass from that of the sample in the tube.

If you fail to clean any sample residue from the sample tube walls, results will be less 
accurate. The sample along the walls will be included in the sample weight, but will 
not be heated to the same temperature (and will therefore not react) as the sample 
that is properly located in the bottom of the tube.

   

        Figure 4-11.  Sealing the Sample Tube   

The value recorded at this step is prior to sample preparation and analysis on the 
analyzer. Sample preparation and analysis will usually cause a change in this value. 
The difference between the before preparation and analysis and after preparation 
and analysis values may be useful when estimating how much contaminant is 
contained in fresh sample.
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Installing the Sample Tube on the Analysis Port

1. Carefully slide the sample tube retaining nuts and ferrules over the open ends of the 
sample tube. The larger diameter nuts and ferrules should be placed on the larger side of 
the tube, and the smaller diameter nuts and ferrules should be placed (narrow end down) 
on the smaller side of the sample tube.

Figure 4-12. Sample Tube Components

2. Place an O-ring around the sample tube near each opening. 

3. Remove any sample tube stoppers from the tube immediately before connecting the 
sample tube to the analyzer. Insert the open ends of the sample tube into the openings 
under the upper panel, aligning the thermocouple in the proper position (either inside or 
outside the sample tube; refer to Changing the Thermocouple Position in this chapter). 

4. Press the sample tube up into the analyzer until it comes to a stop. Tighten the fittings by 
screwing the sample retaining nuts until they are finger-tight. 

Always wear gloves when handling quartz sample tubes. The salts from bare hands 
lower the normal melting point of quartz (approximately 1300 ºC) to a much lower 
temperature. Further, oils from your skin may destroy the quartz when the tube is 
heated.

Be careful not to allow the nuts to slide rapidly down the tube and smash into the 
curved portion of the tube, or the tube may be damaged.

Sample Tube Ports

Sample Tube

Ferrules (narrow 
ends down)

O-rings

Retaining Nuts

Do not overtighten the analysis port fittings. Doing so may break the sample tube. 
The O-rings are sealed when the fittings are finger-tight.
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Removing the Sample Tube

It is recommended that you allow the furnace and sample tube to return to ambient 
temperature before touching them. If the sample tube has cooled, use rubber gloves when 
removing it. If it is still hot, be sure to use the cotton gloves provided.

1. If the furnace is closed around the sample tube, unlatch and open it.

2. Loosen the sample retaining nuts, being very careful to support them. As you loosen the 
nuts, also support the sample tube and pull it gently down out of the analyzer. When the 
nuts are sufficiently loose, the sample tube, retaining nuts, ferrules, and O-rings should 
slide out of the analyzer. If necessary, use the extractor tool to pull the O-rings out of the 
port(s).

3. Inspect the O-rings for cracks or other damage that might cause leaks. If the O-rings are 
cracked or damaged, replace them before reinstalling the sample tube. (Extra O-rings are 
shipped with the analyzer.) Otherwise, clean the O-rings you removed, dry them, and 
reinstall them.

The furnace and sample tube may remain very hot for some time after analysis has 
ended. The sample tube retaining nuts are extremely hot, approximately 110 ºC. Use 
Extreme caution!

Support the sample retaining nuts so that they do not fall rapidly out of the analyzer. 
This may cause severe damage to the sample tube.

Use only KalrezTM O-rings. Kalrez is rated for both chemical and temperature 
suitability in this application. O-rings of other materials could burn, melt, or 
decompose.
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Using the Cold Trap or Delay Path

A cold trap is used to condense liquids out of the gases flowing through the analyzer before 
they reach the detector. Specific instructions for using the cold trap are included in the 
instructions for performing each type of analysis in the tutorial (Appendix J).

A delay path is used to reduce the perturbation (disturbance) of the gas flow caused by 
injections of gas through the septum.

The cold trap or delay path is installed in the set of ports located under the top panel, to the left 
of the sample tube ports.

Figure 4-13. Location of the Cold Trap or Delay Path

1. Insert the open ends of the cold trap (or delay path) into the openings under the upper 
panel. If they are difficult to insert, loosen the attachment nuts by unscrewing them 
slightly.

Figure 4-14. Cold Trap Components

Diversion Ports

Cold Trap

Delay Path

The same 
components are 
used when installing 
the delay path.

Retaining Nut

Ferrule

O-ring
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2. Press the cold trap (or delay path) up into the analyzer until it comes to a stop; securely 
tighten the fittings. 

3. If you wish to use a dewar to reduce the temperature of the cold trap, fill the dewar with 
the appropriate coolant. Place it underneath the cold trap so that the cold trap is immersed 
in the coolant.

Using a Dewar

Precautions

We recommend the following be observed when handling dewars containing liquefied gases:

• Protect yourself by wearing 1) goggles (or a face shield), 2) an insulated or rubber 
apron, and 3) insulated gloves.

• When pouring cryogenic liquids from one container to another: 1) cool the receiving 
container gradually to minimize thermal shock, 2) pour the liquefied gas slowly to 
prevent splashing, and 3) vent the receiving container to the atmosphere.

• Use a plastic stirring rod when stirring substances in a dewar containing liquefied gases 
(or other materials of extremely low temperature). Do not use a glass or metal stirring 
rod unless it is coated with some type of protective coating.

• Do not remove the mesh covering from the dewar flask. This covering is in place to 
minimize the risk of flying particles if the dewar is accidentally knocked over or 
dropped and broken. 

If the nuts are unscrewed until they become free of the analyzer, they will fall out of the 
analyzer.

Do not overtighten the fittings. A sufficient seal is achieved when the fittings are 
finger-tight.

Cleaning the cold trap is a regular maintenance procedure. A schedule and 
instructions are contained on page 9-4.

Always handle dewars with care. Any product incorporating a vacuum is a potential 
safety hazard and should be treated with caution. Always observe the precautions 
listed below.
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• Do not handle heavy objects above the dewar. If unavoidable, place a protective cover 
over the dewar’s opening. If an object of sufficient weight is accidentally dropped into 
the dewar, shattering may occur.

Placing the Dewar Under the Cold Trap

To surround the cold trap, the dewar must rest on a small stand. Hold the dewar beneath the 
cold trap, then raise it until you can slide the stand underneath the dewar. Then lower the 
dewar until it rests on the stand. Make sure the cold trap is immersed.

Mixing an IPA/LN2 Slurry

An isopropyl alcohol (IPA)/liquid nitrogen (LN2) slurry is used to maintain cold trap 
temperatures of approximately -80 °C. Use the following instructions to mix such a slurry if 
this is the temperature you wish to maintain.

1. Chill a 600-mL dewar by rinsing it with LN2. Allow a small amount of LN2 to remain in 
the bottom of the dewar (approximately 1 cm deep).

2. Stirring constantly, slowly add approximately 500 mL of IPA. For greatest safety, use a 
laboratory squirt bottle. Squirt the stream of IPA along the inside edge of the dewar, very 
near the top, allowing the IPA to flow down the dewar’s inside wall. Do not stop stirring 
the mixture in the bottom of the dewar, even if stirring becomes difficult. As you continue 
stirring and adding IPA, the mixture will loosen and become easier to stir.

3. When all the IPA has been placed in the dewar, slowly begin pouring LN2 into the dewar. 
Approximately 1 liter is needed. You must continuously stir the mixture as you add the 
LN2. As ice chunks form, break them up and stir them down into the mixture. Avoid 
splashing. Gently knock ice chunks away from the sides of the dewar and continue 
stirring. Add liquid nitrogen until the slurry is within 25 mm (1 in.) of the top of the dewar.

4. Lift the stirrer out of the slurry and observe as the slurry drips into the dewar; the stirrer 
should be thickly coated with slurry. 

Your goal is to achieve a slurry that has a thick, syrupy consistency without large chunks. 
When the slurry is cold enough, small pieces of ice may be present (10 - 20% of the 
mixture). A little ice accumulation along the sides of the dewar is acceptable. 

Improperly mixing an IPA/LN2 slurry could cause injury. If you do not stir the mixture 
continuously, gas may build up under the surface, causing the liquids to splash out 
of the dewar.
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Checking the Cryogen Level

If you are performing an analysis that requires use of the cold trap and cryogen, check the 
cryogen level in the dewar. It should be about 25 mm (1 in.) from the top. 

Cleaning the Dewar

The dewar must be cleaned between uses. Empty the dewar, then rinse it with water. Make 
sure that it is dry before using it again.

Using the Septum

The septum is used for injecting quantities of gas into the analyzer, such as during a loop 
calibration. The septum is located in the upper left corner of the recessed portion of the front 
panel.

Figure 4-15. Location of the Septum

Accuracy of data is diminished when poor techniques are used for injecting gas through the 
septum. The following guidelines should help you maximize the accuracy of your data.

Injecting the gas through the septum causes a peak to appear, but it also causes a perturbation 
in the flow of gas through the analyzer. This perturbation is visible in the peak data. You can 
minimize this perturbation by injecting the gas more slowly into the septum. However, 
prolonging the injection causes the peak to spread.

The cryogen must not be cold enough to trap the carrier gas or analysis gas. Do not 
use liquid nitrogen with argon carrier gas. For example, use an alcohol and liquid 
nitrogen slurry (-80 ºC).

Use appropriate safety procedures when handling all cryogens. Be sure to wear 
safety glasses and gloves, and observe the precautions listed earlier in Precautions.

Septum
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You must develop your injecting method to balance your desire to minimize the perturbation 
with your need for sharper peaks. The Peak Editor (described on page 7-14) enables you to 
adjust your peak data to reduce the effects of perturbation.

• Always hold the syringe by its metal parts away from the needle. Holding the syringe 
by the glass allows your body heat to affect the volume of gas in the syringe.

• After filling the syringe, allow the syringe to lie on a room-temperature surface, such as 
that of the workbench, for about a minute. This helps ensure that the syringe and its 
contents are at room temperature.

• If the gas you are using is lighter than air, do not allow the filled syringe to remain in a 
vertical position (needle up); the gas will diffuse out and the total volume will be 
reduced.

• To fill the syringe: first empty it completely, then insert it into a septum accessory 
installed on the gas regulator. Draw the syringe plunger back until the syringe is 
completely filled with gas. Remove the syringe from the septum, and allow it to return 
to room temperature as described above. Then, press the plunger into the syringe until 
the correct amount of gas is contained in the syringe.

• An alternative way to fill the syringe with nitrogen (evaporating from liquid nitrogen), 
is to empty the syringe, then hold the tip of the needle just above the surface of a 
quantity of liquid nitrogen. Draw the syringe plunger back to fill the syringe with 
nitrogen gas. Allow the syringe to stabilize at room temperature, then push the plunger 
into the syringe until the correct amount of gas is contained in the syringe.

• Make sure the needle is inserted fully into the septum on the analyzer.

• Make sure that you inject the entire quantity of gas that you have measured into the 
syringe. (Press the plunger into the syringe completely.)

Cooling Options

The furnace must cool during temperature-programmed analyses if (1) a low temperature is 
required as part of the analysis, or (2) you simply wish to speed cooling of the furnace in order 
to increase sample throughput, or reduce analysis time.

Cooling options are listed below. If you wish to speed the cooling of the furnace to increase 
throughput, the choice may be one of convenience. If cooling is required for your analysis, the 
CryoCooler may be required.

• Allow the temperature to return to ambient over time
If time is not a consideration, you may wish to allow the furnace to cool over time. It 
may take two hours or more for the furnace to cool from 1100 °C to near ambient. This 
may be acceptable when time is not limited.
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• Promote cooling by manually opening the furnace
The furnace cools more rapidly when it is open. This option requires the availability of 
an operator to open and close the furnace at the appropriate times during analysis.

• Connect a cooling gas or cryogen flow to the inlet on the front of the furnace
You can connect a cooling flow of an appropriate gas or cryogen to the inlet on the 
furnace. Read the caution above. This option can provide rapid cooling of the sample, 
but offers no control of the target temperature or the speed at which it is achieved. The 
gas or cryogen must be nonreactive, such as nitrogen, air, helium, argon, liquid 
nitrogen, or liquid argon.

• Connect the KwikCool to the inlet in the front of the furnace
The KwikCool allows you to ramp the furnace temperature rapidly down near ambient, 
which reduces the time required to complete analyses and increases throughput. 
Instructions for attaching the KwikCool to the furnace are provided in Chapter 2. A 
KwikCool is included as a standard accessory with every AutoChem II 2920.

• Connect the optional CryoCooler to the inlet in the front of the furnace
The CryoCooler provides control of the sample temperature from temperatures as low 
as -70°C. The CryoCooler is required for accurate analyses that include signal recording 
below ambient. Instructions for attaching the CryoCooler to the furnace are provided in 
Chapter 2 (refer to Chapter 10 for ordering information).

When it has been used recently, the furnace and/or the sample tube may be hot. Use 
the cotton gloves provided with the analyzer to protect your hands.
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Protecting the Detector Filaments by Flowing Gas

The flowing gas also continuously cleans the plumbing of any water vapor which can enter 
when the sample tube is removed. Ten cm3/min is sufficient to perform this function.

Specifying Analysis Temperatures 

The guidelines listed here are for all analysis types.

Starting Temperature

Experiments should be started at a temperature that is lower than that at which the reaction 
begins. If the reaction begins below ambient temperature, you should use the optional 
CryoCooler.

Maximum Temperature

The experiment’s maximum temperature is limited to the temperature at which your sample 
sinters1 or melts. 

Ramp Rate

The recommended ramp rate is 5-10 °C/min. However, you may wish to use a different ramp 
rate for various purposes. For example, if you have identified 500 °C as the starting 
temperature of the reaction being observed, it is more expedient to ramp the temperature 
rapidly (for example, 50 °C/min.) to a value near 500 °C, then proceed with the experiment at 
5-10 ºC/min.

A carrier gas must be flowing through the detector whenever the detector filaments 
are turned on; otherwise, the filaments will deteriorate and lose sensitivity. If the 
gases are shut off, the filaments are automatically turned off after five minutes.

1. Sintering is the fusing of small particles (or small features of a sample). Sintering tends to reduce the 
active surface area.
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Performing an Analysis

Before starting your analysis, make sure:

• the correct gases are connected and that the Gas Selections dialog (Unit menu) reflects 
the current gas connections

• the sample has been prepared and the sample tube installed on the analyzer

1. Select Unit > Start analysis; the Sample Analysis dialog is displayed with the Open 
Sample information dialog positioned on top.

2. Choose a file for your analysis (or accept the default to create a new one) and click OK; 
the Sample analysis dialog containing the parameters of the selected file (or the defaults) 
is displayed.

3. Review and verify analysis conditions and report options; edit if necessary.

4. Click Next; the second view of the analysis dialog is displayed. From the drop-down 
list(s), select the calibrations to be associated with each experiment (if any).

5. Click Next; specify report output options.

6. Click Next to review the safety information.

Appendix J provides tutorials for performing a TPR, TPD, TPO, and Pulse 
Chemisorption analysis.

Chapter 6 provides a description of the dialogs used for performing an analysis.

This group of push buttons 
is not displayed on the 
Basic presentation; you 
cannot edit parameters 
when using the Basic 
mode.
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7. Click Start to begin the analysis. A dialog allowing you to monitor the progress of the 
analysis is displayed. 

You can also use this dialog to edit any step after the current one. Simply suspend the 
analysis; this enables the editing push buttons. After editing is completed, resume the 
analysis.
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Listing File Statistics

You can generate a list of the following information on one or more sample or parameter files:

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status (sample information files)

Perform the following steps to generate a list:

1. Select File > List.

2. Select the type of file on which you wish information; a dialog similar to the one shown 
below is displayed.

3. From the Files list box, choose the desired file(s). If you wish to include all files in the list, 
leave all files deselected.

4. At the Destination field, click on the down arrow and choose an output destination. If you 
choose File as the destination, enter a name in the File name field (or accept the default).

5. Click OK; a list for the requested file(s) is sent to the specified destination.
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Exporting Data from a Sample Information File

Data from a sample information file can be exported in ASCII or Grams/32 format. ASCII 
data can then be imported into other applications, such as spreadsheets. Grams/32 data can be 
imported into the Grams/32 program (a peak-editing program used with earlier versions of the 
AutoChem software) and manipulated independent of the AutoChem 2920 analysis program. 
Refer to Appendix D for a description of exported data.

Perform the following steps to export a sample information file:

1. Select File > Export; the Export Sample File dialog is displayed.

2. From the Files list box, choose the file(s) you wish to export. You can choose multiple 
files by holding down  and clicking on the desired files.

3. From the Settings group box:

a. Choose whether you are exporting in ASCII or Grams/32 format.

b. Choose a destination for your exported file. 

If you choose File, enter a name in the File name field (or accept the default). If you 
choose Printer, the Copies field is enabled allowing you to print up to 4 copies.

You must choose File as the destination when exporting in Grams/32 format.
Jul 09                                                  4-33 



Exporting Data from a Sample Information File AutoChem II 2920
4. Click OK; the Collected Data Export Options dialog is displayed.

5. Choose the experiments whose data you wish to export. Then select any other desired 
options. Refer to Chapter 5 for additional information on this dialog.

6. Click OK; data are exported to the specified destination.

Only the Selected 
Experiments group 
box is displayed if 
data are being 
exported in the 
Grams/32 format.
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Creating and Assigning a Calibration File

After you have completed your analysis, you can edit your peaks to create a calibration file 
and assign the file to your experiment. There are two types of calibration files you can create 
and assign: a Vapor calibration and a User-Defined calibration. The example in this section 
shows a User-Defined one. 

Editing the Peaks

1. Select Reports > Peak Editor from the main menu.

2. Select the desired sample file and click OK; the Peak Editor, Stacked view dialog, is 
displayed. This view of the dialog displays all calibrations and experiments contained in 
the file, stacked one after the other.

3. Click a calibration experiment; the name of the experiment displays in the title bar of the 
dialog.

4. Click the Edit Peaks tab; the Edit Peaks dialog and table for the selected calibration are 
displayed.

5. Right-click in the graph area and select Find All Peaks; this option finds all peaks and 
marks them.

6. Right-click and select Save.

Peaks should be in a positive position before integrating. If you have any negative 
peaks: right-click in the graph area, choose View, Display and click the Invert option

You can further define peaks if desired. Select the peak (the baseline area of the peak 
displays in green when selected), right-click, and use the Mark Left Edge and Mark 
Right Edge options.
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Creating the Calibration File

After you have defined your calibration peaks, you can create the calibration file.

1. Select Unit > TCD Calibration >, New; the TCD Calibration dialog is displayed.

2. Click Load Calibration Data; the Load Calibration Sample File dialog is displayed.

3. Select the sample file containing the calibration data.

4. Enter an intuitive description in the Description field. It is important that you use a 
description that you will easily recognize.

5. Delete from the Peak Table any data not associated with your calibration experiment.

6. Using the formula given below, calculate the peak volume for each peak in the table; enter 
the results into the appropriate fields.

Example: Calculations for 1 cm3 injection, ambient temperature of 22 °C, ambient 
pressure of 760 mmHg:

7. Click Save to save the file, then Close to close the dialog.

Vsyrinj
273.15

Tamb 273.15+
----------------------------------×

Pamb

760 mmHg
----------------------------× VPeak=

1 273.15
22 273.15+
----------------------------× 740

760 mmHg
----------------------------× 0.901cm3STP=
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Repeat steps 1 through 7 for each gas concentration in the calibration. For example, if you 
have gas concentrations of 10%, 30%, and 20%, you should mark your calibration peaks and 
create calibration files for all three concentrations; a total of three files.

Assigning the Calibration File to the Experiment

Now you must assign the calibration to the appropriate experiment.

1. Click back into the Peak Editor dialog and select the Experiments-Stacked tab.

2. Click a sample experiment. Remember, you can view the experiment name in the title bar.

3. Click the Edit Peaks tab; the Edit Peaks dialog and table for the selected sample 
experiment are displayed.

4. Right-click in the graph area and select Find All Peaks from the shortcut menu.

5. You should have only one peak in the table; if multiple peaks are included, delete all but 
the desorption peak. The desorption peak typically is the last one in the table.

6. Right-click in the graph area and select Set Calibration from the shortcut menu; the Set 
Calibration dialog is displayed.
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7. Click on the down arrow to the right of the Calibration field and choose the calibration file 
you created for the concentration of the selected experiment. Be sure that the Experiment 
and the Calibration match.

8. Right-click in the graph area and select Save from the shortcut menu.
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5.  FILE MENU

The File menu contains options that allow you to manage sample and parameter files.

Description

Listed below are brief descriptions of the File menu options. Detailed descriptions follow this 
section.

Open Opens an existing file or creates a new file. When you select this 
item, a drop-down menu is displayed containing three types of files: 
sample information, analysis conditions, and report options. Page 5-3.

Save Saves the file in the active window. Page 5-54.

Save As Allows you to save the file that is in the active window under a 
different name. It also can be used to save a subset of a sample file as 
an independent parameter file. Page 5-54.

Save All Saves all open files. Page 5-55.

Close Closes the file in the active window. Page 5-56.

Close All Closes all open files. Page 5-56.

Print Prints details of the selected file(s). Page 5-57.
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List Generates a list of certain information for the selected sample file(s) 
or parameter file(s). Page 5-58.

Import MS Signal Allows you to import data collected on a Pfeiffer Vacuum (formerly 
Balzers) mass spectrometer which uses the Quadstar software. Page 
5-59.

Export Exports a sample file in ASCII format or in a format compatible with 
the Grams/32 application (a peak editing program used previously 
with the AutoChem). Page 5-62.

Exit Exits the analysis program. Page 5-65.
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Open

Select Open to create a new file or edit an existing one. The following file types are available:

• Sample information
• Analysis conditions
• Report options

Regardless of which file type you select, a dialog box similar to the one shown below is 
displayed. 

File name For sample information files, this field contains the next 
sequenced file name generated by the system. 

For parameter files (analysis conditions and report options), 
the file name displayed includes the wild card (*) and the 
default extension as follows:

*.ANC for analysis conditions

*.RPO for report options

If you are creating a new file, enter a name in the File name 
field. If you are editing an existing file, select a file from the 
list.

Files This window displays the files available in the selected 
directory for the chosen status. This list includes AutoChem 
II 2920 files as well as AutoChem 2910 files (if applicable). 
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Refer to Selecting Files on page 3-6 for a description of the other fields on this dialog box.

Sample Information

Sample Information files contain information used to control the analysis, as well as collected 
data. A sample information file consists of four parts:

• Sample information
• Analysis conditions
• Report options
• Collected data (this part does not appear until analysis is complete)

Portions of the sample file can also exist as parameter files separate from the sample informa-
tion file itself. These parameter files contain frequently used analysis conditions and report 
options that can be conveniently loaded into a new sample information file.

Sample information files are presented in three different formats, Basic, Advanced, and 
Restricted. You can select any one of these formats as your default. A convenient toggle button 
makes it easy to switch between Basic and Advanced formats, regardless of which is selected 
as your default.

• Basic Format 
Presents the entire sample information file in a single dialog box. Basic format makes it 
easy to select previously created, standard parameter files from convenient drop-down 
lists.

• Advanced Format 
Presents all four parts of the sample information file as a group of dialog boxes with 
index card-type tabs (although the Collected Data tab does not appear until after 
analysis). Clicking on each tab opens the associated dialog. Use this format to create 
customized sample information files. 

• Restricted Format 
Restricted presentation format is identical to Basic presentation format, except it 
prevents the operator from switching to the Advanced presentation. Restricted 
presentation limits the operator’s ability to change analysis conditions and report 
options. 

Select Options > Option presentation to specify your default format. 

Files
(continued)

If you select an AutoChem 2910 file to use in the AutoChem 
II 2920 application and it is saved, it will no longer be 
compatible with the AutoChem 2910 application. Be sure to 
use the Save as function to save it as a different name if you 
want the file to remain 2910-compatible.
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Basic Presentation

The Basic format displays all parameters of the sample information file on a single dialog. 
With the Basic format, you can quickly create a sample information file using predefined 
parameter files. If you wish to view or edit specific parameters, you can switch easily to the 
Advanced format by clicking  Advanced. 

Sample Contains the description of the current sample file.

If this is a new file, this field contains the next sequenced 
description based on the format you specified in Sample 
defaults (see Chapter 8). You can enter a new description or 
add to the existing one if desired.

Range: 50 alphanumeric characters

Mass Allows you to enter the mass of the sample. 

Analysis Conditions Displays the name of the current Analysis Conditions file.

If this is a new file, this field contains the name of the file 
you specified as the default. Click on the down arrow to the 
right of the field to choose a different file. This list includes 
Analysis Conditions files supplied with the analysis program 
as well as those you create and save to the directory 
specified as the Parameter Files directory (Chapter 8). If new 
files are not saved to the specified directory, they are not 
included in the list.

This list is disabled for files which have been used for an 
analysis.
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View Allows you to view details about the currently selected step 
in the analysis conditions set.

Report Options Displays the name of the current Report Options file.

If this is a new file, this field contains the Report options file 
you specified as the default. Click on the down arrow to the 
right of the field to choose a different file. This list includes 
Report Options files supplied with the analysis program as 
well as those you create and save to the directory specified 
as the Parameter Files directory (Chapter 8). If new files are 
not saved to the specified directory, they are not included in 
the list.

Reports List Box Displays a list of available reports. The checked reports are 
the ones requested for the current Report options file. If this 
is a new file, the checked reports are the ones you specified 
for the default(s). You can select (or deselect) reports by 
double-clicking on the desired report. Alternatively, you can 
highlight the report and press Spacebar.

Replace All Allows you to copy an existing sample file’s values into the 
sample information file you currently have open. A file 
selection dialog is displayed. Choose the file containing the 
values you wish to copy, then click OK; the values are 
copied into the new file automatically. You may then edit the 
values in the new sample file without altering the sample file 
from which they were copied.

Save Saves the currently open file.

Close Closes the currently open file.

Advanced Switches the presentation format to the Advanced 
presentation. 
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Advanced Presentation

The Advanced format displays the sample information file in a manner similar to that of an 
index card file. Each parameter has its own tab and is accessed by clicking the tab. Or, you can 
use Prev and Next to move through the dialogs. This format allows you to create customized 
sample information files. 

The prompts for the Sample, Operator and Submitter fields may be customized by selecting 
Sample defaults from the Options menu. Refer to Chapter 8 for instructions on customizing 
these prompts. 

Sample Contains the description of the current sample file.

If this is a new file, this field contains the next sequenced 
description based on the format you specified in Sample 
Defaults (refer to Sample Defaults on page 8-7). You can 
enter a new description or add to the existing one if desired.

Operator
Submitter

Displays the Operator and Submitter names (if specified) of 
the current sample file.

If this is a new file, these fields contain the names specified 
in Sample defaults. You can enter a different name in either 
(or both) field if desired. You can also edit the prompts for 
these fields or choose to have them omitted entirely.
Jul 09                                                    5-7 



Open AutoChem II 2920
The Analysis Conditions and Report Options tabs of the Advanced presentation sample 
information file are described in subsequent sections.

Mass Allows you to enter the mass of the sample. 

Add Log Entry Displays a dialog box allowing you to enter pertinent 
information relating to the sample. Any information you 
enter here is printed as part of the Analysis Log report (select 
in Report Options).

Comments Use this field to enter any comments about the sample or the 
planned analysis conditions that you wish to note. 
Comments entered here are printed in the header of some 
reports.

Range: Up to 500 alphanumeric characters

Replace All Allows you to copy the values for all parameters of an 
existing sample file into the sample information file you are 
creating. A file selection dialog is displayed. Choose the file 
containing the values you wish to copy, then click OK; the 
values are copied into all parameters of the new file 
automatically. You can then edit the values in the new 
sample file without altering the sample file from which they 
were copied.

Each of the individual tabbed dialogs that make up the sample information file can 
also be replaced separately, using Replace that appears on each. Individual Replace 
buttons replace only the data on the dialog box that is currently shown.

Basic Switches the presentation format to the Basic presentation. 
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Restricted Presentation

A third format is provided to control access to some portions of the sample information file. 
Restricted format displays in the same manner as the Basic presentation format.

In Restricted presentation format, the Advanced button does not appear on the screen, so the 
operator cannot switch to the Advanced format. This format is also password-protected, 
preventing the operator from making changes to analysis conditions and report options sets. 
Chapter 8 provides additional information on this format.

Restricted presentation is ideal for laboratories in which standard analysis procedures are 
established by a lab manager, while one or more lab technicians actually perform the analyses. 
The lab manager can create independent analysis conditions and report options files 
containing standard sets of operating conditions, then the operator(s) can use Restricted mode 
for daily operations, selecting the standard parameter files from the drop-down lists.

The Restricted format 
does not allow switching 
to the Advanced format 
for editing.
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Analysis Conditions

Analysis conditions files specify each step in the analysis, including temperatures, pressures, 
and gases. You can create an Analysis Conditions file as an independent parameter file or as 
part of the sample information file. You can also save the analysis conditions portion of the 
sample information file as a parameter file.

When creating parameter files to display in the drop-down list on the Basic sample 
information dialog, be sure to save them to the directory specified as the Parameter 
File directory (explained on page 8-17).

Analysis Conditions If you are opening an existing analysis conditions file, this 
field contains the description

If you are creating a new analysis conditions file, this field 
contains the description specified in Sample defaults. You 
can enter a new description or add to the existing one if 
desired. Use a description that will help you identify this set 
of analysis conditions in the future.

Range: 40 alphanumeric characters

Replace Allows you to copy values from an existing file to the one 
you are creating. A dialog box is displayed allowing you to 
choose the desired file. You can then edit these values if 
desired; the file you copied them from will not be affected.

Synopsis Displays a list of the steps the analyzer will follow during 
the analysis.
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An analysis is a complete characterization of the sample; in other words, it is all of 
the experiments and steps within the Synopsis. It may consist of up to 99 separate 
experiments, such as TPR or TPO. Each experiment may consist of up to 1000 steps.

Synopsis
(continued)

The Synopsis is the key to the AutoChem II 2920’s high 
level of automation. This list enables the software to control 
and change the gas flow, temperature, and data recording 
process. It causes the analyzer to progress to the next step, or 
to wait until specific criteria are met before proceeding. In 
all, this list provides a step-by-step guide for the analysis. 

Insert Allows you to insert a new experiment or a step within an 
experiment.

Steps within 
Experiment 1

This dialog displays 
if you are inserting a 
new experiment.

This dialog displays 
if you are inserting a 
step within an 
experiment.
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Insert
(continued)

At some points in the sequence of steps, all steps are 
available. At other points, certain steps cannot be performed. 
For example, you cannot start a new experiment inside a 
Repeat loop.

The steps that appear in the list box are those which are 
currently available. To select an experiment or step to insert: 
click on it, then click OK. A dialog enabling you to specify 
instructions for the step or experiment is displayed. Each of 
the specific step and experiment dialogs are discussed in 
subsequent sections.

The new step is inserted directly before the step that was 
highlighted when Insert was selected. After you insert a 
Repeat or Record step, the automatically entered Stop 
Repeat or Stop Record step is highlighted. Any steps 
inserted at that point will occur within the Repeat or Record 
loop.

You can also insert steps after the analysis has started by suspending the analysis.

You can easily move a step from one position in the list to 
another. Click on it, then use Ctrl + ↑ or Ctrl  + ↓ to move 
the highlighted step.   

Delete Deletes the selected item from the synopsis list. If you click 
this button when an experiment is selected, the entire 
experiment (including all its steps) is deleted after a 
confirmation.

Edit Enables you to edit the selected experiment or step; an 
associated dialog is displayed. 

You can also edit a step or experiment during analysis. 
However, you must suspend the analysis before any editing 
can be accomplished. You can edit only the steps or 
experiments following the current one; all completed steps 
will be disabled.

After an analysis has been completed, Edit displays as View. 
Steps may be viewed but not edited.

Clear Clears the list of experiments and steps for this Analysis 
Conditions dialog. A confirmation message is displayed.
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Insert Method Allows you to insert the entire list of steps from another 
analysis conditions file. After you click this button, select an 
analysis conditions file from the list. All the steps in that file 
are inserted directly above the highlighted step. Inserted 
methods can be edited without altering the original analysis 
conditions file(s) from which they were copied.

For example, if you have three different standard sample 
preparation methods that you use under varying circum-
stances, create an analysis conditions file for each 
preparation method. Then use Insert Method to insert the 
appropriate preparation method in the analysis conditions 
file you create when you are ready to analyze a sample.

You can also create several analysis conditions files contain-
ing individual experiments, then use Insert Method to com-
bine them into a comprehensive analysis comprised of these 
individual analyses.

Step Detail Displays information about the currently highlighted step in 
the Synopsis. The information displayed for each step is a 
summary of the information contained on that step’s dialog.
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Insert Experiments

An analysis set is created by inserting a series of experiments in the sample file Synopsis. You 
can insert up to 99 experiments. There are four types of experiments that you can insert in an 
analysis conditions set. The following dialog is displayed when you choose to insert an 
experiment:

The first type is the customizable Experiment. You will insert into this Experiment the 
individual steps which control the reaction(s) in the analysis. When you insert an experiment, 
you specify the Initial Conditions, then insert individual steps. Each step can be customized in 
detail.

There are also three specialized experiments which can be inserted:

• Loop Calibration
• Gas Calibration
• Vapor Calibration

The sequence of steps in the three specialized experiments cannot be altered. 

Data from one experiment (of any of these four types) are not available for editing 
until the next experiment in the analysis has begun recording.
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Experiment

Inserts a basic experiment into the list of steps.

Experiment 
description

Allows you to enter a description or identifier for this 
experiment. The description you enter in this field appears in 
the legend of the report.

Type of analysis Select the type of analysis from the drop-down list

Choices: Temperature-Programmed Oxidation
Temperature-Programmed Reduction
Temperature-Programmed Desorption
Physisorption Surface Area
Pulse Chemisorption
Other

It is important to select the correct experiment type because the type is referenced 
during some other operations. For example, a Pulse Chemisorption report can only 
be generated for those experiments specifying Pulse Chemisorption as the type.
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Active Metals Opens the Active Metals Table dialog, allowing you to 
specify the percent of sample weight of the active metals in 
the sample (in the far right column), and the stoichiometry 
factor.

The contents of this table are copied from the default table on the Options menu. 
After the sample file is created, however, the contents of this table become specific 
to the file. Changes made in this table do not affect the default table and changes 
made to the default table do not affect this table.

Insert Inserts a new row into the table; the row is inserted above 
the selected one.

Delete Deletes the selected row.

Clear Clears the table of all entries except one; one is required.

Initial Conditions The push buttons in this group box allow you to specify 
initial conditions for the analysis.
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Zones Displays the Set Temperature Zones dialog allowing you to 
set the heat zone temperatures.

Valid ranges for the selected field are displayed in the 
information bar.

The Filament temperature must be set at least 20 ºC higher 
than the Block zone temperature. 

The Reflux must be at least 10 °C cooler than the Flask 
zone.

If the optional Vapor Generator is not installed when the 
analysis is started, the Vapor Generator fields are ignored by 
the instrument when you start the analysis.

Gas Flows Displays the Gas Flows dialog.

Displays the valid 
range for the selected 
field.
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Gas Flows
(continued)

This dialog allows you to choose the gases you wish to use 
for this step, specify the flow rates, specify the percent of the 
carrier gas mixture which is composed of the reactive, and 
set the state of the rotary valves.

Prep Gas
Carrier/Reference
Gas
Loop Gas

For each set of inlet ports, you may select a gas from the 
drop-down list.

Rate: 0 to 175 cm3/min

The gases that appear in each drop-down list are those 
specified in Gas Defaults (accessed from the Options 
menu). Also contained in these lists are two special 
selections: None and Manual Mixer. Select None when no 
gas is to be flowing (the flow rate is ignored). Select 
Manual Mixer if an external gas blender is to be used (the 
flow rate displayed in the dialog is ignored and, instead, is 
controlled by the external blender). As with other selections, 
the manual mixer must be configured to an inlet port from 
the Gas Selections dialog of the Unit menu.

When you start an analysis, the system checks to ensure that 
the selected gases are connected to the appropriate ports. If 
there is a discrepancy between a gas selected for the current 
sample file and the gas indicated in the Gas Selections 
dialog, an error message is displayed when you attempt to 
begin the analysis.

Make sure the appropriate gases are attached to the appropriate ports, and that the 
Gas Selections dialog accurately shows which gas is connected to each port.

Different reference
rate

The carrier gas flows through two separate paths through the 
analyzer: through the path that contains the sample tube, and 
through the reference path. The reference path flows directly 
from the inlet over the reference detector, making it possible 
for the detector to detect variations in the gas that traveled 
through the sample tube (Carrier) path.

The same flow rate is typically used for both the Carrier and 
Reference Gas. If you wish to use different flows in these 
two paths, select Different reference rate, then specify the 
flow you wish to use for the reference gas path in the Rate 
field below the check box. (The Rate field above the check 
box determines the Carrier gas flow rate.) 
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• Avoid placing incompatible gases in the analyzer in immediate sequence.

When you change the gas flowing into the analyzer, the new gas enters the ana-
lyzer while the previous gas is still present. 

You can “purge” the previous gas before starting to flow the new gas by selecting 
an inert gas for the initial conditions gas in an experiment step, or by inserting an 
extra Change gas flows step in which you flow an inert gas between the flows of 
incompatible gases. If you do so, you must also insert a Wait step specifying how 
long to flow the inert gas. You can specify a specific time period or select one of 
the other Wait step criteria. (Each of these steps is described later in this chapter.)

• Changes in the gas cause a brief adjustment of the Mass Flow Controller(s) involved in 
the change.

This adjustment may be detected by the TCD, and may be visible in the data (if 
data are being recorded when the gas flow is changed).

Either disregard such disturbances in the data or stop recording before you 
change the gas flows, then insert a Wait for stable baseline step after the Change 
gas flows step. Resume recording after a stable baseline is detected. A suggested 
sequence of steps then might be as follows:

• Start recording
• Experiment steps as needed
• Stop recording
• Change gas flows

Active Concentration Specify the percent of the gas mixture which is composed of 
the reactive gas versus an inert filler. This value is used for 
pulse chemisorption data reduction.

Blend carrier and 
loop gases

Select this option to have the carrier and loop gases blended. 
Then enter the percentage for the gases. Whichever field you 
make an entry in, the other field automatically defaults to a 
percentage totaling 100.

Cold Trap Valve
Analysis Valve
Loop Valve
Vapor Valve

Choose a status for each valve.

If you select Vapor for the status of the Vapor valve and the 
Vapor Generator is not attached to the instrument when the 
analysis is started, an error message  notifying you of the 
discrepancy is displayed.

The following two concerns do not arise when you insert the first Experiment in the 
Synopsis, but they must be considered when selecting gases for subsequent 
experiments and for subsequent Change Gas Flows steps.
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• Wait for stable baseline
• Start recording
• Experiment steps as needed

Outputs Displays the Outputs dialog allowing you to specify the state 
of the digital and relay outputs.

Ports are provided for connecting auxiliary inputs and 
outputs. For example, the digital outputs can be used to 
control a mass spectrometer.

Refer to Appendix E, page E-1 for a complete description of 
the auxiliary input/output function.

Peaks Allows you to control peak detection during analysis. After 
analysis, you can further control peak detection using the 
Peak Editor, described in Chapter 7.

The TCD detects and records all deviations from baseline, 
but only those which satisfy the criteria established in this 
dialog are reported as peaks.

The defaults for the parameters on this dialog are usually acceptable. A complete 
explanation of each parameter on this dialog is contained in Appendix H, page H-1.
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Loop Calibration

Loop Calibration enables you to calibrate the gas injection loop. This experiment verifies the 
exact volume of the loop for use in calculations on analyses in which the loop is used. Sample 
analysis data yield signal vs. temperature data and peak areas. Associating the sample 
information file with a loop calibration file makes it possible for the software to convert 
sample data to volume values.    

Recording Options

Include input signal [n] These options allow you to use external electrical input from 
an auxiliary port, or you can choose to report an instrument-
specific parameter from the drop-down list.

Refer to Appendix E, page E-1 for additional information on 
auxiliary input/outputs.

Zero the TCD signal 
when recording starts

Allows you to zero the TCD signal automatically the first 
time recording starts in an experiment.

Invert the TCD signal Inverts the TCD signal. For example, if you expect to obtain 
only negative peaks, this option can be used to record the 
peaks in the positive direction.

Appendix J provides a tutorial for performing a loop calibration.
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Description Enter an identifier for this experiment. It is important to use 
a descriptive identifier here, in order to easily identify this 
data when displayed in sample reports.

Calibration Gases Allow you to select the carrier and loop gases to be used in 
this calibration. The gases available are those specified in 
the Gas defaults accessed from the Options menu.

Flow Rate Specify the flow rate for the loop and carrier gases.

Typically, the default of 10 cm3/min is appropriate.

Loop thermal 
equilibration delay

Allows you to specify the duration of the equilibration delay. 
This delay allows extra time for the instrument to stabilize 
thermally after the baseline has fully stabilized.

Physical Syringe 
Volume

Enter the volume of gas to be injected from the syringe you 
are using. For example: enter 0.45 for a 0.5 cm3 loop, 0.95 
for a 1.0 cm3 loop, and 4.5 for a 5.0 cm3 loop.

Zero the TCD signal 
when recording starts

Select this option to zero the TCD signal automatically the 
first time recording starts in an experiment. 

Invert the TCD signal Inverts the TCD signal. For example, if you expect to obtain 
only negative peaks, this option can be used to record the 
peaks in the positive direction.

Zones
Outputs

These buttons function in the same manner as those 
described earlier in Experiment.

Gas Flows Enables you to specify the Preparation gas and its flow rate. 
This feature is useful if you will have a sample loaded while 
calibration is occurring.
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Gas Calibration

The Gas Calibration experiment enables you to calibrate the Thermal Conductivity Detector 
so that peak area data can be converted to volume data. During a Gas Calibration, a series of 
known gas mixtures flows through the analyzer and the resultant signal readings are recorded. 
The analyzer can then use these data to calculate the concentrations of unknown mixtures 
flowing past the detector during subsequent analyses.

Gas Flows
(continued)

When you start an analysis, the software checks to be sure 
that the gases you select are connected to the appropriate 
ports by comparing them to the Gas Selections dialog of the 
Unit menu. If there is a discrepancy between a selected gas 
and the gas indicated in the Gas Selections dialog, an error 
message is displayed when you attempt to begin the 
analysis.

Make sure the appropriate gases are attached to the appropriate ports, and that the 
Gas Selections dialog accurately shows which gas is connected to each port.

Enter a flow rate in the Rate field.

Range: 0 to 175 cm3/min.

Appendix J provides a tutorial for performing a gas calibration (page J-42.)

Description Enter an identifier for this experiment. It is important to use 
a descriptive identifier here, in order to easily identify this 
file when it is associated with sample files.
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Calibration Gases These drop-down lists allow you to select the Carrier (Gas 
1) and Loop (Gas 2) gases to be used in this calibration. The 
gases available are those specified in the Gas defaults list on 
the Options menu. Refer to Appendix C for gas 
combinations.

Flow Rate This field allows you to specify a flow rate for the 
calibration gases. Typically, the same flow rate is used for 
both the Carrier and Reference gas. If you wish to use 
different flows, select Different reference flow.

Range: 0 to 175 cm3/min

Different reference 
flow

This option allows you to use different flows for the 
calibration gases. When you select this option, the Rate field 
directly below is enabled so that you can enter a different 
flow. This flow is used for the reference gas; the carrier gas 
will use the flow specified in the Flow Rate field (explained 
previously).

The Carrier gas flows through the path that contains the 
sample tube, and through the reference path. The reference 
path flows directly from the inlet over the reference detector, 
making it possible for the detector to detect variations in the 
gas that traveled through the sample tube (Carrier) path.

Range: 0 to 175 cm3/min

Zero the TCD signal 
when recording starts

Select this option to zero the TCD signal automatically the 
first time recording starts in an experiment. 

Invert the TCD signal Select this option to invert the TCD signal. For example, if 
you expect to obtain only negative peaks, this option can be 
used to record the peaks in the positive direction.

Zones
Gas Flows
Outputs

These buttons function in the same manner as those 
described earlier in the Experiment section beginning on 
page 5-15.
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Vapor Calibration

A separate calibration of the Thermal Conductivity Detector TCD must be made when vapor 
is to be used during analysis. The Vapor Calibration experiment enables you to calibrate the 
TCD so that peak area data can be converted to volume data. During a Vapor Calibration, a 
series of known vapors at specified temperatures is flowed through the analyzer and the 
resultant signal readings are recorded. The analyzer can then use this data to calculate the 
unknown concentrations of vapors flowing past it during subsequent analyses.

Appendix J provides a tutorial for performing a vapor calibration, page J-45.

Description Enter an identifier for this experiment. It is important to use 
a descriptive identifier here, in order to easily identify this 
file when it is associated with sample files.

Carrier group box Choose the carrier gas you wish to use and enter the rate at 
which it is to flow.

Range: 0 to 175 cm3/min

Loop group box Choose the loop gas you wish to use and enter the rate at 
which it is to flow.

Range: 0 to 175 cm3/min
Jul 09                                                    5-25 



Open AutoChem II 2920
Reflux and Flask 
Temperatures

Enter a minimum (initial) and maximum (final) temperature 
for each zone.

Range: 20 to 150 °C

Number of steps Allows you to enter the number of temperature target 
adjustments you wish to have performed for the reflux and 
flask heat zones. Data will be collected for a period of time 
at each step. 

The temperature increment is derived using the following 
formula:

For example, say the minimum temperature is 60, the 
maximum is 120, and you have entered 5 steps.

The resulting target temperatures will be 60 (the minimum 
and first step), 75, 90, 105, and 120.

Zero the TCD signal 
when recording starts

Select this option to zero the TCD signal automatically the 
first time recording starts in an experiment. 

Invert the TCD signal Select this option to invert the TCD signal. For example, if 
you expect to obtain only negative peaks, this option can be 
used to record the peaks in the positive direction.

Zones
Outputs

These buttons function in the same manner as those  
described earlier in the Experiment section.

Temperature increment 
Tmax Tmin–

Number of steps 1–
----------------------------------------------------=

 120 60–
5 1–

--------------------- 15 degrees between each step=
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Insert Experiment Step

After you have set up the initial conditions for your basic Experiment, the Analysis Conditions 
dialog is again displayed showing the Experiment inserted. Clicking  now allows you to insert 
a step in the Experiment you just added to the Synopsis. You can insert steps in a wide variety 
of sequences. You can also use steps repetitively within the Experiment.

Unlike the basic Experiment, specialized experiments are pre-programmed so that you can 
insert them in your analysis as a single step. There are three specialized experiments for 
calibration: Loop Calibration, Gas Calibration, and Vapor Calibration. Each of them 
automatically performs a complex series of actions.

Change Gas Flows

Displays the Gas Flows dialog. This dialog is identical to the one that is opened when Gas 
Flows is selected from the Insert Experiment Step dialog. A complete description of this 
dialog is found on page 5-17.

Change Temperature Zones

Displays the Set Temperature Zones dialog. This dialog is identical to the one that is opened 
when Zones is selected from the Insert Experiment Step dialog. A complete description of this 
dialog is found on page 5-17.

You cannot change the steps included in a specialized experiment, but you can 
include specialized experiments in analyses that contain other experiments. For 
example, you can include a Loop Calibration experiment in an analysis that also 
contains a Pulse Chemisorption experiment.
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Change Valves

Displays the Valves dialog, allowing you to choose the state in which each of the rotary valves 
is to be placed.

If you select Vapor for the Vapor Valve and you do not have the Vapor Generator attached, an 
error message notifying you of the discrepancy is displayed.

DDE Command

The DDE (Dynamic Data Exchange) Command experiment step enables the 2920 application 
to communicate with another DDE-aware application, such as a mass spectrometer or blender 
program, running on the computer.

Service Enter the name of the service provided by the DDE-aware 
application (refer to the DDE server application’s user 
manual).

Topic A service will contain one or more topics as described in the 
application’s user manual. Enter the desired topic.

Transaction Type Enables you to choose a type of transaction.
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Execute a remote 
command

Select this option to execute the command you enter in the 
Data field. 

Poke data into 
another application

Select this option to send the text string you enter in the Data 
field to the specified application.

Retrieve and log 
a data item

Select this option to add the response to the transaction you 
specify in the Item field to the analysis log.

Item If you selected Retrieve and log a data item or Poke data 
into another application, enter the name of the transaction 
(refer to the DDE server application’s user manual).

Data If you selected Execute a remote command or Poke data 
into another application, enter the command or data as a 
text string.
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Dose

When the analysis is performed, pay close attention to the instructions given in 
prompts that appear on the screen. Perform the prompted steps in the order given.

Dosing Choices Mark a radio button to select the appropriate dosing method 
for this experiment step. 

Inject Loop Gas Automatically injects the contents of the loop into the path 
that leads to the sample. The contents of the loop are pushed 
out of the loop by the Carrier Gas.

Manual Injection Prompts you to inject a dose of gas into the septum using a 
syringe.

Get Physisorption 
Point

Prompts you through the steps necessary to collect data for a 
physisorption point. These steps include placing a dewar of 
liquid nitrogen around the sample tube, waiting for a return 
to baseline, then replacing the dewar with water at room 
temperature. You can take repeated points by placing the 
Dose step within a Repeat Loop (discussed later in this 
chapter).

After Injection Allows you to specify the conditions for completion of this 
step.
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Baseline Click to specify Baseline settings if you have selected a Wait 
step that depends upon the Baseline.

Establish the Slope or Acceleration threshold and 
Duration for determining what constitutes a Stable 
Baseline, a Change From Baseline, and a Return To 
Baseline. These values control whether a particular change 
in the signal is significant to the current experiment; in other 
words, they define a stable baseline.

Some Wait steps are contingent upon the values you select 
here. For example, if your experiment contains a Wait until 
Baseline is stable step, the signal is compared to these 
values to determine if a stable baseline has been established. 
Lower slope/acceleration values and longer durations create 
a more rigorous definition of these factors than higher values 
and shorter durations. Normally the default values are 
satisfactory.

The range for each field on this dialog is displayed in the 
information bar at the bottom of the dialog when the field is 
selected.

Displays the 
range for the 
selected field.
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Recording

Allows you to specify how frequently the signal reading is recorded.

Range: 0.1 to 10.0 seconds

Recommended values are 1.0 for TPR, TPD, and TPO experiments, and 0.2 for pulse 
chemisorption.

The Start Recording dialog starts the recording of the signal for this analysis. A Stop 
Recording step is inserted in the list of steps automatically on the Analysis Conditions dialog 
when you insert a Start Recording step. 

If a Start Recording step is immediately followed by a step that prompts an 
immediate peak, peak data are recorded before any baseline readings can be 
collected. To collect some baseline data before the first peak in such an experiment, 
insert a Wait for ____ minutes step after the Start Recording step, but before the step 
which causes the peak.
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Repeat

When you insert a Repeat step in your analysis conditions, the Start Repeat Sequence dialog 
opens allowing you to specify the duration of the repeat sequence. After you complete the 
Start Repeat Sequence dialog and click OK, a Start Repeat step and a Stop Repeat step are 
automatically inserted in the list of steps for this analysis. You may insert multiple experiment 
steps within the Repeat loop.

Repeat until peaks are 
equal or ____ times. 

Stops repeating the steps within the loop when the last four 
peaks of this experiment have equal volumes or when the 
maximum number of repeats is reached. 

(Equal means the last four peaks are within 15% of their 
average, and the average of the last four peaks is larger than 
the first peak or the average of the last four peaks is larger 
than 

where N is the number of peaks.)

This option is useful when performing H2 or CO pulse 
chemisorption on supported metal catalysts.

Repeat until peaks are 
zero or ____ times.

Stops repeating the steps within the loop when the last four 
peaks of this experiment have zero volume or when the 
maximum number of repeats is reached. (Zero volume is 
defined in the software as four peaks with volumes within 
10% of each other and all volumes less than 50% of the first 
peak.) 

This option is useful when performing an N2O 
decomposition for characterizing copper catalysts.

N 5+
N

-------------
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Set Outputs

When this step is selected, the Outputs dialog opens. Select each signal you wish to enable. A 
complete discussion of the auxiliary input/output options is contained in Appendix E, page 
E-1.

Temperature Ramp

Insert this step to change the sample temperature.

Repeat _____ times. Stops repeating the steps within the loop when the specified 
number of times is reached.

Range: 1 to 200 times

Repeat until peaks match the 
first peak or  _____times. 

Stops repeating the steps within the loop when the peaks 
match the first peak or when the maximum number of 
repeats is reached.

Range: 1 to 200 times

Furnace Ramp Ramps the furnace temperature directly to the End 
temperature, ignoring the sample temperature.
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Sample Ramp Ramps the sample temperature to the End temperature. The 
actual furnace temperature is adjusted to meet this target.

Sample Ramp with 
Equilibration

Ramps the sample temperature to the End temperature and 
waits for it to equilibrate before proceeding.

Return to Ambient Allows the furnace temperature only (not the sample 
temperature) to return rapidly to a temperature between 14 
and 50 °C.

End Temperature Enter the ending temperature for this ramping procedure.

Range: -120 to 1100 ºC with optional CryoCooler
Ambient to 1100 °C without

An ending temperature below 20 °C enables the CryoCooler 
(if installed) automatically.

This field is disabled when Return to Ambient is selected.

Ramp Rate Enter the ramp rate for this ramping procedure. 

Range: 0.1 to 90.0  ºC/min

This field is disabled when Return to Ambient is selected.

Hold Time Enter the amount of time to hold the temperature at the 
conclusion of this step. If Equilibrate is selected, the hold 
time is not started until the temperature is equilibrated. 

Range: 0.00 to 720.00 min

This field is disabled when Return to Ambient is selected.

If you are ramping from subambient temperatures and the CryoCooler is installed, 
the target temperature should be held for a minimum of 15 minutes. This ensures 
that the entire furnace has reached thermal equilibrium before the ramp begins. 
Otherwise it may take several minutes for the temperature ramp rate to stabilize.
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Wait

Allows you to specify a waiting routine.

Enable KwikCool Select this to use the KwikCool to reduce the furnace 
temperature more rapidly during cool-down. If this option is 
checked and the KwikCool is not attached to the analyzer 
when the analysis is started, an error message is displayed.

If the CryoCooler (rather than the KwikCool) is attached, the 
cool-down operation is performed by the CryoCooler.

Wait ____ minutes. Specify an exact number of minutes to wait. 

Range: 0.01 to 720.00 minutes

Wait for operator Enter a description of the operator’s task, such as “Fill the 
dewar, then click OK.”

During an analysis, the message you enter is displayed on 
the monitor at the appropriate time and the attention LED on 
the upper front panel will flash or blink. The analysis 
continues after the operator clicks OK. Be sure to specify 
whether the operator should first perform the task or first 
click OK.

Wait until Baseline 
is stable.

Waits until the baseline becomes stable. If you choose this 
option, click Baseline to specify the settings.
5-36                                                    Jul 09



AutoChem II 2920 Open
Wait for change from 
Baseline or ____ minutes.

Enter the number of minutes to wait, then click Baseline to 
specify the settings.

Range: 0.01 to 720.00 minutes

Wait for return to Baseline. Waits for a return to Baseline. If you choose this option, 
click Baseline to specify the settings.

Wait for digital input number 
______  or ____ minutes.

Enter the number of the digital input source being awaited, 
then specify the maximum number of minutes to wait for 
input. If the digital input is not received before the time 
elapses, the analysis will continue, and a warning message is 
displayed. Digital inputs are electrical connections to the 
right side of the instrument. See Appendix E, page E-1 for 
additional information. 

Range: Digital input 1 to 4
0.01 to 720.00 minutes

Baseline Click to specify Baseline settings if you have selected a Wait 
step that depends upon the Baseline. 

This dialog is described on page 5-31.

Wait for synchronization 
message.

Select this option to direct the 2920 software to act as a DDE 
server. When the 2920 program receives a message from 
another DDE application (the client), this Wait will be 
completed and logged into the sample log.

The DDE client must use the following parameters in an 
Execute a Remote Command in order to provide the 
synchronization message.

Service WIN2920
Topic Command
Item Sync
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Termination

This step is automatically inserted in every experiment. The contents of this step are the post-
analysis conditions specified using Sample defaults on the Options menu. You can view and/or 
edit the details of this dialog by clicking on the Termination step when it is selected 
(highlighted); the Termination dialog is displayed.

Zones Displays the Set Temperature Zones dialog allowing you to 
view or edit current temperature zones. Refer to page 5-17 
for information on this dialog. 

Gas Flows Displays the Gas Flows dialog allowing you to view or edit 
current gasses and their flows. Refer to page 5-17 for 
information on this dialog. 

Return sample to ambient 
temperature

Select this option to have the sample cooled to ambient 
temperature.

Enable KwikCool Select this option to enable the KwikCool during the cool-
down operation. If the CryoCooler rather than the KwikCool 
is attached, the cool-down operation is performed by the 
CryoCooler.

Leave the detector 
enabled after analysis

Several hours may be required for the instrument to reach 
thermal stability after the detector is enabled. This option 
keeps the detector enabled after analysis, allowing the 
instrument to remain stable.

It is not necessary to have gas flowing through the detector, 
but it is good practice to use an inert gas to continuously 
purge the system.

Outputs Displays the Outputs dialog allowing you to view or edit the 
digital and relay outputs. Refer to page 5-20 for additional 
information on this dialog. 
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Report Options

This dialog is used to edit existing report options, or to specify report options for a new file. 

When creating parameter files to display in the drop-down list on the Basic sample 
information dialog, be sure to save them to the directory specified as the Parameter 
File directory (see Chapter 8).

Report options If you are editing an existing file, this field displays the 
description or identification of the report options file. This 
description can be edited if desired.

If this is a new file, this field contains the description 
specified in Sample defaults. You can enter a new 
description or add to the existing one if desired. Use a 
description that will help you identify this set of report 
options in the future.

Range: 40 alphanumeric characters

Replace Allows you to copy values from an existing file to the one 
you are creating. A dialog is displayed so that you may 
choose the file containing the values you wish to copy. Since 
the values are copied into the new file, you can edit them 
without changing values in the original file.
Jul 09                                                    5-39 



Open AutoChem II 2920
Show report title This option allows you to have a heading appear on your 
report and to enter a title for it.

If this is a new file, the title you specified as the default is 
displayed. Accept the default title or enter a different one.

Show graphic Select this option to have a graphic (bitmap or enhanced 
metafile) display above the report title. For example, you 
may wish to display your company logo. Click Browse to 
select the desired bitmap, then enter the Height and Width in 
the fields provided. This image can also be edited from the 
report window.

Selected Reports Contains a list of available reports. A report is selected when 
it is preceded with a check mark. Select reports by double-
clicking the desired report(s). Alternatively, you can 
highlight the desired report and press Spacebar. Reports are 
deselected in the same manner. Certain reports can be edited 
by highlighting the desired report and clicking Edit. 

Edit Allows you to edit the highlighted report. Clicking Edit 
opens the appropriate dialog box. The dialog(s) associated 
with each type of report are described in the following 
sections.

The Summary Report and the Analysis Log cannot be 
edited.
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Tabular Report Option

Clicking Edit when Tabular Report is selected opens the following dialog:

Selected Experiments All related experiments in the current file are displayed. 
When the report options file is used in a sample information 
file, any experiment you do not wish to include in the report 
may be deselected.

If this is a new file, no experiments are listed. Experiments 
are not included in the list until data are collected.

Report data points at 
specified interval

Select this option to report data points at a specified interval, 
then specify the frequency of reported data (the number of 
seconds between reported data readings).

This feature is useful if you anticipate a large amount of data 
to be collected during the analysis (such as in a lengthy 
analysis with readings taken every second). If you do not 
specify an interval for data reporting, all points are reported, 
regardless of the length of the report.
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BET Surface Area Report Option

Clicking Edit when BET Surface Area is selected opens the following dialog:

Selected Experiments All related experiments in the current file are displayed. 
When the report options file is used in a sample information 
file, any experiment you do not wish to include in the report 
may be deselected.

If this is a new file, no experiments are listed. Experiments 
are not included in the list until BET data are collected.

Report Type From this group box, choose the type of report(s) desired. If 
you choose Multipoint or Multipoint plus one single point, 
the choices on the right side of the group box are enabled. 
You can choose as many of these options as desired.

Adsorbate 
cross-sectional area

Enter the appropriate value. The adsorbate cross-section is 
the area occupied by a single adsorbed molecule on the 
adsorbent surface.
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Langmuir Surface Area Report Option

Clicking Edit when Langmuir Surface Area is selected opens the following dialog:

Selected Experiments All related experiments in the current file are displayed. 
When the report options file is used in a sample information 
file, any experiment you do not wish to include in the report 
may be deselected.

If this is a new file, no experiments are listed. Experiments 
are not included in the list until data are collected.

Report Type From this group box, choose the type(s) of reports you wish 
to generate. 

Adsorbate 
cross-sectional area 

Enter the appropriate value. The adsorbate cross-section is 
the area occupied by a single adsorbed molecule on the 
adsorbent surface.
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Total Pore Volume

Clicking Edit when Total Pore Volume is selected opens the following dialog:

Selected Experiments All related experiments in the current file are displayed. 
When the report options file is used in a sample information 
file, any experiment you do not wish to include in the report 
may be deselected. 

If this is a new file, no experiments are listed. Experiments 
are not included in the list until data are collected.

Adsorbate density 
conversion factor 

Enter the appropriate value for converting the gas volume to 
liquid volume. This value can be obtained by dividing the 
gas density by the liquid density at the adsorption 
temperature.

Density conversion factor = 
ρgas
ρl

----------
TBATH
TSTP

----------------×
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Pulse Chemisorption Report Option

Clicking Edit when Pulse Chemisorption is selected opens the following dialog:

Selected Experiments All related experiments in the current file are displayed. 
When the report options file is used in a sample information 
file, any experiment you do not wish to include in the report 
may be deselected. 

If this is a new file, no experiments are listed. Experiments 
are not included in the list until related data are collected.

Area to Volume Conversion Select Calculated (default) to use the standard calculation:

If you select this method, enter the number of peaks to be 
used for saturation.

This method uses the raw signal; a calibration file is not 
required.

Select Calibrated if greater flexibility is desired. This 
method enables you to use selected peaks for the conversion. 
To use this method, a calibration step must be included in the 
experiment in the sample information file.

Volume volume injected active concentration×
area of last peak

---------------------------------------------------------------------------------------------=
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First Order Kinetics Report Option

Clicking Edit when First Order Kinetics (heat of adsorption) is selected opens the following 
dialog:

Selected Experiments All related experiments in the current file are displayed. 
When the report options file is used in a sample information 
file, any experiment you do not wish to include in the report 
may be deselected. However, you must include at least three 
experiments for the first order of kinetics to be calculated. 

If this is a new file, no experiments are listed. Experiments 
are not included in the list until related data are collected.

Tabular Report Select this option to have a tabular (data in a table form) 
report generated.

Plot Select this option to have the data plotted in a graphical 
format
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Loop Calibration Report Option

Clicking Edit when Loop Calibration is selected opens the following dialog:

Analysis Log Report

When Analysis Log is selected, a log of analysis operations is included in the reports. The 
Analysis Log cannot be edited.

Selected Experiments All loop calibration experiments in the current file are 
displayed. When the report options file is used in a sample 
information file, any experiment you do not wish to include 
in the report may be deselected. 

If this is a new file, no experiments are listed. Experiments 
are not included in the list until related data are collected.
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Graph Report Options

The AutoChem II 2920 program contains 10 user-defined graphs, each definable with regard 
to the x-axis, y-axis and y-overlay. The graphs are named as follows:

<Y-axis choice> and <Y-axis Overlay Choice> vs. X-axis choice>. For example: TCD Signal 
and TCD Concentration vs. Time,

Ten default files, which may be edited, are included in the program. They are:

All graph report options are similar and are edited in the same manner. Click Edit on a selected 
graph report; a dialog similar to the following is displayed.

Any signal (the detector signal or the 1 or 2 auxiliary signal) may be plotted against time or 
temperature. Any signal can be overlaid onto the primary signal. 

TCD Signal vs. Time
TCD Temperature vs. Time
TCD Signal vs. Temperature
TCD Concentration vs. Time
TCD Concentration vs. Temperature
Input Signal 1 vs. Time
Input Signal 1 vs. Temperature
Input Signal 2 vs. Time
Input Signal 2 vs. Temperature
TCD Signal and TCD Concentration vs. Time
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For color output to a monitor or printer, signals are displayed in different colors. For black and 
white output, different symbols are used.

Selected Experiments All experiments are selected by default. When the report 
options file is used in a sample information file, each 
experiment in the sample file is listed. Any experiment you 
do not wish to include in the report may be deselected.

If this is a new file, no experiments are listed. Experiments 
are not included in the list until related data are collected.

Show peak marks Select this option to:

• display the areas and baselines on the graph
• draw a straight baseline between the selected peaks
• enable the Peaks push button, allowing you to specify 

the peaks to include in the experiment

This option is disabled for new files.

Do not plot more 
than ____  points

Allows you to specify a maximum number of points to plot. 
Typically, the default of 1000 is sufficient. You can specify 
up to 8000 if higher resolution and more detail is desired. 
The speed at which graphs are plotted on some computers 
may be affected when large numbers of points are requested.

Options Opens a dialog that contains a list of all the peaks for the 
results of the experiment highlighted in the Experiments list 
box. All peaks are selected by default; remove the check 
mark next to any peak you do not wish to include on the 
graph.

The Label radio buttons enable you to choose the peak label 
that will be displayed on graphs.
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X-Axis
Variable Specify Time or Temperature for the X-axis variable.

Autoscale Select this option to have the X-Axis scaled automatically. 
As the default, this axis begins at zero, and the system uses 
the highest value collected during analysis as the ending 
point. The Axis From and To fields are disabled if you 
choose to autoscale data.

If you choose not to autoscale data, you must enter  from and 
to values. The value entered in the To field must be greater 
than the value entered in the From field.

Y-Axis 
Variable Select a Y-axis variable from the drop-down list. 

Overlay You can use this feature to overlay another variable with the 
current one. Select a variable from the drop-down list if 
desired.

Autoscale Select this option to have the Y-Axis scaled automatically. 
This axis begins at zero by default; the system uses the 
highest value collected during analysis as the ending point. 
The Axis From and To fields are disabled if you choose to 
autoscale data.

If you choose not to autoscale data, you must enter from and 
to values. The value entered in the To field may be less than 
the value entered in the From field if you plan to invert 
negative-going peaks.
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Collected Data

The tab for Collected Data does not appear on the Advanced dialog presentation until after 
analysis.

Po of adsorbate Displays the saturation pressure of the adsorbate.

Ambient temperature Displays the room temperature.

Ambient pressure Displays the room pressure.

Experiment Defaults to the first experiment of the current file. Click the 
down arrow to choose other experiments in the file.

Physical injection volume Displays the volume of the syringe used to perform the 
manual injections.

Active Concentration Displays the percent of the gas mixture that is composed of 
the reactive gas versus an inert filler.

Peak table Displays the peak summaries for the experiment shown in 
the Experiment field.
5-52                                                    Jul 09



AutoChem II 2920 Open
Use Fitted points Select this option to report peak data obtained using the Fit 
peak option in the Peak Editor (refer to Peak Editor on page 
7-14).

Active Metals Enabled for Pulse Chemisorption reports; displays the 
Active Metals Table dialog, allowing you to specify the 
percent of sample weight of the active metals in the sample 
(in the far right column), and the stoichiometry factor.

The contents of this table are copied from the default table on the Options menu. 
After this sample file is created, however, the contents of this table become specific 
to the file. Changes made in this table do not affect the default table and changes 
made to the default table do not affect this table.

Insert Inserts a new row into the table; the row is inserted above 
the selected one.

Delete Deletes the selected row.

Clear Clears the table of all entries except one; one is required
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Save

Save enables you to save any changes made to the file in the active window. The file is saved 
under its current name.

Save As

Save As enables you to save the sample file or parameter file in the active window under a 
new name. Saving the file under a new name allows you to make modifications without 
changing the original file. 

You can save a sample information file as another sample information file or as any parameter 
file. Parameter files, however, can be saved only as another parameter file of the same type. 
For example, you can save the analysis conditions portion of a Sample Information file as an 
analysis conditions file or the report options portion as a report options file. But an analysis 
conditions file can be saved only as another analysis conditions file.

Saving Parameter Files for Subsequent Use

Save As is a useful tool for making analysis conditions and report options files that were 
created as part of an Advanced format sample information file available to be copied to other 
Sample Information files. When the Analysis Conditions window is open, select Save As, 
Analysis Conditions (or Report Options, if applicable) from the File menu. Be sure to save 
the file to the directory specified as the Parameter Files directory (see Parameter Files 
Directory on page 8-17) or it will not display in the drop-down list on the Basic Sample 
Information file editor. The default directory is PARAMS. 

After you use the Save As function, the original file is still open, not the new file. To 
edit the new file, close the original file first, then open the new file.
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When you select Save As with a sample information file open, three choices are presented: 
Sample Information, Analysis Conditions, and Report Options. Select the desired file type; a 
dialog box similar to the one shown below is displayed.

Save All

Save All enables you to save all open files under their current names. This option provides a 
faster way to save all open files at one time and avoids having to perform a Save operation on 
each individual file. 

File name Enter a name of up to 8 characters or select a file from the 
Files list box. If you select an existing file as the new name, 
the data contained in that file are overwritten.

Status
Files
Directories

These options are explained in Selecting Files beginning on 
page 3-6.
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Close

Close enables you to close the file in the active window. The following message is displayed if 
changes have been made to the file:

(path\file name) has been changed. Save changes before closing?

Yes                                  No                              Cancel

Click Yes to save the changes and close the dialog box
Click No to discard the changes and close the dialog box
Click Cancel to allow the file to remain active

Close All

Close All enables you to close all open files under their current names. The following message 
is displayed for each file in which changes have been made:

(path\file name) has been changed. Save changes before closing?

Yes                                  No                              Cancel

Click Yes to save the changes and close the dialog box
Click No to discard the changes and close the dialog box
Click Cancel to allow the file to remain active
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Print

Print enables you to print details of a file, or multiple files. 

When you select Print, three choices are presented: Sample information, Analysis 
conditions, and Report options. Regardless of which file type you select, a dialog similar to 
the one shown below is displayed.

File name The name of the file you select from the Files: list window is 
copied to this field. If choosing multiple files, the last name 
chosen is displayed.

Status
Dates
Files
Directories

These options are explained in Selecting Files beginning on 
page 3-6.

Settings group box The Destination field contains a list of the available print 
destinations.

If you select Printer, the Copies field is enabled allowing 
you to enter up to four copies.

If you select File, the tabular reports of the requested file are 
converted to a text file which can be viewed with a text 
editor or other text file manipulation tools. The File name 
field is also enabled allowing you to enter a name (or you 
can accept the default).

Displays the type of file 
requested; in this example, 
a Sample Information File.
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List

List enables you to generate a listing of the following information on a selected file, or on 
multiple files:

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status

When you select List from the File menu, three choices are presented: Sample information, 
Analysis conditions, and Report options. 

Regardless of which file type you select, a dialog similar to the one shown below is displayed.

File name If you select only one file from the Files: list box, the name 
is copied to this field. If multiple files are selected, the last 
one selected displays.

Displays the type of file 
requested; in this example, 
a Sample Information File.

You may request a list of multiple files by holding down Ctrl while selecting files. If 
no files are selected, a list is generated for all files.

Status
Dates
Files
Directories

These options are explained in Selecting Files beginning on 
page 3-6.
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Import MS Signal

Import MS Signal allows you to import data collected by a ThermoStar or MicroStar Mass 
Spectrometer.  

Select Import MS Signal from the File menu; the Open Mass Spectrometer Data File dialog is 
displayed.

Settings group box The Destination field contains a drop-down list of the 
available print destinations.

Choices: Screen, Printer, File

If you select Printer, the Copies field is enabled allowing 
you to enter up to four copies.

If you select File, the File name field is enabled allowing 
you to enter a name (or you can accept the default).

In order to have the analog signals import properly, they must be configured in a 
certain manner in the mass spectrometer software. Refer to the next page for 
information on configuring the signals.

File name Displays the wildcard (*) with the extension of the selected 
file type. The file type extensions are:

• MDC (Quadstar)
• ASC (Quadera) 
• XLS (TAMS)
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After you select the desired file and click OK, the Import Mass Spectrometer Signal dialog is 
displayed.

File type Displays a drop-down list of file types.The files types are 
those produced from the Mass Spectrometer software used 
with the 2920. 

The choices are Quadstar, Quadera, or TAMS. 

Date Range Use this push button to limit the files displayed in the Files 
list to a specified date range. Refer to page 3-7 for an 
explanation of this dialog.

Files list Displays the files available in the current directory.

Mass Spectrometer File Displays the mass spectrometer file you selected from the 
previous dialog to import into the AutoChem program.

AutoChem Sample Displays the AutoChem sample file into which the mass 
spectrometer file will be imported.

If you have a sample file open, its name is displayed in this 
field and the data will be imported into this file when you 
click OK.

If you do not have a sample file open, the next sequenced 
file number is displayed in this field. When you click OK, 
the data will automatically import and assume the next 
sequenced number; you will not be asked if you wish to 
create the file.

Browse This push button is provided for each type of file so that you 
can choose different files from the ones displayed.
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Configuring the Analog Signals

Analog signals must be configured only when using Quadstar software. If you are using 
Quadera and TAMS software, this procedure is not required.

The import utility reads both the mass spectrometer data and any analog signals that are 
collected by the mass spectrometer. The analog signals must be configured for them to be 
imported properly. This is accomplished through the Parset program.

1. Launch the Parset program using Windows Explorer: double-click on Parset.exe.

2. Refer to the Instrument Configuration section of the ThermoStar operator’s manual and 
configure the characteristic curves as follows:

A1 = T
A0 = TCD
Jul 09                                                    5-61 



Export AutoChem II 2920
Export

Export allows you to copy data in a sample information file and reformat it in ASCII format 
or Grams/32 format. ASCII data can be imported into other applications, such as spreadsheets. 
Grams/32 data can be imported into the Grams/32 program (the peak editing program used in 
previous versions of the software) and then manipulated without use of the AutoChem II 
analysis program. You may select multiple files by holding down  and clicking the left mouse 
button once on each file. See Appendix D for a description of exported data.

Select Export from the File menu; the Export Sample File dialog is displayed.

File name The name of the file you select from the Files: list box is 
copied to this field.

Status
Dates
Files
Directories

These options are explained in Selecting Files beginning on 
page 3-6.

Export Type You can export the data from a 2920 sample information file 
in an ASCII or Grams/32 format.

Choose ASCII to create a data file that can be imported into 
an application such as a spreadsheet program.

Choose Grams/32 to create a data file that can be imported 
into the Grams/32 program.
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When you click OK, the Collected Data Export Options dialog is displayed.

 

Destination Contains a drop-down list of the available destinations.

Choices: Screen, Printer, File

A sample information file exported as a Grams/32 type can only be generated to a 
File destination. When you export a Grams/32 type, five separate files (which can be 
read only by the Grams/32 software) are generated. Refer to Appendix D for 
information on the contents of these files.

If you select Printer, the Copies field is enabled allowing 
you to enter up to four copies.

If you select File, enter a name in the File name field of the 
Settings group box (or accept the default).

Selected Experiments All related experiments in the current file are displayed. 
When the report options file is used in a sample information 
file, any experiment you do not wish to include in the report 
may be deselected.

This portion of the dialog is the only field displayed if you 
are exporting a file as a Grams/32 type.

Peak summaries Exports a summary of the peaks contained in the selected 
experiment(s).

Only the Selected 
Experiments portion of this 
dialog displays if you 
choose Grams/32 as the 
type of Export.
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Measurements Selecting this option enables the options in the 
Measurement Reporting Options and TCD Signal 
Options group boxes.

Measurement Reporting 
Options

Provides options for reporting measurements.

Report measurements 
at a specified interval

Select this option to report measurements at a specified 
interval; a field is enabled so that you may enter an interval 
(the number of seconds between reported data readings). 
You may wish to use this feature if a large amount of data 
was collected during the analysis (such as in a lengthy 
analysis with readings taken every second). If you do not 
specify an interval for data reporting, points are reported as 
follows:

• Up to 500 lines per experiment if destination is to the 
screen or to a printer.

• Up to 10,000 total lines if destination is to a file.

Select a time interval 
to report

Select this option to specify relative starting and ending 
times of the measurements you wish to export. This feature 
allows you to specify a region of interest to be extracted 
from a large data set.

TCD Signal Options Provides options for reporting the TCD signal.

Report the calibrated 
data

Exports the calibrated values for the TCD signal if 
calibration data are available.

Normalize by weight Divides the TCD signal by the sample weight to correct the 
signal strength for different sample sizes.
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Exit

Exit enables you to exit the AutoChem II analysis program. Select Exit from the File menu. 

• If a window containing unsaved changes is open when you select Exit, the following 
message is displayed:

(path\file name) has been changed. Save changes before closing?

Yes                                  No                              Cancel

Click Yes to save the changes and close the dialog box
Click No to discard the changes and close the dialog box
Click Cancel to allow the file to remain active

• If an analysis is in progress, the following message is displayed:

2459- An instrument is busy. A delay in restarting this application could 
result in loss of data. Continue with program Exit?

                        Yes                           No

Click Yes to exit the analysis program. The analysis continues, but the data are 
not recorded permanently on the computer’s disk drive until you restart the 
AutoChem II 2920 application. If a loss of power occurs to the AutoChem 
analyzer before you restart the application, the data will be lost.

Click No to allow the analysis program to remain active and the analysis to 
finish.

• If a report is in progress or a report window is open, the following message is displayed:

A report is currently printing. Exiting this application now will cancel the 
report. Continue with the termination?

                        Yes                           No

Click Yes to cancel the report(s) and exit the analysis program.
Click No to allow the analysis program to remain active.
Jul 09                                                    5-65 



Exit AutoChem II 2920
5-66                                                    Jul 09



AutoChem II 2920 Description
6.  UNIT MENU

The Unit menu contains options that enable you to perform analyses.

Description

Listed below are brief descriptions of the Unit menu options. Detailed descriptions follow this 
section.

Start Analysis Opens a series of dialog boxes that enable you to start an 
analysis. Page 6-3.

Reset After confirmation, resets the system to a safe state. 
Page 6-11.

Enable Manual Control Enables you to control various instrument components 
manually, using the instrument schematic (disabled during an 
analysis that is not suspended). Page 6-12.

Show Instrument 
Schematic

Displays the instrument schematic. Page 6-16.

Show Status Displays only the Status Bar of the operational window. 
Page 6-18.
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Unit Configuration Displays the hardware configuration, as established when the 
instrument was installed, including software version, 
communications ports, and installed options. Page 6-19.

Also allows you to enter the loop (if present) volume.

Gas Selections Allows you to specify which gases are connected to the 
analyzer ports. Page 6-20.

Gas Flow Constant 
Calibration

Displays a dialog enabling you to obtain the conversion 
constant of a gas. The conversion constant is used by the 
Mass Flow Controllers to ensure accurate flow control. Page 
6-21.

TCD Calibration Displays a series of dialogs allowing you to create, edit, and 
manage calibration files. Calibration files enable the software 
to convert sample signal, temperature, and peak area data to 
volume data. Page 6-22. 

Instrument Calibration Displays a dialog for calibrating various instrument 
components. This dialog is used to calibrate the sample 
thermocouple. Page 6-28.

Vapor Generator 
Calibration

Displays a dialog for calibrating various components of the 
optional Vapor Generator. This option is disabled if the Vapor 
Generator is not attached to the instrument. Page 6-30.
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Start Analysis

When you select Start Analysis, the Analysis dialog is displayed with a file selection dialog 
positioned on top. You can either select a sample file that was created and saved earlier, or you 
can create a new sample file now.

Which option you choose depends on the method you prefer for your laboratory. The analysis 
process is the same either way. For example, your lab may prefer to create numerous sample 
files in advance, then analyze the samples when they become available. Alternatively, your lab 
may prefer to create sample files for each sample as you begin the analysis.

After you choose a sample file and click OK, the Analysis dialog becomes totally visible. 

The appearance of the Analysis dialog depends on whether you are using the Advanced or 
Basic mode. The same fields appear on both dialogs; however, the Advanced dialog contains 
additional push buttons that allow you to insert and edit individual steps.

If there are any inconsistencies between the sample information file you choose and 
the way the instrument is configured, a message is displayed instructing you to cor-
rect them. For example, if the sample information file specifies helium for the 
Preparation gas, but the Gas Selections dialog indicates that helium is not connected 
to a Preparation gas port, the software informs you of the discrepancy.

The software is unable to determine if the wrong gas is physically connected to the 
port. It can only check that the gas you wish to use agrees with the gas you have 
identified for each port in the Gas Selections dialog. It is important to be sure that the 
Gas Selections dialog accurately reflects which gas is physically connected to each 
port.
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View Allows you to choose from four views to display in the 
current window.

Operate Displays the dialogs associated with the current operation.

Instrument 
schematic

Displays the instrument schematic. Refer to Show 
instrument schematic on page 6-16 for a description of the 
components contained on the schematic.

Results Displays analysis results as they are collected.

Sample log Displays a log of each step as it is completed, as well as any 
error messages or manual operations that occur during the 
analysis.

Sample Displays the description for the current file. 

Mass Enables you to enter an accurate weight of the sample to be 
analyzed.

Browse Allows you to choose a different sample file for the current 
analysis.

This group of push 
buttons does not 
display when using 
the Basic format.
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Replace all Allows you to replace the contents of the current file with 
those of another one. After the values have been copied into 
the current file, you may edit them in any way you wish. 
Editing the values will not affect the file from which they 
were copied.

Analysis Conditions Displays the current Analysis Conditions file. This drop-
down list contains predefined parameter files, some of which 
are supplied with the analysis program. For newly created 
files to display in this list, they must be saved to the directory 
specified as the parameter files directory (see Chapter 8). 
Click the down arrow to the right of the field to choose a 
different file.

The window directly below this list contains the conditions 
specified in the Analysis Conditions file. If you are using the 
Advanced format for the current analysis, you can edit the 
conditions using the push buttons provided below the 
Analysis Conditions window. Refer to page 5-11 for details 
on these push buttons.

You can also edit analysis conditions after the analysis has 
begun. Click Suspend to suspend the analysis; this enables 
the editing push buttons. You can edit only the steps or 
experiments following the current one. After editing is 
complete, resume the analysis.

Report Options Displays the current Report Options file. This drop-down list 
contains predefined parameter files, some of which are 
supplied with the analysis program. For newly created files to 
display in this list, they must be saved to the directory 
specified as the parameter files directory (refer to Parameter 
Files Directory on page 8-17 for additional information). 
Click the down arrow to the right of the field to choose a 
different file. 

The window directly below this list contains the reports 
requested for the current Report Options file. You can select 
additional reports or deselect currently selected ones if 
desired. A report is selected when it is preceded with a check 
mark. Simply double-click to select (or deselect) a report. 
Alternatively, you can highlight the report and press the 
Spacebar.
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Click Next to advance to the second view of the Analysis dialog. This view enables you to 
choose a TCD calibration for each experiment in this sample’s analysis conditions set. A TCD 
calibration allows the areas of the peaks recorded by the instrument to be converted into 
volumes. A TCD calibration is not required by all analysis types, nor is it necessary to select 
the calibration from this dialog. A calibration can be associated with an experiment during 
peak editing (after analysis has ended).

The default(s) for the calibration file(s) are those specified using the TCD Calibration Defaults 
option on the Unit menu (discussed later in this chapter). 

The files available in each drop-down list are those available for the instrument.

Click Next to advance to the next view of the Analysis dialog. This view enables you to 
generate reports automatically when the analysis is complete. The reports generated are those 
selected in the report options portion of the sample information file.
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Click Next; a dialog instructing you to verify the following is displayed:

• Verify that the gas bottles connected to the analyzer are correctly identified in the 
software.

• Verify in the sample file that the combinations or sequence of gases in the analyzer are 
not dangerous, and that the sample will not react with any of the gases in a dangerous 
way.

• Verify that the current method for venting the analyzer’s exhausts is adequate and safe 
for all products of the analysis.

Report After Analysis Choose this option to have the reports specified in the 
sample file generated automatically after the analysis is 
complete.

Number of Reports Enabled when Printer is selected as the report destination. 
You can print up to four copies.

Destination Allows you to choose a destination for the reports

Choices: File, Printer, Screen

If you choose Screen for the destination, many options are 
available for manipulating and customizing your reports.

File name Enabled when File is selected as the report destination, 
allowing you to enter a file name (or you can accept the 
default).
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After you have ascertained that all conditions are safe for the analysis, click Start to begin the 
analysis. The original view of the Analysis window is displayed, except that now it tracks the 
progress of the analysis.

Synopsis Shows the list of experiment steps in the sample information 
file. Upcoming steps are shown in blue or black. The current 
step is highlighted and shown in light blue; completed steps 
are shown in light green.

You may scroll through the list to review the analysis steps. 
You can also edit steps that have not been started; the analysis 
must be suspended to do this (see Suspend on the following 
page).

Step Detail Shows detailed information about the current step.

Stop Stops operation of the current step and automatically 
suspends the analysis. Click Resume to restart the analysis. 
The analysis resumes at the beginning of the next step. This 
button is used to skip the current step.

Manual Control is allowed while an analysis is suspended.

Cancel Cancels the analysis; the current step is not completed. After 
confirmation, the analysis ends and leaves the analyzer in the 
current state. The analysis cannot be resumed. To return the 
analyzer to a safe state automatically, select Reset from the 
Unit menu.
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Suspend Suspends the analysis. This button is a toggle button; it reads 
Resume when the analysis is suspended.

You may wish to suspend the analysis to edit steps in the list 
or add steps to the list. Steps can only be added or edited in 
the portion of the list that has not yet been executed; such 
editing is available only if you are using Advanced 
presentation format. The current step cannot be edited. Click 
Resume to continue the analysis after editing has been 
completed.

Manual Control is allowed while an analysis is suspended.

During analysis, analysis conditions can be edited only using this view of the Start 
Analysis dialogs. Analysis conditions cannot be edited in the sample file during 
analysis.

There is a very brief pause while the analyzer suspends or resumes the analysis. Do 
not reclick the button.

Messages If you have included an experiment step that requires a 
message to the user, the message is displayed on the monitor 
when the appropriate point in the analysis is reached. For 
example, if you have included a Dose step that takes a BET 
measurement, you are prompted to change the dewar at the 
appropriate time. The operator performs the required 
function, then clicks OK to resume analysis.
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Viewing the Results

To view data as they are collected, select Results from the View drop-down list. Up to four 
signals may be displayed on the graph: TCD, Sample Temperature, Input Signal 1 and Input 
Signal 2. The scales for the first two signals are shown on the right and left Y-axes, 
respectively. If more than two signals are selected, the additional signals are shown without 
scales.

Click Options to customize the presentation of data in the Results view. You can change the 
axes and select or deselect the data that are presented. If you specify a value for Starting at (X-
Axis), only those data collected after that point are shown. If the Starting at value is greater 
than the experiment duration, then all data are shown.
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Click Scaling to adjust the scale of a selected signal. The example shown below is the Scaling 
dialog associated with the Temperature signal.

In addition to allowing you to adjust the scale of the Concentration and Signal Results, the 
Scale TCD dialog lets you indicate (by checking the box) whether or not you wish to display 
the Concentration. (The concentration will be displayed if a Gas Concentration calibration has 
been associated with the experiment.)

Reset

Use this option to abort the current analysis and return the analyzer to a safe state. The 
following actions occur:

• All gas flows stop
• The detector is disabled
• The heat zones are reset to 0 °C
• The target furnace temperature is reset to 20 °C 

Do not select this option unless you are sure you want to stop the current analysis. The analysis 
cannot be resumed after Reset is selected.
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Enable Manual Control

Select Enable manual control to manually control components such as the valves, Mass Flow 
Controllers, heat zones, etc. If the instrument schematic is not displayed, select Show 
Instrument Schematic from the Unit menu.

You can select system components using the mouse or the tab key. A component is selected 
when it is surrounded by a ruled box. The information window on the right of the schematic 
indicates the name of the selected component in the upper pane and related statistics in the 
lower pane.

Most components on the instrument schematic can be manually controlled. These components 
each have a shortcut menu displaying the operations available for that component. This 
shortcut menu is accessed by right-clicking on the desired component, or by using the shortcut 
keys, Shift F9. 

Extreme caution should be used when Manual Control is enabled, so that a 
dangerous condition is not created. If you are not qualified to prevent dangerous 
conditions (such as volatile combinations of gases), DO NOT attempt to operate the 
analyzer using Manual Control.

Manual Control cannot be selected during an automatic operation unless the 
operation is suspended.

Indicates whether 
manual control is 
enabled or disabled.

Indicates the item 
selected and 
related statistics.
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Gas Valves (Inlet) Click a gas valve icon to display (in the yellow window on 
the right) the name of the gas connected to each of that 
valve’s four ports. The port’s state (Open or Closed) is also 
displayed.

From left to right, the valves control the Preparation gas, the 
Carrier gas, and the Loop gas.

Flow Gas [n] Select the gas to flow
Stop Flow Closes the open valve

Mass Flow Controllers The Mass Flow Controllers control the flow of gas into the 
analyzer. Clicking on a MFC icon displays its current flow 
rate and the target rate for the current experiment. The current 
flow rate is also shown next to the MFC symbol. If the flow 
has been turned off (all inlet valves are closed), the target rate 
shown is the last non-zero target.

From left to right on the display, the MFC’s control the 
Preparation gas, the Reference gas, the Carrier gas, and the 
Loop gas.

Set Flow Rate
Displays a dialog so that you can enter a flow rate. 

Range: 0 to 175 cm3/min.

Stop Flow
Stops the flow of gas through the selected Mass Flow 
controller.

Rotary Valves The Rotary Valves control the flow of gas through the cold 
trap, the sample tube, the loop, and the optional Vapor 
Generator. Each valve has two states. Clicking the valve icon 
displays its state. Right-clicking the valve icon enables you to 
change the state of the valve. Click on the desired state.

From left to right, the valves and their states are as follows:

Cold Trap   Bypass, Trap
Analysis Analyze, Prepare
Loop    Fill, Inject
Vapor (optional)    Vapor, Bypass

Closed Open

Current flow rate 
of MFC

Represents the 
MFC
Jul 09                                                 6-13 



Enable Manual Control AutoChem II 2920
Heat Zones Heat Zones control the temperature of various parts of the 
analyzer. Component heat zones are enclosed with a red 
rectangle. Click a Heat Zone icon to display its current flow 
temperature and the target temperature for the current 
experiment step.

Right-click, then choose Set Temperature, to change the 
heat zone’s target temperature. We recommend using one 
temperature (100 °C, for example) for all heat zones to ensure 
a cleaner system.

Range: 20 to 150 ºC for all zones
(except optional Vapor Generator)

From left to right on the display, the Heat Zones control the 
Cold Trap, the Analysis Valve, Detector, and Loop Valve 
(and if the Vapor Generator Option is installed,  from top to 
bottom; Vapor Valve, Vapor Reflux, and Vapor Flask 
temperatures).

Sample Furnace The Sample Furnace controls the temperature of the sample. 
Click its icon to display the Sample Temperature, the Target 
Temperature, the Furnace Temperature, and the Ramp Rate.

Right-click, then choose Set Temperature to change the Set 
Point and/or the Ramp Rate.

Set Point Range: -70 to 1100 ºC (with optional CryoCooler);
 ambient to 1100 °C (without CryoCooler)

Ramp RateRange: 0.1 to 90.0 ºC/min

Detector There are actually two areas of the detector icon that can be 
controlled. Click the filaments (right side) to specify their 
temperature. Click the other side of the rectangle to control 
the detector heat zone’s temperature. In either case, right-
click, then click on Set Temperature to change the 
temperature. The Filament Temperature must be set at least 
20 °C above that of the detector heat zone.

Detector Heat Zone Temperature Range: 20 to 150 ºC 

Filament Temperature Range: 20 to 250 ºC

Heat zones are enclosed 
with a red rectangle. This 
example shows the Vapor 
Reflux heat zone.

Block Filament
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The following components on the instrument schematic are for informational purposes only; 
they cannot be controlled using the manual control function.

Auxiliary I/O The Auxiliary I/O display provides a list of the current 
auxiliary settings for Digital and Relay Output (DO and RO) 
and for Digital Input (DI). The current Auxiliary 1 and 
Auxiliary 2 signals are also displayed, if they were recorded.

A complete discussion of the auxiliary inputs and outputs is 
contained in Appendix E, page E-1.

Calibration Valves Click a Calibration Valve icon to display its state (Open or 
Closed). There are three Calibration Valves, lettered, from 
left to right, B through D. These valves are used by the 
software during automatic calibration processes.

Generally, it is not necessary for the operator to change the 
state of the calibration valves.

KwikCool The KwikCool (if installed) icon appears on the schematic 
below the sample tube. The two states of the KwikCool valve 
are open or closed.

CryoCooler The CryoCooler (if installed) icon appears on the schematic 
below the sample tube. The two states of the CryoCooler 
valve are open or closed.

Auxiliary Port The Auxiliary Port enables you to connect an external 
detector, such as a mass spectrometer, to the analyzer. It is 
located on the left side panel as you face the unit. On the 
instrument schematic, it is located on the left of the Cold Trap 
Valve Heat zone.

Closed
Open

Cold Trap Valve 
Heat Zone

Auxiliary 
Port
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Show Instrument Schematic

Select this option to display the instrument schematic. The components of the instrument 
schematic are described in the previous section, Enable Manual Control. 

The instrument schematic is a visual representation of the internal components of the analyzer. 
Remember that the schematic does not show the components’ actual appearance or position. 
Instead, it provides a simplified graphic illustration.

In automatic mode, the schematic displays information about the instrument’s status, as well 
as providing updated information during an analysis. In Manual Mode, the schematic makes it 
easy to change the status of various instrument components. 

Pressure Transducer Displays the current pressure in the carrier gas path, upstream 
from the septum, but downstream from the Mass Flow 
Controller.

Septum The septum is used for making manual injections of gas into 
the gas stream. Refer to Using the Septum on page 4-26.

Indicates whether manual 
control is enabled or 
disabled.

Indicates the item 
selected and its related 
statistics.
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Gas Pathways

The colored lines that lead from the various gas inlets through the analyzer and to the exhaust 
represent the current flow path. Each gas source is represented by a different color:

The behavior of the Loop valve is one example. When an analysis includes a loop injection, 
the instrument schematic shows the path that is available in Fill mode, then in Inject mode. In 
Fill mode, the analysis gas is shown entering the loop, and excess gas is vented out the 
exhaust. In Inject mode, the analysis gas is shown bypassing the loop and exiting the analyzer 
through the exhaust. At that time, the carrier gas path is available from the inlet all the way 
through the loop, through the sample tube, and past the detector.

When the valve switches to Inject mode, the quantity of analysis gas that is contained in the 
loop — one exact unit — is pushed out of the loop and through the sample tube by the carrier 
gas. When the software is recording the TCD signal, the loop injection shows as a peak on the 
Results view of the Analysis window.

The analysis gas may, in fact, be dissipated greatly as it travels out of the loop and through the 
sample tube, particularly if the carrier gas flow rate is low. Higher carrier gas flow rates 
minimize the dispersion of the loop gas.

Pink Loop gas
Royal blue Carrier and Reference gases
Lime green Preparation gas
Black Blended gas

When a gas valve is opened or the flow path is changed, it takes several minutes for 
the new gas to move through the entire system.
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Show Status

Select this option to display the status bar. The bottom portion of the Analysis dialog sequence 
displays the instrument’s Status Bar. This option allows you to display only the status bar of 
the operational window.

The Status Bar displays:

During analysis, the Status Bar also displays:

If more than one instrument is attached to your computer, each instrument’s Status 
Bar is displayed in a different color to help you differentiate the instruments’ 
displays.

Run File Gives the name of the sample information file currently being 
used for analysis. If no file is currently selected, this field 
remains blank.

Temperature Gives the sample’s temperature, as measured by the sample 
thermocouple.

TCD Reading Displays the current detector reading (0.0000 if disabled).

Sample (Identifier) Gives the identifier of the sample information file currently 
being used for analysis. If no file is currently selected, this 
field remains blank.

Time Displays the number of seconds that have elapsed since data 
recording began. This field is blank when no data are being 
recorded.

Step Shows the step currently being performed. When no analysis 
is in progress, Status: Idle is displayed instead.

Duration Shows the amount of time that has elapsed since the current 
step was started. If the analysis is waiting for a fixed period 
of time, the time left to wait is shown in parentheses next to 
the time.

Repeat Count Shows how many times the current Repeat loop has been 
entered. 
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Unit Configuration

Select this option to display the configuration of the instrument’s software, communications 
ports, and options.

Software Versions
MIC BIOS

Gives the name and version of the instrument’s internal 
software.

Controller Gives the name and version of the instrument’s controller 
software.

Application Gives the name and version of the application currently being 
run on the control module.

Options Displays the options available for the AutoChem II and 
whether they are installed or not.

For the Temperature Controller: M = Micromeritics, 
E = Eurotherm

Comm Port Displays the communications port the instrument is using to 
communicate with the computer.

Serial # Displays the instrument’s serial number, as it was entered 
during installation.

Loop Volume Allows you to enter the volume of the gas injection loop that 
is attached to the instrument. Three standard-volume loops 
are provided with your instrument. The loop volume is 
determined by performing a loop calibration. Loop 
calibration is performed by a specialized experiment step 
(refer to Appendix J, page J-38.).
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Gas Selections

Select this option to specify which gases are connected to the ports for the preparation, carrier/
reference, and loop gases.

This dialog contains a drop-down list of the available gases for each of the 12 available ports. 
Each gas also has its MFC constant listed.

Identify what gas is attached to each port by selecting that gas name from the drop-down list. 
If no gas is attached to a given port, select None. 

The gases in the drop-down list are those specified in the Gas Defaults table (on the Options 
menu).

When an analysis is started, the software checks the gases specified in the sample information 
file against the gases identified in this dialog. If there is a discrepancy between the gas 
indicated in the sample information file and the gas indicated in the Gas Selections dialog, a 
message is displayed; analysis cannot begin until the discrepancy is resolved.

Gas Selections cannot be changed during an automatic operation.

The software is unable to determine if the wrong gas is physically connected to the 
port. It can only check that the gas you wish to use agrees with the gas you have 
identified for each port in the Gas Selections dialog. It is important to be sure that the 
Gas Selections dialog accurately reflects which gas is physically connected to each 
port.
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Gas Flow Constant Calibration

Select this option to determine a constant that is used by the analyzer to ensure accurate gas 
flows through each Mass Flow Controller.

A table of the constants for the most commonly used gases is provided in Appendix C. A set of 
conversion constants is shipped with the analyzer, and is displayed in the Gas Defaults table 
accessed from the Options menu. In most cases, the defaults provided in the table work well.

If you are using a gas that is not listed in the Gas Defaults table, or if you suspect that one of 
the MFCs is not functioning properly, calculate a new constant using the instructions and the 
worksheet provided in Appendix F.

The Mass Flow Controllers (MFCs) of your AutoChem II 2920 were calibrated before 
shipping. Unless you suspect that one of the MFCs is operating improperly, you 
should use the calculated (factory) values.
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TCD Calibration

Analyses with the AutoChem II 2920 yield data on signal reading, peak area, temperature, and 
time (plus auxiliary signals, if they were recorded). These data are sufficient for many 
applications, but in some cases, volume data are desired as well.

A group of automatic calibration routines are provided in the form of specialized experiment 
steps. A calibration run is an analysis using one of these experiment steps. The calibration run 
can be performed before or after the sample analysis. A calibration experiment can be included 
as a step within your sample analysis, or it can be performed as a separate analysis.

After the sample data and calibration data are collected, the calibration file is associated with 
the sample file, and the sample data are converted to volume. A single calibration run can be 
associated with an unlimited number of sample data files. For example, TPR yields peak area 
and the temperature(s) at which maximum reduction occurs. To obtain the volume of gas 
uptake, however, you must select a calibration file to associate with the analysis file. Then you 
can create reports in which the area data are converted to volume data.

You can associate a calibration file with a sample file in three different ways:

• Select TCD calibration, Defaults on the Unit menu and specify a default calibration 
file for each experiment type.

• Use the default file specified or choose a different file from the second view of the Start 
Analysis dialog.

• Click Set Calibration on the Peak Editor dialog (described on page 7-14). This choice 
allows you to select a calibration file that was created after the sample file was used in 
an analysis.

Defaults

In applications where volume data are not needed, it is not necessary to perform a 
calibration. If volume data are desired, calibration may be performed either before or 
after the analysis.
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Allows you to specify default calibration files for each type of analysis. An additional default  
can be specified for analyses you have customized, using the Other drop-down list. Setting 
default calibrations can save you time when you frequently perform analyses using the same 
gases.

The calibration files that appear in the lists are those that are available for the instrument.

You will have two opportunities to select a different calibration file before you print a report: 
during the series of dialogs used to start an analysis (Start Analysis from the Unit menu), and 
using Set Calibration on the Peak Editor dialog.

New

Allows you to create a new TCD calibration file; the New TCD Calibration dialog is 
displayed.

After you click OK, a related dialog allowing you to specify the details is displayed. TCD 
calibration files are used to convert sample data to volume data. Examples of these calibrations 
are provided in the tutorials (Appendix J).

Gas Enables the analyzer to determine what mixture of gases is 
flowing past the detector. Use this calibration when the 
volume of gas uptake is needed.

Vapor Enables the analyzer to determine the volume of vapor used 
during the analysis. Use this calibration when the optional 
Vapor Generator is used in conjunction with the loop.

User defined Enables the analyzer to convert peak area data to peak 
volume data for analyses in which the injection loop was 
used. Use this calibration when the loop volume is needed.
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Open

Allows you to open an existing calibration file for editing; the Edit Existing TCD Calibration 
dialog is displayed.

This dialog contains a drop-down list of existing TCD calibration files. After choosing the 
desired file, click OK; the TCD Calibration dialog is displayed.

Peak Table For a gas calibration, this table displays the sample file 
number, the experiment identification, the TCD signal, and 
the percentage of concentration.

For a vapor or user-defined calibration, this table displays the 
sample file number, the experiment identification, the peak 
area and peak volume.

The values in the table are graphically depicted in a plot 
adjacent to the table.

This type of peak table is 
displayed for a gas 
concentration calibration.

This type of peak table is 
displayed for a vapor or 
user-defined calibration.
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Loaded Samples Lists the calibration files currently open.

Delete Peak Deletes the selected peak.

Load Calibration Data Allows you to load another calibration file. The calibration 
file you choose must have been created with the current 
instrument. If you select a file created on a different 
instrument, an error message is displayed.

Degree Allows you to choose a different degree of polynomial; 
usually the 2nd degree is adequate.

Coefficients Shows the fit of data to the polynomial.

Description Displays the name of the current calibration file. This field 
can also be used to enter a new name when changes have 
been made.

Save Enabled when the current file has been edited, allowing you 
to save the changes. If you wish to save it under a different 
name, enter a new one in the Description field.

Close Closes the dialog.
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Report

Select this option to print a report of a calibration file.

Calibration From the drop-down list, select the file for which you wish to 
generate a report.

Report Destination
Copies

Enabled if you choose Printer as the report destination. You 
can print up to four copies.

Destination Allows you to choose a destination for the report.

Choices: File, Printer, Screen

File name Enabled if File is selected as the report destination, allowing 
you to enter a file name (or accept the default).
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List

Select this option to display a list of the files in the Calibration Directory, including details 
such as the calibration file’s identifier (as entered in the sample information file) and the date 
the file was created (or last edited).

Next
Prev

Allow you to view the next or previous page of the list (if 
they exist).

Close Closes the window.

Print Prints the list.

Header This toggle button hides/shows the header of this list.  If the 
header is selected, it appears on every page of the list when it 
is displayed and/or printed.
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Instrument Calibration

A calibration of the analyzer is performed before the analyzer is shipped; the correct 
calibration values for each instrument are shipped with the analyzer. The contents of this 
calibration file are loaded into the analyzer software during installation.

This option displays the Instrument Calibration dialog.

This dialog shows calibration data for the AutoChem II 2920 components. It also enables you 
to calibrate the sample thermocouple. Recalibration should be performed only when you have 
replaced the sample thermocouple or when the analyzer’s calibration file (which was installed 
during initial installation of the software) has been corrupted or lost. Refer to Recalibrating 
the Sample Thermocouple on page 9-18 for instructions for using this dialog to calibrate the 
sample thermocouple. 

You should not attempt to calibrate other components without contacting your Micromeritics 
service representative.

Do not attempt to use the Calibrate Hardware dialog to calibrate the analyzer unless 
you are specifically instructed to do so by a Micromeritics service representative.

Load from File Allows you to load a different calibration file.

Save to File Allows you to save the current calibration settings to a file. 
This function is useful in protecting your calibration data. It 
is wise to save the current settings before attempting a 
recalibration. Be sure to use the next sequenced file name 
generated by the system.
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Accept Replaces the existing calibration values with those you have 
entered in this session. After a confirmation, the software 
gives you the opportunity to save the existing values. The 
Calibrate Hardware dialog is closed after you accept the new 
values.

Cancel Cancels any changes made to the current calibration settings. 
A warning message is displayed before the dialog closes.

Reset Enabled when a change has been made to any field on this 
dialog. Click this push button to reset any changed value(s) to 
its last saved state.

Do not attempt to edit parameters of the following options unless instructed to do so 
by a Micromeritics service representative.

Furnace PID Displays the control parameters for the temperature 
controller. The default values provide linear temperature 
ramps from ambient to 1100 ºC.

Sample PID Displays the control parameters for the sample temperature. 
The proportional and derivative are used. The default values 
are recommended.

MFC Full Scale Displays the full scale flow rate for the mass flow controllers. 
The full scale was determined using H2 as the calibration gas.
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Vapor Generator Calibration

This option allows you to calibrate various components of the optional Vapor Generator. This 
option is available only if the Vapor Generator is installed on the analyzer. Refer to 
Recalibrating the Vapor Generator’s Heated Zones on page 9-20 for instructions on 
calibrating the vapor generator.

Do not attempt to use the Calibrate Vapor Generator dialog to calibrate the analyzer 
unless you are specifically instructed to do so by a Micromeritics service 
representative.

Load from file Allows you to load a previously saved calibration file.

Save to file Allows you to save the current calibration values to a file.

Accept Accepts the current values and closes the dialog.

Cancel Cancels any changes made to the current calibration settings. 
A warning message is displayed before the dialog closes. 

Reset Enabled when a change has been made to any field on this 
dialog. Click this push button to reset any changed value(s) 
to its original state.
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7.  REPORTS MENU

The Reports menu contains options which allow you to start, open, and close reports. This 
menu also allows you to access the Peak Editor, a flexible and powerful tool for processing 
results.

This chapter describes the options contained on the Reports menu, as well as a few examples 
of generated reports.

Description

Listed below are brief descriptions of the options contained on the Reports menu. Detailed 
descriptions follow this section.

Start Report Allows you to generate a report on a sample which has been 
analyzed or on one which is being analyzed. Page 7-2.

Close Reports Allows you to close all open report windows. Page 7-3.

Open Report Allows you to open a saved report. Page 7-4.

Peak Editor Allows you to view peak data, combine and overlay results 
from multiple analyses, change the calibration files selected, 
and edit the data. Page 7-14.
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Start Report

Select this option to generate a report on a sample analysis. The Start Report dialog is 
displayed.

File name The name you select from the Files list box is copied to this 
field. If you select multiple files, the last one selected is 
displayed. If you have a file open, its name is displayed.

Status Refer to “Selecting Files” on page 3-6.

Dates Refer to “Selecting Files” on page 3-6.

Copies Enabled when the Printer destination is chosen, allowing 
you to print up to four copies of the selected report(s).

Destination Displays a drop-down list of output destinations.

Choices: File, Printer, Screen

If you select Printer, requested reports are printed to the 
selected printer.

If you select Screen, many options are available for 
manipulating and customizing reports. Refer to Onscreen 
Reports on page 7-5 for manipulation methods of onscreen 
reports.
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If you choose a single sample file and click OK, the Select Reports dialog is displayed so that 
you may select the desired reports. The reports selected are the ones you specified in the 
sample file. This dialog allows you to deselect reports or select additional ones. If you choose 
more than one file, this dialog is not displayed; the reports selected in each file are generated.

Double-click on the report(s) you wish to select (or deselect). A check mark is placed before 
each selected report. Pressing the Spacebar (when the report is highlighted) performs the 
same function. After you make your report selection and click OK, the requested reports are 
sent to the specified destination.

Close Reports

This option enables you to close all open report windows at one time. This avoids having to 
select close on each report window. This option is unavailable if reports are being generated.

Destination
(continued)

If you select File, the tabular reports of the requested file are 
converted to a text file which can be viewed with a text editor 
or other text file manipulation tools. Graphical reports cannot 
be generated to a file.

File name Enabled when you select File as the destination. Allows you 
to enter a name, or you may accept the default.

Files list box Displays a list of the available sample files for the choice 
shown in the Status field.

Directories Displays a list of available drives and directories. The drive 
and directory last accessed is displayed immediately above 
the Directories list box.

A check mark indicates 
the report is selected.
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Open Report

Select this option to open a saved report. The Open dialog is displayed.

Select the desired report, then click Open. The report is displayed on the screen.

Refer to “Onscreen Reports” on page 7-5 for an explanation of the commands available for 
onscreen reports.
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Printed Reports

Header

All printed reports (either to the screen or to a printer) contain a header displaying file 
statistics.

• Tabular and graphical reports contain sample and instrument statistics such as date and 
time of analysis, analysis conditions, and so forth.

The headers for these reports also contain notes of any changes to the sample file 
which occur after analysis.

• Summary report headers contain the same type of information displayed in tabular and 
graphical reports with the exception of notes.

Onscreen Reports

The report window containing onscreen reports provides many options for customizing and 
manipulating reports: 

• a tool bar
• shortcut menu options
• zoom feature
• axis cross hairs 

When reports are printed to the screen, they are printed in a window like the one shown below. 
Each requested report is listed in the Reports window on the tool bar; reports are also indicated 
by selectable tabs across the top of the report header. To view a specific report, select its tab or 
select the report in the Reports window and click Show.
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Tool Bar

Tabs display for each type of report you choose to generate.

Header

Displays tabular 
(or graphical) 
data.

Options on 
tool bar

List of reports 
requested

Reports Contains a list of all requested reports.

Show Shows the selected report in the report window. If the report 
has been hidden, it and its associated tab will become visible.
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Delete Deletes the selected report. A deletion confirmation dialog is 
displayed since this function cannot be undone. The deleted 
report(s) will have to be regenerated if deleted in error.

Hide Hides (removes) the selected report from the report window. 
The report’s associated tab is also removed. 

Open Allows you to open a previously saved report file.

Print Displays a print dialog so that you can choose an appropriate 
printer for report output. A list of available reports is 
displayed in the window on the right side of the dialog.

For convenience in selecting which reports to print, push 
buttons are provided beneath the report window. Or, you can 
make your selection by clicking on the desired reports.

Current selects the report displayed in the report window.

Shown selects only the shown reports; any non-highlighted 
reports indicate they are hidden. You can still select hidden 
reports from this window to print.

All selects all reports, including those that may have been 
hidden.

Clear clears all selections.

Save Saves all reports of the currently open file in a report format 
using the same name as the sample file, only with an rep 
extension. If you wish to specify a name and/or specific 
reports to save, use the Save As push button.
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Save As Allows you to save all or specified reports from the currently 
open file. The push buttons displayed on this dialog perform 
in the same manner as the print dialog (explained above).

Reports can be saved in three different formats:

Report system (*.rep): Saved in a format which allows you to 
reopen the file using the Open push button on the Report 
window tool bar.

Spreadsheet (*.xls): Saved in a format which can be imported 
into most spreadsheet programs.

Ascii Text (*.txt): Saved in ASCII text which can be 
imported into programs accepting this type of file.

Default Fonts Displays the Default Fonts dialog so that you can edit report 
fonts.

The window on the left lists the items for which the font can 
be edited.

Click Edit to edit the font of a selected item; a font dialog is 
displayed so that you can specify the desired font and 
attributes.

Click Save to save the changes as the default. If you do not 
click Save, the changes will apply to the current report set 
only. The next reports will revert to the default font.

Click Load to load the default font of a selected item.

Close Closes the Report window.

If you have multiple reports open, you may wish to use the 
Close Reports option on the Report menu. This option 
allows you to close all open Report windows at one time, 
without having to click Close on each Report window.
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Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a 
report. 

For Tabular Reports

Resize column Displays a dialog so that you can specify the width of the 
selected column (in inches).

Rename column Displays a dialog so that you can edit the name of the 
selected column. Use Ctrl + Enter to insert line feeds.

Move column Allows you to move the location of the selected column to 
the left or to the right.

Align column Enables you to right-align, left-align, or center the data in the 
selected column.

Hide column Displays a list of all columns, enabling you to select the one 
you wish to hide.

Show column Displays a list of all hidden columns, enabling you to select 
the one you wish to have shown again.

Column font Displays a Font dialog, allowing you to change font attributes 
for the tabular data in the current report.

Header font Displays a Font dialog, allowing you to change font attributes 
for column headers in the current report.
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For Graphs

Edit title Allows you to edit the table title and font.

Copy table as text Enables you to copy the entire table (column headers and 
data) and then insert it into another program. Columns are 
tab-delimited, allowing easy alignment.

Use this option to copy data easily and quickly from the 
AutoChem program to other applications such as spreadsheet 
programs.

Autoscale Sets the axis boundaries to autoscale, presenting the signal in 
full scale.

Redraw Sets axis boundaries to their original view, allowing easier 
editing of peaks.

In many cases, the Autoscale and Redraw options will show very little difference. 
Both options are also used to return the view to its original presentation after 
zooming a report or to remove cross-hairs.

Show curve Allows you to show curves that have been hidden. This 
option is disabled (greyed) if no curves have been hidden.

Hide curve Allows you to hide (remove) unwanted curves.
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Edit curve Displays the Curve Properties dialog, allowing you to edit 
curve properties.

Title Displays the title of the curve you are editing.

Style Drop-down list containing styles in which collected data can 
be displayed. 

Choices: Curve, Histogram, Points, Curve and Points

Curve group box Contains options for curves and points. You can edit the 
curve interpolation, the style of curve and/or points, as well 
as the pen color. The options in this group box are disabled if 
Histogram is chosen in the Style drop-down list.

Histogram group box Allows you to specify the type of fill as well as the color if 
Histogram is chosen as the style for collected data.
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Edit axis Displays the Axis Properties dialog, allowing you to edit axis 
properties.

Edit legend Displays the Legend Properties dialog, allowing you to edit 
the placement of the legend.

Edit title Displays the Title Properties dialog, allowing you to edit the 
current graph’s title and font.

Copy as metafile Copies the graph and places it on the clipboard, allowing you 
to paste it into other applications accepting Windows 
metafiles. 

Use this option to capture graphics for use in reports and 
presentations.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine fine 
detail of the distribution. To use this feature, simply hold down the left mouse button and drag 
the mouse cursor (drawing a box) across the area you wish to view; then release the button. 
The enlarged area immediately fills the graph area. You can return to the normal view by right-
clicking on the graph and selecting Autoscale. 

Axis Cross-Hair

A cross-hair function is available so that you can view axis coordinates. To use this feature, 
simply left-click in the desired area of the graph.

You can remove cross-hair lines and return to the normal view by right-clicking on the graph 
and selecting Autoscale or Redraw. You can also click out of the graph area to remove cross-
hair lines.

Copy as text Copies the data used to generate the graph as a series of tab-
delimited columns of text.

X-axis position

Y-axis positionPoint of coordination
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Peak Editor

The Peak Editor allows you to view and edit data from sample files. You can view the peaks in 
a stacked or overlaid manner. You can also edit the peaks and delete undesirable ones.

When you select the Peak Editor option, the Edit Sample Peaks dialog allowing you to select 
the desired file(s) is displayed. The fields on this dialog function in the same manner as other 
dialogs allowing you to select files. The Peak Editor allows you to view up to 16 experiments 
at one time. If you choose files containing more than 16 experiments, a dialog displaying the 
experiments available in the chosen files is displayed.

This dialog allows you to choose the 16 experiments you wish to view and defaults with the 
first 16 experiments selected. You may deselect and select as desired. This is accomplished by 
double-clicking on the file, or by highlighting the file and pressing the space bar (the same 
method used in selecting reports).
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After you select your file(s) or your experiments (whichever is relevant) and click OK, the 
Peak Editor window is displayed. 

This window contains five tabs. the first three tabs — Experiments Stacked, Experiments 
Overlay, and Signals View — provide different views of the data; the last two tabs — Edit 
Peaks and Fit Peaks — provide the TCD vs. time (or temperature) and tabular information for 
the integrated peaks.

Features of the Peak Editor Window

The Peak Editor window provides the following tools for viewing and editing peaks:

• Shortcut menus
• Shortcut keys
• Zoom in on the TCD signal
• Cross-hairs

Shortcut Menu

A shortcut menu is available for each view of the Peak Editor window. This shortcut menu 
contains the available functions and is accessed by right-clicking in the graph area. For 
example, when you right-click in the Experiments view, the following menu is displayed:

The options on the menu displayed for each view are explained in subsequent sections.

Function Tabs

Displays the name 
of the selected 
experiment.
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Shortcut Keys

Shortcut keys are provided for many of the functions in the Peak Editor. These shortcut keys 
have been assigned function-relevant characters enabling you to remember them more quickly. 
For example, Ctrl+A is assigned to Autoscale. Refer to the following table for a complete list 
of the shortcut keys you can use while operating the Peak Editor.

Table 7-1. Shortcut Keys for the Peak Editor

Zoom Feature

A zoom feature is included with the Peak Editor allowing you to zoom in on peaks. This 
feature functions in the same manner as the zoom for reports; hold down the left mouse button 
and drag the mouse cursor (drawing a box) across the area you wish to view; then release the 
button. If you have multiple graphs displayed, the area you define on the selected graph is 
enlarged for each graph. You can return to the normal view by right-clicking on the graph and 
selecting Autoscale, or you can use the shortcut keys Ctrl + D.

Cross-Hairs

When you click the mouse in the graph area, locator cross-hairs are displayed. The exact 
values associated with the intersection of the cross-hairs are displayed along the axes. This 
makes it easy to determine exact values for points on the second Y-axis, or for the point on the 
time/temperature trace that corresponds with the signal/temperature trace. Refer to Axis 
Cross-Hair on page 7-13 for additional information on cross-hairs.

Key(s) Function
Ctrl + A Sets the axes to autoscale (full scale view)
Ctrl + D Returns the Peak Editor window to its original view
Ctrl + M Shows or Hides Peak Marks
Ctrl + T Displays the X-axis by Time or Temperature
Ctrl + F Copies a graph(s) as a Metafile, allowing you to paste it into another 

application
Ctrl + C Copies data to the clipboard, allowing you to paste it into another 

application 
Ctrl + N Advances you to the next peak
Ctrl + P Returns you to the previous peak
Ctrl + L Marks the left edge of the peak
Ctrl + R Marks the right edge of the peak
Ctrl + S Saves the changes made to the current file
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Experiments

The Experiments View shows curves for all experiments within the selected files. You can 
display the curves in a stacked fashion or in an overlaid fashion. You can display up to 16 
experiments; each experiment is displayed in a different color.

Stacked

The Stacked view displays up to 16 experiments, stacked one after the other. In this view, you 
can select the individual experiments to obtain information. When you select an experiment, 
its name is displayed in the title bar of the window. Cross-hairs are also displayed to show 
exact values in the selected area.

When you right-click in the graph area, the following shortcut menu is displayed: 

Peak marks can be shown or hidden.

X-axis can be displayed as Time or Temperature.

Some functions are assigned shortcut keys allowing you to perform the action 
without having to access the shortcut menu. Refer to Table 7-1, page 7-16, for a list of 
the shortcut keys available with the Peak Editor. You may wish to make a copy of this 
table and keep it close to your keyboard. 
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Autoscale Sets the axis boundaries to autoscale, presenting the signal in 
full scale.

Redraw Sets axis boundaries to their original view, allowing easier 
editing of peaks.

In many cases, the Autoscale and Redraw options will show very little difference. 
Both options are also used to return the view to its original presentation after 
zooming a report or to remove cross-hairs.

View Displays a cascading menu allowing you to:

• Show or hide the peak marks
• Specify X-axis in Time or Temperature
• Copy the contents of the window to the clipboard as a 

metafile or as text, then paste it into another application

Insert Enables you to insert experiments from another sample file.

Remove Removes the selected experiment from the Peak editor 
window; the data are not deleted from the sample file. 

Save As Allows you to save the experiments in the window as a new 
sample file. For example, if you have a file opened 
containing five experiments but are only interested in two of 
them, you can remove the three of no interest and save the 
file with the remaining two.

Close Closes the Peak Editor window.
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Overlay

The Overlay view displays up to 16 experiments, overlaid on each other. This view does not 
allow you to select an experiment; you must switch to the Stacked view to select experiments. 

When you right-click in the graph area, the following shortcut menu is displayed:

The options on this menu are identical to the ones available in the Stacked view (page 7-17). 
Remove is disabled on this menu because individual experiments cannot be selected in the 
Overlay view.
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Signals View

The Signals view displays the signals for the selected experiement stacked one on top of the 
other. This allows you to view the relationship of peaks to temperature and auxiliary signal 
conditions that occurred during data collection.

When you right-click in the graph area of the Signals view, the following shortcut menu is 
displayed:

Some functions are assigned shortcut keys allowing you to perform the action 
without having to access the shortcut menu. Refer to Table 7-1 on page 7-16 for a list 
of the shortcut keys available with the Peak Editor. You may wish to make a copy of 
this page and keep it close to your keyboard. 

Autoscale Sets the axis boundaries to autoscale, presenting the signal in 
full scale.

Redraw Sets axis boundaries to their original view, allowing easier 
editing of peaks.

In many cases, the Autoscale and Redraw options will show very little difference. 
Both options are also used to return the view to its original presentation after 
zooming a report or to remove cross-hairs.
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Edit Peaks

Edit Peaks allows you to edit the peaks of the selected experiment; the Peak Table dialog 
listing peak information for all peaks of the selected experiment is displayed.

Use one of the following methods to select a peak:

• Highlight the desired peak in the Peak Table

• Access the shortcut menu and select Next Peak or Previous Peak until you navigate to 
the desired peak

• Use Ctrl + N (advance to the next peak) or Ctrl + P (return to the previous peak) to 
navigate to the desired peak

When a peak is selected, its peak marks display in a light green color; the peak marks for 
unselected peaks display in red.

Peaks are edited by accessing functions from the shortcut menu which is displayed when you 
right-click in the graph area.

X-Axis Enables you to display the X-axis by Time or Temperature.

Copy Enables you to copy the graph area to the clipboard as a 
metafile or as text, then paste it into another application.

Close Closes the Peak Editor window.
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Some functions are assigned shortcut keys allowing you to perform the action 
without having to access the shortcut menu. Refer to Table 7-1 on page 7-16 for a list 
of the shortcut keys available with the Peak Editor. You may wish to make a copy of 
this page and keep it close to your keyboard.

Autoscale Sets the axis boundaries to autoscale, presenting the signal in 
full scale.

Redraw Sets axis boundaries to their original view, allowing easier 
editing of peaks.

In many cases, the Autoscale and Redraw options will show very little difference. 
Both options are also used to return the view to its original presentation after 
zooming a report or to remove cross-hairs.

Next Peak Advances you to the next peak.

Previous Peak Returns you to the previous peak.

Insert New Peak Inserts a new peak in a graph.

Click in the graph where you want to insert a peak, then 
select Insert New Peak.

Mark Left Edge A peak is automatically marked by the program; this option 
allows you to redefine the left edge. Simply place the mouse 
cursor where you wish to have the left edge marked, right-
click, and select this option.
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Mark Right Edge A peak is automatically marked by the program; this option 
allows you to redefine the right edge. Use the same method 
used for marking the left edge.

Find All Peaks This option is used to find all peaks automatically in the Peak 
Editor window.

This is a rapid technique for integrating pulse chemisorption 
data. This option is most effective for narrow peaks with 
good baseline separation.

Delete Peak Removes the selected peak from the peak table. Deletes all 
peak information for a single peak.

Delete All Peaks Clears the Peak table of all data and removes all markings 
from the peaks. 

View Displays a cascading menu allowing you to:

• Show the peak table
• Show or hide the peak marks
• Specify X-axis in Time or Temperature
• Enable or disable smoothing, and invert or zero the signal 

(peak)
• Copy the contents of the window to the clipboard as a 

metafile or as text, then paste it into another application

Save Saves the peak table to the sample file.

Set Calibration Allows you to choose a TCD calibration that is appropriate 
for the current experiment.
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Fit Peaks

Fit Peaks allows you to separate overlapping peaks by fitting curves to the data, and save 
them as a new peak table.

Peak Integration 
Options

Displays the Peak Detection/Integration Options dialog.

This dialog allows you to adjust the parameters enabling you 
to optimize the results you obtain using the Find All Peaks 
option. Refer to Appendix H, page H-1 for additional 
information on this dialog.
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Right-click in the graph area to access the shortcut menu for creating the table.

Some functions are assigned shortcut keys allowing you to perform the action 
without having to access the shortcut menu. Refer to Table 7-1 on page 7-16 for a list 
of the shortcut keys available with the Peak Editor. You may wish to make a copy of 
this page and keep it close to your keyboard.

Autoscale Sets the axis boundaries to autoscale, presenting the signal in 
full scale.

Redraw Sets axis boundaries to their original view, allowing easier 
editing of peaks.

In many cases, the Autoscale and Redraw options will show very little difference. 
Both options are also used to return the view to its original presentation after 
zooming a report or to remove cross-hairs.

Insert New Peak Set Enables you to define a region of the TCD signal that 
contains multiple peaks. The peak fitting and optimization 
are constrained to this region of the TCD signal.

Click in the graph where you want to insert a new peak set, 
then select Insert New Peak Set.

After you add the peak set, you can use the commands on the 
graph shortcut menu to define the peak set (mark edges, for 
example).
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Insert New Peak Inserts a new peak in a graph.

Click in the graph where you want to insert a peak, the select 
Insert New Peak

Mark (Peak Set) 
Left Edge

Changes the left edge of the peak set.

Mark (Peak Set) 
Right Edge

Changes the right edge of the peak set.

Change Peak Shape Allows you to choose the type of peak shape.

Log Normal Skewed This is a 4-parameter, log-normal shape that allows for 
skewed peaks, and is the default peak.

Gaussian This is the traditional symmetrical shape.

View Displays a cascading menu enabling you to show the peak 
table or copy the contents of the window to the clipboard as a 
metafile or as text, then paste it into another application

Delete Peak Removes the selected peak from the peak set table.

Delete Peak Set Deletes the selected Peak set from the table.

Delete All Peaks Removes all peaks and peak-set information from the table.

Import Standard Peaks Imports the saved peak parameters from the Peak Edit screen 
and uses them for the initial estimates for the peak set.

Optimize Peaks Locates the best peak height, width, and skewness after initial 
peak estimates have been given.

Auto Fit Locates the best number of peaks and parameters from the 
Peak Set without user estimates.

Display Enables you to smooth the signal for display purposes only, 
and to select or deselect zeroing and signal inversion.

Save Save the current peak set.

Close Closes the Peak Editor window.
7-26                                                    Jul 09



AutoChem II 2920 Report Examples
Report Examples

This section contains examples of some of the types of reports that may be generated by the 
AutoChem II 2920 analysis program. You can customize portions of some reports, such as the 
title and the axes of graphs, using the Report Options tab of the sample information file 
(Advanced format only). If reports are printed to the Screen, there are many ways in which 
they can be manipulated and customized.
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Summary Report
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TPD Analysis

First Order Kinetics
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TCD Signal vs. Temperature
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TPR Analysis

TCD Signal vs. Time
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BET Surface Area
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TCD Signal vs. Time
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Pulse Chemisorption

Cubic Crystallite Size:   2.6396 nm 
7-34                                                    Jul 09



AutoChem II 2920 Report Examples
TCD Signal vs. Time
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Loop Calibration
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TCD Signal vs. Time
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8.  OPTIONS MENU

The Options menu enables you to configure the system to suit your laboratory’s requirements. 
With the options on this menu, you can:

• Specify data presentation modes
• Specify units of measurement
• Specify the grid layout of graphical reports
• Select a default for the format of the sample information file, as well as for its values
• Specify or edit program defaults
• Enter environmental conditions
• Specify a directory for predefined parameter files

Description

Listed below are brief descriptions of the Options menu contents. Detailed descriptions are 
found in this chapter.

Option Presentation Allows you to set the default for the sample information file 
presentation format. Choose between Basic, Advanced, or 
Restricted format. Page 8-3.

Units Allows you to select the units of measurement for quantity 
and pressure data presented on the screen and in printed 
reports. Page 8-5.

Graph Grid Lines Allows you to specify the way in which graph lines are 
shown on the screen and in printed reports. Page 8-6.
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Sample Defaults Allows you to specify defaults for the parameters contained 
in the sample information file. Page 8-7.

Gas Defaults Provides a table defining characteristics of gases used for 
analysis, to be used in calculations. Page 8-13.

Vapor Defaults Allows you to enter the Antoine constants for vapors and/or 
edit vapor defaults. Page 8-14.

Active Metal Defaults Provides a table defining characteristics of metals contained 
in samples, to be used in calculations. Page 8-15.

Environmental Defaults Allows you to enter the current environmental conditions, so 
that their effect on analyses can be accounted for in 
calculations. Page 8-16.

Parameter File Directory Allows you to specify a directory for predefined parameter 
files displayed in the drop-down lists of the Basic sample 
information dialog. Page 8-17.

Service Test Mode Provides password-protected access to certain functions of 
the analyzer to Micromeritics-trained service personnel only. 
Do not attempt to access Service Test Mode unless you are 
specifically directed to do so by a Micromeritics service 
representative. Page 8-18.
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Option Presentation

Sample information file dialogs may be presented in three formats: Advanced, Basic, and 
Restricted. 

Advanced Format 

Presents all four parts of the sample information file as a group of dialog boxes with index 
card-type tabs (the Collected data tab does not appear until after analysis). Clicking on each 
tab opens an associated dialog. 

Use this format when you wish to edit the parameter files and create customized Sample 
Information files, rather than using standard parameter files. Just click on the tab of the 
parameter you wish to edit, or use Next and Prev to navigate among the dialogs.

Basic and Advanced format files provide a toggle button for conveniently switching 
back and forth between them, regardless of which format is specified as the default.
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Basic Format 

Presents the entire sample information file in a single dialog box. 

Basic format makes it easy to select previously defined parameter files from convenient drop-
down lists. If editing is required, you can easily switch to the Advanced format by clicking 
Advanced.

Restricted Format 

Restricted format is identical to the Basic format, except that certain menu options are 
disabled. You also cannot switch to the Advanced format. This format is password-protected 
and typically is used in laboratories where analysis conditions must remain constant, for 
example, in the pharmaceutical industry.

You can enter any password (up to 31 characters) to enable the Restricted format. The same 
password must be used to exit the Restricted format. For example, if you enter “password” to 
enable the restricted format, then you must enter “password” to exit. If you forget the 
password, open the system INI file and navigate to the Private section. The password is shown 
immediately following “OptionPresentationPassword.” Make a note of the password, exit the 
INI file, and enter the password where requested. Deleting the password from the INI file will 
not disable the Restricted mode; you must enter the password using the Password dialog to 
exit the Restricted format.

Not available in the 
Restricted format.
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Units

This option enables you to select the units of measurement for the quantities and pressures 
displayed on the screen or in printed reports.

Quantity Choose one of the following for quantity data presentation:

cm3/g STP
µmol/g
mmol/g

Pressure Choose one of the following for pressure data presentation:

Atm
bar
kPa
mbar
mmHg
psia
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Graph Grid Lines

Graph Grid Lines enables you specify how you wish graph lines to be displayed on screen 
and in printed reports; the Graph Grid Lines dialog is displayed.

X-Axis
Y-Axis

Enables you to choose Major and/or Minor lines to 
display in printed reports for the Logarithmic and Linear 
scales. 

If you deselect these items (remove the check marks), 
your report will not display grid lines.

Grid Line Styles Allows you to choose the type of grid line to display if 
grid lines are being shown.
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Sample Defaults

This option allows you to specify default parameters for the dialogs used to create sample 
information files. 

Sample defaults are the values you see in the sample information editors when you create a 
new sample file. For efficiency, it is best to specify defaults for materials you most commonly 
analyze. You can always edit the values in the sample file when it is created. 

The dialog used for specifying default parameters is presented in the same format you have 
selected as your default for sample information files. Sample defaults cannot be specified 
using the Restricted format.

Basic

Sequence Allows you to specify a default sequence for the file name. 
The number you specify is incrementally sequenced each 
time you create a file. It is the number that appears in the File 
name field when you select File > Open > Sample 
Information.

• Use numbers, letters, or other printable characters, such 
as dashes.

• Include at least three numbers

• Use up to eight characters.

• Do not use characters such as * or ?. Refer to your system 
operating manual for more information.
Jul 09                                                    8-7 



Sample Defaults AutoChem II 2920
Sample Allows you to enter an additional identification that provides 
more information than the sequence alone.

In the field on the left, you can edit the prompt for the sample 
identification. For example, you may prefer to use Test or 
Material. The maximum number of characters is 20.

In the field on the right, you can specify a format for the 
sample identification.

• Use numbers, letters, or other printable characters, such 
as dashes.

• Include the automatically generated file name as part of 
the identification by using the $ symbol where you want 
the sequence number to appear.

For example, if the sequence number is 000-001, enter 
the sample identification as follows:

Lab #25 - $

The resulting sample identification for the first Sample 
Information file would be:

Lab #25 - 000-001

and for the second one:

       Lab #25 - 000-002, and so on.

Replace All Click this button to copy the values from an existing sample 
information file into the default file you are creating. A 
dialog is displayed so that you can choose the file containing 
the values you wish to copy. Click OK; the values are copied 
into the defaults automatically. You may then edit the values 
in the default file without altering the sample information file 
from which they were copied.

Mass Enter a value for the sample mass. This value can be edited in 
the sample file if needed.
8-8                                                    Jul 09



AutoChem II 2920 Sample Defaults 
Analysis Conditions From the drop-down list, choose a default analysis conditions 
file. The list contains the analysis conditions files included 
with the software, as well as any you have created and stored 
in the parameter file directory (selected on the Options 
menu). Each step in the analysis is listed in the Synopsis and 
its parameters can be viewed by clicking View.

Report Options From the drop-down list, choose a default report options file. 
The list contains the report options files included with the 
software, as well as any you have created. 

Report Options List Box Contains the reports available for the report options file you 
selected as the default. Select the report(s) you wish to 
include as your default(s).

Save Saves the defaults you have selected.

Close Closes the dialog. If there are any unsaved changes, you are 
given the option to save them.

Advanced Changes the presentation of the Sample Defaults dialog to the 
Advanced presentation.
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Advanced

When you select Sample Defaults while your system is set to Advanced format, the Sample 
Defaults dialog is displayed in the Advanced format.

Sequence Allows you to specify a default sequence for the file name. 
The number you specify is incrementally sequenced each 
time you create a file. It is the number that appears in the File 
name field when you select File > Open > Sample 
Information.

• Use numbers, letters, or other printable characters, such 
as dashes.

• Include at least three numbers

• Use up to eight characters.

• Do not use characters such as * or ?. Refer to your system 
operating manual for more information.

Sample Allows you to enter an additional identification that provides 
more information than the sequence alone.

In the field on the left, you can edit the prompt for the sample 
identification. For example, you may prefer to use Test or 
Material. 
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Sample
(continued)

In the field on the right, you can specify a format for the 
sample identification.

• Use numbers, letters, or other printable characters, such 
as dashes.

• Include the automatically generated file name as part of 
the identification by using the $ symbol where you want 
the sequence number to appear.

For example, if the sequence number is 000-001, enter 
the sample identification as follows:

Lab #25 - $

The resulting sample identification for the first Sample 
Information file would be:

Lab #25 - 000-001

and for the second one:

       Lab #25 - 000-002, and so on.

Operator
Submitter

These fields contain the name (or other identification) of the 
operator performing the analysis, and the department, 
customer, etc., that submitted the sample for analysis.

In the fields on the left, you can change the prompts.

In the fields on the right, you can specify the default names or 
titles.

• Include the automatically generated file name as part of 
the identification by using the symbol $ where you want 
the sequence number to appear. Refer to the example in 
the previous section.

• Select Omit to prevent the fields from appearing on the 
sample information dialog.

Mass Enter a value for the default sample mass. You can edit this 
value in the sample file if needed.
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Analysis Conditions Defaults

The default settings for analysis conditions files are specified using the Advanced format 
sample information file defaults, regardless of whether you plan to create independent analysis 
conditions files, or complete analysis conditions dialogs as part of the sample information file.

Select Options > Sample Defaults; the Advanced presentation of the 2920 Defaults dialog is 
displayed; click the Analysis Conditions tab. The fields on the sample defaults dialog are 
identical to the ones on the Advanced format sample file, which is described on page 5-10.

Report Options Defaults

The default settings for report options files are set using the Advanced format sample 
information file defaults, regardless of whether you plan to create independent report options 
files, or complete report options tabs as part of the sample information file.

Select Options > Sample Defaults; the Advanced presentation of the 2920 Defaults dialog is 
displayed; click the Report Options tab. The fields on the sample defaults dialog are identical 
to the ones on the Advanced format sample file, which is described on page 5-39.

Comments Enables you to enter comments concerning the sample or its 
conditions. The information you enter in this window 
displays in the report header

Replace All Click this button to copy the values from an existing sample 
information file into the default file you are creating. A 
dialog is displayed so that you can choose the file containing 
the values you wish to copy. Click OK; the values are copied 
into the defaults automatically. You may then edit the values 
in the default file without altering the sample information file 
from which they were copied.

If you repeatedly use the same sample preparation techniques, then vary the 
analysis parameters, you may wish to make your default analysis conditions the 
preparation steps alone. Then the preparation steps will always be in place when you 
open a new sample information file, ready for you to add analysis steps as needed.

When the first experiment is inserted into an analysis conditions file, its initial values 
are set by the first experiment step in the default analysis conditions. Including a 
single “default” experiment step in your default sample file will ensure that new 
experiments are properly initialized.
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Gas Defaults

In order to characterize the gases used in an analysis, a symbol and a Mass Flow Controller 
(MFC) Constant must be defined. A table is provided, containing default values for the 
following:

Symbol Lists the standard symbol (mnemonic) for each gas.

MFC Constant Contains the MFC Conversion Constant for each gas listed. 
This constant allows the MFC to control the gas flow 
precisely. If this number is incorrect, the actual flow rate for 
that gas differs from the rate reported.

This value defaults to 1 when a new gas is listed. You must 
enter the correct gas constant. A table of MFC conversion 
constants is provided in Appendix C. If the gas you are using 
is not listed in the table, or if you are using a mixture of 
gases, you can determine the correct MFC Constant using the 
instructions in Appendix F.

In general, the MFC conversion constants provided with the analyzer are accurate 
and should be used. If you suspect that a MFC is not functioning properly, you may 
wish to calibrate the MFC. 

% Active Concentration Displays the percentage of the gas that is active.
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You can change any one of the values in the table by highlighting it and entering the value you 
prefer. You can also edit the gases listed using the following push buttons:

Vapor Defaults

This option allows you to specify defaults for vapors when used in an analysis.

Insert Inserts a row in the table in which you may enter a new gas 
and its values. The new row is inserted before the row in 
which the cursor is located.

Delete Deletes from the table the row in which the cursor is located. 
No confirmation is provided; therefore, do not click Delete 
unless you are certain this is what you wish to do.

Clear Clears all but one entry of the table, after confirmation. One 
entry is required.

Name Lists the name of the vapor.

A, B, C These columns enable you to enter the Antoine constants 
used in the vapor TCD calibration.

Temp. Min/Temp. Max Enables you to enter a temperature range (in K) in which the 
constants are valid.

Insert Inserts a row before the selected row, allowing you to add a 
new vapor to the table.
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Active Metals Defaults

In order to characterize the active metals in a sample, certain properties of the metals must be 
defined.

A table containing default values for the following properties is provided:

Delete Deletes the selected vapor from the table; no confirmation is 
provided. 

Clear Clears all but one entry from the table; one entry is required.

The values defined in this table are the defaults used when a new entry is inserted 
into the metal table of the Pulse Chemisorption report options. Changing this table 
does not affect the tables within the report options files.

Atomic Weight The atomic weight of the element.

Range: 1.0000 to 500.0000

Atomic Area The atomic cross-sectional area of the element. 

Range: 0.0000 to 9.9999 nm2

Density The density of the element. 

Range: 0.0000 to 99.9999 g/cm3
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You can change any of these values by highlighting it, then entering the value you prefer. You 
can also edit the elements listed using the following buttons:

Environmental Defaults

To ensure accurate loop calibration and BET surface area data, you should enter current 
environmental conditions every day, or whenever there is a significant change in one or more 
of the environmental conditions. These values are used in some calculations to account for the 
effect of environmental conditions on the analysis. When you select this option, the 
Environmental Defaults dialog opens.

As an analysis is started, these parameters are saved in the Collected Data portion of the 
sample information file. (Collected Data can be viewed in the sample file in Advanced format 
only.)

Stoichiometry Factor A factor which expresses the ratio between the number of 
active metal atoms and the number of adsorbate molecules. 
This number varies, based on the adsorbate used. The most 
common value should be entered into the defaults table. 
Within the Pulse Chemisorption report options; the value for 
a specific analysis can be set.

Range: 0.001 to 100.000

Insert Inserts a row in the table in which you may enter a new gas 
and its values. The new row is inserted before the row in 
which the cursor is located.

Delete Deletes from the table the row in which the cursor is located. 
No confirmation is provided; therefore, do not click Delete 
unless you are certain this is what you wish to do.

Clear Clears all but one entry of the table, after confirmation. One 
entry is required.

Displays the valid 
range for the 
selected field.
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Valid ranges for the selected field are shown in the information bar on the dialog.

Parameter Files Directory

When you select this option, the Parameter File Directory Selection dialog is displayed.

This option allows you to choose which analysis conditions and report options files (parameter 
files) display in the drop-down lists on the Basic format sample information dialog. You do so 
by selecting a directory. Parameter files located in the specified directory appear in the drop-
down lists; files located in other directories do not.

For this reason, it is important that whenever you create an independent parameter file, you 
save it in the correct directory. The destination directory is specified on the Open Analysis 
Conditions or Open Report Options dialog when you first begin to create the parameter file. To 
be sure that the parameter files you create are included in the drop-down list, make sure that 
the directory they are saved to matches the directory specified using this option.

Ambient temperature Enter the temperature of the room in which the analyzer is 
located.

Ambient pressure Enter the atmospheric pressure of the room in which the 
analyzer is located.

Saturation pressure 
(Po) of adsorbate

Enter the saturation pressure of the adsorbate gas in the room 
in which the analyzer is located. Disregard this field if the 
saturation pressure of the adsorbate gas is not pertinent to 
your analysis.
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Service Test Mode

Various service tests are included in the AutoChem II 2920 operating program. These tests can 
be performed only with the assistance of a trained Micromeritics service representative. When 
you select Service Test Mode from the Options menu, a dialog box prompting you to enter a 
password is displayed. This password is coded to change on a regular basis and is known only 
by your service representative. You will not be able to perform these tests without his 
guidance. 
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9.  TROUBLESHOOTING AND MAINTENANCE

This chapter describes potential operational problems and their solutions, and maintenance 
procedures. If further assistance is needed after following the procedures in this chapter, 
contact a Micromeritics service representative. 

Troubleshooting

Operating problems encountered with the analyzer are usually easily corrected. Typical 
problems and corrective actions are described in the following table. 

Table 9-1.  Potential Operational Problems

What Happened Why What To Do
Unit does not work when 
power switch is turned 
on. 

Power cord not fully inserted at 
one of the ends. 

Insert power plug firmly into 
outlet socket; insert unit 
connector into power connector 
opening. 

No power at outlet. Plug in lamp or small appliance 
to test outlet. If there is no 
power, contact electrician. 

Plug prongs bent so that contact 
not made at outlet.

Gently move power plug at 
outlet while watching the status 
LEDs on the front panel. If at 
least one LED becomes 
illuminated, have an electrician 
replace the outlet or the plug. 

Power cord damaged.  Have electrician check cord 
using a test meter. Replace cord 
if defective.

Loose internal connection or 
broken wire. 

Call a Micromeritics Service 
Representative for repair or 
replacement. 

Liquid nitrogen boils 
away too quickly to 
complete an analysis. 

Dewar damaged. Replace dewar.
Lengthy analysis. Refill dewar during analysis.

Specified temperature 
not reached or not 
maintained.

Thermocouple or other internal 
component is damaged or 
disconnected.

Call the appropriate service 
personnel.
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Table 9-1.  Potential Operational Problems (continued)

What Happened Why What To Do

Gas drained from tank. Leaks in the gas line connection. Replace the gas tank; then 
pressurize the system. Close, then 
open the cylinder valve. If the 
needle on the pressure gauge on 
the gas cylinder jumps abruptly, a 
leak in the gas line connection 
may be indicated. Check all gas 
line connections.

Too much heat supplied 
to analyzer.

Thermocouple or other internal 
component is damaged or 
disconnected.

Call the appropriate service 
personnel.

A stable TCD baseline 
cannot be maintained.

TCD filaments are contaminated 
or need to be replaced.

Refer to Replacing the Thermal 
Conductivity Detector (TCD) to 
clean the TCD filaments or 
replace the TCD.

Possible leak in Reference/carrier 
path.

Perform leak test in the 
Reference/carrier path. Refer to 
Performing a Leak Test.

Faulty RTD in one of the 
temperature zones.

Access manual mode and check 
for temperature stability in the 
temperature zones.

Data collection results in 
very high or very low 
peaks that are 
inconsistent with 
previous experience. 

TCD filaments are contaminated 
or need to be replaced.

Refer to Replacing the Thermal 
Conductivity Detector (TCD) to 
clean the TCD filaments or 
replace the TCD.  

A different (lower) TCD 
temperature is being used.

Repeat the analysis using a 
higher temperature.

During data collection, a 
TCD signal of zero is 
recorded, or no peaks are 
seen.

TCD filaments are contaminated 
or need to be replaced.  

Refer to Replacing the Thermal 
Conductivity Detector (TCD) to 
clean the TCD filaments or 
replace the TCD.  

TCD temperature was not reset 
after a run automatically 
suspended.

Be sure to re-enable the TCD 
after all run suspensions.
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Maintenance Schedule

Use the following table to determine when maintenance procedures should be performed. 

U = User procedure
F = Factory/Micromeritics Service procedure
I = Inspect
R = Replace
A = As necessary

Procedure Location of 
Instructions 

(Page)

3 Months 
75 runs

6 Months 
150 runs

9 Months 
225 runs

12 Months 
300 runs

Clean cold trap 9-4 U/I/A U/I/A U/I/A F
Change septum 9-6 U/R F
Change loop 9-7 U/I/A F
Replace TCD 9-10 U/I/A F
Adjust sample 
thermocouple

4-11 U/I/A F

Replace sample tube filter 9-13 U/R F/R
Clean analyzer 9-15 U/I/A F
Clean foam air filter 9-16 F
Clean dewars 4-26 U/I/A U/I/A U/I/A F
Change sample O-rings 4-21 F/R
Perform leak check 9-24 U/A F
Check temperature 
stability

F F

Check sample 
thermocouple calibration

9-18 F/A

Perform calibration run F F
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Maintenance Procedures

Changing or Cleaning the Cold Trap or Delay Path

Because the cold trap removes condensibles from the gas stream, it will require occasional 
cleaning. The delay path (used for BET analyses) also attaches to the cold trap port fittings. If 
you need to change from one attachment to the other, follow the steps below, but substitute the 
appropriate attachment during reassembly.

Figure 9-1. Location of Cold Trap or Delay Path

To clean the cold trap, follow the steps below. 

1. If a dewar is around the cold trap, raise the dewar slightly, move the dewar support out of 
the way, and remove the dewar. Allow the cold trap to warm to room temperature. 

2. From the Unit menu, select Show instrument schematic, then select Enable manual 
control. Right-click on the cold trap valve (the detail from the schematic is shown below) 
and choose Bypass. 

Cold Trap Ports

Delay Path

Cold Trap

Depending upon the state of the analyzer, the cold trap fittings may be hot. Use 
caution. If necessary, wear cotton gloves to protect your hands.
9-4                                                    Jul 09



AutoChem II 2920 Maintenance Procedures
3. Loosen the retaining nuts on the cold trap port fittings. (These can be unscrewed using 
your fingers.)

4. Remove the cold trap (or delay path), nuts, ferrules, and O-rings.  

5. Clean the cold trap (or delay path) by flushing it with isopropyl alcohol (IPA). Dry the trap 
in an oven or by blowing compressed air or nitrogen through it before replacing it.  

6. Inspect the O-rings for cracks or other damage that might cause leaks. If the O-rings are 
cracked or damaged, replace them before reinstalling the cold trap (or delay path). (Extra 
O-rings are shipped with the analyzer. Refer to Chapter 10 for ordering information.) 
Otherwise, clean the O-rings you removed, dry them, and reinstall them.

7. Place the retaining nuts, ferrules, and O-rings on the cold trap (or delay path).

8. Hold the cold trap (or delay path) in place and tighten the retaining nuts. Tighten the nuts 
only enough to hold the cold trap securely in place and prevent leaks.  

Representation of Cold 
Trap/Delay Path

Cold Trap 
Heat Zone

Cold Trap Valve

O-ring

Ferrule

Retaining Nut

Cold Trap

The Cold Trap is shown in 
this illustration; the same 
fittings are used for the 
Delay Path.

Use only KalrezTM O-rings. Kalrez is rated for both chemical and temperature 
suitability in this application. O-rings of other materials could burn, melt, or 
decompose.

Do not over tighten the retaining nuts. Doing so may damage the O-rings. Finger-
tight is sufficient.
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Changing the Septum

Because the septum is pierced each time you perform an analysis requiring an injection, it will 
eventually leak. When the analyzer septum begins to leak, replace it with a new septum.  

To replace the septum, follow the steps below.  

1. Turn the knurled septum retaining nut on the front panel counterclockwise to loosen it. 

2. When the mounting nut is free, remove it with the old septum.  

3. Remove the old septum from the retaining nut.  

4. Install a new septum using the original retaining nut.  

5. Use your fingers to turn the septum retaining nut clockwise until it is tight. You will feel 
resistance as the septum is squeezed, and then the nut will be difficult to tighten further.  

Septum Connector

Septum

Retaining Nut

Do not use a wrench to tighten the septum retaining nut. Do not overtighten the 
retaining nut. Doing so may damage the septum or the fitting.
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Changing the Injection Loop

1. Make sure that no heat is being applied to the analyzer. If necessary, enable manual control 
and set the target temperature for the heat zones to ambient. Wait for the analyzer to cool 
down.

2. Press in on the right side of the retractable handle on the top of the analyzer to protrude the 
handle. Then, using the handle, open the top panel. The top panel is hinged to allow easy 
access to its components; it is not necessary to remove the top panel.  

Pull down the upper front panel.

3. The Fill/Inject (Loop) valve cover is held in place by two retaining plungers. Remove the 
valve cover by pulling the plungers outward until the Fill/Inject valve cover is released. 
Pull the cover up and out.

4. Remove the insulation from Fill/Inject valve (not shown).

For viewing purposes only, 
this illustration shows the top 
panel entirely removed. It is 
not necessary for you to 
remove the panel.

Retaining Plunger 
(two per valve cover)

Fill/Inject (Loop) 
Valve Cover

Upper Front Panel

Depending upon the state of the analyzer, the internal components may be hot. Use 
caution.
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5. Unscrew the loop nut and lay it aside. It may be necessary to loosen the screw in the 
middle of the assembly in order to free the loop nut.

6. Use a 1/4-in. open-end wrench to loosen the nuts on the injection loop.

7. Pull up and remove the injection loop and enclosure ring from the mounting plate.

8. Install the replacement injection loop by placing the ends of the loop into the sides of the 
valve and turning the nuts finger-tight.

9. Push the replacement loop down to contact the mounting plate and place the loop 
enclosure ring firmly into place.

Loop Nut

Loop Enclosure Ring

Loop

Loop Retaining Nut

Mounting Plate
Fill/Inject (Loop) Valve

Make sure the body of the loop is positioned in the temperature-controlled enclosure 
of the loop valve. This orientation keeps the temperature (and volume) of the loop 
constant. Failure to keep the full loop at a constant temperature may cause variations 
in the quantity of gas contained in the loop.

Loop Nut

Loop Enclosure Ring

Loop

Loop Retaining Screw 
(remains in place but 
may be temporarily 
removed)

Loop Retaining Nuts 
(Insert loop ends into the 
valve here, then tighten 
nuts.)
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10. Screw the loop nut down finger-tight. Tighten the screw in middle of the assembly if it 
was loosened earlier.

11. Tighten the loop nuts securely, using a 1/4-in. open-end wrench.

12. Check the injection loop for leaks. Refer to Checking the Analyzer for Leaks later in this 
chapter. If you detect a leak, the injection loop is probably not installed properly. Repeat 
the installation and check for leaks again.

13. After you have checked for leaks, move the insulation back into position and reinstall the 
Fill/Inject valve cover.

14. Close the top panel and the lower front panel.

15. After installing a new injection loop, it is necessary to calibrate the loop. Follow the 
instructions for performing a loop calibration in Appendix J.

Then update the loop volume recorded on the Unit Configuration dialog. This dialog is 
accessed from the Unit menu.   

The smaller loops connect to the same openings in the valve, but they rest in a 
different position than the larger loop, as shown below.

Loop Retaining Nuts (Insert 
loop ends into the valve here, 
then tighten nuts.)

Loop Enclosure Ring 
(the loop is inside the 
enclosure ring.)

Loop Nut

Both the 0.5-cm3 and the 
1.0-cm3 loops are located 
in this position when 
installed on the analyzer.
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Replacing the Thermal Conductivity Detector (TCD) Assembly 

Because the filaments in the thermal conductivity detector assembly are heated to high 
temperatures and may be exposed to corrosive gases, they will eventually fail. Any of the 
following problems may indicate that the TCD filaments need to be replaced:

• A stable TCD baseline cannot be maintained.

• Data collection results in very high or very low peaks that are inconsistent with previous 
experience.

• During a data collection, no TCD signal is displayed on the main display, or the 
software indicates that no TCD signal is present.

In some instances, contamination of the thermal conductivity detector filaments will produce 
the symptoms described above. To clean the filaments, set the filament zone to 150 °C and 
flow an inert gas through the analyzer for several hours. If this action does not correct the 
problem, perform the following steps to replace the thermal conductivity detector assembly.

1. Make sure that no heat is being applied to the analyzer. If necessary, enable manual control 
and set the target temperature for the heat zones to ambient. Wait for the analyzer to cool 
down.

2. Turn instrument power switch off but do NOT disconnect the power cord from the 
analyzer.

3. Press in on the right side of the retractable handle on the top of the analyzer to protrude the 
handle. Then, using the handle, open the top panel. The top panel is hinged to allow easy 
access to its components; it is not necessary to remove the top panel.  

Pull down the upper front panel.

The power cord must remain connected to maintain an electrical ground connection 
to the analyzer.
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4. Pull the Bypass/Trap valve cover retaining plungers outward until the Bypass/Trap valve 
cover is released. Pull the cover up and out.

5. Remove the insulation from the rear of the Bypass/Trap valve and locate the TCD 
assembly (not shown).

6. Loosen all four fittings for the stainless steel tubing. Label each piece of tubing for 
reconnection.

7. Unplug the TCD assembly cable from the card cage motherboard and cut the plastic cable 
ties that retain the various cables. This frees the cables so that you can remove the TCD 
and its cable.

TCD assembly
Bypass/Trap 
valve cover

Power cord

Upper front panel

TCD block

The thermal conductivity detector assembly and nearby components may be hot. 
Make sure you allow the TCD to cool before removing it. Use the cotton gloves 
provided with the analyzer to protect your hands.
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8. Use a screwdriver to remove the two TCD mounting screws from the yoke plate. Lift the 
TCD assembly out of the analyzer.

9. Install the new TCD assembly in the analyzer. Reconnect the tubing at all four fittings and 
reconnect the cable to the card cage motherboard.

10. Reinstall the insulation in the rear of Bypass/Trap valve over the TCD assembly.

11. Reinstall the Bypass/Trap valve cover and allow the retaining plungers to snap into place.

12. Close the top panel and the upper front panel.

13. Turn the instrument power switch ON.

14. Adjust the filament temperature to 150 °C and select an inert carrier gas to flow through 
the TCD. Set the TCD Zone temperature to 110 °C.

15. Allow the TCD baseline to stabilize. You can observe the TCD reading from the 
instrument’s Status Bar. (Display the Status Bar by selecting it from the Unit menu.) 
Stabilization may take several hours.

TCD cable

Mounting plate
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Changing the Analysis Port (Sample Tube) Filter

A frit filter is used to protect the analyzer internal components from contaminants that may be 
forced out of the sample tube during an analysis. However, as the analyzer is used, the filter 
may gradually become clogged with trapped particles. If the filter does become blocked, it 
must be removed and cleaned or replaced. One indication of a clogged filter is a sample 
pressure greatly exceeding atmospheric pressure (displayed on the instrument schematic). The 
nominal sample pressure reading should be a few mmHg above atmospheric pressure.

To change the analysis port filter, follow the steps below:

1. Loosen the analysis port fittings while holding the sample tube.

2. Carefully remove the sample tube by unscrewing the retaining nuts. Be careful not to 
allow the nuts to slide down onto the curved portion of the sample tube or the tube may 
break.

3. Remove the left (smaller) sample tube fitting (it has a tube within a tube).

The sample tube and nearby components may be hot. Make sure you allow the 
sample tube to cool before removing it. Use the cotton gloves provided with the 
analyzer to protect your hands.

Sample Tube 
Retaining Fitting

Sample Tube 
Retaining Nut

O-ring

Spacer
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4. Use a small diameter probe to remove the O-ring and frit filter disk from the sample tube 
fitting.

5. Install a new (or cleaned) analysis port filter in the sample tube fitting. (Extra frit filters 
are shipped with the analyzer. Refer to Chapter 10 for ordering information.)

6. Inspect the O-ring for cracks or cuts. If the O-ring is damaged, replace it with a new O-
ring. (Extra Kalrez O-rings are shipped with the analyzer. Refer to Chapter 10 for ordering 
information.) Otherwise, clean the O-ring you removed, dry it, and place it in the sample 
tube fitting. Make sure the O-ring is securely in place.

7. Place the left sample tube fitting back into position and tighten it slightly.

8. Reinstall the right sample tube fitting and sample tube, then tighten both fittings.

Sample Tube Fitting

O-ring

Frit Filter Disk

Use only Kalrez O-rings. Kalrez is rated for both chemical and temperature suitability 
in this application. O-rings of other materials could burn, melt or decompose.
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Cleaning the Analyzer

The exterior casing of the analyzer may be cleaned using a clean cloth, dampened with 
isopropyl alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution.  

Cleaning the Vapor Generator

If the optional vapor generator is installed, it is necessary to clean it before changing the liquid 
you use in it. To clean the Vapor Generator:

1. Fill the flask with Isopropyl Alcohol (IPA).

2. Install the flask on the analyzer

3. Flow an inert gas through the Vapor Generator and analyzer for approximately 20 minutes.

Such cleaning can be performed using Manual Control. Instructions for using Manual Control 
are contained in Chapter 6.

Cleaning the Dewar

The dewar must be cleaned between uses. Empty the dewar, then rinse it with water. Make 
sure that it is dry before the next use.

Be sure to observe dewar precautions when cleaning the dewar. Refer to Precautions on page 
4-24.

Do not immerse the analyzer or the power cord in any liquids. Doing so could result 
in electrical shock to personnel or damage to the unit. 

Do not allow liquid to penetrate the casing of the analyzer. Doing so could result in 
damage to the unit. 
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Changing or Cleaning the Foam Air Filter

The air filter in the AutoChem II analyzer should be cleaned every 30 days (more frequently in 
environments with high levels of dust). If, after cleaning, you determine that the filter is 
degrading, it should be replaced.

1. Click Show instrument schematic from the Unit menu to display the instrument 
schematic. Click the Analysis valve and ensure that it is in the Prepare position. (If it is 
not, enable manual control and place it in the Prepare position.)

2. Remove the furnace, the cold trap (or delay path), the sample tube, and any other parts or 
accessories (such as the optional Vapor Generator or a dewar) from the front of the 
analyzer.

3. Remove the screws that hold the stainless steel support plate in place.

4. Hold the furnace support post and lift the support plate up and away from the analyzer.

5. Pull the filter up and out of the analyzer.

Filter

Support Plate
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6. Rinse the filter with clean water and allow it to dry completely.

7. If the filter is in good condition, place it back inside the instrument. If the filter needs to be 
replaced, obtain a new filter and place it inside the instrument.

8. Place the support plate back into position and reinstall its retaining screws.

9. Reinstall the furnace, cold trap (or delay path), sample tube, etc.

Adjusting or Replacing the Sample Thermocouple

The sample thermocouple is designed to pass either through the analysis port and into the 
sample tube or through an adjacent opening to rest along the side of the sample tube.

Because the sample thermocouple is heated to high temperatures, it will eventually fail and 
must be replaced. Two indications that the sample thermocouple may need to be replaced are 
unreasonably high sample temperature readings or erratic sample temperature readings.

To replace the thermocouple, follow the instructions for Changing the Position of the 
Thermocouple on page 4-11. Instead of moving the thermocouple from one position to the 
other, disconnect the used thermocouple from the cable that attaches it to the analyzer. Attach 
the new thermocouple to the cable and place it in the appropriate opening.

After you replace the sample thermocouple, you must calibrate it using the 
instructions in the following section.
Jul 09                                                9-17 



Maintenance Procedures AutoChem II 2920
Recalibrating the Sample Thermocouple

A complete calibration file is created specifically for each analyzer before the analyzer is 
shipped. This calibration file is installed during initial software installation (Chapter 2). You 
may need to recalibrate the sample thermocouple if you replace the thermocouple or if the 
original calibration file is corrupted or missing. 

Use the following instructions to recalibrate the sample thermocouple.

Before beginning, make sure:

• The analyzer and software are turned on.

• You are familiar with manually controlling the analyzer.

• All gas flows through the analyzer are stopped.

• All heat zones are stabilized at ambient temperature.

• The furnace is open and the sample tube is removed (the thermocouple is bare and 
exposed).

• A traceable thermocouple meter and a water bath (ambient temperature) to immerse the 
sample thermocouple are available.

1. Select Unit > Instrument Calibration; the Instrument Calibration dialog opens.

Do not attempt to calibrate anything other than the sample thermocouple without 
prior approval from a qualified Micromeritics Service Representative.
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2. Place the water bath around the thermocouple so that the lowest 25 mm (1 inch) is 
immersed in the water. Place the thermocouple meter (reference thermocouple) parallel to 
the sample thermocouple so that both thermocouples are at the same temperature.

3. After the reference thermocouple temperature stabilizes, enter its reading on the Calibrate 
dialog. To do so, click the Low Cal field, then press the space bar. The Calibrate dialog is 
displayed. Enter the value in the Low Calibration field, then click OK.

4. Remove the water bath. Move the tip of the reference thermocouple so that it touches the 
sample thermocouple tip, yet allows the furnace to be closed.

5. Use manual control of the sample furnace to set the furnace target temperature to 1000 °C. 
Use a ramp rate of 50 °C/min. (Refer to Enable Manual Control on page 6-12.)

6. Observe the instrument schematic to ensure that both the furnace temperature and sample 
temperature are increasing.

7. After the furnace and sample temperature have stabilized, read the value from the 
reference thermocouple. Enter its reading on the Calibrate dialog. To do so, click on the 
High Cal field, then press the space bar. The Calibrate dialog is displayed. Enter the value 
in the High Calibration field, then click OK.

8. Use manual control of the furnace to return its temperature to ambient.

9. On the Instrument Calibration dialog, click Accept to save the new calibration values. The 
software then displays dialogs that allow you to verify this change and make a backup 
copy of the values you are replacing. If desired, make a backup copy by clicking Yes then 
specifying a file name. 
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Recalibrating the Vapor Generator’s Heated Zones

The Vapor Generator is an option that is initially calibrated by Micromeritics personnel, either 
at the factory or on-site during installation. If the factory values become corrupted for any 
reason, use the following instructions to recalibrate the Vapor Generator’s heated zones. This 
process consists of taking temperature readings of the three heat zones (valve, flask, and 
reflux) at ambient, then near the maximum temperature allowed. These temperature readings 
are entered in the software and the Vapor Generator is calibrated automatically. 

Before beginning, make sure:

• The analyzer and software are turned on.

• You are familiar with manually controlling the analyzer.

• All heat zones to be calibrated are stabilized at ambient temperature.

• A traceable thermocouple meter is available.

• The flask is filled with water and installed on the port.

• The heating mantle is in place (but it may be unzipped) and the connector is plugged in.

1. Select Unit > Vapor Generator Calibration; the Calibrate Vapor Generator dialog is 
displayed. (In this example, the default values are shown, not the calibrated values.)

Do not attempt to calibrate the Vapor Generator unless you are specifically 
instructed to do so by a Micromeritics Service Representative.
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2. Press in on the right side of the retractable handle on the top of the analyzer to protrude the 
handle. Then, using the handle, open the top panel. The top panel is hinged to allow easy 
access to its components; it is not necessary to remove the top panel. 

Pull down the upper front panel.

3. Take the ambient temperature readings for the three zones as instructed below. For each 
zone, enter the ambient temperature reading in the Calibrate dialog. To do so, click on the 
Low Cal field, then press the space bar. The Calibrate dialog is displayed. Enter the value 
in the Low Calibration field, then click OK. Repeat for each zone.

a. Valve zone: Place the thermocouple probe into the small hole in the valve cover. After 
the thermocouple meter reading stabilizes, enter it in the Calibrate dialog. 

b. Reflux zone: Remove the valve cover. The RTD probe is located directly above the 
reflux zone and in front of the valve. It is held in place by a nut and ferrule. Before 
removing the probe, you must measure it or mark it so that you can place it back at the 
same height. Remove the probe, immerse the RTD probe and thermocouple probe in 
cold water. When the temperature reading stabilizes, enter it enter it in the Calibrate 
dialog.

c. Flask zone: place the thermocouple probe next to the Resistance Temperature Device 
(RTD), which is located on the floor of the heating mantle. Zip the mantle closed to 
hold the probe in place. When the thermocouple meter reading has stabilized, enter it in 
the Calibrate dialog.

For viewing purposes only, 
this illustration shows the top 
panel entirely removed. It is 
not necessary for you to 
remove the panel.

Vapor Generator 
Valve Cover
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4. The reflux zone probe must be calibrated at a high temperature, around 70 to 100 °C. Use 
hot water or another heat source to heat the reflux zone probe and the reference 
thermocouple probe simultaneously. When the temperature stabilizes, record the 
temperature from the reference thermocouple meter. On the Calibrate dialog, enter the 
new High Calibration value for the reflux zone. Click OK.

5. Reinstall the reflux zone probe. Replace the Vapor Generator valve cover.

6. Use manual control to set the target temperature for each of the other Vapor Generator heat 
zones. (For complete instructions on using manual control, see Chapter 6.)

• Set the valve zone at 110 °C.
• Set the flask zone at 90 °C.
• Set the reflux zone at 80 °C, although it needs no further calibration.

Install the flask, 
filled with water. 
Zip the heating 
mantle and plug in 
the connector.
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7. Insert the reference thermocouple into the small access hole in the valve cover.

8. Observe the detail box on the instrument schematic (shown above) to ensure that the 
temperature of each zone is increasing.

9. After the temperature of each zone has stabilized, read the value from the reference 
thermocouple probe, using the locations described earlier. Enter these readings on the 
Calibrate dialog in the High Calibration fields. To do so, click on one of the High Cal 
fields, then press the space bar. The Calibrate dialog is displayed. Enter the value, then 
click OK. Repeat for each zone.

10. Use manual control to return the zone temperatures to ambient. Replace the valve cover.

11. On the Calibrate Vapor Generator dialog, click Accept to save the new calibration values. 
The software then displays dialogs that allow you to verify this change and make a backup 
copy of the values you are replacing. If desired, make a backup copy by clicking Yes then 
specifying a file name. 

12. Replace the analyzer’s top panel.

Vapor Valve 
Zone

Vapor Reflux 
Zone

Vapor Flask 
Zone

Detail Box

Click on a zone, 
then observe its 
temperature here.
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Performing a Leak Test

Set Up

1. Select Unit > Enable Manual Mode, then select Unit > Show Instrument Schematic.

2. Set all heat zones to ambient temperature.

3. Set all four Flow Controllers to 50 cm3/min.

4. Allow the analyzer to cool to room temperature.

Preparation Gas Path Tests

1. Right-click the analysis valve and choose Analyze.

2. Right-click the Prep. valves and select Flow Gas [n] (He).

3. Plug the preparation gas exhaust outlet.

4. Observe the Preparation Gas Flow Controller reading as it slowly drops to zero.

Loop Gas 
Flow Controller

Reference Gas 
Flow Controller

Carrier Gas 
Flow Controller

Preparation Gas 
Flow controller

Heat Zones

This test must be done in the order detailed in this document to test fully the 
AutoChem. Any flow reading other than zero indicates a leak in the gas flow path 
being tested.
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A flow reading of zero indicates the flow path between the Preparation Gas Flow 
Controller and the preparation exhaust does not leak.

This tests all fitting connections in the gas flow path and part of the analysis valve.

5. Any flow reading other than zero indicates a leak in the gas flow path being tested.

6. To fix a leak that may be indicated on the Preparation Gas Flow Controller, tighten the 
fittings in the gas flow path and observe the reading for any decrease that would indicate 
that the leak has stopped.

7. Right-click the Preparation Gas Flow Controller and choose Stop Flow. This will close the 
helium valve.

8. Remove the plug from the preparation gas exhaust outlet.

Reference Gas Path Tests

1. Valve positions need not be preset for this test.

2. Right-click the Carrier valves and choose Flow Gas [n] (He) through the Reference Gas 
Flow Controller.

3. Plug the reference gas exhaust outlet.

4. Observe the Reference Gas Flow Controller reading as it slowly drops to zero.

5. A flow reading of zero indicates the flow path between the Reference Gas Flow Controller 
and the reference gas exhaust does not leak.

This tests all fitting connections in the gas flow path and the reference side of the thermal 
conductivity detector.

Any flow reading other than zero indicates a leak in the gas flow path being tested.

6. Right-click the Reference Gas Flow Controller and select Stop Flow. This will close the 
helium valve.

7. Remove the plug from the reference gas exhaust outlet plug in place.

Any leak detected in the remaining steps of this procedure may be fixed by using the 
same process mentioned in Step 6.
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Carrier Gas Path Tests

1. Right-click the Cold Trap Valve and select Bypass.

2. Right-click the Analysis Valve and select Prepare.

3. Right-click the Loop Valve and select Fill.

4. Turn the pressure control knob on the helium gas regulator to deliver less than 5 psi.

5. Right-click the Carrier Valves and choose Flow Gas [n] (He).

6. Plug the analysis gas exhaust outlet.

7. Right-click on Calibration Valve B and select Close Valve, then repeat the step for 
Calibration Valve C.

8. Observe the Carrier Gas Flow Controller reading as it slowly drops to zero.

9. A flow reading of zero indicates the flow path between the Carrier Gas Flow Controller 
and Calibration Valve B does not leak.

10. Right-click Calibration Valve B and select Open Valve.

11. Observe the Carrier Gas Flow Controller reading as it slowly drops to zero or remains at 
zero from the previous test.

A flow reading of zero indicates the flow path between the carrier MFC and the carrier 
exhaust outlet does not leak.

This tests all fitting connections in the gas flow path and part of the analysis valve, part of 
the bypass valve, the transducer, the septum, part of the inject valve, and the analysis side 
of the thermal conductivity detector.

12. Right-click the Loop Valve and select Inject.

13. Observe the Carrier Gas Flow Controller reading as it slowly drops to zero or remains at 
zero from the previous test.

A flow reading of zero indicates the flow path between the Carrier Gas Flow Controller 
and the carrier gas exhaust outlet does not leak.

This tests all fitting connections in the gas flow path, the remaining parts of the Loop 
Valve, and the loop.

14. Install an empty sample tube on the sample port.

15. Right-click the Analysis Valve and select Analyze.
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16. Observe the Carrier Gas Flow Controller reading as it slowly drops to zero or remains at 
zero from the previous test.

A flow reading of zero indicates the flow path between the Carrier Gas Flow Controller 
and the carrier gas exhaust outlet does not leak.

This tests all fitting connections in the gas flow path, the sample tube, and the remaining 
parts of the Analysis Valve.

17. Install a cold trap (or a delay path) on the cold trap port.

18. Right-click the Cold Trap Valve and select Trap.

19. Observe the Carrier Gas Flow Controller reading as it slowly drops to zero or remains at 
zero from the previous test.

A flow reading of zero indicates the flow path between the Carrier Gas Flow Controller 
and the carrier gas exhaust outlet does not leak.

This tests all fitting connections in the gas flow path, the remaining parts of the Cold Trap 
Valve, and the cold trap.

20. Right-click the Carrier Valves and select Stop Flow. This will close the helium valve.

21. Remove the plug from the analysis exhaust outlet.

22. Reset the pressure on the Helium gas regulator to its original pressure.

Vapor Generator (If installed) Gas Path Tests 

1. Right-click the Loop Valve and select Inject.

2. Right-click the Vapor Valve and select Bypass.

3. Right-click Calibration Valve C and select Close Valve, then repeat the step for 
Calibration Valve D.

4. Plug the loop gas exhaust outlet.

5. Plug the vapor generator gas exhaust outlet.

6. Right-click the Loop Gas Valves and choose Flow Gas [n] (He) (or other appropriate gas) 
through the Loop Gas Flow Controller.

7. Observe the Loop Gas Flow Controller reading as it slowly drops to zero.

A flow reading of zero indicates the flow path between the Loop Gas Flow Controller and 
Calibration Valves C and D does not leak.

This tests all fitting connections in the small section of the gas flow path to Calibration 
Valves C and D.
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8. Right-click Calibration Valve D and select Open Valve.

9. Observe the Loop Gas Flow Controller reading as it slowly drops to zero or remains at 
zero from the previous test.

A flow reading of zero indicates the flow path between the Loop Gas Flow Controller and 
the loop gas exhaust outlet does not leak.

This tests all fitting connections in the gas flow path, portions of the vapor generator 
valve, and the tubing up to the inject valve.

10. Install an empty flask onto the vapor generator port.

11. Right-click the Vapor Valve and select Vapor.

12. Observe the Loop Gas Flow Controller reading as it slowly drops to zero or remains at 
zero from the previous test.

A flow reading of zero indicates the flow path between the Loop Gas Flow Controller and 
the loop gas exhaust does not leak.

This tests all fitting connections in the gas flow path, the remaining portions of the vapor 
generator valve, and the relief valve in the vapor generator.

13. Right-click the Loop Gas Flow Controller and select Stop Flow. This will close the gas 
valve. 

14. Remove all exhaust plugs.

Loop Gas Path Tests (Vapor Generator not installed)

1. Right-click the Vapor Valve and select Inject.

2. Right-click Calibration Valve C and select Close Valve, then repeat the step for 
Calibration Valve D.

3. Plug the loop gas exhaust outlet.

4. Right-click the Loop Gas Valves and choose Flow Gas [n] (He) (or other appropriate gas) 
through the Loop Gas Flow Controller.

5. Observe the Loop Gas Flow Controller reading as it slowly drops to zero. 

A flow reading of zero indicates the flow path between the Loop Gas Flow Controller and 
Calibration Valves C and D does not leak.

This tests all fitting connections in the small section of the gas flow path to Calibration 
Valves C and D.

6. Right-click Calibration Valve D and select Open Valve.
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7. Observe the Loop Gas flow Controller reading as it slowly drops to zero or remains at zero 
from the previous test.

A flow reading of zero indicates the flow path between the Loop Gas Flow Controller and 
the loop gas exhaust outlet does not leak.

This tests all fitting connections in the gas flow path, Calibration Valves C and D, and the 
tubing to the Loop Valve.
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10. ORDERING INFORMATION

The AutoChem II 2920 Analyzer components and accessories can be ordered by:

• Telephone: 770/662-3636
• Email: customer.service@micromeritics.com
• Internet: www.micromeritics.com

When ordering, please use the information provided below.

Part Number Item and Description

292-42803-00 Operator’s Manual, AutoChem II 2920 Analyzer

008-42001-00 Analytical Methods in Fine Particle Technology, a comprehensive 
resource of information on particle analysis. This hardbound text 
describes theory, instrumentation, and applications pertaining to 
chemisorption and temperature-programmed reactions, as well as other 
analytical methods used in the characterization of catalysts and other 
materials.

291-34005-00 KwikCool; provides rapid cooling of the furnace, decreasing analysis 
time and increasing throughput.

291-34012-00 Vapor Generator; allows a carrier gas to take vapor generated from liquid 
at up to 100 ºC

291-33005-00 CryoCooler; allows furnace system to hold sample at approximately -120 
°C, then ramp upwards. Includes benchtop dewar. 

021-00000-00 Model 021 LN2 transfer system, for easy filling of sample dewars; 
includes 47-L Dewar, mobile platform, and pump with 100-cm discharge 
line

291-25911-00 Cold trap assembly, stainless steel 

290-25845-00 Delay path assembly (for BET analysis), copper

290-25846-00 Gas inlet line assembly; includes copper tubing, with ferrules and nuts 
(1/8-in. male fitting to connect to analyzer on one end, 1/8-in. female 
fitting to connect to regulator on opposite end), 6 ft (1.8 m) in length  

290-25446-01 Same as 290-42846-00, except 16 ft (5 m) in length

201-25818-00 Gas inlet line assembly; includes stainless steel tubing, with ferrules and 
nuts (1/8-in. male fitting to connect to analyzer on one end, 1/8-in. 
female fitting to connect to regulator on opposite end), 6 ft (1.8 m) in 
length

201-25818-01 Same as 201-25818-00, except 16 ft (5 m) in length
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Part Number Item and Description

930-54603-00 Brush, narrow; for cleaning sample tubes  

004-54609-00 Brush, wide; for cleaning sample tubes

291-31801-00 Cover, half, for cold trap dewar. (Two needed per dewar.)

004-61064-00 Dewar, 600 cm3

004-62102-00 Rotor for 6-port rotary valves

004/25940/00 Ferrule, one piece, 1/8-in. PEEK, for the quartz thermocouple sheath, 
which mounts through a 1/8-in. fitting

004/25938/00 Ferrule, one piece, 1/16-in. ID, for mounting the sample thermocouple in 
the same 1/8-in. fitting as the quartz thermocouple sheath

004-25913-00 Ferrule Set (front and rear), 1/8 in., PEEK polymer

291-25815-00 Ferrule, for sample tube, 6 mm

291-25818-00 Ferrule, for sample tube, 12 mm

004-27041-00 Filter Disk, fritted, 20 µm SS, 1/4-in. diameter x 1/16-in. thick, for 
sample exhaust port

290-29800-00 Flowmeter, bubble, 10 cm3 

004-16247-00 Fluid, gas bubble

004-32187-00 Gloves, cotton flannel, pair

290-62600-00 Injection loop, 0.5 cm3 nominal, stainless steel 

290-62601-00 Injection loop, 1.0 cm3 nominal, stainless steel 

290-62602-00 Injection loop, 5.0 cm3 nominal, stainless steel, silver-solder joints in 
loop

004-25678-00 O-ring, -009 KalrezTM, for sample tube outlet side

004-25465-00 O-ring, -010 Kalrez, for sample port

004-25474-00 O-ring, -013 Kalrez, for sample tube inlet

004-32164-01 Quartz Wool, 4-in. x 6-in. bag

004-25549-00 Reducer, 1/8 in. tube x 1/4 in. tube, for regulators

004-16836-00 Reference Material, silver oxide

290-25842-00 Septum, external gas-sampling assembly

280-32800-00 Support, sample weighing

004-61602-00 Syringe, 1 cm3
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Part Number Item and Description

004-61604-00 Syringe, 10 cm3

004-61606-00 Syringe, 0.1 cm3

291-53904-00 Thermocouple, sample, pre-shaped for analyzer

291-61702-00 Sample tube, quartz

004-32004-00 Stopper for sample tube inlet

004-32604-08 Cap, plastic, for sample tube exhaust

292-32801-00 Protective shelf mat

004-62230-32 Gas regulator, 2-stage, CGA 320 fitting, 30 psig (CO2)

004-62230-35 Gas regulator, 2-stage, CGA 350 fitting, 30 psig (CO, H2)

004-62230-54 Gas regulator, 2-stage, CGA 540 fitting, 30 psig (O2)

004-62230-58 Gas regulator, 2-stage, CGA 580 fitting, 30 psig (N2,He, Ar. Kr)

004-62230-59 Gas regulator, 2-stage, CGA 590 fitting, 30 psig (ultrapure air)

004-62200-58 Gas regulator, 2-stage, CGA 580 fitting, 100 psig (N2, He, Ar, Kr)

004-33601-00 Expansion Kit; adds an additional outlet to the gas regulator (includes 
fittings and instructions)

004-54805-00 Extraction Tool, for inserting quartz wool into or for removing from 
sample tubes
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Determining the Sample Mass

Complete instructions for determining the mass of your sample and loading it into the sample tube are 
located in Chapter 4 beginning on page 4-10. This worksheet provides a format for recording the values 
necessary to calculate the sample’s mass. A space is also provided for recording the sample mass after 
analysis.

Some operators prefer to use the sample’s mass after the analysis; this is particularly desirable when a sig-
nificant amount of sample preparation occurs in situ during the analysis. If you want the after-analysis 
value for the mass to be used in calculations, determine the after analysis sample mass, then open the 
sample information file and enter the after analysis mass in the Sample mass field before editing or report-
ing data for the analysis.

In some cases, the difference in the sample’s mass recorded after the analysis versus that recorded before 
the analysis may be significant in assessing the results.

Sample identification:____________________________________________

________

1 Empty sample tube mass (including quartz wool and stoppers): ________

2 Sample tube plus sample mass: ________

3 Sample mass (Step 2 - Step 1): ________

4 Sample tube plus sample mass after analysis (optional): ________

5 Sample mass after analysis (Step 4 - Step 1) (optional) ________
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Manual Injections

When a series of manual injections is performed, it may be useful to list the planned injection volumes, 
then check each one off immediately after it is performed.

Injection Volume
Check when 
completed Comments

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

13.

14. 

15.

16.

17.

18.

19.

20.
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Current Gas Connections

Use this form to record the gases currently connected to the analyzer. You may wish to post the completed 
form on or near the analyzer.

This form may help you make sure that the correct gas for each port is identified in the software. Com-
plete the form, then open the Gas Selections dialog from the Unit menu. Verify that the correct gas is 
selected for each port. If you are using the optional Gas Blender, you can also record the gases connected 
to each blender port.

Unit number (S/N): ___________________________________

Date: _______________________________________________

Operator: ___________________________________________

Preparation Gas Carrier/Reference Gas Loop Gas
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B.  CALCULATIONS

Volume at STP

Volume at standard reduction of gas data to Standard Temperature Pressure (STP) conditions 
(273.13K and 760 mmHg).

VSTP = Volume at STP, cm3

Va = Volume at ambient temperature and pressure, cm3

Ta = Ambient temperature, °C
Pa = Ambient pressure, mmHg

Injection Loop Calibration

These equations are used during calibration of a dose loop

VSSTP = Volume of syringe at STP, cm3

VS = Physical volume of syringe, cm3

Ta = Ambient temperature, °C
Pa = Ambient pressure, mmHg
Vl = Effective loop volume (at loop temperature), cm3

Al = Average peak area of loop injections
AS = Average peak area of syringe injections

VSTP Va
273.15

273.15 Ta+
----------------------------⎝ ⎠
⎛ ⎞ Pa

760 mmHg
----------------------------⎝ ⎠
⎛ ⎞×=

VSSTP
VS

273.15
273.15 Ta+
----------------------------⎝ ⎠
⎛ ⎞ Pa

760 mmHg
----------------------------⎝ ⎠
⎛ ⎞×=

Vl
Al VSSTP
×
AS

----------------------⎝ ⎠
⎛ ⎞=
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Injection Loop Volume – Temperature Change

This equation is used to correct the apparent loop volume when the temperature of the loop 
heat zone is changed.

Vn = New Effective Loop Volume, cm3

Vo = Old Loop Volume, cm3

To = Old Loop Temperature, °C
Tn = New Loop Temperature, °C

Calibration Error (Goodness of Fit)

This equation is a means to determine whether the calibration curve is acceptable.

E% = Percent error
Qm = Quantity measured
Qc = Quantity calculated
N = Number of measurements

Percent Dispersion

This equation is used in a Pulse Chemisorption analysis to calculate the percent dispersion. 
Some understanding of the chemistry is required to select the proper stoichiometric factor and 
gram molecular weight.

PD = Percent dispersion
Vs = Volume sorbed (cm3 at STP)
SFcalc = Calculated stoichiometry factor
SW = Sample weight (g)
GMWcalc = Gram Molecular Weight (g/g-mole)

Vn Vo
To 273.15+
Tn 273.15+
----------------------------⎝ ⎠
⎛ ⎞=

E%
Qmi

Qci
–( ) 2

N 1–( )
----------------------------

i 0=

N

∑=

1
2
---

PD 100
VS SFcalc×

SW 22414×
-----------------------------⎝ ⎠
⎛ ⎞GMWcalc=
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BET Surface Area

For each included point i, relative pressure P/Poi and specific volume adsorbed VSTPi are cal-
culated for a single point BET. Then the BET transformation Bi is calculated:

where Bi is in units of g/cm3 STP.

A linear least squares fit is performed on the (Bi, P/Poi) paris where Bi is the dependent vari-
able and P/Poi is the independent variable. The following are calculated:

Slope, S, g/cm3 STP
Y-intercept, YINT, g/cm3 STP
Error of the slope, SERR, g/cm3 STP
Error of the y-intercept, YIERR g/cm3 STP
Correlation coefficient, CC

Using the results of the above calculations, the following are calculated:

BET Surface Area (SABET m2/g):

CSA = adsorbate molecular cross-sectional area (nm2)

BET C value:

Volume of monolayer (cm3/g STP):

Bi

P
Poi
--------

1 P
Poi
--------–⎝ ⎠

⎛ ⎞  VSTPi

-------------------------------------=

SABET
CSA 6.023 1023×( )×

22414 cm3 STP( ) 1018 nm2/m2( ) S YINT+( )××
---------------------------------------------------------------------------------------------------------------------=

C S YINT+
YINT

-------------------=

VM
1

C YINT×
-------------------- 1

S YINT+
-------------------= =
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Error of the BET Surface Area (m2/g):

Langmuir Surface Area

For each included point i, pressure Pi and specific volume adsorbed VSTPi are calculated as 
for a single point BET. Then the Langmuir transformation Li is calculated:

where Li is in units of g/cm3 STP.

A linear least squares fit is performed on the (Li, P) pairs where Li is the dependent variable 
and P is the independent variable. The following are calculated:

Slope, S, g/cm3 STP
Y-intercept, YINT, g/cm3 STP
Error of the slope, SERR, g/cm3 STP
Error of the y-intercept, YIERR g/cm3 STP
Correlation coefficient, CC

Using the results of the above calculations, the following are calculated:

Langmuir Surface Area (SALAN m2/g):

Volume of monolayer (cm3/g STP):

BETERR
SABET SERR 2 YIERR 2+( )

0.5
×

YINT S+
---------------------------------------------------------------------=

Li
Pi

VSTPi

-----------=

SALAN
CSA 6.023 1023×( )×

22414 cm3 STP( ) 1018 nm2/m2( ) S××
-----------------------------------------------------------------------------------------------=

VM
1
S
---=
B-4                                                    May 06
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Langmuir b value:

Error of the Langmuir Surface Area (m2/g):

Total Pore Volume

Total pore volume VPOR at a selected physisorption point is calculated:

DCF = adsorbate density conversion factor

Volume Sorbed

This equation is for loop or syringe injections to calculate volume removed from the injec-
tions by the sample.

Vs = Volume sorbed, cm3

N = Number of injections
Vi = Volume per injection, cm3

Vna = Total volume not sorbed, cm3

Peak Area Volume

This is the basic data reduction equation. It converts the area under a peak to cm3 of gas.

Vpa = Peak area volume, cm3

Ap = Peak area
Fc = Calibration factor

b YINT( )  VM( )=

LANERR
SALAN SERR×

S
-------------------------------=

VPOR VSTP( ) DCF( )=

VS NVi Vna–=

Vpa Ap Fc×=
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Stoichiometry Factor

The calculated stoichiometry factor is a weighted average. It is dependent on both the indi-
vidual stoichiometry factor and number of moles of each active metal.

SFcalc = Calculated stoichiometry factor
SFN = Stoichiometry factor for metal N
F1 = Fraction of sample weight for metal N
Watomic1 = Gram molecular weight of first metal (g/g-mole)
GMWcalc = Gram molecular weight (g/g-mole)

Gram Molecular Weight

The calculated Gram Molecular Weight is a weighted average of the number of moles of each 
active metal.

GMWcalc = Gram molecular weight (g/g-mole)
FN = Fraction of sample weight for metal N
WatomicN = Gram Molecular Weight of first metal (g/g-mole)

Cross-Sectional Area

SAcalc = Calculated cross-sectional area
FN = Fraction of sample weight for metal N
SAN = Cross-sectional area for metal N
WatomicN = Gram molecular weight of first metal (g/g-mole)

SFcalc
F1 SF1×
Watomic1
---------------------⎝ ⎠
⎛ ⎞ F2 SF2×

Watomic2
---------------------⎝ ⎠
⎛ ⎞ …

FN SFN×
WatomicN
----------------------⎝ ⎠
⎛ ⎞+ + + GMWcalc⋅=

GMWcalc
1

F1

Watomic1
-------------------⎝ ⎠
⎛ ⎞ F2

Watomic2
-------------------⎝ ⎠
⎛ ⎞ …

FN

WatomicN
-------------------+ + +

-----------------------------------------------------------------------------------------------=

SAcalc
F1 SA1×
Watomic1
---------------------⎝ ⎠
⎛ ⎞ F2 SA2×

Watomic2
---------------------⎝ ⎠
⎛ ⎞ …

FN SAN×
WatomicN
----------------------⎝ ⎠
⎛ ⎞+ + + GMWcalc⋅=
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Metal Density

Dcalc = Calculated density
FN = Fraction of sample weight for metal N
DN = Density for metal N
WatomicN = Gram Molecular Weight of first metal (g/g-mole)

Metallic Surface Area

This equation calculates the effective metallic surface area per gram of sample.

SAMetallic = Metallic surface area (m2/g of metal)
Vs = Volume sorbed (cm3 at STP)
SFcalc = Calculated stoichiometry factor
SAcalc = Calculated specific surface area
SW = Sample weight (g)

Active Particle Size

This equation calculates the active particle size.

APS = Active particle size
Dcalc = Calculated metal density (g/cm3)
Ws = Sample weight, g
GMWcalc = Gram molecular weight (g/g-mole)
SAcalc = Calculated specific surface area (per gram of metal)

Dcalc
F1 D1×
Watomic1
-------------------⎝ ⎠
⎛ ⎞ F2 D2×

Watomic2
-------------------⎝ ⎠
⎛ ⎞ …

FN DN×
WatomicN
-------------------⎝ ⎠
⎛ ⎞+ + + GMWcalc⋅=

SAMetallic
VS

SW 22414×
-----------------------------⎝ ⎠
⎛ ⎞ SFcalc( )× 6.123 1023×( )× SAcalc( )×=

APS 6

Dcalc( )
WS

GMWcalc
----------------------⎝ ⎠
⎛ ⎞× 6.023 1023×( ) SAcalc( )××

---------------------------------------------------------------------------------------------------------------------=
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First Order Kinetics

This series of steps calculates the First Order Kinetics (Heat of Desorption). At least two 
experiments must be run — commonly 3 experiments are run. The ramp rate must be differ-
ent for each run. The data are plotted and the slope determined.

The general equation is:

Determine the slope s by plotting 2 ln Tp - ln β vs.   then determine Ed using:

β = Ramp rate, degrees/min
Ed = Heat of desorption, K joules/(mole K)
R = Gas constant
Tp = Temperature at peak max
s = Slope
A = The quantity adsorbed at saturation
C = A constant related to the desorption rate

β
Tp 2
---------⎝ ⎠
⎛ ⎞ln Ed

RTp
---------–

EdA
RC
---------⎝ ⎠
⎛ ⎞ln+=

1
Tp
-----

Ed s R×=
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Vapor Generator

The partial pressure of the vapor is estimated using the Antoine equation:

pv = Partial pressure of vapor at reflux temperature in mmHg
A = Antoine coefficient A
B = Antoine coefficient B
C = Antoine coefficient C
T = Temperature in Kelvin

The following references contain Antoine constants:

• R. Reid et.al., The Properties of Gases and Liquids, McGraw-Hill (1987)
• J. Dean, Lange’s Handbook of Chemistry, McGraw-Hill (1999)

Use the appropriate format of the Antoine equation as given by R. Reid or J. Dean. Some 
authors prefer to use temperature in Celsius rather than Kelvin and, similarly, log10 (Pv) rather 
than ln(Pv).

The fraction of vapor can then be calculated using:

yv = Fraction of vapor at the reflux temperature
P = Ambient pressure

The volume of vapor for each peak in the vapor calibration is determined from:

Vv = Vapor volume at reflux temperature
Vl = Loop volume at STP
tv = Reflux temperature in °C

pvln A B
T C+
-------------–=

yv
Pv

P
-----=

Vv Yv Vl
273.15

tv 273.15+
--------------------------××=
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C.  GAS INFORMATION

Table C-1. Relative Thermal Conductivity of Gases

Name Chemical Formula Conductivity (Relative to Air)
Air 1.00
Ammonia NH3 0.92
Argon Ar 0.68
Butane C4H10 0.60
Carbon Dioxide CO2 0.62
Carbon Monoxide CO 0.97
Ethane C2H6 0.79
Helium He 5.84
Hydrogen H2 7.07
Krypton Kr 0.37
Methane CH4 1.29
Neon Ne 1.87
Nitric Oxide NO 0.99
Nitrogen N2 1.00
Nitrogen Dioxide NO2 or N2O4 1.51
Nitrous Oxide N2O 0.65
Oxygen O2 1.02
Sulfur Dioxide SO2 0.38
Water Vapor H2O 0.67
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Table C-2. Typical Gases Used with the AutoChem 2920 Analyzer

Test Gases Flow Rate 
(cm3/min)

Other
Preparation Carrier Loop

TPR Experiment Argon 10% H2 in 
Argon

N/A 50

Calibration N/A 10% H2 in 
Argon

Argon 50 TCD Level 
Calibration

TPD Ammonia Helium or
15% NH3 in 
Helium

Helium N/A 50

Calibration N/A Helium NH3 in Helium 50 TCD Level 
Calibration

TPD Pyridine Helium Helium Helium 50 Pyridine in Vapor 
Generator

Calibration N/A Helium Helium 50 User-Defined 
Pyridine in Vapor 
Generator

TPD Hydrogen 10% H2 in 
Argon

Argon N/A 50 Calibration

Calibration N/A Argon 10% H2 in 
Argon

50 TCD Level 
Calibration

TPD Oxygen 10% O2 in 
Helium

Helium N/A 50

Calibration N/A Helium 10% O2 in 
Helium

50 TCD Level 
Calibration

TPO Experiment Helium 10% O2 in 
Helium

N/A 50

Calibration N/A 10% O2 in 
Helium

Helium 50 TCD Level 
Calibration

H2 Pulse 
Chemisorption

10% H2 in 
Argon

Argon 10% H2 in 
Argon

50

CO Pulse 
Chemisorption

10% H2 in 
Argon

Helium 10% CO in 
Helium

50

Calibration Not required
BET Surface Area Helium 30% N2 in 

Helium
N/A 50

Calibration N/A 30% N2 in 
Helium

N/A 50 User-Defined 
Manual injections 
of N2 (0.5, 1.0, 1.5, 
and 2.0 cm3)
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Table C-3. Conversion Constants for the Mass Flow Controllers (MFCs)

Gas Symbol MFC Conversion Constant 
(H2 = 1.000)

Acetylene C2H2 0.6535
Air (mixture) 0.9901
Allene C3H4 0.4752
Ammonia NH3 0.7822
Argon Ar 1.3861
Arsine A5H3 0.7525
Boron Trichloride BCl3 0.4356
Boron Trifluoride BF3 0.5743
Bromine Pentafluoride BrF5 0.2871
Bromine Trifluoride BrF3 0.4356
Butane C4H10 0.2871
Butene C4H8 0.3267
Carbon Dioxide CO2 0.7723
Carbon Monoxide CO 0.9802
Carbon Tetracloride CCl4 0.3465
Carbon Tetrafluoride CF4 0.4752
Carbonyl Fluoride COF2 0.2673
Carbonyl Sulfide COS 0.6733
Chlorine Cl2 0.8218
Chloroform CHCl3 0.4356
Chlorine Trifluoride ClF3 0.4257
Cyanogen C2N2 0.4950
Cyclopropane C3H6 0.5050
Deuterium D2 0.9901
Diborane B2H6 0.5446
Dichlorosilane SiH2Cl2 0.4356
Dimethylamine (CH3)2NH 0.6634
Dimethylether (CH3)2O 0.5842
Ethane C2H6 0.5446
Ethyl Chloride C2H5Cl 0.2871
Ethylene C2H4 0.6139
Ethylene Oxide C2H4O 0.5842
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Gas Symbol MFC Conversion Constant 
(H2 = 1.000)

Fluorine F2 0.9208
Fluroform CHF3 0.5644
Freon 11 CCl3F 0.3762
Freon 12 CCl3F2 0.3861
Freon 13 CClF3 0.4257
Freon 13 B1 CBrF3 0.4059
Freon 14 CF4 0.4703
Freon 21 CHCl2F 0.4554
Freon 22 CHClF2 0.5050
Freon 23 CHF3 0.5644
Freon 113 CCl2F-CClF2 0.2277
Freon 114 CCl2F4-CClF2 0.2554
Freon 115 CClF2-CF3 0.2713
Freon 116 CF3-CF3 0.2277
Germane GeH4 0.6436
Helium He 1.3762
Hexamethyldisizane HMDS 0.1386
Hydrogen H2 1.0000
Hydrogen Bromide HBr 0.9703
Hydrogen Chloride (Dry) HCl 0.9802
Hydrogen Fluoride HF 0.9901
Hydrogen Iodide HI 0.9505
Hydrogen Selenide H2Se 0.8317
Hydrogen Sulfide H2S 0.8416
Isobutane C4H10 0.3069
Isobutylene C4H8 0.3366
Krypton Kr 1.3762
Methane CH4 0.8020
Methylamine CH3NH2 0.5644
Methyl Bromide CH3Br 0.6436
Methyl Chloride CH3Cl 0.6832
Methyl Fluoride CH3F 0.7525
Methyl Mercaptan CH4S 0.5842
Neon Ne 1.3861
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Gas Symbol MFC Conversion Constant 
(H2 = 1.000)

Nitric Oxide NO 0.9901
Nitrogen N2 0.9950
Nitrogen Dioxide NO2 0.7525
Nitrogen Trioxide N2O3 0.4356
Nitrogen Trifluoride NF3 0.5446
Nitrous Oxide N2O 0.7426
Oxygen O2 0.9802
Ozone O3 0.7327
Pentaborane B5Hg 0.2871
n Pentane C5H12 0.2376
Perchloryl Fluoride ClO3F 0.4455
Phosgene COCl2 0.5050
Phosphine PH3 0.7822
Phosphorous Pentafluoride PF5 0.3465
Propane C3H8 0.3861
Propylene (Propene) C3H6 0.4653
Silane SiH4 0.6733
Silicon Tetrachloride SiCl4 0.3168
Silicon Tetrafluoride SiF4 0.3960
Sulfur Dioxide SO2 0.7228
Sulfur Hexafluoride SF6 0.2970
Trichlorosilane SiCHl3 0.3267
Trimethylamine (CH3)3N 0.3168
Tungsten Hexafluoride WF6 0.2871
Uranium Hexafluoride UF6 0.2178
Vinyl Bromide C2H3Br 0.5248
Vinyl Chloride C2H3Cl 0.5347
Vinyl Fluoride C2H3F 0.5743
Xenon Xe 1.3762
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D.  FORMAT OF EXPORTED DATA

Data collected using the AutoChem II 2920 analyzer can be exported to a file for use in other 
applications. Data may be exported as an ASCII or Grams/32 (a peak-editing program used in 
earlier versions of the AutoChem application) format. Instructions for exporting data are 
contained in Chapter 4. 

ASCII Format

Data are exported in the following format when ASCII is chosen as the export type:

Header:

<sample id>
<operator>
<submitter>
<sample mass>
<instrument serial number>
<ambient temperature>
<ambient pressure>
<Po of adsorbate>

After the Header is exported, the remaining data are determined by whether Peak Summaries 
or Measurements was specified in the report options set.

• For Peak Summaries, the peaks for each selected experiment in the file are 
summarized. Data are exported as follows:

<experiment number>, <start time (minutes)>, <stop time (minutes)>
    
• For Each Peak:

<experiment type>, <start time (minutes)>, <stop time (minutes)>,
   <temperature at maximum (°C)>, <area>

   <experiment type> is one of the following: TPD", :TPR", "TPO", "Physisorption",
    "Chemisorption", "Level Cal.", "Vapor Cal.", "Loop Cal.", "Other"

• For Measurements, the data points for each checked experiment in the file are 
reported. Data are exported as follows:

<experiment number>, <start time (minutes)>, <stop time (minutes)>
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For Each Point:
   <time (minutes)>, <temperature  (°C)>, <TCD signal>, <event flag>, <input

 signal 1>, <Input signal 2>

The TCD signal may be either calibrated or not calibrated based upon the 
selections made when the export operation was performed.

The event flag is either 1 or 0. The state of the event flag switches when a pulse 
chemisorption dose is started.

Grams/32

When Grams/32 is chosen as the export type, five files are created for each experiment 
selected for export. The data in these files can be read only by the Grams/32 software. Table 
D-1 lists the names and contents of these files.

Table D-1. Grams/32 Export File Names

Where xxx is the first three characters of the input sample file name and nn is the number of 
the experiment within the sample.

For example, the second experiment of the sample file ABC.SMP would be exported into the 
following Grams/32 files:

ABC02.CGM
ABCSG02.SPC
ABCTM02.SPC
ABCT102.SPC
ABCT202.SPC

File Name Contents

xxxnn.CGM Calibrated TCD signal vs. time (same as xxxSGnn.SPC when no 
calibration is specified)

xxxSGnn.SPC Uncalibrated TCD signal vs. time

xxxTMnn.SPC Sample temperature vs. time

xxxT1nn.SPC Auxiliary signal one vs. time

xxxT2nn.SPC Auxiliary signal two vs. time
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E.  AUXILIARY INPUTS AND OUTPUTS

You can connect analog and digital signals to the AutoChem II 2920 analyzer. Two connectors 
are available on the analyzer’s right side panel; both are industry-standard “D” shell 
connectors. You must supply a shielded cable for any auxiliary signal you connect to the 
analyzer. All cables must use male pins in the connectors. The analog connector uses a 15-pin 
body; the digital connector uses a 25-pin body. The cable shield must connect to a metal shell 
“D” connector housing.

Software

Analog inputs are enabled by marking one or both check boxes on the Insert Experiment 
dialog; this dialog is opened from the Analysis Conditions dialog of the sample information 
file (Advanced format only). Click Insert, then select Experiment. After an auxiliary input is 
enabled, it remains enabled for the duration of the experiment. Because an analysis can be 
comprised of many experiments, an input can be disabled or enabled at various points in the 
analysis, as determined by the selection on the New Experiment dialogs.

Digital inputs are controlled by inserting a Wait step in the analysis. On the Wait dialog 
(shown below), mark the radio button next to Wait for digital input number. Specify 1 or 2 to 
indicate the desired input signal. Enter a number of minutes to wait; if the desired signal is not 
received before that amount of time elapses, the analysis continues without the input.

Click this button to 
set the analog and 
digital outputs.

Mark one or 
both boxes 
to enable the 
analog 
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Analog and digital outputs are enabled by marking the applicable check box(es) on the 
Outputs dialog. The Outputs dialog is available when you are setting the initial conditions for 
an experiment (by clicking the Outputs button on the New Experiment dialog), or at many 
other points in the analysis (by inserting a Set Outputs step in the Synopsis). The state of the 
auxiliary outputs can therefore be changed frequently throughout the analysis.

The state of the auxiliary inputs and outputs is displayed on the instrument schematic. 
Auxiliary signals can be incorporated in reports (overlaid over other data in graphs), in the 
Results view of the Analysis dialog (during analysis), and in the Peak Editor.

In the Auxiliary Status Display on the instrument schematic, a zero or a one is displayed to 
show the state of each digital output (DO), relay output (RO), and digital input (DI). Refer to  
Digital on page E-4 for additional information.

The voltage is displayed for each analog input (AUX 1 and AUX 2).

Auxiliary status 
display
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Analog

The 15-pin analog connector provides two output signals and two input signals.

Outputs

The two output signals are:

• The TCD signal, which could be as high as 12 volts (positive or negative)

• The sample temperature signal, which is a buffered voltage from the sample 
thermocouple. The voltage ranges from –0.365 V at –40 °C, 0 at 0 °C, to 10.88 V at 
110 °C. The signal follows the type-K thermocouple nonlinear characteristic.

The signals are available at these pins:

Inputs

The inputs are available for connection to other detectors, such as a mass spectrometer. The 
voltage range is –15 to 15 volts. The software can record these signals at the same time as it 
records TCD and sample thermocouple data. 

The signals connect to these pins:

All other pins in the 15-pin connector are floating (not connected). You should connect the 
metal shell of your connector to chassis ground and the cable shield to maintain shielding of 
the signals.

TCD (+) 7

TCD (–) 5

Temp (+)  8

Temp (–)  6

1

2
3

4

5
6

7

8

9
10
11

12
13

14

15

Auxiliary input 1 (+) 4

Auxiliary input 1 (–) 3

Auxiliary input 2 (+) 2

Auxiliary input 2 (–) 1

1

2
3

4

5
6

7

8

9
10
11

12
13

14

15
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Digital

The 25-pin digital connector provides floating signals to control and monitor external 
hardware, such as auxiliary detectors or chart recorders.

The outputs consist of four sets of latching relay contacts and four opto-coupled photo 
transistors. The inputs are two optically isolated photo couplers.

The software sets these as logic 1 or logic 0, as defined by the analysis step. They are 
displayed on the instrument schematic.

 A logic 1 causes the relay to connect the “common” contact to the “normally open” contact. 
The relay will retain this condition even when power to the instrument is disconnected. A logic 
0 causes the relay to connect the “common” contact to the “normally closed” contact.

A logic 1 to the opto couple outputs causes the NPN photo transistor to be turned on. A logic 0 
turns the NPN photo transistor off. 

The two opto-coupled inputs are read by the instrument as logic 1 (when current flows through 
the opto coupler photo diodes) or logic 0 (when no current is flowing).

Electrical Specifications

Relays

Maximum voltage: 250 VAC, 48 VDC

Maximum switching current: 4A at 250 VAC; 3A at 30 VDC

Maximum switching current: 100 mA at 100 VDC

Opto-coupled outputs

Maximum voltage, VCE = 70 VDC

Maximum reverse voltage, VCE = 7 VDC

Maximum current = 10 mA

Opto-coupled inputs

Maximum reverse voltage = 3 v

Nominal forward voltage = 1.3 v at 10 mA

Minimum current required to be recognized by the 2920 analyzer = 1 mA
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Digital Connector Pin Designations

Pin Type Function

1 Relay 1 normally closed

2 Relay 1 common

3 Relay 1 normally open

4 Relay 2 normally closed

5 Relay 2 common

6 Relay 2 normally open

7 Relay 3 normally closed

8 Relay 3 common

9 Relay 3 normally open

10 Relay 4 normally closed

11 Relay 4 common

12 Relay 4 normally open

13 Not used Not used

14 Opto output 1 collector

15 Opto output 1 emitter

16 Opto output 2 collector

17 Opto output 2 emitter

18 Opto output 3 collector

19 Opto output 3 emitter

20 Opto output 4 collector

21 Opto output 4 emitter

22 Opto input 1 anode (+)

23 Opto input 1 cathode (-)

24 Opto input 2 anode (+)

25 Opto input 2 cathode (-)
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F.  CALIBRATING THE MASS FLOW CONTROLLERS 
FOR EACH GAS 

The AutoChem II 2920 Analyzer uses Mass Flow Controllers (MFCs) to control the flow of 
gases. These MFCs require a conversion constant for each gas or gas mixture, to compensate 
for variations in gas flows resulting from variations in the gases’ properties. Default MFC 
conversion constants are provided for a wide variety of gases is contained in the software. You 
can view this table by selecting Options > Gas Defaults. A more complete list of gases and 
their conversion constants can be found on page C-3 in Appendix C.

In most cases, using the default MFC conversion constant yields accurate data. You may wish 
to determine a new conversion constant if:

• You are using a unique gas mixture
• The gas you wish to use is not included in the table 
• You require a higher precision calibration of the MFCs for a given gas
• Unexpected analysis data lead you to believe that the default value is in error

Gas Mixtures

To determine the conversion constant for a gas mixture, you must first obtain the conversion 
constant for each gas in the mixture. For each gas, you may either use the default conversion 
constant or determine a new constant using the method described in this appendix. A 
combination of default and calculated constants may be used. 

After a constant is obtained for each gas in the mixture, use the formula on the worksheet at 
the end of this appendix to determine the constant for the mixture.

Flow Measurement

An external device that measures the flow of gas from the analyzer’s exhaust is used during 
MFC calibration. A soap bubble burette is shipped with your instrument. For even more 
precise calibration, you may choose to use another type of flow meter; follow these 
instructions for obtaining a new conversion constant, substituting your flow meter for the 
bubble burette.
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Installing the Soap Bubble Burette

1. Carefully unwrap the glass tube and the rubber bulb.

2. Attach one end of the flexible tubing to the side arm of the glass tube. Attach the metal 
tubing provided with the bubble burette to the other end of the flexible tubing.

3. Locate the exhaust port that corresponds to the MFC you are using for this calibration. 
Remove external plumbing from that port and attach the bubble burette using the 
connector provided with the burette. For example, if you are using the Carrier Flow 
Controller, attach the bubble burette to the carrier gas exhaust port.

4. Fill the rubber bulb with leak detector fluid. An 8-oz. bottle of the fluid is included in the 
accessory kit. Attach the bulb to the bottom of the glass tube.

These instructions are for assembling and using the burette supplied by 
Micromeritics. If you are using another type of flow meter, follow the meter 
manufacturer’s assembly and operation instructions.

Analyzer Inlet Ports

Glass Tube

Clamp and Stand
(not included)

Rubber 
Bulb

Flexible Tubing

Metal Tubing

Connector

Analyzer Exhaust 
Ports

The soap bubble burette must be held in an upright position. An example of a stand 
and clamp is shown in the illustration above.
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Determining the Constant for Individual Gases

1. Make a copy of the Gas Flow Constant Calibration Worksheet (at the end of this 
appendix). Use the worksheet to complete the following procedure.

2. If the gas for which you wish to determine a calibration factor is not attached to an inlet 
port, attach it before proceeding. Use an inlet port for the MFC you plan to use during this 
calibration. For example, if you plan to use the carrier MFC, attach the gas to one of the 
carrier inlet ports.

3. From the Unit menu, select Gas flow constant calibration. On the dialog box, mark a radio 
button to indicate which MFC you plan to use. The MFCs are identical, so you should use 
the most convenient one.

4. Flow the gas to be calibrated through the appropriate Mass Flow Controller by following 
these steps:

a. Select Unit > Show instrument schematic. Then, select Unit > Enable manual 
control. (The manual control function is explained on page 6-12.)

In this example, 
the carrier gas 
MFC is used.
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b. On the instrument schematic, place the cursor over the icon that represents the inlet 
valves for the Flow Controller you are using. Click the right mouse button and select 
the Flow Gas (number) option for the inlet valve to which the new gas is connected.

c. Place the cursor over the icon representing the Mass Flow Controller you wish to use. 
Click the right mouse button, then select Set Flow Rate. A window opens allowing 
you to specify a flow rate. 

Be sure to use a rate that can be verified by the flow meter you plan to use. Record the 
flow rate on line 1 of the worksheet. Click OK to close the dialog. 

5. Make sure a flow meter is connected to the appropriate exhaust port. Measure the actual 
flow rate in standard cm3/min and record the flow rate on line 2 of the worksheet. 

If you are using the bubble burette shipped with your analyzer, observe a bubble as it rises 
through the glass tube. The lines on the glass tube indicate the beginning and ending 
points for measuring the progress of a bubble through the tube. Use a stopwatch to 
measure the amount of time that elapses from the moment the bubble passes the lower 
mark on the tube until the moment it passes the higher mark on the tube. 

In this example, the carrier 
gas MFC will be used to 
obtain a calibration factor 
for the new gas.

The current flow rate is 
displayed beside the MFC 
icon.

In this example, the new 
gas is connected to carrier 
gas inlet port 2. Inlet valve 
2 is opened to create a 
gas flow through the 
carrier MFC.
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6. Convert the measured flow to Standard Temperature and Pressure (STP) conditions. The 
formula is provided on the worksheet; record the value on line 3.

7. Enter the measured flow rate at STP on the Gas Flow Constant Calibration dialog. Click 
Accept to calculate a conversion constant for this gas. Record the value on line 5.

8. Open the Gas Defaults table (on the Options Menu) and update it to include the new gas 
and its conversion constant. (If you have used this process to obtain a new constant for an 
existing gas in the table, update the conversion constant for that gas.) 

The gas you just added can then be selected for any port on the Gas Selections 
Dialog. If you plan to leave this gas connected to the port, be sure to change the gas 
selection for that port to the correct name.
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Gas Flow Constant Calibration Worksheet

Follow the instructions for calibrating the analyzer’s Mass Flow Controllers for a given gas, 
using this form to record measured values and perform calculations included in this process. 
Instructions are provided for single (individual) gases and gas mixtures.

Single Gases

MFC being used (optional):

____ Preparation

____ Reference

____ Carrier

____ Analysis (Loop)

Gas:_________________________________

1. MFC flow rate (as set on instrument schematic): __________

2. Measured flow rate (using an external flow meter): __________

3. Convert the flow rate to Standard Temperature and Pressure (STP) using the following 
formula:

Rate at STP = Rate measured (cm3) x 

Measured rate at STP: __________

4. Enter the value from # 3 in the Measured Flow field of the Gas Flow Constant Calibration 
dialog, then click Accept.

5. The new MFC Conversion Constant (displayed at the bottom of the Gas Flow Constant 
Calibration dialog) is: __________

6. Enter the new Conversion Constant for this gas (# 5) on the Gas Defaults table, which is 
accessed from the Options menu.

273.15 K
273.15 K room temp °C+
------------------------------------------------------------------ atmospheric pressure

760 mmHg
----------------------------------------------------------×
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Gas Mixtures

Obtain a conversion constant for each gas in the mixture. Use the conversion constant 
provided in the Gas Defaults table (on the Options menu) or in Table C-3 on page C-3, or use 
the instructions above to obtain a new constant. Record the names and constants for each gas 
in the mixture in the table provided in this section. Use the following formula to calculate the 
conversion constant for the gas mixture. 

M = the mixture conversion constant
P = the percentage of gas n in the mixture, expressed as a whole number 

(example: for 15%, use 15, not .15)
F = the conversion constant (factor) for gas n (From the Gas Defaults Table or from 

step 5 on this worksheet)

Enter the gas mixture in the Gas Defaults table; use M as the conversion constant.

Mixture name:_____________________ Constant (M):____________________

Gas Name (n) Conversion Constant (F)
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.

M 1
P1

F1 100×
---------------------

P2
F2 100×
--------------------- +...+

Pn
Fn 100×
---------------------+

----------------------------------------------------------------------------------------------------=
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G.  ATOMIC WEIGHTS AND CROSS-SECTIONAL AREAS 
FOR SELECTED METALS

Metal Symbol Atomic Weight
(g/mole)

Cross-Sectional Area
(sq nm)

chromium Cr 51.996 0.0635

cobalt Co 58.933 0.0662

copper Cu 63.546 0.0680

gold Au 196.967 0.08696

hafnium Hf 178.490 0.0862

iridium Ir 192.220 0.0769

iron Fe 55.847 0.0613

manganese Mn 54.938 0.0714

molybdenum Mo 95.940 0.0730

nickel Ni 58.710 0.0649

niobium Nb 92.906 0.0806

osmium Os 190.220 0.0629

palladium Pd 106.400 0.0787

platinum Pt 195.090 0.0800

rhenium Re 186.207 0.0649

rhodium Rh 102.906 0.0752

ruthenium Ru 101.070 0.0613

silver Ag 107.868 0.0869

tantalum Ta 180.947 0.0800

thorium Th 232.038 0.1350

titanium Ti 47.900 0.0741

tungsten W 183.850 0.0741

vanadium V 50.942 0.0680

zirconium Zr 91.220 0.0877
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AutoChem II 2920 Appendix H
H.  PEAK DETECTION/INTEGRATION OPTIONS

Peak detection parameters can be customized using the Peak Detection/Integration Options 
dialog. If you customize this dialog when you create the sample file, you can control peak 
detection during analysis. You can also control peak detection after analysis by customizing 
this dialog in the Peak Editor. The defaults for the parameters on this dialog are usually 
acceptable, but they may be changed if you wish. 

• To open this dialog while you are creating the sample file:
With the sample file open in Advanced presentation, click on the Analysis Conditions 
tab. Click Insert, then select Experiment. Click Peaks.

• To open the dialog while you are in Peak Editor:
Select the Edit Peaks tab. Then right-click in the graph area and choose Peak 
Integration Options.

The TCD detects and records all deviations from baseline, but only those which satisfy the 
criteria established in this dialog are reported as peaks.

Peak detection is accomplished through a combination of noise, height, and area 
thresholds.
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Baseline Mode

This feature affects how the Find All Peaks function works.

If Best Fit Baseline is selected, the bottom of the peaks is placed in the baseline that best 
describes the signal outside the range of the peaks. This assumes a linear baseline between the 
beginning and the end of the peak.

If Snap to Baseline is selected, the bottom of the peaks is moved to the signal recorded, not 
the best fit baseline between the peaks.

Threshold Y Level

Sets the minimum height for peaks to be identified and included in the peak table. This value is 
expressed in terms of the trace’s Y-axis units. Use a value of 0 (zero) to include all peaks.

Smoothing

This feature allows the software to average the points before using them, so that noise spikes 
are ignored. Specify the number of points you wish the software to average into a single value 
during the peak picking process.

The smoothing parameter can be turned off by setting the value at 1 or 0 (zero). A setting of 1 
disables smoothing, and the peak edges are interpolated to the best X-axis value. A setting of 0 
also disables smoothing, but the peak edges (the points where the peak begins and ends) are 
not interpolated. Instead, the nearest data point is used as the peak edge.

Sensitivity

Sets the noise rejection level for identifying the peaks in a trace. Use a value from -100 to 
100%. For example, a sensitivity level of 5% means that 5% of all local maxima in the trace 
are greater than the noise and are, therefore to be considered as peaks. A value of 100% 
identifies all local maxima (or minima for traces with transmission Y units) as peaks. One 
possible exception to note is the combination of other rejection parameters (such as Minimum 
Peak Area and Threshold Y Level) which can reject peaks even when the sensitivity is set to 
100%.

The sensitivity can also be set to negative values to define a specific noise level (in Y units) for 
peak rejection. For example, a sensitivity setting of -2.5% sets the noise rejection to 2.5 V. 
This means that maxima with an amplitude of 2.5 V or less will be considered as baseline 
noise instead of as peaks. (As opposed to the Threshold Y Level rejection parameter which 
eliminates refined peaks by using their height above the baseline.)

A setting of 0 (zero) automatically sets a default noise level for the trace.
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Max Shoulder Ratio

There can also be “shoulder peaks” (also called combination peaks) within a group. (For a 
discussion of peak groups, see the description of Max Group Separation below.) Shoulders are 
usually small peaks that are overlapped on the front or the tail of a larger peak. These peaks 
can also be called “leaders” and “followers,” respectively. As with baseline groups, the areas 
of these peaks can be calculated incorrectly. If the larger “parent” peak has a long tail with a 
much smaller peak riding on it, most of the area under the trace belongs to the parent peak. 
However, if the area of these peaks was determined using baseline grouping, the smaller peak 
would be calculated by using vertical drop lines at the edges. This would give the parent peak 
too little area, and the rider peak too much.

The software can detect these shoulder peaks. The areas of shoulder peaks are calculated by 
drawing a skimmed baseline from the leading edge to the trailing edge. Either an exponential 
or a straight skim line can be used. The skim type is specified by a secondary method 
parameter (see the Grams/32 manual Appendix or the Method Editor) and the default is 
exponential skimming. The remaining area between the shoulder peak baseline and the group 
baseline is considered to be part of the parent peak.

The Max Shoulder Ratio parameter is used to specify whether the peaks that are overlapped 
in the front or the tail of much larger peaks should be identified as shoulder peaks. To use 
shoulder peak detection, use a non-zero value for the Max Shoulder Ratio parameter. After a 
baseline group has been identified, the software looks for peaks within the group that satisfy 
the following shoulder peak criteria: 

Shoulders must have a significantly higher Y value at one edge than the other. More 
importantly, the height of the shoulder above the common value must be much smaller than 
the height of the “parent” (larger) peak above the same valley. It must be smaller by the Max 
Shoulder Ratio setting. For example, a setting of 33 implies that shoulders must be smaller 
than 33% of their parents in terms of height above the common valley. The areas for shoulder 
peaks are calculated by drawing a skimmed baseline from the left edge to the right edge of the 
peak. The remaining area between the shoulder peak baseline and the group common baseline 
is considered to be part of the parent peak.

Shoulder peaks can only be calculated within a group of peaks. (See the description of peak 
groups in the section below on Max Group Separation.) If the Max Group Separation 
parameter is set to 0 (no groups), a Max Shoulder Ratio parameter value is not used. Use a 
value of zero to specify no shoulder peak detection.

A value of 33% works well with most data. Use a setting of zero to treat shoulder peaks with a 
perpendicular drop to the common group baseline instead of a skimmed baseline. 

If the software detects unwanted baseline noise peaks, try increasing the Sensitivity setting. 
Conversely, if some peaks are not detected, decrease the value.
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Max Group Separation

The software normally calculates peak areas by drawing a “valley-to-valley” baseline from the 
leading edge to the trailing edge of every identified peak. However, in many traces, the valleys 
between peaks do not always drop back to the original baseline. If a valley-to-valley baseline 
is used for this type of peak, the calculated area does not accurately reflect the true area under 
the peak.

The software provides a parameter that allows the calculation of “Baseline Groups.” A group 
of peaks is defined by a common baseline that extends from the leading edge of the first peak 
in the group to the trailing edge of the last. The areas of grouped peaks are calculated by 
dropping vertical lines from the peak edges down to the group baseline. (Note there may also 
be “Report Groups” defined by the method and assigned group letters from A through Z. 
Unlike these Baseline Groups, the Report Groups need not be next to one another. The two 
types of groups are not related.)

The Max Group Separation parameter is used to determine which peaks in a trace have a 
common baseline. When using peak grouping, the software compares the width (actually 
double the largest half width) of every identified peak in a trace to the width of the following 
peak. The Max Group Separation parameter specifies a percentage of the smallest of these two 
widths in X units. If the edges of two adjacent peaks differ by less than this value, the two 
peaks constitute a group and are given a common baseline. For example, if two adjacent peaks 
in the trace have largest half widths of 1 and 1.5 respectively, and the Max Group Separation 
parameter is set at 20%, then a difference of less than 0.4 X units between the adjacent edges 
of these peaks would make them a group with a common baseline. If the same two peaks have 
adjacent edges that are greater than 0.4 X units apart, they do not define a group, and each 
peak has its own separate baseline.

The areas for grouped peaks are calculated by drawing imaginary vertical lines from the peak 
edges to the common baseline. Any peaks that share common edges are automatically 
considered a group and are given a common baseline for any Max Group Separation setting 
greater than 0. To specify no peak grouping (each identified peak has its own baseline), use a 
setting of 0. A value of 33% for this parameter works well with most data. Use a setting of 
zero to force all baselines to be drawn from peak valley to valley.

Minimum Peak Area

This parameter sets the minimum area required for refined, processed peaks to be recognized, 
identified, and included in the peak table. Any peak with a calculated peak area smaller than 
the current setting is not detected. Values for this parameter are expressed in terms of the trace 
X-axis units multiplied by the Y-axis units (e.g., millivolt-minutes).

Setting the Sensitivity parameter to large values (greater than 20%) can cause noise “spikes” 
(or “dips”) on the sides of major peaks to be identified as peaks themselves. If the areas of the 
peaks are smaller than the Minimum Peak Area parameter, major peaks in the trace may not be 
identified at all. Exercise caution when using high Sensitivity settings with the Minimum Peak 
Area parameter.
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If peaks are not detected by the software, lower the setting with a smaller value. You must 
adjust this parameter in conjunction with the Peak Sensitivity and/or Threshold Y parameters 
above. Peak rejection is accomplished through a combination of peak height and peak area 
rejection parameters. If the software is not detecting your peak(s) of interest, you probably 
need to decrease both parameters.
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I.  ERROR MESSAGES

Error messages are listed numerically. If the Action response instructs you to contact your 
service representative, record the error message and make backup copies of any files involved 
in the operation.

2200 Series

2201- Cannot execute report subsystem.
2202- Cannot execute Peak Editor subsystem.

2400 Series

2401- FATAL ERROR: (error message)

2430- Error accessing file (file name), error code = [n]

The 1000-series error messages (used primarily for software testing) are not 
included in this appendix. These errors should not occur during normal operation. 
If you receive a 1000 series error message or an error message not listed in this 
appendix: record the error message, make backup copies of any files involved, 
then contact your service representative.

Cause: The software for the report (or Peak Editor) subsystem has been cor-
rupted and cannot be started.

Action: Reinstall the AutoChem software.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative if you continue to 
receive this message.

Cause A: Hard disk may be damaged.

Action A: Contact your service representative.

Cause B: A software error occurred when the file was accessed.
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2431- Error writing file (file name), error code = [n].

2432- Invalid response from MMI ‘File_READ’ request.

2433- New entries have been found in this directory. Refresh the directory 
information?

Action B: Contact your service representative.

Cause C: The name specified contains one or more invalid characters.

Action C: Enter a valid file name; do not use special characters such as * or ?.

Cause: The hard disk does not have enough space left to perform the opera-
tion.

Action: Copy files not used regularly from the hard disk to a CD or network 
drive, delete them from the hard disk, and then try the operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: Several files (sample information, analysis conditions, or report 
options) have been added to this directory by some function other than 
the analysis program.

Action: Select Yes to update the directory information with data form each new 
file. This operation may take a minute.

Select No if you do not want to spend the time updating the directory 
information. This option may be feasible if a large number of files have 
been copied into the directory and you know the name of the file you 
wish to access.
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2434- File (file name) - Subset # [n] wrote wrong amount of data.

2436- Path specification (path name) is invalid.

2437- File (file name) does not exist.

2438- Disk drive (letter): is inaccessible.
2439- Could not register file.
2440- Subset not found.
2441- Seek within file failed.
2442- Had header in subset file.
2443- Subset owner denied access.
2444- Not a valid file format.
2445- Subset wrote the wrong amount of data.
2446- Error reading data.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: You entered an invalid path name and/or extension.

Action: Type a valid path name (including the proper extension) and press 
Enter.

Cause: You entered a file specification that does not exist.

Action: Enter an existing file specification or select a file name from the list 
box.
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2447- Error writing data.

2448- File directory (path name) is invalid. Resetting to the installation directory.

2449- This field does not contain a valid file specification.

2450- Sample Defaults may not be edited while this operation is in progress. Do you 
wish to save and close the Sample Defaults edit session?

2452- Attempt to write MICATTR.DIR in read only mode. (file name)
2453- Attempt to append MICATTR.DIR in read only mode. (file name)

2454- Too many selections for a print-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories list to move to the correct directory.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your operating sys-
tem or Windows manual and reenter the name.

Cause: You are in the process of initiating an automatic analysis (an analysis in 
which sample files are created using the defaults) while editing the 
defaults.

Action: Finish your edit session of the defaults and close the dialog. Then 
restart the automatic analysis.

Cause: The Read-Only attribute is turned on in the application’s 
MICATTR.DIR file (this file exists in each folder containing sample or 
parameter files).

Action: Use Windows Explorer to access the folder containing the 
MICATTR.DIR file and disable the Read-Only option.
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2455- Too many selections for an export-to-file operation. Only the first (number)
selections will be processed. Please reselect the remainder.

2456- Insufficient file handles available. Application cannot continue.

2457- Results cannot be displayed. More than (number) windows are currently dis-
playing or printing results.

2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

2459- An instrument is busy. A delay in restarting this application could result in loss 
of data. Continue with program Exit? (Yes, No)

Cause: You selected too many files for this operation.

Action: Select only the number of files specified in the message.

Cause: You have more than 50 files open at the same time.

Action: Refer to the manual for your operating system and set the limit for 
open files to 50 or greater.

Cause: You have too many windows open in the application.

Action: Close some of the open windows.

Cause: You are attempting to exit the application while the instrument is per-
forming a critical operation. This operation must be completed before 
the application can be stopped.

Action: Wait a short time and attempt to stop the application again.

Cause: You are attempting to exit the application while an analysis is in 
progress. While this is possible, the data collected while the application 
is inactive will not be permanently recorded until the application is 
restarted. A power failure to the instrument could cause some data to 
be lost. Continued data collection may also exhaust the memory of the 
controller.

Action: If you are not concerned with the potential for loss of data should a 
power failure occur, select Yes to continue; otherwise select No.
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2460- Fatal Communications error on (Unit n - S/N: nnnn)

2461-No active instruments. The application will unconditionally terminate.

2471- Unit n - S/N: nnnn has an invalid communications port specified. It cannot be 
initialized.

Cause: There was a fatal error in the serial communications between the appli-
cation and the interface controller (the software and the instrument). 
All displays for that instrument will be closed.

Action: Check that the interface controller is connected to the control module 
on the communications port configured in the Setup program. Stop the 
2920 software and then restart it. If this error persists, contact your 
Micromeritics Service Representative.

Cause: At least one instrument must be active for the application to operate. 
The initialization of all of the instruments configured with the Setup 
program has failed. The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the instrument’s failure to initialize. See the instructions for that 
message. 

Action B: Ensure that the instrument is attached to the computer on the commu-
nications port configured with the Setup program. Verify that the 
instrument has the power switch in the ON position and that the light 
on the front panel is illuminated. If the application continues to fail in 
its attempts to initialize the instrument, contact your Micromeritics 
Service Representative.

Cause: The communications port associated with this unit was not valid.

Action: Run the Setup program and install the unit on a valid port.
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2474- Unit n - S/N: nnnn communications port specified in the program control files 
is already in use. Unit cannot initialize.

2475- Unit n - S/N: nnnn communications port specified in the program control files 
cannot be accessed. Unit cannot initialize.
2476- Unit n - S/N: nnnn startup failed. Cannot initialize the communications port.

2477- Unit n - S/N: nnnn did not properly initialize.

Cause: The communications port associated with this instrument is in use by 
some other program in the system.

Action: Close the other program to release the port. Restart the 2920 software.

Cause: The communications port associated with this unit was not valid.

Action: Run the Setup program, specifying a valid port for this unit, when you 
are prompted to do so.

Cause: The software was unable to initialize this instrument; this is usually 
caused by one of the conditions listed in the error messages above.

Action: Correct the problem as described above, then restart the application.
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2478- Error copying sequential data segment.

2479- Unit n - S/N: nnnn The instrument is busy performing an operation of which 
this application is unaware. Do you want to cancel?

2480- File <name> cannot be analyzed. It is currently being edited.

2481- Error accessing the sample information file <name>.

Cause: An internal processing and/or hardware error occurred while accessing 
a portion of a sample file.

Action: Confirm that the media being accessed does not contain errors; for 
example, you may wish to use a utility such as ScanDisk.

Contact your service representative if you continue to receive this mes-
sage. 

Cause: During initialization, the instrument was found to be analyzing, but the 
analysis program has no record of it. 

Action: Click Yes to cancel the analysis and synchronize the analysis program 
with the instrument’s status. Click No to abort the initialization and 
allow the analyzer to continue the analysis.

Cause: You are trying to start an analysis using a file that is open for editing.

Action: Finish editing the file, save and close it, then start the analysis. 

Cause: An unexplained error prevents you from accessing this file.

Action: The hard disk drive may be corrupt. Run diagnositics.
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2482- File cannot be opened for writing. It is already in use.

2483- An analysis cannot be performed on (file name). It is open for editing and con-
tains errors.

2484- The edit session for <name> must be saved before the analysis.  Save changes 
and proceed with the analysis? (yes, no)

2485- The service test file has an invalid status and cannot be used for this analysis.

2486- Could not construct (name) report type. Program will terminate.
2487- Could not start report generator. Error code (number). Program will terminate.

Cause: You attempted to open a file that is currently being used (either by this 
application or another).

Action: Locate the application using the file (in the Micromeritics application, 
use the Windows menu item to get a list of all windows, one of which 
may contain this file).

Cause: You are trying to start an analysis using a file that contains errors and is 
open for editing.

Action: Finish editing this file, save and close it, then start the analysis. 

Cause: You are trying to start an analysis using a file that contains unsaved 
changes and is open for editing.

Action: Select Yes to save the changes and proceed with the analysis; select No 
to cancel the analysis and continue editing the Sample Information file.

Cause: The selected service test file has a status other than No Analysis.

Action: Select a different service test file or create a new one and use Replace 
All to copy parameters from the file you originally selected.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this mes-
sage.
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2488- File (file name) cannot be opened for editing. It is already in use.

2489- File (file name) cannot be opened for writing. It is already in use.

2490- No ‘.INI’ file present. Application will terminate.

2491- Highlighted fields contain errors. Please correct the errors before closing.

Cause: The file you specified is already open for editing.

Action: Check the windows list to locate the other edit session.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: The ASCII (.INI) file containing initialization and system options 
information cannot be found. The .INI file may have become cor-
rupted. The ASAP 2920 cannot be run without this file.

Action: Uninstall, then reinstall the ASAP 2920 application as described 
below. When you uninstall the application, only the application files 
are deleted; the 2920 data files remain intact.

a. From the Windows Start menu, select Settings > Control Panel > 
Add or Remove Programs.

b. Select AutoChem II 2920, then click Remove.

c. Insert the 2920 Setup CD in the CD drive and reinstall the 2920 
application (refer to “Installing the Software” on page 2-18).

d. Start the 2920 application.

Cause: The highlighted fields contain invalid entries. You will not be able to 
close the dialog box until you correct the errors.

Action: Check the entries, correct the errors, and close the dialog box.
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2492- This field’s entry is invalid.

2493- An entry is required for this field.

2494- Value is out of the valid range.

2495- Value is out of the valid range. Enter a value between (value) and (value).

2496- Invalid number.

2497- This field contains an invalid character.

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: This field contains an invalid entry.

Action: Enter or select an appropriate value.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select a value within the indicated range. 
The valid range is shown in the information bar across the bottom of 
the dialog.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter a value between the range indicated.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.
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2498- The requested change to the Sample’s status is invalid at this time.

2499- Sequence number must contain at least 3 digits.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered data) could not be done.

Action: Contact your service representative if you continue to receive this mes-
sage. Record the name of the sample file in which the problem 
occurred.

Cause: You tried to enter a sequence number that did not contain at least three 
digits.

Action: Enter a sequence number that contains at least three digits.
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2500 Series

2500- All sample files that can be created using the sequence number pattern already 
exist. You may want to modify the next sequence number.

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid loss of data.

2502- Error writing to file (name) during print. Error code: (number).

2503- Error converting file (name). Could not create DIO intermediate file.

Cause: No more sample information files can be created using the currently 
specified file sequence number.

Action: Select Options > Sample defaults from the main menu and enter a 
new sequence number.

Cause: A large number of windows is open and consuming the system 
resources available to all applications.

Action: Close any unneeded windows to free system resources. Contact your 
service representative if you continue to receive this error message.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause A: Insufficient space is available on the hard disk. The DIO file is placed 
in the directory specified by the TEMP environment variable.

Action A: Determine if there is sufficient space on the drive where the TEMP 
directory is located.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative.
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2504- Cannot create output file for sample (name).

2505- Error Logger cannot be initialized. Error code (number). Program will exit.

2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your service repre-
sentative if you continue to receive this message.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.

Cause: The selected output device is not installed.

Action: Select a different output device in the System Configuration dialog. 
Install the device using the Control Panel, Printers operation.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

Cause: An error occurred while the program was opening a file necessary to 
the report operation.

Action: Use the name given in the error message to investigate. Contact your 
service representative if you continue to receive this error message.
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2510- (sample file) Error parsing reports from file (name). Reports cannot be 
produced.

2511- Print job (name) has been cancelled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) has been canceled.

2513-  Unable to read the calibration file (file name).

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and 
remove the invalid character.

Cause B: The system was unable to create the usual temporary files during the 
report, possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your service representative.

Cause: The disk drive does not have enough space for the temporary file 
required by the Windows Print Manager. Therefore, printing of the 
requested report has been canceled.

Action: Delete unnecessary files form the disk. You will require at least five 
megabytes of free space for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.

Cause: The calibration file selected for loading is not valid or cannot be read.

Action: Confirm the media containing the alleged calibration file has no prob-
lems.
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2514-  Unable to write the calibration file (file name).

2515-  Warning:  Changing the calibration information will affect the performance of 
the instrument. Only qualified service personnel should do this. Do you wish to 
proceed?

2516-  Warning:  Keeping a backup copy of the calibration data is recommended by 
Micromeritics. Would you like to do so now?

2517-  Canceling this dialog will reset the calibration state to what it was when this 
dialog was first opened. Are you sure you want to cancel?

2521- Unable to program controller.

Cause: An attempt to Save calibration data has failed due to possible media 
problems.

Action A: Confirm the media containing the alleged calibration file has no prob-
lems.

Action B: Choose an alternate media to Save the calibration data.

Cause: You are in the process of performing a calibration.

Action: Calibration operations should only be done under the direction of qual-
ified service personnel.

Cause: You have completed a calibration procedure.

Action: Save the calibration data to a file.

Cause: You have completed a calibration procedure, but you have not accepted 
the new calibration data.

Action: If the calibration operation was successful, click Accept.

Cause: A hardware malfunction has occurred.

Action: Contact your local service representative.
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2522- Invalid controller application file.

2523- Programming the controller failed. 
2524- CRC check failed on programming controller. 
2525- Unknown error programming controller. 
2526- Controller download was not successful.
2527- Controller CRC error on boot block. 
2528- Controller DRAM error. 
2529- Controller Com1: error. 
2530- Controller Com2: error. 
2531- Controller debug port error. 

2532- The instrument contains a different software version. Do you want to reset it?

2533-  Mass initialization failed.

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the AutoChem program.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this mes-
sage.

Cause: The application has discovered that a different version of software is 
already running on the instrument. 

Action: If there is no chance that some instrument other than the 2920 is con-
nected to the instrument, select Yes to reset the instrument and down-
load the proper software. Otherwise, select No to leave the instrument 
unchanged.

Cause: The instrument initialization found that the instrument hardware con-
figuration did not meet the minimum requirements.

Action: Contact your service representative.
May 06                                                      I-17 



AutoChem II 2920 Appendix I
2534- Error opening file (name) for printing. Error code: (number)

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.
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4200 Series

4200- At least two experiments are needed for this report.

4202- Null connection, unable to start Transaction.
4203- Advise for unknown transaction received. 
4204- Unable to create DDE conversation <number>. 
4205- Unable to create DDE transaction <number>. 
4206- Callback for unknown transaction received.
4207- DDE error number <number>. 

4208- An error occurred while loading the application control information.  Data entry 
cannot be performed. (Code #)

Cause: The report options for this report do not include the selection of at least 
two experiments.

Action: Open the sample file and choose at least two experiments for this 
report.

Cause: A DDE operation was not properly executed.

Action: Ensure that the other application is loaded and in a state which supports 
DDE operations. If the problem persists, exit all applications and Win-
dows, then restart the applications.

Cause: The DDE command was not specified correctly.

Action: Review the DDE server application manual for the specific command 
and enter it correctly in the DDE command step. If the problem per-
sists, exit all applications and Windows, then restart the applications.

Cause: An error occurred accessing the control information disk file required 
by this application.

Action: The disk drive may have failed or be corrupt. Run diagnostics on the 
disk drive.
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4209- New steps cannot be inserted in the synopsis at any point that precedes the 
step that is currently being executed.

4210- No new steps may be inserted. Analysis is complete.

4213- This analysis can only be executed when Service Test mode is enabled.

Cause: The analysis has already progressed past the point at which you 
attempted to insert a step; therefore the step would not be performed.

Action: Insert the new analysis step after the step that is currently being exe-
cuted.

Cause: The analysis for this sample file has ended. You cannot insert a step in 
a sample file whose analysis is complete.

Action: The analysis conditions for a completed sample cannot be changed. 
You can, however, create a new sample file and use the Replace button 
to copy the values from the completed file. Then, add the desired step 
to the new sample file. A new sample can be analyzed using the new 
(edited) sample file.

Cause: You have attempted to analyze a sample using an analysis conditions 
set which may only be used under the supervision of an authorized 
Micromeritics Service Representative. These analysis conditions are 
provided to assist in the diagnosis of certain instrument problems.

Action: Contact your Micromeritics Service Representative for advice on your 
current problem.
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4214- This analysis exceeds the maximum allowed length.

4219- At least one experiment must be selected and at least one box checked.

4220- Unexpected I/O error accessing data for an experiment in sample <name>.

Cause: The current analysis conditions script contains the maximum number 
of allowed steps (1000). You cannot add another step.

Action: Divide the analysis steps into two or more sample information files. 
Allow the sample tube to remain undisturbed on the analyzer while you 
repeatedly start analyses using these sample information files in 
sequence. When you divide the steps between sample information 
files, plan your divisions so that the ending conditions of one file and 
the initial experiment conditions of the next file facilitate the continu-
ing analysis. The data from the various sample information files can be 
integrated using the Peak Editor, since multiple sample information 
files can be edited at once. Note that the maximum number of exper-
iments that can be loaded into Peak Editor at one time (regardless of 
the number of sample files) is 16.

Cause: You are attempting to export the collected data from a Sample file, but 
not all of the required fields on this dialog box have been completed 
correctly.

Action: Select at least one experiment to be exported and check either Peak 
summaries, Measurements, or both. 

Cause: An unexpected disk error occurred while you were attempting to 
access experiment data. 

Action: The hard disk drive may have failed or may be corrupted.  Run diag-
nostics.
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4221- Cannot append an experiment to Sample file <name>. Maximum size may be 
exceeded.

4222- The Active Metal Table Options dialog box does not specify a stoichiometry 
factor for element <name>. One (1.0) was substituted for this value in the calculations.

4223- No element in the Active Metals Table Options has a `% of Sample Weight’ 
value greater than zero.

4224- The first peak is larger than the last. This report assumes inverse 
chemisorption.

Cause: You selected Save As from the experiment editor and elected to append 
the loaded experiments to an existing file. Either the existing Sample 
file already contains the maximum number of allowed experiments or 
the hard disk is full.

Action: Verify that at least 20 megabytes of disk space are available on the tar-
get disk drive and that the target Sample file contains fewer than 20 
experiments.

Cause: The Pulse Chemisorption report was selected, and requires a valid sto-
ichiometry factor for calculations. The Active Metal Table does not 
contain a valid stoichiometry factor for the specified element.

Action: Open the sample file in Advanced presentation. Click on the Report 
Options tab. Select the Pulse Chemisorption report, then click the Edit 
button. Edit the Active Metal Table for this file, specifying a valid sto-
ichiometry factor for the metal named in the error message. Save and 
close the file, then print the report.

Cause: The Pulse Chemisorption report was selected. None of the metals in 
the Active Metal Table are designated as being part of this sample.

Action: Edit the Active Metal Table in the Pulse Chemisorption report options 
and specify a `% of Sample Weight’ greater than zero for at least one 
metal.

Cause: This message appears on the Pulse Chemisorption Report when an 
inverse chemisorption experiment is reported.

Action: None required; informational only. If this experiment is not actually an 
inverse chemisorption experiment, it is not appropriate for this type of 
data reduction.
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4225- No reports were selected.

4226- No experiments were selected for inclusion in this report.

4227- The data requested on this report are not available.

4228- This sample does not contain an experiment which can be used in a <name> 
calibration.

Cause: A report was requested, but there are no reports selected in the sample 
information file.

Action: Open the sample information file and edit the report options. Make 
sure that at least one report type is selected (double-click on a report to 
select it; a check mark appears next to each selected report).

Cause: The report type that was selected for printing requires that you specify 
which experiments should be included in the report. No experiments 
were selected for this report.

Action: Open the sample file in advanced presentation. Click on Report 
Options, then on the selected report type. Click Edit and choose the 
experiments you wish to include in this report. If none of the experi-
ments within the Sample file are applicable to this type of report, dese-
lect the report type from the list shown on the Report Options dialog.

Cause: The data requested on a report, such as the Auxiliary 1 signal, are not 
contained within any of the selected experiments.

Action: Open the sample file in advanced presentation. Click the Report 
Options tab, then deselect this report type. Or, click the report type, 
then click the 

button. When the editing dialog for this report type opens, change the 
options so that they request data contained within the file.

Cause: You are attempting to load a sample which does not have valid peaks 
for this type of calibration into the calibration editor. A Gas Concen-
tration calibration requires a TCD Calibration experiment. A Spread 
Peaks calibration requires a Vapor Calibration experiment. A User 
Defined Peaks calibration will accept any experiment type with valid 
peaks defined.

Action: Select a sample file that contains the appropriate experiment type.
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4229- The calibration data for experiment <name> may already be loaded. You may 
delete duplicates after loading.

4230- The destination of a Grams/32 export must be a file.

4231- An error occured exporting experiment <number> from the sample ‘<file name>’.

4232- At least two peaks are required to determine heat of desorption.

Cause: Before you can reload the peak information for a sample file into the 
TCD Calibration dialog, you must first delete all previously loaded 
peaks.

Action: Delete all peaks from the dialog, then try loading the sample file again.

Cause: You selected a destination other than File for exporting in the Grams/
32 format.

Action: Perform the export operation again and choose File as the destination. 
You must use a File destination to export Grams/32 data.

Cause: You were attempting to export data to the Grams/32 application when 
an error occurred. Either the disk file required by the export could not 
be created or the named experiment contains invalid data.

Action: Ensure that sufficient disk space (at least 20 MB) to contain the 
exported file is available. Also examine the selected experiment with 
the Peak Editor to ensure that it contains valid data.

Cause: The heat of desorption is determined by fitting data obtained at differ-
ent temperature ramp rates. At least two data points must be present for 
the fit to be performed.

Action: Repeat the analysis with at least two experiments that have different 
ramp rates. Refer to Appendix J, TUTORIALS for a tutorial on per-
forming a TPD analysis.
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4233- Default mass spectrometer file directory (path name) is invalid. Resetting to the 
installation directory.

4234- File (name) is not a mass spectrometer data file.

4235- The mass spectrometer file (file name) cannot be opened for reading.

4236- The calibration data file (name) was not created with this instrument.

4237- Peak processing cannot be performed. The mass spectrometer data cannot be 
imported.

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories list to move to the correct directory.

Cause: You selected a file that does not contain appropriate mass spectrometer 
data.

Action: Choose a file that contains data collected by the Pfeiffer Vacuum (for-
merly Balzers) mass spectrometer using the QuadStar software.

Cause: A file-access error occurred when you attempted to access the mass 
spectrometer file.

Action: Ensure that you have selected a valid file name, and that you have the 
required permissions to read mass spectrometer files.

Cause: You attempted to load a calibration file containing data collected on an 
instrument different from the current one.

Action: Choose a sample file containing calibration data that were collected on 
the current instrument.

Cause: The mass spectrometer data did not include identifiable peaks.

Action: Select a different mass spectrometer file.
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4238- Peak Editor cannot be started.

4239- A calibration from instrument S/N <number> is required to calibrate experiment 
<name>.

4240- Error writing calibration information. The calibration of experiment <name> 
could not be changed.

Cause: You attempted to open the Peak Editor, but one of its components is 
missing.

Action: Reinstall the software.

Cause: In order to associate a calibration file with a Sample file, both files’ 
analyses must have been performed on the same instrument. The 
instrument must be connected to the computer for its calibration files to 
be available.

Action: Ensure that the instrument with the designated serial number is con-
nected to the computer and is active.

Cause: The calibration information for an experiment could not be changed 
because of an error writing to the disk file.

Action: The hard disk drive may have failed or it may be corrupt. Run diag-
nostics. Check that no other application has write access to the sample 
information file.
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4241- TCD Calibration is required for the calculations of this report.

4242- No valid vapors available.

4243- Ambient Temperature should be > 10 ºC.

4244- Average Syringe Area should be > 0.

4245- The peak table contains [nn] peaks. Exactly 6 peaks are required for loop 
calibration.

Cause: This report requires that TCD calibration be applied to the sample file.

Action: BET, Langmuir, and Total Pore Volume reports require inclusion of a 
TCD calibration. Use the Edit Peak view of the Peak Editor to assign a 
TCD calibration to the file. 

Cause: You are performing a vapor calibration and the peak table contains at 
least one entry in which the reflux temperature is not in the temperature 
range of any item in the vapor defaults.

Action A: Check the vapor defaults and see if the vapor you wish to use is listed; 
if so, ensure that its temperature range is correct.

Action B: If the values in vapor defaults are correct, delete the peaks in the peak 
table which have reflux temperatures outside the range of all items in 
the vapor defaults table.

Cause: The value for the ambient temperature is out of range; it is possible that 
the sample file has been corrupted.

Action: Call your Micromeritics service representative.

Cause: There is no peak data for the Loop calibration.

Action: Using the Peak Editor, edit the peaks, inserting new peaks if possible.

Cause: The number of peaks for the Loop calibrating is less than six; six are 
required.

Action: Using the Peak Editor, edit the peaks. Insert enough peaks to total six.
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4375- Cannot insert peak with negative height.

4376- Auto Fit cannot be executed unless a valid peak-set is selected.

4377- This operation cannot be performed on a negative peak set.

Cause: You attempted to insert a peak below the peak set’s baseline.

Action: Insert the new peak above the peak set’s baseline and/or adjust the 
baseline.

Cause A: You attempted to auto-fit a peak set, but there is no peak set current 
active.

Action A: Click on the desired peak or peak set in the peak-fit table to select a 
peak sest.

Cause B: You attempted to auto-fit, but there are no peak sets in the experiment.

Action B: Insert a new peak set into the experiment. Then choose Auto Fit  to find 
all peaks in the set.

Cause A: You attempted to insert a peak in a negative peak set.

Cause B: You attempted to move the boundaries of a negative peak set.

Cause C: You attempted to change the shape of a peak found within a negative 
peak set.

Cause D: You attempted to optimize the peaks of a negative peak set.

Cause E You attempted to auto-fit the peaks of a negative peak set.

Action: Invert the graph to make the peak set positive, then repeat the 
operation.
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6209- File cannot be opened for writing. It is already in use.

6219- Warning: the instrument (Unit <n> - S/N: nnn) is uncalibrated.

6221- Unit   - S/N:nnn has an invalid status/calibration file and cannot be initialized.

6222- The Vapor Generator for the instrument (Unit <n> - S/N: nnn) is uncalibrated.

6224- Unit   - S/N:nnn has an invalid status/calibration file and cannot be initialized.

Cause: You are attempting to access a file that is in use by some other part of 
the application.

Action: Close the window or application which is currently using the desired 
file and try again.

Cause: During initialization, the instrument determined that no calibration data 
exists for this instrument.

Action: Before performing any analysis or experiment, load the calibration 
information from the factory-supplied disk.

Cause: The status/calibration file, which tracks the status of the instrument, 
cannot be read by the AutoChem software.

Action: Reinstall the AutoChem software to make sure that the file is installed  
correctly.

Cause: During initialization, the instrument determined that no calibration data 
exists for this instrument.

Action: Before performing any analysis or experiment, load the calibration 
information from the factory-supplied disk.

Cause: The AutoChem software cannot read the file that tracks the instru-
ment’s status.

Action: Reinstall the AutoChem software to make sure that the file is set up 
correctly.
May 06                                                      I-29 



AutoChem II 2920 Appendix I
6225 - No Vapor Generator calibration is available on Unit n - S/N: nnn.
6226- No instrument calibration is available on Unit n - S/N: nnn.

6231- The sample has an invalid status and cannot be used for this analysis.

6232- Warning: The furnace is open, and sample/furnace temperature is above ambi-
ent. Do you want to continue? (Yes, No)

Cause: The unit could not be initialized because no factory-supplied calibra-
tion file has been loaded.

Action: Load the factory-supplied calibration file.

Cause: Only sample files with a status of No Analysis can be used for anal-
ysis. The sample file you have selected has a status other than No 
Analysis.

Action: Select a sample file with a status of No Analysis. 

Cause: The sample’s temperature (or that of the furnace) was above ambient, 
and/or the furnace was open when you attempted to start the analysis. 

Action: If the furnace/temperature condition is correct, click Yes. Otherwise, 
click No, correct the problem, then restart the analysis.
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6233- Warning: The furnace is open. Do you want to continue? (Yes, No)

6234- Warning: The sample/furnace temperature is above ambient. Do you want to 
continue? Yes, No

6264- Warning: The CryoCooler needs to be re-filled. Do you want to continue? (yes, 
no)

Cause A: You tried to start an analysis with the furnace door open, or the furnace 
is not connected to the analyzer. 

Action A: If the furnace condition is correct, click Yes. Otherwise click No, cor-
rect the problem, and restart the analysis.

Cause B: You tried to start an analysis with the furnace door closed, but the inter-
lock switch inside the furnace has failed.

Action B: Contact a Micromeritics Service Representative.

Cause: The sample’s temperature (or that of the furnace) was above ambient 
when you attempted to start the analysis. 

Action: If the sample’s temperature is correct, click Yes. Otherwise, click No, 
correct the problem, and restart the analysis.

Cause: You are starting an analysis with a low level of liquid in the Cryo-
Cooler.

Action: Select Yes to proceed with the analysis if the CryoCooler is not 
required. Select No, refill the CryoCooler, and restart the analysis if the 
CryoCooler is needed for this analysis.
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6267- Inter-application message cannot be delivered. Select Continue to resume 
analysis.
6268- Analysis paused. An inter-application message could not be delivered.
6269- Analysis paused. An inter-application message failed. The Receiver was busy.
6270- Analysis paused. An inter-application message failed. The Receiver refused the 
request.
6271- Analysis paused. An inter-application message failed for an unknown reason. 

6273- Warning. For the chosen total flow rate and blending proportions, the carrier 
and/or loop MFC will be set to a flow rate less than 10 cm3/min. Blending performance 
may not be acceptable. Do you wish to keep these settings? (Yes, No)

6275- Instrument (Unit, S/N) initialization failure (code)

Cause A: A DDE operation was not properly executed.

Action A: Ensure that the other application is loaded and in a state which supports 
DDE operations. If the problem persists, exit all applications and Win-
dows, then restart the applications.

Cause B: The DDE command was not specified correctly.

Action B: Review the DDE server application manual for the specific command 
and enter it correctly in the DDE command step.  If the problem per-
sists, exit all applications and Windows, then restart the applications.

Cause: You requested blending of the carrier and loop gasses, but the propor-
tions of the gasses and the flow rate of the mixture chosen caused at 
least one of the MFCs to be set to a rate less than 10 cm3/min. The 
accuracy of the MFC at such low flow rates may be unacceptable for 
some applications.

Action: Click Yes if reduced accuracy is acceptable or click No and change the 
proportions or total flow rate.

Cause: An internal error has occurred.

Action: Record the contents of the error message, then contact your Micromer-
itics service representative.
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6400 Series

6400- Warning. The flow sensed by the carrier flow sensor is below 5 cm3/min.

6401- Warning. The flow sensed by the reference flow sensor is below 5 cm3/min.

6402- Warning. The flow of the carrier Mass Flow Controller is below 5 cm3/min.

6403- Warning. The flow of the reference Mass Flow Controller is below 5 cm3/min.

Cause: The gas flow in the analysis path carrier gas plumbing is inadequate. 
Either it is blocked, or the gas source (its associated valves and gas 
supplies) is not activated.

Action: Ensure that the analysis gas Mass Flow Controller is set for a flow 
greater than 5 cm3/min., that one of its valves is open, and that the gas 
supply to the open valve is operating correctly.

Cause: The gas flow in the reference gas plumbing is inadequate. Either it is 
blocked, or the gas source (its associated valves and gas supplies) is not 
activated.

Action: Ensure that the reference Mass Flow Controller is set for a flow greater 
than 5 cm3/min., that one of its valves is open, and that the gas supply 
to the open valve is operating correctly.

Cause: The gas flow in the carrier gas plumbing is inadequate. Either it is 
blocked, or the gas source (its associated valves and gas supplies) is not 
activated.

Action: Ensure that the carrier Mass Flow Controller is set for a flow greater 
than 5 cm3/min., that one of its valves is open, and that the gas supply 
to the open valve is operating correctly.

Cause: The gas flow in the reference gas plumbing is inadequate. Either it is 
blocked, or the gas source (its associated valves and gas supplies) is not 
activated.

Action: Ensure that the reference Mass Flow Controller is set for a flow greater 
than 5 cm3/min., that one of its valves is open, and that the gas supply 
to the open valve is operating correctly.
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6404- Warning. The flow of the loop Mass Flow Controller is below 5 cm3/min.

6405- Warning. The flow of the carrier Mass Flow Controller differs from the target 
flow by 10% or more.

6406- Warning. The flow of the reference Mass Flow Controller differs from the target 
by 10% or more.

6407- Warning. The flow of the loop Mass Flow Controller differs from the target by 
10% or more.

Cause: The gas flow in the analysis gas plumbing is inadequate. Either it is 
blocked, or the gas source (its associated valves and gas supplies) is not 
activated.

Action: Ensure that the analysis Mass Flow Controller is set for a flow greater 
than 5 cm3/min., that one of its valves is open, and that the gas supply 
to the open valve is operating correctly.

Cause: The gas flow in the carrier gas plumbing is inadequate. Either it is 
blocked, or the gas source (its associated valves and gas supplies) is not 
activated.

Action: Ensure that the carrier Mass Flow Controller is set for a flow greater 
than 5 cm3/min, that one of its valves is open, and that the gas supply to 
the open valve is operating correctly.

Cause: The gas flow in the reference gas plumbing is inadequate. Either it is 
blocked, or the gas source (its associated valves and gas supplies) is not 
activated.

Action: Ensure that the reference Mass Flow Controller is set for a flow greater 
than 5 cm3/min., that one of its valves is open, and that the gas supply 
to the open valve is operating correctly.

Cause: The gas flow in the loop gas plumbing is inadequate. Either it is 
blocked, or the gas source (its associated valves and gas supplies) is not 
activated.

Action: Ensure that the loop Mass Flow Controller is set for a flow greater than 
5 cm3/min, that one of its valves is open, and that the gas supply to the 
open valve is operating correctly.
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6408- Warning. The detector heat zone has been reporting an invalid temperature 
(reading) for one minute.
6409-Warning. The loop heat zone has been reporting an invalid temperature (reading) 
for one minute.
6410- Warning. The analysis heat zone has been reporting an invalid temperature 
(reading) for one minute. 
6411- Warning. The cold trap heat zone has been reporting an invalid temperature 
(reading) for one minute.
6412- Warning. The vapor valve heat zone has been reporting an invalid temperature 
(reading) for one minute. 
6413- Warning. The vapor flask heat zone has been reporting an invalid temperature 
(reading) for one minute. 
6414- Warning. The vapor reflux heat zone has been reporting an invalid temperature 
(reading) for one minute. 

6415- Warning. The furnace thermocouple is not connected.

Cause A: Heater cable is loose or disconnected.

Action A: Connect the heater cable.

Cause B: There is a failure in the hardware or electronics.

Action B: Establish an Idle state in the instrument, turn the instrument power 
OFF, then turn it back ON. Allow the software to be initialized. If the 
problem recurs after the software has been active for about one minute, 
contact your Micromeritics Service Representative.

Cause A: The cable connecting the furnace thermocouple to the front panel of 
the instrument has been disconnected.

Action A: Connect the cable (the connector is shaped so that it can only go in one 
way).

Cause B: There is a failure in the hardware or electronics.

Action B: Contact your Micromeritics Service Representative.
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6416- Warning. The sample thermocouple is not connected or operating properly.

6417- Warning. System pressure has been above the allowed limit for more than 10 
seconds.
6418- Warning. System pressure has been above the tolerance level for more than 
one minute.

6419- Warning. Manual Control of the furnace is not supported when the Sample 
Temperature system is active.

Cause: Either the sample thermocouple is not connected, or it is not operating 
properly.

Action: Remove the top cover of the instrument and inspect the sample ther-
mocouple cable to insure that it is properly connected. If everything 
appears correct, substitute a different thermocouple. If the problem per-
sists, there is a failure in the hardware or electronics. Contact a 
Micromeritics Service Representative.

Cause: Gas flow is restricted at some point in the system.

Action: Examine the instrument schematic display to determine the current 
flow path from the carrier Mass Flow Controller, then examine the 
instrument’s components that correspond to the flow path. Use Manual 
Control to identify the location of the restriction. A typical source of 
blockage is a sample that is too tightly packed in the tube. Clear the 
restriction, if possible. If necessary, contact a Micromeritics Service 
Representative.

Cause: The operator has attempted a Manual Control operation during an auto-
matic analysis. The current step involves the sample temperature sys-
tem.

Action: Do not attempt manual operations during an analysis. If you wish to 
alter the sample temperature system manually during the analysis, sus-
pend the analysis, perform the operation, then resume the analysis. 
(The current step is skipped and the analysis is resumed on the next 
step.) 
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6420- Warning. Manual Control of a flow-related item is not supported when the Flow 
Management system is active.

6421- Warning. Manual Control of a TCD-related item is not supported when the Sig-
nal Management system is active.

Cause: You have attempted a Manual Control operation during an automatic 
analysis. The current step involves a flow-related item.

Action: Do not attempt manual operations during an analysis. If you wish to 
alter a flow-related item manually during the analysis, suspend the 
analysis, perform the operation, then resume the analysis. (The current 
step is skipped and the analysis is resumed on the next step.) 

Cause: You have attempted a Manual Control operation during an automatic 
analysis. The current step involves a TCD-related item.

Action: Do not attempt manual operations during an analysis. If you wish to 
alter a TCD-related item manually during the analysis, suspend the 
analysis, perform the operation, then resume the analysis. (The current 
step is skipped and the analysis is resumed on the next step.) 
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6422- Warning. Manual Control of a heat zone is not supported when the Signal Man-
agement system is active.

6423- Error. Operation suspended. The flow sensed by the carrier flow sensor is 
below 5 cm3/min.

6424- Error. Operation suspended. The flow sensed by the Reference Flow sensor is 
below 5 cm3/min.

Cause: You have attempted a Manual Control operation during an automatic 
analysis. The current step involves a heat zone.

Action: Do not attempt manual operations during an analysis. If you wish to 
alter a heat zone manually during the analysis, suspend the analysis, 
perform the operation, then resume the analysis. (The current step is 
skipped and the analysis is resumed on the next step.) 

Cause: The gas flow in the analysis gas plumbing is not adequate. Either it is 
blocked, or the gas source (a Mass Flow Controller, its associated 
valves, and gas supplies) is not activated.

Action: Ensure that the analysis Mass Flow Controller is set for a flow greater 
than 5 cm3/min., that one of its valves is open, and that the gas supply 
to the open valve is operating correctly.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you 
enable Manual Control, click on the detector heat zone and set the 
temperature to the correct value.

Cause: The gas flow in the reference gas plumbing is inadequate. Either it is 
blocked, or the gas source (a Mass Flow Controller, its associated 
valves, and gas supplies) is not activated.

Action: Ensure that the reference Mass Flow Controller is set for a flow greater 
than 5 cm3/min., that one of its valves is open, and that the gas supply 
to the open valve is operating correctly.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you 
enable Manual Control, click on the detector heat zone and set the 
temperature to the correct value.
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6425- Error. Operation suspended. The flow of the carrier Mass Flow Controller is 
below 5 cm3/min.

6426- Error. Operation suspended. The flow of the reference Mass Flow Controller is 
below 5 cm3/min.

Cause: The gas flow in the carrier gas plumbing is inadequate. Either it is 
blocked, or the gas source (its associated valves and gas supplies) is not 
activated.

Action: Ensure that the carrier Mass Flow Controller is set for a flow greater 
than 5 cm3/min., that one of its valves is open, and that the gas supply 
to the open valve is operating correctly.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you 
enable Manual Control, click on the detector heat zone and set the 
temperature to the correct value.

Cause: The gas flow in the reference gas plumbing is inadequate. Either it is 
blocked, or the gas source (its associated valves and gas supplies) is not 
activated.

Action: Ensure that the reference Mass Flow Controller is set for a flow greater 
than 5 cm3/min., that one of its valves is open, and that the gas supply 
to the open valve is operating correctly.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you 
enable Manual Control, click on the detector heat zone and set the 
temperature to the correct value.
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6427- Error. Operation suspended. The flow of the prep Mass Flow Controller differs 
from the target by 10% or more.

6428- Error. Operation suspended. The flow of the carrier Mass Flow Controller dif-
fers from the target by 10% or more.

Cause: The gas flow in the prep plumbing is inadequate due to either a block-
age or the gas source (its associated valves and gas supplies) is not acti-
vated.

Action: Ensure that the prep Mass Flow Controller is set for a flow, that one of 
its associated valves is open, and that the gas supply to the open valve 
is operating correctly.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you enable 
Manual Control, click on the detector heat zone and set the temperature 
to the correct value.

Cause: The gas flow in the carrier plumbing is inadequate due to either a 
blockage or the gas source (its associated valves and gas supplies) is 
not activated.

Action: Ensure that the carrier Mass Flow Controller is set for a flow, that one 
of its associated valves is open, and that the gas supply to the open 
valve is operating correctly.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you 
enable Manual Control, click on the detector heat zone and set the 
temperature to the correct value.
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6429- Error. Operation suspended. The flow of the reference Mass Flow Controller 
differs from the target by 10% or more.

6430- Error. Operation suspended. The flow of the loop Mass Flow Controller differs 
from the target by 10% or more.

6431- Error. Operation suspended. The detector heat zone has been reporting an 
invalid temperature (reading) for one minute.
6432- Error. Operation suspended. The loop heat zone has been reporting an invalid 
temperature (reading) for one minute. 
6433- Error. Operation suspended. The analysis heat zone has been reporting an 
invalid temperature (reading) for one minute.
6434- Error. Operation suspended. The cold trap heat zone has been reporting an 
invalid temperature (reading) for one minute. 
6435- Error. Operation suspended. The vapor valve heat zone has been reporting an 
invalid temperature (reading) for one minute.  
6436- Error. Operation suspended. The vapor flask heat zone has been reporting an 
invalid temperature (reading) for one minute. 

Cause: The gas flow in the reference gas plumbing is inadequate. Either it is 
blocked, or the gas source (its associated valves and gas supplies) is not 
activated.

Action: Ensure that the reference Mass Flow Controller is set for a flow greater 
than 5 cm3/min., that one of its valves is open, and that the gas supply 
to the open valve is operating correctly.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you enable 
Manual Control, click on the detector heat zone and set the temperature 
to the correct value.

Cause: The gas flow in the loop gas plumbing is inadequate. Either it is 
blocked, or the gas source (its associated valves and gas supplies) is not 
activated.

Action: Ensure that the loop Mass Flow Controller is set for a flow greater than 
5 cm3/min., that one of its valves is open, and that the gas supply to the 
open valve is operating correctly.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you enable 
Manual Control, click on the detector heat zone and set the temperature 
to the correct value.
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6437- Error. Operation suspended. The vapor reflux heat zone has been reporting an 
invalid temperature (reading) for one minute.  

6438- Error. Operation suspended. The furnace thermocouple is not connected.

Cause A: Heater cable is loose or disconnected.

Action A: Connect the heater cable.

Cause B: A failure has occurred in the hardware or electronics.

Action B: Establish an Idle state in the instrument, turn the instrument power 
OFF, then turn it back ON. Allow the controller software to be initial-
ized. If the problem recurs after the software has been active for about 
one minute, contact your Micromeritics Service Representative.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must rees-
tablish the TCD temperature using Manual Control. After you enable 
Manual Control, click on the detector heat zone and set the tempera-
ture to the correct value.

Cause C: The heat zone is calibrated incorrectly.

Action C: Contact your Micromeritics Service Representative.

Cause A: The cable connecting the furnace thermocouple to the front panel of 
the instrument has been disconnected.

Action A: Connect the cable (the connector is shaped so that it cannot be improp-
erly inserted).

Cause B: There is a failure in the hardware or electronics.

Action B: Contact your Micromeritics Service Representative.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you 
enable Manual Control, click on the detector heat zone and set the 
temperature to the correct value.
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6439- Error. Operation suspended. The sample thermocouple is not connected or 
operating properly.

6440- Error. Operation suspended. System pressure has been above the allowed limit 
for more than 10 seconds.

6441- Error. Operation suspended. An invalid instruction has been encountered 
(code # at # in experiment # after step #).

Cause: Either the sample thermocouple is improperly connected or it is not 
functioning properly.

Action: Remove the top cover of the instrument and inspect the sample ther-
mocouple cable to ensure that it is properly connected. If the connect 
appears correct, substitute a different thermocouple. If the problem per-
sists, there is a failure in the hardware or electronics. Contact a 
Micromeritics Service Representative.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you enable 
Manual Control, click on the TCD heat zone and set the temperature to 
the correct value.

Cause: Gas flow has been restricted at some point in the system.

Action: Examine the instrument schematic display to determine the current 
flow path from the carrier Mass Flow Controller, then examine the 
instrument’s components that correspond to the flow path. Use Manual 
Control to identify the location of the restriction. A typical source of 
blockage is a sample that is too tightly packed in the tube. Clear the 
restriction, if possible. If necessary, contact a Micromeritics Service 
Representative.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you enable 
Manual Control, click on the detector heat zone and set the temperature 
to the correct value.

Cause: A software error has occurred.

Action: Carefully record the entire text of this error message and the name of 
the sample file. Contact your Micromeritics Service Representative.
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6442- Error. Operation suspended. After 200 attempts, the instrument has failed to 
detect two consecutive peaks of equal area.
6443- Error. Operation suspended. After 200 attempts, the instrument has failed to 
detect two consecutive peaks of zero area.

6444- Error. Operation suspended. A signal wait time-out has occurred.

6445- Error. Operation suspended. A sample temperature operation time-out has 
occurred.

Cause: The sample tube contains little or no sample, or the sample is not react-
ing with the analysis gas.

Action: If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you enable 
Manual Control, click on the detector heat zone and set the temperature 
to the correct value.

Cause: The time allowed for a Wait step expired before the condition(s) of the 
Wait step were met.

Action: Examine the analysis conditions for this analysis to determine if suf-
ficient time was allowed for the conditions of this Wait step to be met. 
Determine if the analysis should proceed. You may either resume the 
analysis or cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you enable 
Manual Control, click on the detector heat zone and set the temperature 
to the correct value.

Cause: The time allowed for a sample temperature operation to be complete 
expired before the target temperature was reached. The control soft-
ware calculates a time limit based upon the ramp rate and the differ-
ence between the current temperature and the target temperature.

Action: Examine the current sample temperature. If it is acceptable for the pur-
poses of the current analysis, you may choose to resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you enable 
Manual Control, click on the detector heat zone and set the temperature 
to the correct value.
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6446- Error. Operation suspended. A gas flow operation time-out has occurred.

6447- Error. Operation suspended. An invalid parameter has been encountered (code 
# #).
6448- Error. Operation suspended. The requested script (ID = #) is not located in the 
instrument.
6449- Error. Operation suspended. There is insufficient room for the script (ID = #) 
(error code #).

6450- Warning. The requested gas flow is not possible because all inlet valves for 
this MFC are closed.

Cause: Stable gas flow in a Mass Flow Controller was not achieved within two 
minutes.

Action: Ensure that the gas supply for the open valve associated with the Mass 
Flow Controller is set to the correct pressure. Use Manual Control to 
detect the cause of the problem.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you enable 
Manual Control, click on the detector heat zone and set the temperature 
to the correct value.

Cause: A software error has occurred.

Action: Carefully record the entire text of this error message. On a floppy dis-
kette, save a copy of the sample file being analyzed. Contact your 
Micromeritics Service Representative.

Cause: A Manual control operation to set a gas flow in a Mass Flow Controller 
was requested, but all associated valves are closed.

Action: Use Manual Control to open the desired gas valve, then repeat the Set 
Flow Rate operation.
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6451- Error. Operation suspended. Communications with the furnace controller were 
unsuccessful due to a time-out.

6452- Error. Operation suspended. Sample temperature ramping/control has failed 
because the actual sample temperature differs from the temperature control element 
by more than 100 degrees C.

6453- Error. Operation suspended. An operation was requested that is not currently 
valid.

6454- Error. Operation suspended. The flow control interface board (channel <num-
ber>) was not ready within the allowed time.
6455- Error. Operation suspended. The heat zones interface board (channel <num-
ber>) was not ready within the allowed time.

Cause: Internal communications between the instrument software and the fur-
nace controller were unsuccessful; several retries were attempted.

Action: Make a note of the code number included in the error message. Contact 
your Micromeritics Service Representative.

Cause: The sample temperature has differed significantly from that of the fur-
nace for at least 10 minutes.

Action: Ensure that the sample thermocouple is properly installed and that the 
furnace is closed.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you 
enable Manual Control, click on the detector heat zone and set the 
temperature to the correct value.

Cause: A software error has occurred.

Action: Carefully record the entire text of this error message and the name of 
the sample file. Contact your Micromeritics Service Representative.

Cause: A hardware error has occurred.

Action: Carefully record the entire text of this error message and the name of 
the sample file. Contact your Micromeritics Service Representative.
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6456- Error. Operation suspended. A heat zone <code number> did not reach its tar-
get of <number> (current temperature = <number>) within the allowed time of 
<number> minutes.
6457- Error. Operation suspended. The furnace did not reach a temperature between 
<number> and <number> in the allowed time of <number> minutes.
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6458- Error. Operation suspended. Sample temperature equilibration is not allowed 
because sample temperature control is not active (code).

6463- Warning. The Cold Trap rotary valve did not operate correctly.

6464- Warning.  The Preparation rotary valve did not operate correctly.

Cause: A hardware error has occurred.

Action: Carefully record the entire text of this error message and the name of 
the sample file. Contact your Micromeritics Service Representative.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you enable 
Manual Control, click on the detector heat zone and set the temperature 
to the correct value.

Cause: An attempt to manually control the Cold Trap valve resulted in incor-
rect operation, possibly due to a mechanical problem. 

Action: Try the operation again 2-3 times. If the problem persists, lower the 
temperature of the associated heat zone and then try the operation 
again. If this is not successful, exit the software program and then turn 
the analyzer’s power off. After a few seconds, turn the analyzer’s 
power back on and then restart the software program. The valve should 
be re-initialized. Check that the valve moves freely using Manual Con-
trol. If the valve is still not operating correctly, contact a Micromeritics 
Service Representative. 

Cause: An attempt to manually control the Preparation (also known as the 
Analysis) valve resulted in incorrect operation, possibly due to a 
mechanical problem.

Action: Try the operation again 2-3 times. If the problem persists, lower the 
temperature of the associated heat zone and try the operation again. If 
this is unsuccessful, exit the program and turn the analyzer’s power off. 
After a few seconds, turn the analyzer’s power back on and restart the 
program. The valve should be reinitialized. Check that the valve moves 
freely using Manual Control. If the valve is still not operating correctly, 
contact a Micromeritics Service Representative.
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6465- Warning. The Inject rotary valve did not operate correctly. 

6466- Warning. The Vapor Generator rotary valve did not operate correctly.

6467- Warning. The KwikCool option is not installed.

Cause: An attempt to manually control the Inject (also known as the loop) 
valve resulted in an incorrect operation, possibly due to a mechanical 
problem.

Action: Try the operation again 2-3 times. If the problem persists, lower the 
temperature of the associated heat zone and try the operation again. If 
this is unsuccessful, exit the program and then turn the analyzer’s 
power off. After a few seconds, turn the analyzer’s power back on and 
restart the program. The valve should be reinitialized. Check that the 
valve moves freely using Manual Control. If the valve is still not oper-
ating correctly, contact a Micromeritics Service Representative. 

Cause: An attempt to manually control the Vapor Generator valve resulted in 
an incorrect operation, possibly due to a mechanical problem.

Action: Try the operation again 2-3 times. If the problem persists, lower the 
temperature of the associated heat zone and then try the operation 
again. If this is unsuccessful, exit the program and turn the analyzer’s 
power off. After a few seconds, turn the analyzer’s power back on and 
restart the program. The valve should be reinitialized. Check that the 
valve moves freely using Manual Control. If the valve is still not oper-
ating correctly, contact a Micromeritics Service Representative. 

Cause: An attempt to control manually the KwikCool option failed because 
the KwikCool option was not detected at the time the control was 
attempted. If analysis is resumed before the problem is corrected, the 
current step will NOT be completed.

Action: Confirm that the KwikCool option cable is properly connected to the 
analyzer. It is recommended that the power to the analyzer be turned 
off when you attach the KwikCool connector to the analyzer (or detach 
it). Once again, use Manual Control to attempt the KwikCool opera-
tion. If the problem persists, you may choose to continue operations 
without using the KwikCool. Or, you may try exiting the software pro-
gram and then turning the analyzer’s power off. After a few seconds, 
turn the analyzer’s power back on and then restart the software pro-
gram. If the problem cannot be corrected, contact a Micromeritics Ser-
vice Representative.
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6468- Error. Operation suspended. The Cold Trap rotary valve did not operate cor-
rectly. 

6469- Error. Operation suspended. The Preparation rotary valve did not operate 
correctly.

Cause: An attempt to control the Cold Trap valve during an analysis resulted 
in an incorrect operation, possibly due to a mechanical problem. If 
analysis is resumed before the problem is corrected, the current step 
will NOT be completed.

Action: Use manual control to try to operate the valve. If the problem persists, 
lower the temperature of the associated heat zone and then try the oper-
ation again. If this is not successful, exit the software program and then 
turn the analyzer’s power off. After a few seconds, turn the analyzer’s 
power back on and then restart the software program. The valve should 
be re-initialized. Check that the valve moves freely using Manual Con-
trol. Restart the analysis. If the problem still persists, contact a 
Micromeritics Service Representative.

Cause: An attempt to control the Preparation (also known as the Analysis) 
valve during an analysis resulted in an incorrect operation, possibly 
due to a mechanical problem. If the analysis is resumed before the 
problem is corrected, the current step will NOT be completed.

Action: Use manual control to try to operate the valve. If the problem persists, 
lower the temperature of the associated heat zone and then try the oper-
ation again. If this is not successful, exit the software program and then 
turn the analyzer’s power off. After a few seconds, turn the analyzer’s 
power back on and then restart the software program. The valve should 
be re-initialized. Check that the valve moves freely using Manual Con-
trol. Restart the analysis. If the problem still persists, contact a 
Micromeritics Service Representative. 
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6470- Error. Operation suspended. The Inject rotary valve did not operate correctly.

6471- Error. Operation suspended. The Vapor Generator rotary valve did not operate 
correctly.

Cause: An attempt to control the Inject (also known as the loop valve) during 
an analysis resulted in an incorrect operation, possibly due to a 
mechanical problem. If the analysis is resumed before the problem is 
corrected, the current step will NOT be completed.

Action: Use manual control to try to operate the valve. If the problem persists, 
lower the temperature of the associated heat zone and then try the oper-
ation again. If this is not successful, exit the software program and then 
turn the analyzer’s power off. After a few seconds, turn the analyzer’s 
power back on and then re-start the software program. The valve 
should be re-initialized. Check that the valve moves freely using Man-
ual Control. Restart the analysis. If the problem still persists, contact a 
Micromeritics Service Representative.

Cause: An attempt to control the Vapor Generator valve during an analysis 
resulted in an incorrect operation, possibly due to a mechanical prob-
lem. If the analysis is resumed before the problem is corrected, the cur-
rent step will NOT be completed.

Action: Use manual control to try to operate the valve. If the problem persists, 
lower the temperature of the associated heat zone and then try the oper-
ation again. If this is not successful, exit the software program and then 
turn the analyzer’s power off. After a few seconds, turn the analyzer’s 
power back on and then restart the software program. The valve should 
be re-initialized. Check that the valve moves freely using Manual Con-
trol. Restart the analysis. If the problem still persists, contact your 
Micromeritics Service Representative.
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6472- Error. Operation suspended. The KwikCool option is not installed.

6473- Warning. The CryoCooler option is not installed.

6474- Warning. The CryoCooler is almost empty. Temperature control may not be 
stable.

Cause: An attempt to operate the KwikCool option during an analysis failed 
because the KwikCool option was not detected at the time the opera-
tion was attempted. If the analysis is resumed before the problem is 
corrected, the analysis will continue without the KwikCool.

Action A: Confirm that the KwikCool option cable is properly connected to the 
analyzer. It is recommended that the power to the analyzer be turned 
off when you attach the KwikCool to the analyzer (or when you detach 
it).

Action B: Use Manual Control to attempt the KwikCool operation that was 
requested during the analysis. If this is not successful, exit the software 
program and then turn the analyzer’s power off. After a few seconds, 
turn the analyzer’s power back on and then restart the software pro-
gram. Restart the analysis. If the problem persists, contact your 
Micromeritics Service Representative.

Cause: You attempted to change the CryoCooler’s settings but the CryoCooler 
was not detected.

Action A: Verify that the CryoCooler is physically connected to the instrument 
and that the retaining screws on the connector are securely tightened.

Action B: Exit the 2920 application, turn off the instrument, then restart the appli-
cation. If the CryoCooler still does not respond, contact your 
Micromeritics service representative.

Cause: The liquid level in the CryoCooler is low. It may be impossible to 
achieve subambient temperatures unless cryogen is added.

Action: If the current analysis requires subambient temperatures, suspend the 
analysis, refill the CryoCooler with liquid nitrogen, then resume the 
analysis.
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6475- Warning. Manual control of the CryoCooler is not supported when the Sample 
Temperature system is active.

6476- Warning. Calibration of the detector heat zone failed. The previous calibration 
will be used.
6477- Warning. Calibration of the loop heat zone failed. The previous calibration will 
be used.
6478- Warning. Calibration of the analysis heat zone failed. The previous calibration 
will be used.
6479- Warning. Calibration of the cold trap heat zone failed. The previous calibration 
will be used.
6480- Warning. Calibration of the vapor valve heat zone failed. The previous calibra-
tion will be used.
6481- Warning. Calibration of the vapor flask heat zone failed. The previous calibra-
tion will be used.
6482- Warning. Calibration of the vapor reflux heat zone failed. The previous calibra-
tion will be used.

Cause: You attempted to change the CryoCooler’s settings while a temperature 
ramp was in progress.

Action: Wait until the temperature ramp is finished before adjusting the Cryo-
Cooler’s settings.

Cause A: The measured temperature when the high calibration value was entered 
was less than the measured temperature when the low calibration value 
was entered.

Action A: Repeat the calibration, ensuring that the entered temperatures are accu-
rate. If you are calibrating the vapor flask zone, ensure that the heating 
mantle is attached to the instrument properly.

Cause B: The temperature is being measured improperly by the instrument.

Action B: Contact your Micromeritics service representative if you continue to 
receive this message.
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6483- Error. analysis cannot proceed. System pressure has been above the allowed 
limit for more than 10 seconds.

Cause: Gas flow has been restricted at some point in the system.

Action: Examine the instrument schematic display to determine the current 
flow path from the carrier Mass Flow Controller, then examine the 
instrument’s components that correspond to the flow path. Use Manual 
Control to identify the location of the restriction. A typical source of 
blockage is a sample that is too tightly packed in the tube. Clear the 
restriction, if possible. If necessary, contact a Micromeritics Service 
Representative.

If you are able to correct the problem, you may resume the analysis; 
otherwise, cancel it. Before you resume the analysis, you must re-
establish the TCD temperature using Manual Control. After you 
enable Manual Control, click on the detector heat zone and set the 
temperature to the correct value.
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J.  TUTORIALS

This appendix contains tutorials for performing a:

• typical analysis, beginning on this page
• TPR analysis, page J-9
• TPD analysis, page J-14
• TPO analysis, page J-19
• BET analysis, page J-23
• Pulse chemisorption analysis, page J-32
• Loop calibration, page J-38
• Gas concentration calibration, page J-42
• Vapor generator calibration, page J-45

Typical Analysis

The instructions in this section are provided to familiarize you with the software and analyzer. 
More detailed instructions for performing each analysis type are found later in this appendix. 

Analysis conditions sets are included with the software for TPR, TPO, TPD, Pulse Chemi-
sorption, and BET experiments. For this tutorial, you may perform any one of these analyses, 
using any sample you choose. Using a reference sample is recommended. 

In this example, we use Cupric Oxide (15-20 mg) to perform a TPR experiment. This analysis 
uses a mixture of hydrogen with an inert gas as the carrier gas. No loop gas is used.

1. Prepare and determine the mass of the sample, then load it on the analyzer. Make other 
preparations for the type of analysis you plan to perform (such as preparing the cold trap 
and dewar, and positioning the thermocouple) as directed in Chapter 4.

2. Make sure that the correct gases are connected. Also check to be sure that the Gas 
Selections table (on the Unit menu) accurately reflects the current gas connections.

3. Select Unit > Start Analysis; the Analysis dialog sequence opens. You are first presented 
a dialog from which to choose a sample file. In this example, you are creating a new 
sample file; click OK to accept the default.

As always, the operator is responsible for making sure that safe combinations of 
samples and gases are used.
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4. Click Yes to create the file. The Analysis dialog opens containing the sample file you are 
creating; all fields contain default values. Complete the dialog as shown below. (Basic 
sample file presentation format is shown; Advanced format may also be used.)

5. Click Next three times to accept the calibration and reports defaults (although these can 
be changed when you are performing your own analyses) and to verify the caution 
information.

6. Click Start and the analyzer begins the experiment.

Observe the Analysis

The Analysis window contains four different views in which to observe the progress of your 
analysis. You select the view from the View drop-down list. The Instrument Schematic view 
shows the current status of the internal components of the instrument. The Results view dis-
plays the results, periodically updating the view as data are collected. The Sample Log view 
lists the completed steps contained in the current experiment, as well as any error messages 
that may have occurred during the analysis. During the time your analysis is running, open 
each view and explore the system’s features.

• Select the Instrument Schematic view and click on the sample tube illustration. The 
box at the lower right corner of the schematic shows updated details about the 
temperatures related to the sample furnace heat zone. Clicking on other parts of the 
schematic causes their details to be displayed in the detail box.

If desired, change or add 
to the default identifier.

Enter the sample mass.

From the drop-down list, select 
the analysis conditions set that 
is appropriate for the type of 
analysis you wish to perform.
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• Select the Results view to observe the peaks after the baseline stabilizes and recording 
begins. This illustration shows the Results view of a TPR analysis on CuO in progress.

Sample Tube Illustration Detail Box
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In the following illustration, Y-axis Temperature readings have been added to the display. 
(Instructions for making such changes to the display are given below.)

Note that the display is rescaled automatically as the experiment progresses.

• While the Results view is displayed, click Options. A dialog opens that allows you to 
change the presentation of the results.

Y-axis Mark the check box(es) for the results you wish to display.

X-axis Mark a radio button to choose Time or Temperature for the 
X-axis. You can also specify the starting value for the X-
axis.
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• Select the Sample Log view to review a list of each step as the analyzer begins it. The 
Sample Log also lists any error messages that occur during the analysis.

Ending the Analysis

During an analysis, the software executes each step in the analysis conditions set. The last 
step in every analysis is the Done step. The Done step lets you specify the ending state of the 
analyzer. The Done step is completed when the analyzer reaches the state specified.

After the Done step is completed, you can continue to examine the data using the various 
views of the Analysis dialog, or you can close the Analysis dialog by clicking Next.

Click Scaling to open a 
dialog that enables you to 
control the scale of the 
selected axis.

Click Scaling for the TCD reading 
to specify whether or not to show 
the concentration (when available) 
and whether or not to autoscale the 
concentration and/or signal 
readings.

Do not close the Analysis dialog until you have finished observing the data using its 
various views.
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After you close the Analysis dialog, you can no longer use its views to assess this sample’s 
data. However, you can view this sample’s data in reports, by using the Peak Editor, and (if 
you use Advanced format for your sample files) by opening the sample information file to 
view the collected data. 

Printing Reports

Desired report options are selected (and edited if required) from the sample information file. 
These reports can be generated automatically to a choice of destinations by selecting the 
report option on the third dialog of the Start Analysis series of dialogs (Chapter 6).

If desired, you can generate partial reports at any time during the analysis or additional 
reports after the analysis. To do so, select Start Report from the Report menu. Select the 
sample file you wish to report on, then click OK. In the reports list box, deselect and/or select 
the reports you do not wish to print, then click OK. 

Refer to Chapter 7 for additional information on reports.

Editing the Peaks

A set of peak-picking parameters is contained in the sample information file. The software 
automatically detects peaks that meet these criteria, and all such peaks are included in the 
results. In some cases, the automatically detected peaks accurately represent the results. How-
ever, it is often helpful to edit the peaks using the Peak Editor. The Peak Editor can be used at 
any time during or after an analysis. 

1. Select Report > Peak Editor; a files list box is displayed. Select the desired sample file, 
then click OK.

The Peak Editor defaults to the Experiments - Stacked view. This view shows the signals 
for all experiments contained in the file in a stacked fashion, one after the other. This 
example shows two experiments.
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2. Right-click in the graph area to display a menu of the functions available while the Peak 
Editor is in this view. Refer to Chapter 7 for a description of these functions.

3. Click Experiments - Overlay; this view displays the results of all experiments (in this 
example, the same two shown previously) in an overlaid manner.

4. Right-click in the graph area to view the functions available for this view.

5. Click View Signals; this view shows the currently selected experiment in context with 
the temperature conditions that occurred during the analysis (as well as auxiliary signals, 
if they were recorded). 

6. Right-click in the graph area to view the functions available in this view.
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7. Click Edit Peaks; the selected experiment is shown with a peak table detailing peak 
information positioned on top.

8. Right-click in the graph area to view the functions available for editing the peaks. 
Experiment with some of the options if you like, then click No when asked if you wish to 
save the peak data. 

9. Click Fit Peaks; this view shows the selected experiment with a peak table positioned on 
top.

This view allows you to define a set of peaks; for example you may wish to create a table 
containing only the peaks of interest.

10. Right-click in the graph area to view the functions available for creating peak sets. 
Experiment with some of the options; you can delete the peak sets when finished.

When multiple peaks are displayed, the peak markings for the selected peak are 
always green.
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Example Analyses

This section contains a description and instructions for performing each type of analysis. The 
descriptions provide a very basic overview of each type of analysis. Recommendations for 
gases, ramp rates, etc. are generalizations which are valid for many types of samples, but not 
all. The examples provided are the same as the standard analysis conditions sets that are 
included in the software. 

TPR Analysis

Description

Temperature-Programmed Reduction (TPR) determines the number of reducible species 
present in the catalyst and reveals the temperature at which reduction occurs. An important 
aspect of TPR analyses is that the sample need not have any special characteristics other than 
containing reducible metals. 

The TPR analysis begins by flowing analysis gas (typically hydrogen in an inert carrier gas 
such as nitrogen or argon) over the sample, usually starting at ambient temperature. While the 
gas is flowing, the temperature of the sample is increased linearly with time and the con-
sumption of hydrogen by adsorption/reaction is monitored. Changes in the concentration of 
the gas mixture are determined. This information yields the hydrogen uptake volume.

The operator is responsible for understanding the sample’s properties, in order to 
make gas and temperature selections that are safe and that yield useful data.

Analysis summaries include a basic explanation of the scientific theory upon which 
the analysis is based. If more extensive theory information is needed, you may wish to 
obtain a copy of Analytical Methods in Fine Particle Technology. Refer to Chapter 10 
for ordering information.

Remember that other chapters in this manual describe each menu, window, and field 
in detail. Refer to these chapters if you have a question about a step described in 
these procedures.
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Preparation

Pretreatment Oxidize by flowing O2 over the sample.

Analysis Flow 5-10% hydrogen/argon OR 5-10% hydrogen/ nitrogen, 
while ramping the temperature. The analyzer records hydro-
gen consumption as a function of temperature. Nitrogen is 
sometimes used because it is more economical than argon. 
However, argon is recommended over nitrogen because the 
resultant peak(s) show no reaction between sample and gas.

Cold Trap A cold trap is not required if you use argon and only traces 
of water are formed as a product of the reduction, and if the 
internal analyzer temperature zones are maintained at 100 
°C or higher during the entire experiment. This method is 
preferred for longer experiments, because it eliminates the 
need to replenish the dewar.

When you use argon, the need for a cold trap may vary. In 
some cases a small amount of water may be found, so the 
cold trap may be needed. If only a small amount of water is 
produced, no cold trap is needed, because the thermal con-
ductivity of argon and water vapor are very similar, so the 
water vapor’s presence does not affect the signal reading. 
Best baseline stability and lowest noise always result from 
using a cold trap.

A cold trap is needed for the entire analysis if you are using 
nitrogen, because water vapor and nitrogen have different 
thermal conductivities.

Before performing an analysis, make sure you have adequately prepared the sample 
and analyzer using the instructions in Chapter 4.
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Procedure

The following steps are provided as an example of how to perform a TPR analysis of copper 
oxide. Make the appropriate modifications to these steps for the material you wish to analyze. 

1. Obtain the sample weight, then install the loaded sample tube on the analyzer. If the 
analysis begins below ambient, either place a dewar of coolant around the sample tube, or 
close the furnace around the sample tube and install the CryoCooler. If the analysis 
begins at ambient, close the furnace around the sample tube.

2. Install the cold trap (if you are using one), then place a dewar filled with coolant around 
it. Make sure that the dewar contains enough coolant to cover the cold trap loops. 

A mixture of isopropyl alcohol (IPA) and liquid nitrogen (LN2) is the recommended 
coolant for this experiment. Place the isopropyl alcohol in a dewar and slowly pour LN2 
into the dewar as you stir the mixture. Continue to add and stir the mixture until it 
becomes a slush. The mixture must be capable of achieving a temperature of about 
-90 ºC. 

3. Create a sample information file for this analysis. (Descriptions of the File menu items 
are found in Chapter 5.) 

a. Select File > Open > Sample Information. Enter a file name or accept the default; 
click OK, then Yes to confirm.

b. Complete the Sample Information dialog. Enter the correct weight and, if desired, 
complete the optional descriptive fields (comments, operator, etc.).

c. Click the Analysis Conditions tab and insert the experiment steps listed below:

Some reactions begin at temperatures below ambient. In such cases, a dewar 
containing an appropriate coolant should be used instead of the furnace at the 
beginning of the experiment. For example, reduction of PtO should begin at 
approximately -50 °C, because the reaction begins at about -30 °C. Alternatively, the 
optional CryoCooler can be used.

Extreme caution should be used when mixing the IPA/LN2. If the dewar is damaged 
during this process, the mixture could be expelled from the dewar, causing injury.
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Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:
Experiment New Experiment Experiment Descrip-

tion
Type an appropriate description.

Type of analysis Select Temperature Pro-
grammed Reduction from the 
drop-down list.

Zones Block
Filament
Cold Trap
Analysis
Loop
Vapor generator
Reflux
Flask

100
175
110
110
110
40
40
40

Gas Flows Prep Helium
Carrier/Reference 10H2-Ar OR 10H2-N2
Loop None
Valve states Trap, Prepare, Fill, Bypass
Flow rate (all gases) 50 cm3/min

Outputs Use defaults
Peaks Use defaults

Wait Wait Select: Wait for 
operator

Type: Add sample and set up cold 
trap.

Change Gas 
Flows

Gas Flows Prep None

Carrier 10H2-Ar
Loop None
Valve states Trap, Analyze, Fill, Bypass

Wait Wait Select: Wait until baseline is stable.
Recording Start Recording One measurement 

every:
1.0 seconds

Temperature 
Ramp

Temperature 
Ramp

Ramp Type Sample Ramp
End Temperature 400
Rate 10.0
Hold Time 0.00

The software automatically inserts a Stop Recording step when a Start Recording step is 
inserted. Make sure that you insert the Temperature Ramp step within the Start/Stop Record-
ing loop.
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d. Click on the Report Options tab and set the values to those you wish to use. 

e. Click Save then Close.

4. Start the analysis. (Descriptions of the Unit menu options are found in Chapter 6.)

a. From the Unit menu, select Start Analysis. From the Files list box, select the sample 
file you just created. 

b. You can edit the sample file, if needed. For this example, no editing is required; click 
Next to continue.

c. The second dialog appears. From the drop-down list, select the calibrations associ-
ated with each experiment in the sample file (if any). For this example, select None.

d. Click Next; the next Analysis dialog appears: the reports dialog, no changes are 
needed.

e. Read the cautionary dialog and make any necessary changes, then click Start to start 
the analysis.

As the temperature increases, the copper oxide is reduced, the water produced by the 
reaction is collected in the cold trap (if used), and the amount of hydrogen consumed is 
detected and transmitted to the software. Use the Results view to display a chromatogram 
of the hydrogen consumed from the detector signal as a function of the ramping 
temperature. 

A hydrogen consumption peak which corresponds to the reduction capacity of copper 
oxide is displayed. The maximum peak should occur at approximately 280 ºC. This 
temperature varies highly, depending on the CuO particle size. Larger particle size shifts 
the temperature upward to 330 °C or more. Under certain combinations of sample, 
hydrogen concentration, and flow rate, two peaks may appear due to the transition state of 
Cu2+ to Cu+ to Cu. 

Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:
Done Done (Click Edit, 

if necessary)
Return to ambient Yes
Detector Off
Gas Flows Not applicable
Zones Not applicable

Calibration files can also be associated with a sample file after analysis through the 
Peak Editor using Set Calibration.
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5. Allow the TCD signal to return to the initial baseline after the peak has been recorded. 
When the analysis concludes, remove the sample tube.

TPD Analysis

Description

Temperature-Programmed Desorption (TPD) analyses determine the number, type, and 
strength of active sites available on the surface of a catalyst from measurement of the amount 
of gas desorbed at various temperatures. 

After the sample has been outgassed, reduced, or otherwise prepared, a steady stream of anal-
ysis gas flows over the sample and reacts with the active sites. (Alternatively, a step-like 
stream of gas is used when Pulse Chemisorption is used to react with active sites.) Pro-
grammed desorption begins when the temperature is ramped linearly over time while a 
constant stream of inert carrier gas passes over the sample. 

At a certain temperature, the heat will overcome the activation energy, breaking the bond 
between the adsorbate and adsorbent. The adsorbed species will then desorb. If different 
active metals are present, they usually will desorb the reacted species at different tempera-
tures. The desorbed molecules enter the stream of inert carrier gas and are swept to the 
detector, which measures the gas concentrations. The volume of desorbed species combined 
with the stoichiometry factor, and the temperature at which pre-adsorbed species desorb, yield 
the number and strength of active sites. 

Preparation

Use the cotton gloves provided in the accessory kit if you wish to remove the sample 
tube before it has cooled. You may use rubber gloves to handle the sample tube when 
it has cooled.

Pretreatment Degas by flowing inert gas (such as helium, argon, or nitro-
gen) over the sample while ramping the temperature.

Analysis Choose a gas mixture from the following table based on the 
results desired. Flow the gas over the sample, then ramp the 
temperature beginning at ambient. 

Results Desired Carrier Gas Analysis Gas

Active Metal Surface Area H2 Chemisorption argon hydrogen

Active Metal Surface Area CO Chemisorption helium carbon monoxide
Acidity helium ammonia (15% maxi-

mum NH3 blended in 
helium)
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Procedure

Instructions given here are specific for analyzing zeolite with ammonia (use 15% maximum 
NH3 blended in helium) at 3 to 20 ºC/min. You should adjust the values given in the example 
to accommodate the analysis you are performing.

1. Obtain the sample weight, then install the loaded sample tube and thermocouple on the 
analyzer. Close the furnace around the sample tube.

2. Create a sample file for this analysis. 

a. Select File > Open > Sample Information. Type a file name or accept the default; 
click OK, then Yes to confirm.

b. Complete the Sample Information dialog. Enter the correct weight and, if desired, 
complete the optional descriptive fields (comments, operator, etc.).

c. Click the Analysis Conditions tab and insert the experiment steps listed below:

Cold Trap Not required.

Before performing an analysis, make sure you have adequately prepared the sample 
and analyzer using the instructions in Chapter 4.
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Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:
Experiment New Experiment Experiment Descrip-

tion
Type an appropriate description.

Type of analysis Select Other from the drop-down 
list.

Zones Block
Filament
Cold trap
Analysis
Loop
Vapor generator
Reflux
Flask

100
175
110
110
110
20
20
20

Gas Flows Prep Helium
Carrier/Reference Helium
Loop None
Flow rate 50 cm3/min
Valve states Bypass, Prepare, Fill, Bypass

Outputs Use defaults
Peaks Use defaults

Temperature 
Ramp

Temperature 
Ramp

Type Sample Ramp
End Temperature 350
Ramp Rate 50.0
Hold Time 10.00

Experiment New Experiment Experiment descrip-
tion

Type an appropriate description.

Type of analysis Select Temperature Pro-
grammed Desorption from the 
drop-down list.

Zones Block
Filament
Cold trap
Analysis
Loop
Vapor generator
Reflux
Flask

100
175
110
110
110
50
40
50

Gas Flows Prep Helium
Carrier Helium
Loop None
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Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:
Experiment
(continued)

Gas Flows Flow rate 50 cm3/min
Valve states Bypass, Prepare, Fill, Bypass

Outputs Use defaults
Peaks Use defaults

Temperature 
Ramp

Temperature 
Ramp

Type Return to Ambient

Change Gas 
Flows

Gas Flows Prep Ammonia (15% maximum NH3 
blended in helium)

Carrier Helium
Loop Ammonia (15% maximum NH3 

blended in helium)
Flow rate 50 cm3/min
Valve states Bypass, Prepare, Fill, Bypass

Wait Wait Select: Wait Type: 60.0 minutes
Change Gas 
Flows

Gas Flows Prep None
Carrier Helium
Loop Ammonia (15% maximum NH3 

blended in helium)
Valve states Bypass, Analyze, Fill, Bypass

Wait Wait Select: Wait Type: 30.00 minutes
Wait Wait Select: Wait until baseline is stable.
Recording Start Recording One measurement 

every
1.0 seconds

Temperature 
Ramp

Temperature 
Ramp

Type Sample Ramp
End Temperature 500
Rate 3.0
Hold Time 0.0

The software automatically inserts a Stop Recording step when a Start Recording step is 
inserted. Make sure that you insert the Temperature Ramp step within the Start/Stop Record-
ing loop.
Wait Wait Select: Wait Type: 30.00 minutes
Temperature 
Ramp

Temperature 
Ramp

Type Return to Ambient
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d. Click the Report Options tab and set the values to those you wish to use. Click Save, 
then Close.

3. Start the analysis. (Descriptions of the Unit menu options are found in Chapter 6.)

a. Select Unit > Start Analysis. From the Files list box, select the sample file you just 
created. 

b. You can edit the sample file, if needed. For our example, no editing is required; click 
Next to continue.

c. The second dialog appears. From the drop-down list, select the calibrations associ-
ated with each experiment in the sample file (if any). For this example, select None.

d. Click Next; the next Analysis dialog appears: the reports dialog. For this example, 
no changes are needed.

e. Read the cautionary dialog and make any necessary changes, then click Start to start 
the analysis.

When the analysis ends, the furnace begins to lower the sample to room temperature. To 
speed cooling of the sample, you may wish to use the optional CryoCooler or KwikCool. 
Remove the sample tube when the analysis is complete.

Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:
Repeatedly insert the last several steps from the step that is double-outlined above (Wait until 
baseline is stable step). Use a different ramp rate for each repetition; after ramping at 3°/min. 
and 5°/min., use 10, 15, and 20°/min. (This shifts the peak as a function of the Heat of Des-
orption.)
Done Done (Click Edit, 

if necessary)
Return to ambient Yes
Detector Off
Zones Not applicable
Gas Flows Not applicable

Use the cotton gloves provided in the accessory kit if you wish to remove the sample 
tube before it has cooled. You may use rubber gloves to handle the sample tube when 
it has cooled.
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TPO Analysis

Description

Temperature-Programmed Oxidation (TPO) examines the extent to which a catalyst can be 
re-oxidized. Generally, TPO analyses are used to measure the degree of reduction of certain 
oxides.

Usually the sample is pretreated and the metal oxides are reduced to the base metal. Then the 
reactant gas is applied to the sample in pulses or (alternatively) as a steady stream. The 
AutoChem 2920 measures the uptake of the reactant gas.

TPO is always performed after TPR is performed. When the TPR experiment concludes, the 
sample is returned to room temperature. (This process can be accelerated using the optional 
CryoCooler or KwikCool.) Then, the analysis gas is changed to 2-5% O2 + He. This gas mix-
ture is flowed through the sample at ambient temperature, then the temperature is ramped up 
to the same maximum temperature used for the preceding TPR analysis. The portion of the 
sample that had been reduced is re-oxidized, and the degree of reduction can be calculated.

If the TPR and TPO results are different, there are two possible causes: the sample material 
sintered or it reacted with the gas.

Preparation

Pretreatment TPR

Analysis 2 to 5% oxygen/helium is flowed through the sample while 
temperature is ramped, beginning at ambient temperature.

Cold Trap None needed

Before performing an analysis, make sure you have adequately prepared the sample 
and analyzer by following the steps described earlier in this chapter.

For the following example, a TPO is performed on WO3. Because TPR is used as the 
preparation for TPO, the TPR process was included in this example.
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Procedure

1. Obtain the sample weight, then install the loaded sample tube and thermocouple on the 
analyzer. Close the furnace around the sample tube.

2. Create a sample file for this analysis.

a. Select File > Open, Sample Information. Type a file name or accept the default; 
click OK, then Yes to confirm.

b. Complete the Sample Information dialog. Enter the correct weight and, if desired, 
complete the optional descriptive fields (comments, operator, etc.)

c. Click on the Analysis Conditions tab and insert the experiment steps in the following 
table:

Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:
Experiment New Experiment Experiment Descrip-

tion
Type an appropriate description.

Type of analysis Select Temperature Pro-
grammed Reduction from the 
drop-down list.

Zones Block
Filament
Cold trap
Analysis
Loop
Vapor generator
Reflux
Flask

100
175
110
110
110
20
20
20

Gas Flows Prep Helium
Carrier 10 H2-Ar
Loop None
Flow rate 50 cm3/min
Valve states Trap, Prepare, Fill, Bypass

Outputs Use defaults
Peaks Use defaults

Temperature 
Ramp

Temperature 
Ramp

Type Return to Ambient

Change Gas 
Flows

Gas Flows Prep None
Carrier/Reference 10 H2-Ar
Loop None
Valve states Bypass, Analyzer, Fill, Bypass
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Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:
Wait Wait Select: Wait for 

operator
Type: Position cold trap dewar 
and close furnace.

Wait Wait Select: Wait until baseline is stable.
Recording Start Recording One measurement 

every
1.0 seconds

Temperature 
Ramp

Temperature 
Ramp

Type
End temperature
Rate
Hold time

Sample Ramp
980
10.0
0.00

The software automatically inserts a Stop Recording step when a Start Recording step is 
inserted. Make sure that you insert the Temperature Ramp step within the Start/Stop Record-
ing loop.
Change Gas 
Flows

Gas Flows Prep Helium
Carrier/Reference Helium
Loop None
Valve states Bypass, Prepare, Fill, Bypass

Temperature 
Ramp

Temperature 
Ramp

Type Return to Ambient

Experiment New Experiment Experiment Descrip-
tion

Type an appropriate description.

Type of analysis Select Temperature Pro-
grammed Oxidation from the 
drop-down list.

Zones Block
Filament
Cold trap
Analysis
Loop
Vapor generator
Reflux
Flask

100
175
110
110
110
20
20
20

Gas Flows Prep Helium
Carrier/Reference 2 02-He
Loop None
Flow rate 50 cm3/min
Valve states Bypass, Prepare, Fill, Bypass

Outputs Use defaults
Peaks Use defaults

Wait Wait Select: Wait until baseline is stable.
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d. Click the Report Options tab and set the values to those you wish to use. 

e. Click Save, then Close. 

3. Start the analysis. (Descriptions of the Unit menu options are found in Chapter 6.)

a. Select Unit > Start Analysis. From the Files list box, select the sample file you just 
created. 

b. You can edit the sample file if needed. For this example, no editing is needed; click 
Next to continue.

c. The second dialog appears. From the drop-down list, select the calibrations associ-
ated with each experiment in the sample file (if any). For this example, select None.

d. Click Next; the next Analysis dialog appears: the reports dialog. For our example, no 
changes are needed.

e. Read the cautionary dialog and make any necessary changes, then click Start to start 
the analysis.

Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:
Recording Start Recording One measurement 

every:
1.0 seconds

Temperature 
Ramp

Temperature 
Ramp

Type Sample Ramp
End Temperature 980
Rate 20.0
Hold Time 0.00

The software automatically inserts a Stop Recording step when a Start Recording step is 
inserted. Make sure that you insert the Temperature Ramp step within the Start/Stop Record-
ing loop
Change Gas 
Flows

Change Gas Flows Prep Helium
Carrier Helium
Loop None
Valve states Bypass, Prepare, Fill, Bypass

Temperature 
Ramp

Temperature 
Ramp

Type Return to Ambient

Done Done (Click Edit, 
if necessary)

Return to ambient Yes
Detector Off
Zones Not applicable
Gas Flows Not applicable
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4. As the temperature increases, the sample is oxidized, and the software calculates the 
volume of oxygen taken up.

5. Allow the TCD signal to return to the initial baseline after the peak has been displayed. 

6. When the displayed sample temperature reaches the ambient temperature, open the 
furnace. Using gloves, remove the sample tube. 

BET Surface Area Analysis

Description

The BET Surface Area analysis lets you evaluate total surface area of the catalyst before and 
after chemisorption. Disactivation, which may occur due to the blocking of pores during the 
chemisorption reaction, as well as the occurrence of sintering of the support, can be studied. 

After outgassing the sample, a mixture of 30% nitrogen and 70% helium is applied to the 
sample which is immersed in a liquid nitrogen (LN2) bath. The amount of nitrogen adsorbed 
(usually measured on desorption) at LN2 temperatures is used to calculate total surface area. 

Because nitrogen uptake is a function of pore size, sample sintering can cause results to show 
reduced surface area. Therefore, it may be helpful to perform BET as the first and last exper-
iments in your analysis, in order to check for sintering of the support.

When the analysis ends, the furnace begins to lower the sample to room temperature. 
To speed cooling of the sample, you may wish to use the optional CryoCooler or 
KwikCool.

Use the cotton gloves provided in the accessory kit if you wish to remove the sample 
tube before it has cooled. You may use rubber gloves to handle the sample tube when 
it has cooled.
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Preparation

Calibration

BET experiments require a separate calibration consisting of three manual injections of nitro-
gen through the septum. You can perform this calibration either before or after the BET 
analysis is performed. As with all TCD calibrations, you will use the Peak Editor to associate 
the calibration file with the analysis file. For this reason, it is necessary that the data on the 
manual injections are collected in a separate experiment from the BET experiment. The injec-
tions may be included in the same analysis as the BET experiment, OR they may be 
performed as a completely separate analysis. You should use the same recording options 
(zero, invert) for the Calibration experiment and the BET experiment.

The method below includes the calibration injections as a separate experiment which follows 
the BET experiment in the analysis.

Injection Size

You should inject three volumes of gas with the goal of approximating the volume of gas 
taken up by the sample. Use one injection slightly larger than the volume you expect, one 
injection slightly smaller than the volume you expect, and one injection between these two 
volumes. The largest injection should be two to three times greater than the smallest injection. 

Pretreatment Flow helium over the sample to remove impurities, usually 
at the maximum temperature tolerated by the sample (for 
example, the temperature at which the sample was calcined).

Analysis Flow 30% N2/He, using a dewar of liquid nitrogen, to mea-
sure the uptake of nitrogen. Then, remove the LN2 dewar 
and replace it immediately with a dewar of water at ambient 
temperature. The amount of N2 desorbed is measured and 
the BET equation is used to calculate the active surface area.

Cold Trap Install the external long delay path. Do not use a cold trap 
dewar.

Pressure regulator For BET Analysis, gas cylinders should be set to a level 
between 10 and 15 psig (69 and 103.5 kPag).

Furnace temperature During pretreatment, select a temperature high enough to 
remove any contaminants or moisture, but not so high as to 
cause sintering or fusing of the sample. Hold the temperature 
long enough to remove any contaminants or moisture. Main-
tain the target temperature for at least 30 minutes to ensure 
adequate degassing. Make sure the Done step is set to return 
the sample temperature to 0 ºC. 
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Because you must use the same syringe for all three injections, be sure to select a syringe that 
can accommodate all three injection volumes. You can estimate the volume of gas uptake if 
you know the approximate surface area (SA) of your sample. Use the following formula to 
determine the approximate volume (Vm) to inject.

 

So:

For example, a sample of 0.1 g of 50 m2/g material has a surface area of 5 m2. Therefore, the 
volume of the gas which will be adsorbed is approximately 1.145 cm3 STP.

Procedure

1. Obtain the sample weight, then install the loaded sample tube and thermocouple on the 
analyzer. 

2. Make sure the Delay Path is installed in the Cold Trap port.

3. Create a sample file containing the appropriate analysis conditions and report options. 
(Descriptions of the options on each dialog are found in Chapter 5.) 

a. Select File > Open > Sample Information. Type a file name or accept the default; 
click OK, then Yes to confirm.

b. Complete the Sample Information dialog using appropriate values.

c. Click on the Analysis Conditions tab and insert the experiment steps listed below:

Vm cm3 STP( ) SA  m2( )

6.023 1023 molecule/mole×( ) 16.21 10 20–  m2/molecule×( )
------------------------------------------------------------------------------------------------------------------------------------------------------- 22414 cm3/mole×=

Vmcm3 STP SA  m2( ) 0.229×=

Before performing an analysis, make sure you have adequately prepared the sample 
and analyzer using the instructions in Chapter 4.
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Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:
Experiment New Experiment Experiment Descrip-

tion
Type an appropriate description.

Type of analysis Select BET Surface Area from 
the drop-down list.

Zones Block
Filament
Cold trap
Analysis
Loop
Vapor
Reflux
Flask

100
175
110
110
110
20
20
20

Gas Flows Prep Helium
Carrier Helium
Loop None
Flow rate 50 cm3/min
Valve states Trap, Prepare, Fill, Bypass

Outputs Use defaults
Peaks Use defaults
Recording options Select: Invert the TCD Signal

Temperature 
Ramp

Temperature 
Ramp

Type Sample Ramp

End Temperature 350

Rate 50.0

Hold Time 0.00

Enable KwikCool No

Temperature 
Ramp

Temperature 
Ramp

Type Return to Ambient

Enable KwikCool Yes

Change Gas 
Flows

Gas Flows Prep None

Carrier 30 N2-He

Loop None

Valve states Trap, Analyze, Fill, Bypass

Wait Wait Select: Wait until baseline is stable.

Wait Wait Select: Wait for 
operator

Type: Click OK to proceed with 
BET measurement.

Recording Start Recording One measurement 
every:

0.1 second
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To include the calibration data collection (three manual injections through the septum) 
within this analysis but as a separate Experiment, also insert the following steps (before 
the Done step):

Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:

Dose Dose Select: Get BET Point

The software automatically inserts a Stop Recording step when a Start Recording step is 
inserted. Make sure that you insert the Dose step and the Temperature Ramp step within the 
Start/Stop Record loop.
Done Done (Click Edit, 

if necessary)
Return to ambient Yes
Detector Off
Zones Not applicable
Gas Flows Not applicable

Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:
Experiment New Experiment Experiment Descrip-

tion
Type an appropriate description.

Type of analysis Select Other from the drop-down 
list.

Zones Block
Filament
Cold trap
Analysis
Loop
Vapor generator
Reflux
Flask

100
175
110
110
110
20
20
20

Gas Flows Prep None
Carrier 30 N2-He
Loop None
Flow rate 50cm3/min
Valve states Trap, Analyze, Inject, Bypass

Outputs Use defaults
Peaks Use defaults

Wait Wait Select: Wait until baseline is stable.

Recording Start Recording One measurement 
every:

0.1 second
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d. Click the Report Options tab and set the values to those you wish to use. 

e. Click Save, then Close. 

4. Start the analysis. (Descriptions of the Unit menu options are found in Chapter 6.)

a. Select Unit > Start analysis. From the Files list box, select the sample file you just 
created. 

b. You can edit the sample file if needed, but for our example, editing is not required; 
click Next to continue.

c. The second dialog box appears. From the drop-down list, select the calibrations 
associated with each experiment in the sample file (if any). For this example, select 
None.

d. Click Next; the next Analysis dialog appears: the reports dialog. For our example, no 
changes are needed.

e. Read the cautionary dialog and make any necessary changes, then click Start to start 
the analysis. During the analysis, you are prompted to change the dewar.

5. When the analysis ends, remove the sample tube from the analyzer, place the caps on the 
tube, and dry off the outside of the tube with a paper towel. 

Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:

Repeat Start Repeat 
Sequence

Select: Repeat Type: 3 times

Wait Wait Select: Wait for 
operator.

Type: Prepare manual N2 

injection. Click OK.

Dose Dose Select: Manual Injection

The software automatically inserts a Stop Repeat step when a Start Repeat step is inserted. 
Make sure that you insert the Wait step within the Start/Stop Repeat loop.

The software automatically inserts a Stop Recording step when a Start Recording step is 
inserted. Make sure that you insert the Dose step and the Temperature Ramp step within the 
Start/Stop Record loop.

Change the dewar rapidly. It is recommended that you hold the water dewar in one 
hand and remove the LN2 dewar with the other to minimize the time required.

Use the cotton gloves provided in the accessory kit if you wish to remove the sample 
tube before it has cooled. You may use rubber gloves to handle the sample tube when 
it has cooled.
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6. Weigh the sample tube, sample, and caps. Subtract this weight from the weight you 
obtained for the sample tube and caps. The resulting weight is the dry sample weight (the 
“after analysis weight”). This weight will be used when you calculate the BET surface 
area, as described in the following sections.

Generating the BET Report

The following tasks must be performed before you can generate the BET report:

• Edit the sample file and the calibration file to ensure that peaks are properly marked
• Create a TCD calibration file
• Associate the TCD calibration file with the sample file

After completion of these tasks, select Start Report from the Reports menu to generate the 
report. Be sure that BET Surface Area is selected (preceded with a check mark).

Edit the peaks in the sample file

1. Select Reports > Peak Editor; the Edit Sample Peaks dialog is displayed.

2. Select the BET sample file you used with the analysis, then click OK.

3. Click on the desired experiment, then click Edit Peaks.

4. Right-click in the graph area and choose Mark All Peaks; all peaks that meet the current 
peak-picking parameters are marked. 

5. If required, edit the edges of the desorption peak as follows:

a. Drag the cursor over the entire baseline of the peak to enlarge the editing area.

b. Click on the baseline of the left side of the peak, right-click and choose Mark left 
edge.

c. Repeat step b for the right side of the peak.

6. As you adjust the peak edges, the values associated with the peak (listed in the peak table) 
are also adjusted. When you are satisfied with the appearance of the peak, right-click and 
choose Save.

The desorption peak is most often used to determine the surface area because the 
desorption process starts with the adsorbate equilibrated on the surface. Also, it is 
simple and convenient to develop a calibration for desorption.
May 06                                                      J-29 



AutoChem II 2920 Appendix J
Edit the peaks in the calibration file

1. Select Peak Editor from the Reports menu; the Edit Sample Peak dialog is displayed.

2. Select the file containing the calibration data you used with the analysis, then click OK.

3. Edit the peaks in the same manner as described for the sample file.

Create a TCD Calibration file

1. Select Unit > TCD Calibration > New; the New TCD Calibration dialog box is 
displayed.

2. Choose User defined, then click OK; the TCD Calibration dialog box is displayed.

3. Click Load Calibration Data; the Load Calibration Sample File dialog is displayed.

4. Select the sample file containing the calibration data, then click OK. The data in the file 
are inserted into the appropriate fields of the TCD Calibration window. 
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5. The values in the Peak Volume column are defaults. The correct values for the volume of 
each injection at STP must be determined using the following formula:

      

Determine the volumes for each calibration peak listed in the table.

6. Enter the converted values (cm3 STP) into the table.

Assess the Peak Area plot, Goodness of Fit, and Coefficients to decide if the calibration 
file is acceptable. Use your laboratory’s standards to determine what level of linearity is 
acceptable. As a general guideline, however, you should use a calibration file with a very 
low value for Goodness of Fit (less than 0.1), when 1st or 2nd Degree is specified.

You may wish to delete any peaks that are outliers (highlight the peak data in the table 
and click Delete Peak). You may also wish to evaluate the results when you change the 
degree (select a different degree from the drop-down list).

7. Enter a new description into the Description field.

8. When you are satisfied with all values in the file, click Save, then Close

Associate the Calibration file with the Sample file

1. Select Reports > Peak Editor; the Edit Sample Peak dialog is displayed.

2. Select the BET sample file you used with the analysis, then click OK.

3. Click on the experiment, then right-click in the graph area and choose Set Calibration; 
the Set TCD Calibration dialog box is displayed.

4. Click the down arrow to the right of the Calibration field and choose the Calibration file 
you just created; click OK.

5. Repeat steps 3 and 4 for each experiment.

6. Click Save, then Close.

VSTP V  injected( )  273.15
273.15 ambient temp+
-----------------------------------------------------------⎝ ⎠
⎛ ⎞ ambient pressure

760 mmHg
----------------------------------------------⎝ ⎠
⎛ ⎞×=
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Pulse Chemisorption

Description

A Pulse Chemisorption analysis determines active surface area, percent metal dispersion, and 
active particle size by applying measured pulses of reactant gas to the sample, depending 
upon what technique is used. Pulse Chemisorption is performed in the same manner as TPD, 
except that the sample is dosed with the analysis gas using the injection loop until each active 
site has reacted. After the active sites have completely reacted, the discretely injected gas vol-
umes emerge unchanged. If TPD is performed after Pulse Chemisorption, additional 
information about the distribution of active sites and the strength of active sites is collected.

The amount chemisorbed is the difference between the total amount of reactant gas injected 
and the amount that did not react with the active sites of the sample. The size of each pulse is 
determined by the loop, which is located on an electrically operated valve. 

Loop Volume

In general, it is desirable for the sample to require at least two doses of gas, but no more than 
ten doses, before the reaction ends (although this may vary from lab to lab). Some factors that 
influence the number of doses required are sample size, the active surface area per unit of 
sample, and the size of the loop. If your pulse chemisorption analysis requires more doses or 
fewer doses than you prefer, you can change either the sample size or the loop size.

Three loops of different sizes are provided with the analyzer; each loop must be calibrated 
before its use. To replace or install a loop, refer to Changing the Injection Loop on page 
9-7. As an alternative to physically replacing the loop, more experienced operators may wish 
to adjust the loop volume by adjusting its temperature. If you change the loop volume by 
changing its temperature, results will be more accurate if you recalibrate the loop volume at 
the new temperature.

Loop Calibration

Before data from an analysis that uses an injection loop can be reduced, a loop calibration 
experiment must be performed. You can perform an independent loop calibration before or 
after the analysis. 

The following example assumes that the loop calibration will be performed after the analysis. 
See the instructions later in this chapter for performing a loop calibration. You can also 
include a Loop Calibration step in your pulse chemisorption analysis.
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Preparation

Pretreatment Degas by flowing inert gas (such as helium, argon, or nitro-
gen) over the sample while ramping the temperature.

Analysis Pulse the loop (analysis) gas over the sample until the peak 
area remains constant.

Cold Trap No cold trap is needed during pretreatment

During the analysis, use the cold trap fixture with a dewar of 
water in place as a short delay path. This delay compensates 
for the flow disturbance caused by each loop injection.

Pressure regulator For Pulse Chemisorption, gas cylinders should be set to a 
level between 10 and 15 psig (69 and 103.5 kPag).

Furnace temperature Select a temperature high enough to remove any contami-
nants or moisture, but not so high as to cause sintering or 
fusing of the sample. Make sure the Done step is set to return 
the sample temperature to ambient.

In the following example, Pulse Chemisorption is performed on a sample of Pt/Al2O3 
with CO. You should alter the analysis conditions to accommodate the analysis you 
are conducting.
May 06                                                      J-33 



AutoChem II 2920 Appendix J
Procedure

1. Obtain the sample weight, then install the loaded sample tube and thermocouple on the 
analyzer. Close the furnace around the sample tube. 

2. Create a sample file for this analysis. 

a. Select File > Open > Sample Information. Enter a file name or accept the default; 
click OK, then Yes to confirm.

b. Complete the Sample Information dialog using appropriate values.

c. Click the Analysis Conditions tab and insert the experiment steps listed below:

Before performing an analysis, make sure you have adequately prepared the analyzer 
using the instructions in Chapter 4.

Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:
Experiment New Experiment Experiment Descrip-

tion
Type an appropriate description.

Type of analysis Select Pulse Chemisorption 
from the drop-down list.

Zones Block
Filament
Cold trap
Analysis
Loop
Vapor generator
Reflux
Flask

100
175
110
110
110
20
20
20

Gas Flows Prep Helium
Carrier/Reference Helium
Loop None
Flow rate 50 cm3/min
Valve states Bypass, Prepare, Fill, Bypass

Outputs Use defaults
Peaks Use defaults

Wait Wait Select: Wait Type: 5 minutes
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Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:

Change Gas 
Flows

Gas Flows Prep Hydrogen

Carrier Helium

Loop None

Valve states Bypass, Prepare, Fill, Bypass

Temperature 
Ramp

Temperature 
Ramp

Type Sample Ramp

End Temperature 120

Rate 10.0

Hold Time 30

Temperature 
Ramp

Temperature 
Ramp

Type Sample Ramp

End Temperature 220

Rate 10.0

Hold Time 30

Temperature 
Ramp

Temperature 
Ramp

Type Sample Ramp

End Temperature 350

Rate 10.0

Hold Time 120.0

Change Gas 
Flows

Gas Flows Prep Helium

Carrier Helium

Loop None

Valve states Bypass, Prepare, Fill, Bypass

Wait Wait Select: Wait Type: 90 minutes

Temperature 
Ramp

Temperature 
Ramp

Type: Return to Ambient

Wait Wait Select: Wait Type: 30 minutes

Temperature 
Ramp

Temperature 
Ramp

Type Sample Ramp

End Temperature 35

Rate 5.0

Hold Time 10.0

Change Gas 
Flows

Change Gas Flows Prep None

Carrier Helium

Loop Carbon Monoxide

Valve states Trap, Analyze, Fill, Bypass

Wait Wait Select: Wait until baseline is stable.
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d. Click the Report Options tab and set the values to those you wish to use. 

e. Click Save, then Close.

3. Start the analysis. (Descriptions of the Unit menu options are found in Chapter 6.)

a. Select Unit > Start analysis. From the Files list box, select the sample file you just 
created. 

b. You can edit the sample file if needed. For our example, no editing is needed; click 
Next to continue.

c. The second dialog appears. From the drop-down list, select the calibrations associ-
ated with each experiment in the sample file (if any). For this example, select None.

d. Click Next; the next Analysis dialog appears: the reports dialog. For our example, no 
changes are needed.

e. Read the cautionary dialog and make any necessary changes, then click Start to start 
the analysis.

Step to Insert
Dialog or 

subdialog(s) For this parameter: Use this value:

Recording Start Recording One measurement 
every:

0.2 second

Wait Wait Select: Wait Type: 3.0 minutes

Repeat Start Repeat 
Sequence

Select: Repeat until peaks are equal or 20 times.

Dose Dose Select: Inject Loop Gas

Select: Wait for Type: 1.5 minutes

The software automatically inserts a Stop Repeat step when a Start Repeat step is inserted. 
Make sure that you insert the Dose step within the Start/Stop Repeat loop.

The software automatically inserts a Stop Record step when a Start Record step is inserted. 
Make sure that you insert the Start/Stop Repeat step and the Dose step within the Start/Stop 
Record loop.
Done Done (Click Edit, 

if necessary)
Return to ambient Yes
Detector Off
Zones Not applicable
Gas Flows Not applicable
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When the analysis ends, the furnace begins to lower the sample to room temperature. To 
speed cooling of the sample, you may wish to use the optional CryoCooler or KwikCool.

When the displayed sample temperature reaches the ambient temperature, open the furnace. 
Using gloves, remove the sample tube. 

Generate the Report

Before proceeding with the steps below, you may wish to open the sample file using the Peak 
Editor on the Reports menu to ensure that the peaks are properly marked. 

There are three possibilities for each dose of gas injected during Pulse Chemisorption: all of 
the gas is taken up by the sample, some of the gas is taken up by the sample, or none of the 
gas is taken up by the sample. When Pulse Chemisorption is properly performed, there will 
be some injections of each type. When you view the data using the Peak Editor, however, 
only those injections in which some or none of the gas is taken up will appear as peaks. When 
all of the gas is taken up by the sample, none of it reaches the detector and, therefore, the 
peak area is zero. These types of peaks are detected automatically by the software and do not 
require marking.

After verifying that the peaks are properly marked, perform the following steps to generate 
the report:

1. Select File > Open > Sample Information.

2. Select the sample file used with this analysis and click OK.

3. Click the Collected Data tab to display its associated dialog box.

4. Enter the percent of active gas in the Active concentration field.

5. Click Active Metals; the Active Metals Table is displayed. Verify that the Stoichiometry 
Factor and the % of Sample Weight values are correct. 

6. Click OK to close the Active Metals dialog box.

7. Verify that the values for the physical injection volume, ambient temperature, and 
ambient pressure are accurate.

8. Select Reports > Start Report to generate the report.

Use the cotton gloves provided in the accessory kit if you wish to remove the sample 
tube before it has cooled. You may use rubber gloves to handle the sample tube when 
it has cooled.
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Loop Calibration

You must calibrate each injection loop before its first use to determine its precise volume 
under local conditions. Calibration consists of:

• Determining the average area of a series of peaks generated by injections of a known 
volume of gas through the analyzer septum using a syringe.

• Determining the average area of a series of peaks generated by injections of the same gas 
using the analyzer’s internal loop.

• Calculating the volume of the loop by comparing the average peak area generated by the 
loop injections with that generated by the syringe injections. 

Update Ambient Pressure and Temperature

Ambient pressure and temperature at the time of the analysis affect the results of a loop cal-
ibration. In calculations, the analyzer uses the ambient pressure and temperature recorded in 
the Environmental Defaults dialog box (accessed from the Options menu). You may wish to 
check and update your environmental defaults before beginning a loop calibration. If neces-
sary, you can also update the ambient temperature and pressure on the Collected Data dialog 
of the sample information file after the analysis. (The sample information file must be opened 
in Advanced presentation in order to view or edit collected data.)

Create a Sample File

First, you must create a sample file:

1. Select Open, Sample information from the File menu; the Sample Information File 
selection dialog appears. 

2. Enter the name you wish to use for this calibration in the File name field. Click OK, then 
Yes to confirm.

3. Complete the fields of the Sample Information dialog as needed.

4. Click the Analysis Conditions tab. Click Insert, then select Loop Calibration from the 
list of available steps.

If the file is in Basic presentation format, click Advanced to switch to the Advanced 
format.
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5. Complete the Loop Calibration Experiment Step dialog using Helium for Gas 1 and 
Argon for Gas 2.

6. Click Zones to set the temperature for the analyzer’s heated zones. Complete the fields of 
the Temperature Zones dialog box as shown below, using 175 °C for the filament and 100 
°C for the block zone. Use the defaults for all other zones. Click OK to close the dialog.

7. Click Save, then Close.

You must create a Loop Calibration for each loop you use, using the temperatures 
used in the analyses that will be associated with the calibration file. If you use different 
temperatures for different analyses, you must create a separate calibration file for 
each temperature configuration.
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Perform the Analysis

1. Make sure the injection loop you wish to calibrate is installed on the analyzer. Refer to 
“Changing the Injection Loop” on page 9-7 for the steps to install or replace an 
injection loop.

2. Select Start Analysis from the Unit menu; select the sample file you just created. 

3. Click Next three times to accept the values contained in this sample information file. 
(Although you can edit these values, no changes are needed for this example). Read the 
cautionary statement, then click Start to start the analysis.

4. As the test progresses, you are prompted to make three manual injections.

For this example, use argon for your injections (because argon is specified as the loop gas 
in the sample information file). Use a volume that is close to the volume of the loop you 
are calibrating. For example, if you are calibrating the 1-cc loop, use a 1-cc syringe and 
inject as close to 1 cc of gas as possible. 

After the third manual injection, the analyzer automatically makes three injections using 
the loop. 

Pay close attention to the instructions given in prompts that appear on the screen. 
Perform the prompted steps in the order given. For example, if you are prompted 
“Click OK, then perform manual injection,” you should perform these actions in the 
order given. Otherwise, data may not be recorded properly

Most accurate data results from keeping injection size as consistent as possible. 
Injection errors may be evident in the data, and may make it necessary to repeat the 
experiment.
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Generate the Report

Each manual and automatic injection results in a peak (if it has been properly performed). 
When the Results view of the Start Analysis window is selected, each peak can be viewed as 
it is collected. The area under the peak corresponds to the amount of argon injected.

Before proceeding with the steps below, you may wish to open the sample file using the peak 
Editor on the Reports menu to ensure that the peaks are properly marked. Instructions for 
using the Peak Editor are located on page 7-14. 

1. Select Start Report from the Reports menu. 

2. Select the sample file you created for this calibration; click OK.

3. Deselect all the reports in the reports list box except the Loop Calibration Report; click 
OK. 

4. Select Unit > Unit Configuration and enter the value printed for the Computed Loop 
Volume @ 0 ºC in the Loop Volume field.

Reports use the loop volume from the System Configuration dialog (Unit menu). 
Environmental conditions are taken from the Environmental Defaults dialog on the 
Options menu. If these values were incorrect during analysis, you can change them 
for this sample file by clicking the sample file’s Collected Data tab and updating the 
appropriate fields.
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Gas Concentration Calibration

After you perform an analysis, you may wish to convert the peak area data it yielded to vol-
ume data. The analyzer can do this automatically, but it must first have some additional 
information.

In some cases (such as in TPR analyses), the analyzer needs to know how to correlate the sig-
nal readings collected in the analysis with the volume of gas uptake at any given point in the 
analysis. If we provide the analyzer with a series of known gas concentrations, and it records 
the signal associated with each known concentration, then it can use this information to cal-
culate the concentrations associated with the signals it recorded during the analysis. From that 
point, it can also calculate the volume of gas associated with each peak in the data. 

1. Prepare a clean, empty sample tube and install it on the analyzer. 

2. Make sure the correct gases are connected. Also check to be sure that the Gas Selections 
table (Unit menu) accurately reflects the current gas connections.

3. Create the sample file:

a. Select File > Open > Sample information; the sample information file selection 
dialog is displayed. 

b. Enter a name (or accept the default). Click OK, then Yes to confirm,

c. Complete the Sample Information dialog as needed.

4. Click the Analysis Conditions tab. Click Insert and select Gas Calibration; the Gas 
Calibration (Concentration) Experiment dialog is displayed.

5. Choose 10 H2-Ar for Gas 1 and Argon for Gas 2, then enter 50 as the flow rate.

The values shown and given in this example are for a typical TPR calibration.
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6. Click Zones to set the temperature for the analyzer’s heated zones. Complete the fields in 
the Set Temperature Zones dialog box as shown below.

7. Click OK to close the Zones dialog, then again to close the Calibration dialog. 

8. Click Save, then Close.

9. Select Unit > Start Analysis. From the Files list box, select the sample information file 
you just created; the Analysis dialog box is displayed. 

10. Click Next three times to accept the values contained in this sample information file. 
(Although you can edit these values, no changes are needed for this example.) 

11. Click Start to start the analysis.

At this time, you can use the other views of the Analysis dialog to observe the progress of 
the analysis.

During the automatic analysis, the analyzer decreases the proportion of the analysis gas in 
10% increments, beginning with 100% and ending with 0%. The resultant data should 
appear as a series of ten stepwise changes in the TCD signal. 

12. When the analysis ends, close the Analysis dialog.

13. When the displayed sample temperature reaches the ambient temperature, open the 
furnace. Using gloves, remove the sample tube. 

14. Select Unit > TCD Calibration.> New. Select Gas, then click OK; the TCD Calibration 
window opens. 

15. Click Load Calibration Data; select the sample information file for this calibration and 
click OK. The TCD Signal vs. Concentration dialog box is displayed.

Use the cotton gloves provided in the accessory kit if you wish to remove the sample 
tube before it has cooled. You may use rubber gloves to handle the sample tube when 
it has cooled.
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16. Verify that the active gas concentration for the carrier gas is correct; edit if necessary.

17. Click OK; the data contained in the sample file are automatically inserted into the 
appropriate fields of the TCD Calibration dialog box.

18. Assess the data listed in the table. In the Concentrations column, enter the starting and 
ending gas mixture percentages. The analyzer calculates the percentages for the rest of 
the table.

19. Assess the gas concentration plot, Goodness of Fit, and Coefficients to determine if the 
calibration file is acceptable. Use your laboratory’s standards to determine what level of 
linearity is acceptable. As a general guideline, however, you should use a calibration file 
with a very low value for Goodness of Fit (less than 1/2% of the maximum 
concentration), when 1st or 2nd Degree is specified.

You may wish to delete any data point that deviates significantly from linear. You may 
also wish to evaluate the results when you change the degree (select a different degree 
from the drop-down list).

20. When you are satisfied with the calibration file, enter an appropriate name in the 
Description field. 

21. Click Save then Close.

22. If you wish to generate a report, select Unit > TCD Calibration > Report and select the 
desired file.
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Calibrating the Vapor Generator

When you use the optional Vapor Generator, you must calibrate it for the type of vapor you 
are using. Associating your analysis data with a Vapor Generator calibration file enables you 
to convert your peak area data to volume data.

You can perform the Vapor Generator calibration either before or after performing your anal-
ysis. A single calibration file can be used with multiple analysis files.

1. Select File > Open > Sample information; the Sample Information File selection dialog 
appears. 

2. Enter the name you wish to use for this calibration in the File name field. Click OK, then 
Yes to confirm.

3. Complete the fields of the Sample Information dialog as needed.

4. Click the Analysis Conditions tab. Click Insert, then select Vapor Calibration; the 
Vapor Calibration Experiment dialog is displayed.

5. Complete the dialog as follows:

If the file is in Basic presentation format, click Advanced to change to the Advanced 
format.

The values shown and given in this example are for a typical Vapor calibration for 
pyridine.
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a. Choose Helium for the Carrier and Loop gases, then enter a flow rate of 50 for each.

b. For the Reflux temperature, enter a minimum of 70 and a maximum of 90.

c. For the Flask temperature, enter a minimum of 80 and a maximum of 100.

d. Enter 5 for the number of steps.

e. Select Invert the TCD Signal. It is a good idea to select this option when using 
Helium for the carrier gas; it improves the performance of automatic peak picking.

f. Click Zones; specify temperatures as shown here:

6. Click OK to close the Set Temperature Zones dialog, then again to close the Vapor 
Calibration Experiment dialog box.

7. Click Save, then Close to close the sample information file.

8. Select Unit > Start Analysis. From the Files list box, select the sample information file 
you just created; the Analysis series of dialogs is displayed. 

9. Click Next three times to accept the values contained in this sample information file. 
(Although you can edit these values, no changes are needed for this example). Click Start 
to start the analysis.

10. At this time, you can use the other views of the Analysis dialog box to observe the 
progress of the analysis. Complete descriptions of these views are located in Chapter 6.

11. When the analysis ends, close the Analysis dialog.

12. When the displayed sample temperature reaches the ambient temperature, open the 
furnace. Using gloves, remove the sample tube. 

You do not have to edit these 
fields; the Reflux and Flask tem-
peratures entered on the Vapor 
Calibration Experiment dialog 
are used.

Use the cotton gloves provided in the accessory kit if you wish to remove the sample 
tube before it has cooled. You may use rubber gloves to handle the sample tube when 
it has cooled.
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13. Edit the calibration file.

a. Select Unit > TCD Calibration > New. 

b. Select Load Calibration Data and select the sample information file for this cali-
bration; the data contained in the file are automatically loaded.

d. Refer to Vapor Generator in Appendix B, page B-9 for calculating the volume of 
each vapor injection, then enter the values for each peak.

e. Assess the plot, Goodness of Fit, and Coefficients to decide if the calibration file is 
acceptable. Use your laboratory’s standards to determine what level of linearity is 
acceptable. As a general guideline, however, you should use a calibration file with a 
very low value for Goodness of Fit (less than 1 to 2% of the signal), when 1st or 2nd 
Degree is specified.

f. You may wish to delete any peaks that are outliers (highlight the peak data in the 
table and click Delete Peak). You may also wish to evaluate the results when you 
change the degree (select a different degree from the drop-down list).

g. When you are satisfied with the calibration file, click Save then Close.

Reports on calibration files can be printed by selecting TCD Calibration, Reports from 
the Unit menu.
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Symbols
$ symbol, 8-8, 8-11

A
Accept, calibration file, 6-29
Accessories, ordering, 10-1
Active concentration, 5-19, 5-52
Active metal, 1-13

calculations, B-6
defaults, 8-15
samples, 4-17

Active Metals Defaults command, 8-15
Active Metals Table dialog, 5-16, 5-53
Active sites, 1-10
Add log entry, 5-8
Adsorbate cross-sectional area, 5-42, 5-43
Adsorbate density conversion factor, 5-44, B-5
Advanced format, 5-4, 5-7, 8-3, 8-10

creating a sample file, 4-7
specifying file defaults, 4-1

Air
filter, changing or cleaning, 9-16
purging from gas lines, 2-32

Ambient temperature, 8-17
Analysis

ending, J-5
observing, 6-8, J-2
starting, 4-30, 6-3
temperature, 4-29
tutorial, J-1
types of, 1-10

Analysis conditions file, 5-10, 5-58
defining, 4-5
editing during analysis, 6-9
printing contents, 5-57
specifying defaults, 8-12

Analysis Log
report, 5-48

Analysis log
making an entry, 5-8

Analysis program
exiting, 5-65
installing, 2-18
installing upgrade, 2-21
uninstalling, 2-29

Analyzer
adding another, 2-22

calibration information, 6-28
changing setup, 2-27
cleaning, 9-15
maintenance, 9-4
moving from one computer to another, 2-23
removing, 2-26
turning on, 2-17
warm-up, 2-17
 See also  Equipment

Antoine
constant, 8-14
equation, B-9

Applications, 1-13
Argon, J-10
Atmospheric pressure, 8-17
Atomic area, 8-15
Atomic weight, 8-15

of selected metals, G-1
Attention light, 3-1
Automatic report generation, 6-6
Autoscale options, 5-51
Auxiliary inputs/outputs, 2-3, 5-20, E-1

manual control, 6-15
Auxiliary port, 6-15
Axis

coordinates, viewing, 7-13
properties, editing, 7-12

Axis Properties dialog, 7-12

B
Baseline, 1-14

reading, 1-7
settings, 5-31

Baseline Detection Parameters dialog, 5-31
Basic format, 5-4, 5-5, 8-4, 8-7

creating a sample file, 4-9
specifying file defaults, 4-3

BET analysis, 1-5, 1-12, 2-8, 2-9
example of, J-23
removing furnace for, 2-9

BET point, 5-30
BET surface area, 1-12

calculations, B-3
example of report, 7-32
report options, 5-42

Blend carrier and loop gases, 5-19
Block zone temperature, 5-17
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C
Cable connections, 2-3
Calculations, B-1

BET surface area, B-3
calibration (goodness of fit), B-2
injection loop, B-1
Langmuir surface area, B-4
loop volume, B-2
percent dispersion, B-2
total pore volume, B-5
Volume STP, B-1

Calibration, 1-10
loop, 5-21, J-38
MFC, 8-13
sample thermocouple, 9-18
TCD, 6-6, J-42
valves, manual control, 6-15
Vapor generator, 6-30, J-45
Vapor generator heat zones, 9-20

Calibration file
assigning to experiment, 4-37, 7-23
associating with sample file, 6-22
creating, 4-36
reinstalling, 2-28
specifying defaults, 6-23

Canceling an analysis, 6-8
Carrier gas, 5-18

flow rate, 5-24
selecting, 6-20

Catalyst pretreatment, 1-13
Cautions, 1-2
Change gas flows step, 5-27
Change temperature zones step, 5-27
Change valves step, 5-28
Changing

air filter, 9-16
cold trap, 9-4
delay path, 9-4
sample thermocouple, 9-17
septum, 9-6
TCD, 9-10

Check boxes, defined, 3-4
Clamp, thermocouple, 4-15
Cleaning

air filter, 9-16
analysis port filter, 9-13
analyzer, 9-15
cold trap, 9-4
delay path, 9-4
dewar, 4-26, 9-15
vapor generator, 9-15

Close, 5-56
Close All command, 5-56

Close Reports command, 7-3
Cold trap, 1-9, 4-23

changing/cleaning, 9-4
O-rings, changing, 9-5
slurry, 4-25

Collected data, 5-52
Collected Data Export Options dialog, 5-63
Comments window, 8-12
Computer

requirements, 1-17
Concentration, displaying during analysis, 6-11
Conductivity, gas, C-1
Constant, 8-13

gas flow, 6-21
Conventions

operator’s manual, 1-2
Coolant, 1-15
Cooling options, 1-15, 4-27

See also CryoCooler
See also KwikCool

Cross hair
axis, 7-13
peak editor, 7-16

Cross-sectional area
calculations, B-6
for metals, G-1

CryoCooler, 1-15, 2-11, 4-28
ice build-up, 2-14
installing, 2-12
maintenance, 2-13
manual control, 6-15

Cryogen, checking level of, 4-26
Curve Properties dialog, 7-11

D
Data

collected, 5-52
exported format, D-1
exporting, 4-33, 5-62
viewing as collected, 6-10

Data entry field, numerical ranges for, 3-4
Date range, 3-7
DDE, 5-37
DDE Command step, 5-28
Defaults

active metals, 8-15
environmental, 8-16
gas, 8-13
parameter files, 8-12
sample files, 4-1, 8-7
TCD calibration, 6-22
vapor, 8-14

Delay path, 1-9, 4-23
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changing/cleaning, 9-4
O-rings, changing, 9-5

Density, active metals table, 8-15
Desorption peak, 4-37
Destination, 7-2
Detector

enabling after analysis, 5-38
filament, protecting, 4-29
how it works, 1-6
manual control, 6-14
signal, 1-8

Dewar
cleaning, 4-26, 9-15
mixing a slurry, 4-25
placing, 4-25
precautions, 4-24
replenishing, 2-15

Dialog and subdialog boxes, 3-4
Dose step, 5-30
Duration, on status bar, 6-18

E
Edit Peaks view, 7-21
Editing reports, 5-40
Electrical requirements, 1-17
Environmental

defaults, 8-16
specifications, 1-17

Environmental Defaults command, 8-16
Equipment

damage or loss, 2-1
description, 1-2
features, 1-4
installing, 2-2
location, 1-14
return, 2-1
unpacking, 2-1
weight and dimensions, 1-17
 See also  Analyzer

Erlenmeyer flask, for Vapor Generator, 2-16
Error messages, I-1
Exhaust venting, 2-6
Exit command, 5-65
Exiting analysis program, 5-65
Experiment

Gas calibration, 5-23
inserting, 5-11, 5-14
Loop calibration, 5-21

Experiment step
Change valves, 5-28
DDE command, 5-28
Dose, 5-30
inserting, 5-15, 5-27

Recording, 5-32
Repeat, 5-33
Set outputs, 5-34
Temperature ramp, 5-34
Wait, 5-36

Experiments view
overlay, 7-19
stacked, 7-17

Export command, 5-62
Export data, 4-33

ASCII format, D-1
Grams/32 format, D-2

Extractor tool, 4-18

F
Fault indicator, 3-1
Filament, 1-6

cleaning/replacing, 9-10
manual control of, 6-14
protecting, 4-29
temperature, 5-17, 6-14

File
destination, 5-57
exporting, 5-62
extensions, 3-8
printing to, 7-3
Sample information files, 5-4
selecting, 3-6
status, 3-6

File menu, 5-1
Close All command, 5-56
Close command, 5-56
description, 5-1, 6-1
Exit command, 5-65
Export command, 5-62
Import MS Signal command, 5-59
List command, 5-58
Open command, 5-3
Print command, 5-57
Save All command, 5-55
Save As command, 5-54
Save command, 5-54

File name, 3-8
included as part of ID, 8-8, 8-11
sequence, 8-7, 8-10

Files list box, using, 3-6
Filter

air, changing/cleaning, 9-16
analysis port, changing, 9-13

First Order Kinetics
calculations, B-8
report options, 5-47

Fit Peaks view, 7-24
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Flask temperature, 5-26
Format for exported data, D-1
Front panel indicators, 3-1
Function Keys

See Shortcut keys
Furnace

cooling, 4-27
installing, 2-8
manually controlling, 6-14
ramp, 5-34
removing for BET analysis, 2-9
thermocouple, 4-14

G
Gas, 1-16

argon, J-10
blending, 5-19
calibration, 5-22, 5-24
changing during analysis, 2-34
configurations, C-2
connections, 2-3
conversion constants for MFC, C-3, F-7
exhausts, 2-6
flow rate specifications, 1-16
injecting, 4-26
lines, purging, 2-33
nitrogen, J-10
pathway colors on schematic, 6-17
purging lines, 2-32, 2-33
regulator, 1-14, 2-3
regulator pressure, 2-5
relative thermal conductivity, C-1
selections, 5-19
specifying port location, 2-31
type required, 1-14
valves, manually controlling, 6-13

Gas Calibration experiment, 5-23
Gas concentration calibration, 6-23, J-42
Gas Defaults command, 8-13
Gas Flow Constant Calibration command, 6-21
Gas Flow Constant Calibration dialog, 6-21
Gas Selections command, 6-20
Gram molecular weight, calculations, B-6
Graph

copying as metafile, 7-12
editing onscreen, 7-10
grid lines, 8-6
histogram, 7-11
legend, editing, 7-12
report options, 5-49
user-defined, 5-49

Graph Grid Lines command, 8-6
Graph Grid Lines dialog, 8-6

Graphic, showing in report title, 5-40

H
Heat of adsorption

First order kinetics, 5-47
Heat zones

manual control, 6-14
Heating mantle, for Vapor Generator, 2-16
Help menu, 3-10
Histogram, 7-11

I
Import MS signal command, 5-59
Indicators, front panel, 3-1
Inert gas, 8-13
Injection guidelines, 4-26
Injection loop, 1-9

calculations, B-1
calibrating, 5-21
See also  Loop

Inlet valves, manual control, 6-13
Input/output

analog, E-3
auxiliary, 2-3, E-1
connections, 5-20
digital, E-4

Insert
experiment step, 5-15
method, 5-13

Installation
CryoCooler, 2-12
hardware, 2-2
KwikCool, 2-10
software, 2-18
Vapor generator, 2-16

Instrument
calibration, 6-28, 9-18
schematic, 6-16

Instrument Calibration command, 6-28
Instrument Calibration dialog, 6-28
Invert peak, 4-35, 7-23
Invert TCD signal, 5-21

K
KwikCool, 1-15, 4-28

enabling, 5-36, 5-38
manual control, 6-15
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L
Langmuir surface area, 1-12

calculations, B-4
report options, 5-43

Leak test
Carrier path, 9-26
Loop gas path, 9-28
performing, 9-24
Prep path, 9-24
Reference path, 9-25
Vapor generator path, 9-27

LEDs, 3-1
Legend Properties dialog, 7-12
legend, editing, 7-12
List, 6-27

generating, 4-32
TCD calibration files, 6-27

List command, 5-58
listing file statistics, 5-58
Location requirements, 1-14
Loop

calibration, J-32, J-38
calibration report, 7-36
changing, 2-32
components, 9-8
gas path, checking for leaks, 9-28
gas, selecting, 6-20
injection, 5-30
volume, 6-19, 6-23, J-32
See also  Injection loop

Loop calibration, 5-21
report options, 5-48

M
Main menu, 3-9
Maintenance, 9-4

CryoCooler, 2-13
schedule, 9-3

Manual Control, 6-12
Manual control, 6-8, 6-9
Manual, operator

conventions, 1-2
organization, 1-1

Mass
determining, 4-18
entering at time of analysis, 6-4

Mass spectrometer data
configuring analog signals, 5-61
importing, 5-59

Messages, error, I-1
Metafile, copying graphs as, 7-12
Metal density, calculations, B-7

Metallic surface area, calculations, B-7
MFC

calibration, 8-13, F-1
constant, 8-13, F-3
conversion constant, 8-13, C-3
manual control, 6-13
specifications, 1-16

Moving an analyzer to another computer, 2-23

N
Nitrogen, J-10

saturation pressure, 8-17
Notes, 1-2

O
Observing the analysis, 6-8
OK indicator, 3-1
On, turning analyzer on, 2-17
Open (reports) dialog, 7-4
Open command, 5-3
Open Report command, 7-4
Operator default, 8-11
Option Presentation command, 8-3
Options

CryoCooler, 4-28
display of those installed, 6-19
Vapor Generator, 2-16

Options button, 6-10
Options menu

Active Metals Defaults command, 8-15
description, 8-1
Environmental Defaults command, 8-16
Gas Defaults command, 8-13
Graph Grid Lines command, 8-6
Option Presentation command, 8-3
Parameter Files Directory command, 8-17
Sample Defaults command, 8-7
Vapor Defaults command, 8-14

Ordering information, 10-1
O-rings, cold trap or delay path, 9-5
Output

analog, E-3
setting, 5-34

Output/input, auxiliary, E-1
Outputs dialog, 5-20
Overlay

Peak Editor, 7-19
report variables, 5-51

Oxidation, 1-11
Oxygen uptake, 1-11
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P
Parameter files, 4-4

Analysis conditions, defining, 4-5, 5-10
listing file statistics, 5-58
printing contents, 5-57
Report options, defining, 4-6, 5-39
saving, 5-54

Parameter Files Directory command, 8-17
Particle size

calculations, active, B-7
distribution of sample, 4-17

Parts, ordering, 10-1
Password

Restricted format, 8-4
Service test mode, 8-2

Peak
area, H-4
area volume, calculations, B-5
data, converting to volume data, J-45
desorption, 4-37
detection, H-1
editing, J-6
editing/marking, 4-35
inverting, 4-35, 7-23
volume calculation, 4-36

Peak area, 1-9
Peak Detection/Integration Options dialog, 7-24, H-1
Peak editor, 1-3, 7-14

Edit Peaks view, 7-21
Experiments view, 7-17
Fit peaks view, 7-24
shortcut menu, 7-15
Signals view, 7-20

Peak Editor command, 7-14
Peak Integration Options dialog, 5-20
Percent metal dispersion, 1-11

calculations, B-2
Perturbation, 4-23, 4-26
Physical syringe volume, 5-22
Pore-plugging, 1-12
Port filter, changing, 9-13
Power

switch, 2-2
Preparation gas, 5-22

selecting, 6-20
Preparing the analyzer for analysis, 4-10
Presentation formats, 5-4
Pressure transducer, location on schematic, 6-16
Print command, 5-57
Printing to a File, 5-57
Pulse chemisorption

area to volume conversion, 5-45
integrating data, 7-23

Pulse chemisorption analysis, 1-11, B-2
active metals, 8-15
example of, J-32
example of report, 7-34
preparing for, J-33

Pulse Chemisorption Report Option dialog, 5-45
Purging the system, 2-32
Push button, defined, 3-4

R
Radio button, defined, 3-4
Ramp

rate, 4-29, 5-35
temperature, 5-34

Recording
options, 5-21
step, 5-32

Reference
flow, 5-18
gas, selecting, 6-20

Reflux temperature, 5-26
Regulator, gas, 2-4
Removing an analyzer, 2-26
Repeat

count, on status bar, 6-18
step, 5-33

Replace all, 8-8, 8-12
Report destination, 7-2
Report options, 5-39

BET surface area, 5-42
editing, 5-39
First order kinetics, 5-47
graphs, 5-49
Langmuir surface area, 5-43
Loop calibration, 5-48
Pulse chemisorption, 5-45
tabular, 5-41
Total pore volume, 5-44

Report options files, 5-39
defining, 4-6
listing file statistics, 5-58
printing contents, 5-57
specifying defaults, 8-12

Reports, 7-12
calculations, B-1
calibration file, 6-26
closing, 7-3
editing, 5-40
editing font, 7-8
examples of, 7-27
generating, 7-2
header, 7-5
onscreen, shortcut menus for, 7-9
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opening, 7-4
saving in other formats, 7-8
selecting, 7-3
showing company logo in title, 5-40
standard, 5-49
Tabular, editing onscreen, 7-9
Tool bar, 7-6
user-defined, 5-49
zoom feature, 7-13

Reports menu
Close Reports command, 7-3
description, 7-1
Open Report command, 7-4
Peak editor command, 7-14
Start Report option, 7-2

Reports screen, 7-4
Reset, 6-11
Restricted format, 5-4, 5-9, 8-4
Results Options dialog, 6-10
Results view, 6-10
Return Materials Authorization, 2-1
Rotary valves, manual control, 6-13
RS-232 cable, 2-3
Run file, on status bar, 6-18

S
Sample

active metal, 4-17
consistency, 4-17
identification, 8-8, 8-10
loading in tube, 4-18
mass default, 8-11
mass, determining, 4-18
preparation, 1-10, 4-15, 4-17
size, 4-17
temperature, ramp, 5-35
thermocouple, 4-12
weighing, 4-18, 4-21

Sample defaults
specifying, 8-7

Sample Defaults command, 8-7
Sample furnace

manual control, 6-14
Sample information files, 5-4

Advanced format, 5-4, 5-7, 8-3
associating with Calibration file, 6-22
AutoChem 2910, 5-4
Basic format, 5-4, 5-5, 8-4
components, 5-4
creating, 4-7
exporting, 4-33, 5-62
File, 5-4
listing file statistics, 5-58

opening, 5-3
printing contents, 5-57
restricted format, 5-9, 8-4
saving, 5-54
specifying defaults, 8-7

Sample thermocouple, 4-11
adjusting/replacing, 9-17
calibration, 6-28, 9-18
replacing, 9-17
selecting position, 4-11

Sample tube
cleaning, 4-15
components, 9-13
filter, changing, 9-13
fitting, 9-14
installing on analysis port, 4-21
removing, 4-22

Saturation pressure of nitrogen, 8-17
Save All command, 5-55
Save As command, 5-54
Save command, 5-54
Save to file calibration, 6-28
Scaling, results view during analysis, 6-11
Schematic, instrument, 6-16
Selecting items from a list, 3-5
Septum, 4-26

changing, 9-6
location on schematic, 6-16

Sequence file name, 8-7, 8-10
Service test mode, 8-2
Set outputs step, 5-34
Set Temperature Zones dialog, 5-17
Setup program

adding an analyzer, 2-22
changing an analyzer setup, 2-27
moving an analyzer to another computer, 2-23
reinstalling analysis program, 2-21
removing an analyzer from the computer, 2-26
using for other functions, 2-20

Sheath, thermocouple, 4-12
Short Status command, 6-18
Shortcut keys, 3-2

for analysis program, 3-3
peak editor, 7-16

Shortcut menu, 3-2
components on instrument schematic, 6-12
experiment view, peak editor, 7-17
for graphs, 7-10
for tabular reports, 7-9
peak editor, 7-15

Signal
input/output, E-3
reading, 5-32
TCD, 5-21
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Signals view, 7-20
Sintering sample, 4-29
Slurry, 4-25
Smoothing, 7-23, H-2
Soap Bubble Burette, F-2
Software

Analysis program, 2-18
installing, 2-18
installing upgrade, 2-21
using, 3-2
using for other functions, 2-20

Specific surface area, 1-12
Spread peaks calibration, 6-23
Start analysis, 6-3
Start Report dialog box, 7-2
Start Report option, 7-2
Status, 3-6
Status bar, 6-18
Step

detail, 6-8
inserting, 5-11
moving, 5-12
on status bar, 6-18
repeating, 5-33
skipping, 6-8

Stoichiometry factor
active metals table, 8-16
calculations, B-6

Stop analysis, 6-8
Submitter default, 8-11
Surface area

metallic calculations, B-7
Suspend analysis, 6-9
Synopsis, 5-10

using to observe the analysis, 6-8
Syringe

using, 4-27
volume, 5-52

System
purging, 2-32
requirements, 1-14
warm-up, 2-17

T
Tabular report options, 5-41
TCD, 1-6

block, components of, 9-12
block, location of, 9-10
calibrating, 5-23
calibrating for vapor analysis, 5-25
manual control, 6-14
reading, on status bar, 6-18
replacing, 9-10

TCD calibration, 5-23, 6-6, J-42
creating new file, 6-23
open file, 6-24
reports, 6-26
specifying default files, 6-23
vapor, 5-25

TCD calibration command, 6-22
TCD signal

invert, 5-21, 5-22, 5-24, 5-26
zero, 5-21, 5-22, 5-24, 5-26

Temperature, 1-6, 1-7
analysis, 4-29
block zone, 5-17
filament, 5-17
maximum recommended, 4-29
on status bar, 6-18
ramp rate, 4-29
range, 1-16
starting, 4-29
TPD analysis, 1-10

Temperature ramp step, 5-34
Temperature-programmed analyses, 1-5

types of, 1-10
Text, copy graph data as, 7-13
Thermal

conductivity, 1-6
stability, 5-38

Thermal Conductivity Detector
See  TCD

Thermocouple
adjusting/replacing, 9-17
changing position, 4-11
clamp, 4-15
recalilbrating, 9-18
sheath, 4-13

Threshold level, H-2
Time, on status bar, 6-18
Title Properties dialog, 7-12
Tool bar, reports window, 7-6
Total pore volume, 1-12

calculations, B-5
report options, 5-44

TPD analysis
example of, J-14
example of report, 7-29

TPO analysis, 1-11
example of, J-19

TPR analysis, 4-20
example of, J-9
example of report, 7-31

Troubleshooting, 9-1
Tutorial

BET analysis, J-23
Gas concentration calibration, J-42
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Pulse chemisorption analysis, J-32
TPD analysis, J-14
TPO analysis, J-19
TPR analysis, J-9
typical analysis, J-1

U
Unit configuration command, 6-19
Unit menu, 6-1

Gas Flow Constant Calibration command, 6-21
Gas Selections command, 6-20
Instrument Calibration command, 6-28
Show Status command, 6-18
TCD Calibration command, 6-22
Unit Configuration command, 6-19
Vapor Generator Calibration command, 6-30

Units command, 8-5
Units of measurement, 8-5
Unstable baseline, 9-2

V
Valves

calibration, manual control of, 6-15
cold trap, manual control of, 6-13
loop, manual control of, 6-13
preparation, manual control of, 6-13
vapor generator, manual control of, 6-13

Vapor analysis calibration, 5-25
Vapor calibration experiment dialog, 5-25
Vapor Defaults command, 8-14
Vapor generator, 1-15

attaching, 2-16
calculations, B-9
calibrating the heat zones, 9-20
calibration, 6-30, J-45
checking for leaks, 9-27
cleaning, 9-15
exhausting for, 2-6

Vapor Generator Calibration command, 6-30
Venting exhausts, 2-6
View mode, 6-10
Voltage, input/output, E-3
Volume

converting sample data to, 5-21
sorbed, calculations, B-5
syringe, 5-22

W
Wait step, 5-36
Warm-up period, 2-17

Warnings, 1-2, 2-6
Weighing the sample, 4-18, 4-21
Windows menu, 3-10

X
X-axis, 5-49, 5-51

Y
Y-axis, 5-49, 5-51

Z
Zero TCD signal, 9-2
Zones push button, 5-17
Zoom feature, 7-13, 7-16
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